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About This Guide

This section briefly summarizes this document and how it can help you as a 
Maximo® user. It also provides information on other MRO resources available 
to you, such as additional documentation and support.

Who Should Read this Guide?

This guide is designed for both novice and experienced Maximo users who will 
be using applications in the following Maximo modules to manage Service 
Desk tickets, work orders, assets and inventory, and purchasing:

! Assets Module
! Contracts Module
! Deployed Assets Module
! Inventory Module
! Planning Module
! Preventive Maintenance Module
! Purchasing Module
! Resources Module
! Safety Module
! Self-Service Module (Desktop Requisitions and Service Requests)
! Service Desk Module
! Service Management Module
! Work Orders Module

For information about using the applications in the following Maximo 
modules, consult the Maximo System Administrator's Guide:

! Administration Module
! Configuration Module
! Financial Module
! Security Module

For additional information about using the applications in the following 
Maximo module, consult the Maximo Report Administration Guide:

! Reporting Module 

For information about using the applications in the following Maximo module, 
consult the appropriate Maximo Enterprise Adapter Guide:

! Integration Module
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How to Use this Guide

The Maximo User�s Guide provides a general introduction to Maximo, and 
should be used together with the Maximo Help when learning about Maximo. 
Each Maximo application contains extensive online help including overviews 
and procedures. This guide introduces you to the applications, and the 
Maximo Help provides the details. For certain subjects, this guide provides 
detailed information to supplement the Maximo Help.

The first two chapters of this guide provide simplified overviews of how 
Maximo stores data in a database, the Multisite implementation of Maximo, 
Workflow, the look and feel of the application screens, and information about 
procedures that are common to more than one module, such as signing in, and 
searching for records.

Subsequent chapters of this guide provide an overview of each of the Maximo 
modules and applications, arranged alphabetically. You can choose which 
chapters to read based on which Maximo modules and applications are 
required to perform your job. Each chapter corresponds to a Maximo module, 
and includes a section for each application that appears in that module. These 
chapters focus on how the applications function as part of Maximo and provide 
a quick reference to common tasks. When overview information applies to two 
or more applications it appears in the module overview, rather than being 
repeated in the application overviews. For detailed instructions on how to use 
an application, refer to the Maximo Help. 

Appendix A lists Maximo's keyboard shortcuts. For information about browser 
shortcut keys, refer to your browser documentation. Appendix B describes 
Maximo�s self-service applications, which are designed for the occasional 
Maximo user. Appendix C lists additional information about using Maximo to 
manage information technology assets.

How to Print this Guide

This document is available in two formats, Adobe® System Incorporated�s 
Portable Document Format (PDF) and Hypertext Markup Language (HTML).

The file 60_mx_ug.pdf is available on the documentation CD.

To print the PDF User's Guide, complete the following steps:

1 Open the User's Guide in Adobe Reader.

2 From the Reader menu choose File > Print. The Print dialog box appears.

3 If you do not want to print the entire guide, enter the pages to print in the 
Pages from fields. 

4 Click OK.

The HTML User�s Guide can be accessed via the Maximo Help menu, it is part 
of the main Maximo Help. The online version of this document contains one 
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HTML page for each chapter of the book. Each chapter must be printed 
individually.

To print the HTML User's Guide, complete the following steps:

1 Open the User's Guide and navigate to the chapter that you want to print.

2 Place your curser in the file to be printed, not in the Table of Contents.

3 Right-click and select Print from the menu. The Print dialog box appears.

4 Click Print.

5 Repeat steps 2 through 4 for each additional chapter that you want to 
print.

Documentation Conventions

This guide describes all of the modules and applications available to an end-
user in a standard "out-of-the-box" Maximo installation, that is, without 
implementation or configuration modifications. Because Maximo can be 
implemented in a variety of ways to match a wide range of business needs, 
this guide may not exactly match your company's Maximo implementation.

Implementation is the process by which a business or company decides 
which components of Maximo will be utilized to meet the needs of the 
business. Some examples of ways that an implementation team can choose to 
implement Maximo include:

! Choosing one or more languages for the implementation.
! Creating one or more Organizations, and one or more Sites.
! Using Maximo for Enterprise Asset Management (EAM), or Information 

Technology Asset Management (ITAM), or both.
! Creating cloned or custom applications.
! Creating custom Start Centers to match job descriptions.
! Choosing to create Workflow processes for records.

Configuration is the process by which an administrator changes the layout 
and or display of a screen for all users. Some examples of ways that a system 
administrator can configure Maximo include:

! Modules can be hidden or renamed.
! Applications can be hidden or renamed.
! Tabs can be added, hidden, or be renamed.
! Fields can be added, hidden, have their location changed, or be renamed.

Personalization is the process by which a user modifies the content and 
display of Maximo data for their screens only. Some examples of ways that 
you can personalize Maximo include:

! Choose a default language, locale, and time zone
! Choose a sort order for columns in a table window.
! Choose to display or collapse sections of an application screen.
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Note that the security settings associated with your user name determine 
your access to Maximo modules, applications, tabs, and actions.

Notation Conventions

This guide uses the following typographical conventions:

Bold type indicates the following elements of the user interface:

! Buttons
! Check boxes
! Field names
! Select Action menu options

Italic type indicates a documentation title, and is used for emphasis.

The greater than sign (>) is used to indicate a menu choice from a submenu, 
for example "Select File > Open." means you should select the File menu, then 
select the Open option from the File menu.

TIP: A tip helps you apply the techniques and procedures described in the text 
to your specific needs.

NOTE: A note provides related information, reminders, recommendations, and 
strong suggestions.

CAUTION: A caution means that taking or avoiding a specific action could cause 
you to lose data.

Related Documentation

The Maximo User�s Guide is part of the Maximo documentation set. You 
receive the Maximo�s documentation set in Adobe® Systems� Portable 
Document Format (PDF) on the Documentation CD. Depending on the options 
purchased, your documentation set can include the following documents: 

! Maximo® Installation Guide specific to your application server and 
operating system

! Maximo® System Administrator�s Guide

! Maximo® Multisite Administrator�s Guide

! Maximo® Report Administration and Development Guide

! Maximo® Workflow� Designer Implementation Guide 

! Maximo® Finance Manager�s Guide 

! Maximo® Project Manager User�s Guide 
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Depending on your database platform and the options you purchase, you also 
might receive third-party manuals and online documentation.

Support

To find the nearest corporate office, visit the company contact page on the 
MRO Web site:

mro.com

MRO Software, Inc. users with a valid Annual Customer Support Plan (ACSP) 
can obtain product support online at:

support.mro.com

NOTE: To use the MRO Software Support Online Web site, you must provide 
your contact information and your MRO Software product serial/license 
number. 

The MRO Software Support Online Web site includes information on product 
releases, software patches, and documentation updates. To find the most 
current version of a document, refer to the Support Web site�s Knowledge 
Base.

http://www.mro.com
http://support.mro.com
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Maximo is a computerized asset maintenance system that provides asset 
management, work management, materials management, and purchasing 
capabilities to help companies maximize productivity and extend the life of 
their revenue-generating assets.

Maximo allows your company to create a strategy for maintenance, repair, 
and operations related to both Enterprise Asset Management (EAM) and 
Information Technology Asset Management (ITAM).

About Maximo

Maximo stores and maintains data about your company�s assets, facilities, 
and inventory. You can use this information to help you schedule maintenance 
work, track asset status, manage inventory and resources, and analyze costs.

Maximo�s software suite can be configured to meet the needs of a variety of 
different businesses, including:

! Manufacturing and utilities production
! Hotels, universities, and other facilities
! Buses, trains, aircraft, and other fleet vehicles
! Information technology (IT) assets 

Maximo helps companies to improve the availability and performance of their 
revenue-generating assets while decreasing operating costs, without 
increasing safety issues. Maximo lets you:

! Record service requests and all related records and communications from 
the initial request to problem resolution.

! Track work orders and failures to better schedule preventive maintenance.

! Track information technology (IT) assets and their configurations across a 
network.

! Track inventory use to find optimum stock levels. The goal is to maximize 
availability of items for upcoming work, while also reducing unnecessary 
inventory and associated carrying costs.

! Track purchasing of inventory stores and materials for work orders. To 
assist in creating budgets, you can use Maximo to track costs for labor, 
materials, services, assets, and tools used to complete work orders.

! Reduce on-the-job injuries and accidents by identifying hazards in the 
workplace and precautions needed to increase safety.

1 Maximo Overview
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Maximo can automate processes that are repetitive or happen on regular 
intervals, for example, preventive maintenance, periodic inspections, or 
reordering inventory items.

Maximo Components

A Maximo installation consists of several components that work together:

! a relational database (briefly described in this chapter)

! application server software (described in your installation guide and in the 
Maximo System Administrator�s Guide)

! Maximo software including

! system administration applications for initial setup, configuration, and 
security (described in the Maximo System Administrator�s Guide)

! end-user applications for asset management (described in this guide)

! Actuate® report software (described in the Maximo Report Administration 
and Development Guide and the Actuate documentation)

Maximo Modules and Applications

Maximo�s applications are grouped into modules. The applications in a module 
have similar purposes, for example, applications related to purchasing are 
grouped together. Some applications, such as Work Order Tracking, function 
individually, while others, such as Precautions, create records designed to be 
used in conjunction with records created in other applications. 

Depending on your job description and security permissions, you may have 
access to some or all of the Maximo modules and applications. 

Chapters that appear later in this guide describe each module and application 
in more detail.    

Module Application Function

Assets Applications to manage assets and locations.

Assets Used to create and store asset numbers and corresponding information, 
such as parent, location, vendor, up/down status, and maintenance 
costs for each asset. 

Condition 
Monitoring

Used to define measurement points for assets or locations, and to 
specify alarm limits and associated work to be performed after reaching 
those limits.

Failure Codes Used to define failure codes and define the Problem, Cause, Remedy 
hierarchy.

Locations Used to create location records and track assets that exist at the 
location. Also used to build hierarchical or networked systems.
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Meters Used to define meters that can be used to track asset and location 
performance.

Meter Groups Used to create groups of meters that can then be applied to assets or 
locations at the same time.

Contracts Applications to manage contracts with vendors.

Labor Rate 
Contracts

Used to define labor rates to be paid to specific crafts and skills when 
hiring workers.

Lease/Rental 
Contracts

Used to define the terms and conditions and payment information for 
lease or rental agreements for rotating assets, including information 
technology assets.

Master 
Contracts

Used to define the contractual relationship with a vendor. A master 
contract links all contracts with the vendor, as well as containing the 
terms and conditions that apply to the associated contracts.

Purchase 
Contracts

Used to create, modify, and view contracts for items or services with 
outside vendors. You can include detailed information about a 
contract's shipping and financial terms, contact information, item and 
service pricing, and delivery times. 

Terms and 
Conditions

Used to enter and maintain a library of terms and conditions to be used 
on contracts and purchasing documents. These terms can contain 
information such as liability concerns, shipping and handling details, or 
delivery time expectations.

Warranty 
Contracts

Used to create warranty and service contracts where vendors maintain 
one or more assets for a fixed fee, or regularly scheduled payment over 
a time period; or to track warranty information for multiple assets or 
locations by time or meter.

Deployed 
Asset

Applications to view information about deployed information 
technology (IT) assets.

Computers Used to view data about specific computers deployed at your company.

Network 
Devices

Used to view information about deployed network devices such as 
routers, switches, and hubs. 

Network 
Printers

Used to view information about deployed network printers. 

Inventory Applications to manage item and tool inventory.

Condition 
Codes

Used to define the codes used to describe the condition of items.

Inventory Used to manage items in inventory, including tracking stock levels, 
reordering items, and tracking rotating assets.

Issues and 
Transfers

Used to issue stock from inventory (with or without a work order), and 
to transfer stock from one storeroom location to another.

Item Master Used to define inventory items, and add them to a storeroom�s stock 
list.

Service Items Used to define services that your company requisitions, either as part of 
the purchasing process, or as part of a work order.

Module Application Function
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Stocked Tools Used to manage tool inventory.

Storerooms Used to define storeroom locations, and view a read-only list of items 
stocked at each storeroom location.

Tools Used to define tools and add them to storerooms.

Planning Applications to plan how work should be performed.

Job Plans Used to create a detailed description of how a job is to be performed and 
the resources required to complete it.

Routes Used to list related work assets (assets and/or locations) that are 
considered "stops" along an inspection or maintenance route.

Safety Plans Used to create a detailed plan of how to service assets or locations 
safely.

Preventive 
Maintenance

Applications to manage preventive maintenance.

Master PM Used to create generic preventive maintenance templates.

Preventive 
Maintenance

Used to plan periodic, preventive maintenance, and inspections for 
assets and locations.

Purchasing Applications to manage purchasing.

Companies Used to manage records for manufacturers, vendors, and other 
companies that do business with you.

Company 
Master

Used to define companies that belong to a Company Set that can be 
shared by one or more Organizations.

Invoices Used to record invoices and match against purchase orders and receipts 
for approval.

Purchase 
Orders

Used to purchase materials or services from an internal supplier or an 
external vendor. 

Purchase 
Requisitions

Used to request the ordering of materials or services.

Receiving Used to receive materials into inventory and record the receipt of 
services.

Request for 
Quotation

Used to request and manage vendor quotations for prices and delivery 
information for goods and services.

Terms and 
Conditions

Used to enter and maintain a library of terms and conditions to be used 
on contracts and purchasing documents. These terms can contain 
information such as liability concerns, shipping and handling details, or 
delivery time expectations.

Resources Applications to create records for individuals and groups.

Crafts Used to create and manage craft records.

Labor Used to create and manage laborer and contractor records.

People Used to create and manage records for people who are listed on Maximo 
records in any capacity.

Module Application Function
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Person Groups Used to create and manage person group records that can be used on 
escalation, Workflow process and other records.

Qualifications Used to create and manage certificate and qualification records.

Safety Applications to record safety information.

Hazards Used to define hazards that exist in the workplace and define how to 
eliminate or mitigate them.

Lock Out/Tag 
Out

Used to create a detailed description of how to eliminate hazards 
associated with related assets or locations.

Precautions Used to define precautions that can be taken to mitigate hazards in the 
workplace.

Safety Plans Used to create a detailed plan of how to service assets or locations 
safely.

Self-Service 
Module

Applications to allow users to create and submit purchase requisitions 
and service requests.

Desktop 
Requisitions

Applications to create requisitions, view drafts and templates, and view 
submitted requisitions.

Service 
Requests

Applications to search Solutions, create service requests, and view 
submitted service requests.

Service Desk Applications to manage customer requests for help, information, and 
service.

Activities Use to report work on activity class work orders.

Changes Used to create records to track changes made to information technology 
(IT) assets.

Incidents Used to create records of incidents that result in an interruption to or 
reduction in the quality of a service.

Problems Used to create records of the underlying problems that cause incidents 
and service requests.

Releases Used to create records to plan and record the release of changes to 
information technology (IT) assets.

Service 
Requests

Used to create records of customer calls or e-mail requesting service.

Solutions Used to create a library of reusable solutions which can be applied to 
incident and problem records.

Ticket 
Templates

Used to create templates for common service desk calls.

Service 
Management

Applications to manage services provided by your company, or 
purchased from vendors.

Service Catalog Used to create service groups and catalog the services provided by those 
groups.

Service Level 
Agreements

Used to define agreements between service providers and customers, 
documenting agreed upon levels of service.

Module Application Function
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Understanding Databases

When you enter information into Maximo, it stores the data in a database. 
Understanding the structure and function of a database helps you to 
understand how Maximo operates. It also helps you to retrieve information.

A database is simply a way of storing and organizing large amounts of 
information, much like an electronic filing cabinet. Because of how the 
information is entered and organized, a computer program can search and 
display requested data quickly. 

Maximo works with Oracle® databases. The Maximo database contains more 
than 490 tables and more than 11,000 columns. 

Database Components

Traditional databases are organized by columns (or fields), rows (or records), 
and tables (or files). Which term is used often depends on whether you are 
talking about the database program or what a user sees on the computer 
screen.

A field is a single piece of information (for example, a name). A record is a 
complete set of fields (for example, a name, address and phone number). A file 
is a collection of records. A telephone directory would be a file since it contains 
a list of records, each consisting of three fields: name, address, and telephone 
number.   

Columns or Fields

In Maximo, each field and check box on the page is a separate column in the 
database. 

Work Orders Applications to manage work orders, labor assignments, and labor 
hours.

Assignment 
Manager

Use to dispatch urgent work and schedule future work requirements.

Labor 
Reporting

Used to report hours worked by labor (employees) or contractors. You 
can enter hours worked by labor ("timecard" reporting), contract/
vendor, ticket, or work order.

Service 
Requests

Used to create records of customer calls or e-mail requesting service.

Quick 
Reporting

Used to report work on open work orders and small jobs without pre-
existing work orders, or to report equipment downtime that involves no 
maintenance work.

Work Order 
Tracking

Used to perform every function related to processing work orders.

Module Application Function



Chapter 1: Maximo Overview

Maximo 6, 08/2006 1-7

A column or field is the smallest unit of data in a database. A field might 
contain a word, a number, or several sentences. Because you enter 
information into specific fields and Maximo uses those fields to store 
information in the database, you can search for information quickly and 
easily.

Columns have properties, which include a unique name, description, data 
type, whether a field is required, optional, or calculated, and so on. A required 
field is one where you must enter data. An optional field can be left empty or 
null. A calculated field does not require data entry. Maximo uses a formula 
based on entries in other fields to calculate the value, for example, a Total 
Cost field. Your company�s business needs determine the properties of a field.

Key Fields

In a database, a key is a field that you use to sort data. It also can be called a 
key field, sort key, index, or key word. For example, if you sort records by 
creation date, the Creation Date field is a key. Some columns are designated 
as primary keys. A primary key is one or more columns that uniquely 
identify a record and make it distinct from other records. For example, the 
work order applications use the work order number as a key.

The value(s) in a primary key cannot be null (empty), and they must be 
unique. Maximo automatically numbers the primary key field in most 
applications. In applications where you can create the primary key, Maximo 
alerts you if you choose a value that has already been used in the data table.

NOTE: When using Multisite key field uniqueness is determined by the level 
the records are stored at: System, Set, Organization, or Site. It is 
possible to have identical key fields in the database for different records 
created at different Organizations or Sites. For more information about 
Multisite, see �Multisite Overview,� on page 1-9.

Rows or Records

Each row in a database table is a collection of related columns (fields), called a 
record. A Maximo record contains the data you enter in fields on the 
computer screen. If you used paper instead of a computer to keep track of your 
data, you would complete a form with related information, with a different 
page for each new record. 

Maximo records include the following examples:

! a work order
! an asset record
! a purchase order
! a row in a table window and its corresponding Row Details 

Tables or Files

Databases are structured so that similar data is stored together in tables, also 
known as files. A table is a grouping of data arranged in rows and columns. In 
general the different Maximo page areas, for example, tabs, subtabs, and table 
windows, each correlate to a different table in the database. Because Maximo 
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uses a relational database, data that you enter into one table can be shared 
with another related table, or used to calculate a value in yet another table.

Structured Query Language

Maximo uses Structured Query Language (SQL) to retrieve data from the 
database. Requests to find information in a database are called "queries." 
SQL is a standard language specifically designed to let people to create, edit, 
maintain, and retrieve data from databases. 

You do not need to know SQL to use Maximo. All Maximo users can perform a 
query to the database from the application pages. For more information about 
database queries, see �Searching the Maximo Database,� on page 2-6. 
However, you should know SQL if you plan to use Maximo to create reports. 

Maximo�s Database Structure

Maximo�s database is a relational database. A detailed look at Maximo�s 
database design is beyond the scope of this guide, but you should be familiar 
with a few additional database concepts which are covered in this chapter. 

You can refer to the Technical Reference Guide or the Data Model Report 
available on the documentation CD for more technical information about the 
Maximo database. 

Relational Databases

The records accessed by Maximo are stored in a relational database. In a 
relational database one table can be connected to another table if they both 
contain at least one common field. For example, the WORKORDER table and 
JOBPLAN table are related because their records both contain job plan IDs. 
This relational structure lets you view the same data in many different ways, 
from many different applications.

Maximo Hierarchies

Some Maximo applications group related records using "parent-child" 
relationships. A parent-child relationship is a one-way referral or link from 
one table to another. A column in the child table refers to a column in the 
parent table. The column referred to in the parent table must be part of the 
primary key. For example, in the Assets application, you can have a "parent" 
asset record that has "child" records for subassemblies. The subassembly 
records contain a reference to the parent record that they "belong to."

Maximo uses these parent-child relationships to group related records such as 
assets, operating locations, or work orders into hierarchies. You can build 
and use hierarchies of records in many Maximo applications, including Assets, 
Companies, Locations, Master Contracts, Preventive Maintenance, and Work 
Order Tracking.
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With a parent-child relationship, you cannot delete a parent record without 
first deleting the children, because if you delete a record from the parent 
table, then the child would have an entry referencing a record that no longer 
exists. 

Data Sharing Between Applications

Because Maximo�s applications work together, data from a column in one 
database table can be shared with other database tables. Because of this 
column sharing, a data entry error in a single field (column) can appear in 
more than one application. 

In many cases you can correct errors, but in some instances after you enter 
data, or change a record�s status, you cannot change the data in the database. 
In these cases Maximo preserves errors intentionally, to create records for 
auditing purposes.

Note that a field that has one name in one application, can have a different 
name in another application but contain the same data. For example, the 
MANUFACTURER column in the ASSET table is the same as the COMPANY 
column in the COMPANIES table. 

TIP: You can find information about each field�s table and column location in 
the database by placing the cursor in a field and pressing Alt + F1.

Multisite Overview

Large businesses often consist of multiple facilities, or even multiple 
companies owned by a parent corporation. Some customers choose to install a 
separate Maximo database at each facility. But often these different facilities 
have common business practices or share common data, and separate 
databases do not meet the needs of the business.

Multisite is a way of implementing Maximo that allows a large company or 
corporation with multiple facilities to share data from a single database, while 
allowing the flexibility to have different business practices and data at 
different facilities. A Multisite setup allows you to organize your Maximo 
database to model your company�s organizational structure. 

The following sections contain a brief overview of Multisite. For more 
information about the Multisite option, refer to the Maximo Multisite 
Administrator�s Guide.

Multisite Levels

Multisite divides data storage into the following different levels:

! System or database � Data that is stored at the system level can be 
accessed by all users who are connected to the Maximo database. You may 
also hear this level referred to as "Enterprise level."

! Set � Data that is stored at the Company Set or Item Set level can be 
accessed by users in the Organizations that share the Company or Item 
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Set. Each Organization can have only one Company Set and one Item Set, 
but more than one Organization can share the same Company or Item Set. 
An administrator uses the Sets application to define Company and Item 
Sets.

! Organization � Data that is stored at the Organization level can only be 
accessed by users within a specific Organization. An Organization can 
contain one or more Sites. Organization level data can not be shared with 
other Organizations. An administrator uses the Organizations application 
to define Organizations.

! Site � Data that is stored at the Site level can only be accessed by users 
at the specified Site. Site level data cannot be shared with other Sites or 
Organizations. An administrator uses the Organizations application to 
define Sites.

When you install Maximo you must create at least one Company Set, Item 
Set, Organization, and Site. That may be all that is required to meet the needs 
of your business. 

Multisite and Maximo

You create person and person group records at the System level, and define 
users and security groups at the System level. Many of the general records 
that are used by all of the Maximo applications, such as classifications, units 
of measurement, and the attached document library, are created at the 
System level. Many of Maximo's automated tasks (Cron tasks, E-mail listener, 
Escalations, and Workflow) are also the system level. 

The Service Desk and applications to manage information technology (IT) 
assets are at the system level. This includes the Bulletin Board, Solutions, the 
ticket applications (Service Requests, Incidents, Problems. Ticket Templates), 
service level agreements, and the Deployed Assets, Deployed Assets 
Administration, and Reconciliation modules.

KPIs and reports are at the system level, allowing you to create and run 
reports against any application or function that Maximo manages.

Company Master records are created at the Company Set level so that the 
records can be shared by more than one Organization. Item records for items, 
services, and tools are defined at the Item Set level, so that the records can be 
shared by one or more Organizations and items and tools can be transferred 
between Organizations and Sites that share the same Item Set. Other item 
related data such as commodities, condition codes, and conversion values 
between order units and issue units are also defined at the Item Set level.

Although currency codes are defined at the system level, other financial 
information (exchange rates, tax codes, General Ledger accounts, financial 
periods, and so forth) is defined at the Organization level. You also create 
contracts (master, labor rate, lease/rental, purchase, and warranty type 
contracts) and vendor records, and define terms and conditions for contracts 
and purchasing at the Organization level.

Calendars and shifts are defined at the Organization level, as are Failure 
Codes. Labor records are defined at the Organization level, as are crafts, 
skills, certifications, qualifications, labor rates, and premium pay rates.
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Assets and locations are at the Site level, and thus condition monitoring, 
failure reporting, meter readings, PMs, and work orders are also at the Site 
level. Job plans are at the System level, but can have Organization or Site 
specific elements. Hazards are defined at the Organization level, but 
precautions, tag outs, and safety plans are defined at the Site level. Labor 
assignments and labor reporting is done against work orders, and thus is also 
at the Site level. Item and tool inventories are managed at the Site level, 
which means that purchasing (PR, RFQ, PO, Receiving, and Invoices) are also 
at the Site level.

The following table lists which applications and functions are defined at each 
Multisite level:     

Multisite Level Applications or functions

System or database � A 
System is a single instance of a 
Maximo database.   A single 
System can contain one or more 
Sets, Organizations, and Sites.

! Attached Document Library
! Bulletin Board
! Classifications
! Communication Templates
! Computers
! Cron Task Setup
! Currency Codes
! Deployed Assets
! Escalations
! Incidents
! Job Plans
! KPIs
! Master PM
! Meters
! Meter Groups
! Network Devices
! Network Printers
! People
! Person Groups
! Problems
! Reconciliation
! Reports
! Security Groups
! Service Level Agreements 
! Service Requests
! Solutions
! Ticket Templates
! Units of Measurement
! Users
! Workflow

Set � Sets exist below the 
System level, but above the 
Organization level, to allow 
multiple Organizations to share 
company and item data. Each 
Organization can have only one 
Company Set and one Item Set, 
but each Set can be shared by 
more than one Organization.

! Condition Codes
! Commodity Codes
! Company Masters
! Conversion values (Order 

Units/Issue Units)
! Item Master
! Service Catalog
! Service Items
! Tools
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Security Overview

Your access to Maximo�s modules, applications, screens, and menu options is 
controlled by your security privileges. All security access to Maximo is based 
on security groups. Your user name is associated with one or more security 
groups, each of which can have different levels of access to Maximo.   Security 
setup is described in detail in the System Administrator�s Guide, but you 

Organization � An 
Organization identifies a unique 
legal entity. A large corporation 
might have different 
Organizations for different 
companies, or group all the 
facilities that exist in a 
continent or country into an 
Organization. There can be 
many Organizations within a 
single Maximo database.

! Calendars
! Chart of Accounts (GL 

Account codes)
! Companies
! Crafts
! Exchange Rates
! Failure Codes
! Hazards
! Labor
! Labor Rate Contracts
! Labor Reporting
! Lease/Rental Contracts
! Master Contracts
! Purchase Contracts
! Qualifications
! Tax codes
! Terms and Conditions
! Warranty Contracts

Site � A Site identifies a work 
location, such as a plant or 
facility.

! Activities
! Assets
! Assignment Manager
! Changes
! Condition Monitoring
! Desktop Requisitions
! Inventory
! Invoices
! Issues and Transfers
! Labor Reporting
! Locations
! Lock Out/Tag Out
! Precautions
! Preventive Maintenance 
! Purchase Orders
! Purchase Requisitions
! Quick Reporting
! Receiving
! Releases
! Request for Quotation
! Routes
! Safety Plans
! Stocked Tools
! Storerooms
! Work Order Tracking

Multisite Level Applications or functions
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should be aware of how security settings can affect your ability to use 
Maximo.

In Maximo all permissions are granted. A new user name or group has no 
permissions until they are granted by the system administrator.

NOTE: Your Maximo license also affects your access to modules and 
applications. Your company may not have purchased a Maximo 
configuration that includes all of the applications documented in this 
guide.

Passwords

You are assigned a user name and password by your system administrator. If 
you have security permissions to do so, you can change your password by 
selecting Profile > Password Information from the navigation links. 

Your system administrator may configure Maximo to 

! specify a required length for passwords. The default is six characters.
! specify the number of days before a password expires.
! require that passwords contain a number or special character
! prevent you from reusing a password.

When you change you password you can enter a password hint. Your system 
administrator can require you to correctly answer the Password Hint 
Question before they will reset your password.

Workflow

Maximo Workflow provides a dependable and repeatable method for routing 
Maximo records to the people that need to act on them. This is useful for 
managing the approval process of records such as tickets, purchasing records, 
and work orders, and ensuring that the approval process happens in a timely 
manner.

Workflow Capabilities

A Workflow process is a preset path that determines the flow of information at 
your company. A Workflow process has the following capabilities:

! A Workflow process can be started automatically or manually.

! Records can be assigned for action to a person, person group, delegate 
(alternate) or a role.

! Users can receive Workflow notifications in their Workflow Inbox or via 
e-mail.

! Workflow tasks can be reassigned to another user when appropriate.

! Standard time periods can be defined at each step, after which the record 
is escalated.



Workflow

1-14 Maximo 6, 08/2006

Understanding Workflow Processes

A Workflow process is a map of your company�s business processes. Any time 
your company�s business rules call for a person to perform an action or provide 
input on a record, Workflow can be configured to electronically route the 
record to the person or group who needs to act on the record. Workflow can 
also automatically evaluate the record to determine the next step for the 
record.

The decision made at each step determines the path the record takes. Certain 
decisions are made by users while others are made automatically by Maximo 
according to information within the record. 

Workflow processes are created for a particular type of record, for example 
work orders. The following is just one example of how a service request might 
move through a work order Workflow process:

! Someone enters a request for a repair via the Service Request application, 
creating a ticket record.

! The Workflow process automatically creates a work order from the ticket 
record.

! The request is routed to a maintenance supervisor, who determines 
whether or not the work must be completed immediately.

! If the work is not urgent, the request is routed to a planner, who assigns 
the work to a laborer.

! The assignment appears in the laborer�s Workflow Inbox. 

! When the work order is saved with a value in the Actual Start field the 
work order status changes to INPRG and the Workflow automatically 
creates an e-mail that notifies the person who requested to work that work 
has started on their request.

! When the work order is saved with a value in the Actual Finish field the 
work order status changes to COMP and the Workflow automatically e-
mails the maintenance supervisor that work has been completed.

! Once the maintenance supervisor approves the completed work, the work 
order status changes to CLOSE.

A Workflow for a purchase requisition (PR) might resemble the following 
example:

! A worker creates a purchase requisition and enters it in Workflow with a 
status of WAPPR.

! The PR is routed to the worker�s direct superior, who reviews the PR and 
approves or rejects it.

! If the total cost of the approved PR is more than a specified dollar amount, 
the PR is routed to the department manager, who must also approve it.

! Once the status has been changed to APPR, the PR is routed to the 
purchasing department, where it is reviewed by the purchasing agent.
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! The purchasing agent creates a purchase order (PO) for the appropriate 
vendors listed on the PR, and changes the PR status to CLOSE once all of 
the PR lines have been assigned to a PO.

! The purchase order(s) created from the PR might then enter a separate PO 
Workflow.

NOTE: When a record enters a Workflow Process, the status change action is 
disabled on that record and Workflow takes control of the status 
changes. A record leaves a Workflow process when it reaches a stop 
node. When a record leaves the control of a Workflow process it becomes 
a regular Maximo record that retains whatever status it had when it left 
the Workflow. 

Using the Workflow Inbox

Your Start Center may be configured so that it contains a Workflow Inbox. 
When Maximo routes a record to you for action, it appears in your in your 
Workflow Inbox. You can click the record ID to view the record.



Workflow

1-16 Maximo 6, 08/2006



Maximo 6, 08/2006 2-1

Maximo is a Web-based product. This chapter describes the different elements 
of the application pages, basic navigation of the user interface (UI), and 
procedures that are common to most or all Maximo applications, such as 
searching and selecting values.

System Requirements

To use Maximo, you need the following:

! a Web browser. Maximo currently supports Microsoft® Internet Explorer 
version 5.5 SP2 or higher.

! a monitor with resolution of 1024 x 768 pixels per inch.

! a user name and a password. These are assigned by your system 
administrator.

In addition, your Web browser should be set to automatically check for newer 
versions of pages stored in Temporary Internet files. 

CAUTION: Pop-up blockers prevent your browser from opening new browser 
windows. Pop-up blockers may interfere with some Maximo 
functionality, for example Maximo Help.

Launching Maximo

Maximo is a Web based application suite. You access it through a Web 
browser by entering the Uniform Resource Locator (URL) that points to an 
application server that is running Maximo. 

NOTE: Your system administrator will provide you with the URL to use to 
connect to Maximo.

Signing In to Maximo

While your system administrator can customize the Maximo Sign-In screen, it 
should include fields to enter your user name and password.

2 Getting Started 
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Maximo Sign In 

If you do not have a user name and password, for example, if you are not a 
Maximo user but must file a maintenance request, click "register now" to 
register yourself and create a user name and password. For more information 
about user self-registration, see �User Self-Registration,� on page B-1.

NOTE: Your user name and password are case sensitive.

When you access reports, Maximo automatically signs you in to Actuate using 
your Maximo user name and password. For information about using reports 
with Maximo, refer to the Maximo Report Administration and Development 
Guide.

Browser Menu and Icons

The menu and toolbar icons at the top of the page control your Web browser. 
Do not confuse them with the Maximo menus and toolbars.

Browser Toolbar

CAUTION: Do not use the browser Forward and Back buttons to navigate 
within Maximo. These buttons act on the browser, and are not part 
of the Maximo software.

For more information about this part of your screen, refer to your browser 
documentation.
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Maximo Navigation Bar

Below the browser menu and toolbar is the Navigation Bar, the first part of 
the Maximo application page. The following figure shows the Navigation Bar:

Maximo Navigation Bar 

Maximo uses the Navigation Bar to identify the current application, display 
messages, and display links that let you maneuver among Maximo 
applications. It contains the following sections:   

! Application icon and name shown on the left to identify the current 
application. The application icon is also a link to the first editable field on 
the application page. 

! Message area in the center. When appropriate, Maximo displays 
messages in this area. These messages are only informational, and need 
no response, for example, �Record has been saved.� 

! Navigation Links in the right corner. The available links vary depending 
on which page you are currently using. Possible options include the 
following links: 

!  Bulletins � Click to display the Bulletin Board and view broadcast 
messages. This link only appears when there are active Bulletin Board 
messages.

!  Go To � Click to display a menu of modules, letting you maneuver 
among modules and applications. 

!  Reports � Click to display a menu of modules, letting you 
maneuver among modules and applications to select an application to 
run reports against.

!  Start Center � Click to return to your Start Center.
!  Profile � Click to manage the personal information (address, 

phone, e-mail, and so forth), defaults, and Maximo password recorded 
on your Maximo Person and User records.

!  Sign Out � Click to sign out of Maximo.
!  Return � Click to return to the previous application page without 

selecting a value. Available after you link to another application.
!  Return with Value � Click to return to the previous application 

page with selected value(s). Available after you link to another 
application.

!  Help � Click to display the help menu (when selected from 
application pages), or context sensitive help (when selected from dialog 
boxes). This link is always available.

Signing Out of Maximo

Do not exit an application by closing the browser. To ensure that the 
connection between your user name and the Maximo server is severed, you 
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should always use the Sign Out link in the Navigation Links to exit Maximo 
before closing the browser. 

Maximo Start Centers

After you sign in, Maximo displays your Start Center. A Start Center 
contains links to actions, applications, data, records, and/or reports that are 
relevant to your job. Start Centers are assigned to security groups by a system 
administrator using the Security Groups application. If your user name is 
assigned to more than one security group, you may have more than one Start 
Center. 

Start Center Components

A Start Center consists of two columns, one narrow and one wide. Each 
column can be configured to display one or more portlets, or windows, which 
display data, links, or reports that are available in a specific Maximo 
application. The portlets that make up a specific Start Center are often chosen 
to support a particular job function, and can include any of the following:

! Bulletin Board � Displays Bulletin Board messages.

! Favorite Applications � Displays links that allow you to launch specific 
Maximo applications.

! Inbox/Assignments � Displays your Workflow Inbox, which contains 
records that have been routed to you and that require some sort of action, 
for example, review and approval. For more information about Workflow, 
see �Workflow,� on page 1-13.

! KPI Graph � Displays one or more Key Performance Indicator (KPI) 
graphs.

! KPI List � Displays a list of links to one or more Key Performance 
Indicator (KPI) records in the KPI Manager application.

! Quick Insert � Displays a list of links that allow you to launch an 
application and add a new record into the database, for example create a 
New Work Order. 

! Result Set � Displays the result set from a saved query. For more 
information about saved queries, see �Using Saved Queries to Search,� on 
page 2-8.

Managing Multiple Start Centers

If you have more than one Start Center assigned to your user name Maximo 
displays each Start Center as a separate tab, one for each Start Center. To 
view a different Start Center, click the tab for that Start Center. 

You can manage multiple Start Centers using the Display Settings link. 
This link allows you to:
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! Change the name of a Start Center.
! Indicate if a Start Center should be displayed or hidden.
! Indicate which Start Center should appear as the first tab (default).

Display Settings Dialog Box

Personalizing Portlets

Each portlet has an application that controls the content and configuration of 
the portlet. If your system administrator has granted you security 
permissions to a portlet�s application, then you can personalize how that 
portlet appears in your Start Center. The buttons that you use to personalize 
a portlet appear in the portlet header.   

Opening an Application

There are several ways to open a Maximo application from your Start Center. 

! Go To link in the Navigation Links � To open an application, click the 
Go To link in the Navigation Links, then select the module and 
application. For example, to open the Work Order Tracking application 
Select Go To > Work Orders > Work Order Tracking.

Button Action

Edit Portlet � Click to open the set up application for the 
portlet.

Minimize Portlet Window � Click to minimize the 
portlet.

Maximize Portlet Window � Click to maximize a portlet 
that has been minimized.

Remove Portlet � Click to remove a portlet from the 
Start Center.

CAUTION: If you do not have appropriate security 
permissions, you may be unable to restore the 
deleted portlet.
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! Favorite Applications portlet � To open an application, click the 
application link in the Favorite applications portlet. For example click 
Work Order Tracking.

! Inbox/Assignments portlet � To open an application and view a record 
that has been assigned to you for action, click the record ID.

! Quick Insert portlet � To open an application and insert a new record, 
click the link in the Quick Insert portlet, for example New Work Order.

! Result Set portlet � To open an application and view a specific record, 
click the record ID in the Result Set portlet.

TIP: You can run more than one Maximo application at the same time, as long 
as the applications are launched in separate browser sessions. For 
example, if you were creating a requisition for materials, you could have 
the Inventory application running in one browser session, and the 
Purchase Requisitions application running in a second browser session. 

Maximo's Application Types

While all of the Maximo applications share a similar look and feel, the 
applications fall into three general types:

! Self-service applications are designed to guide occasional Maximo users 
through the process of creating a record. Maximo contains two self-service 
modules, Desktop Requisitions, and Service Requests. For more 
information, see Appendix B, "Maximo�s Self-Service Applications," on 
page B-1. 

! Simple applications contain a single page. Records are displayed in table 
windows, and searches are accomplished using the table filter. A Search 
Toolbar may or may not appear on the application page. Assignment 
Manager, Condition Codes, Labor Reporting, and several of the 
administrative applications are simple applications.

! Standard applications are applications that contain the following:

! a standard navigation bar and toolbar
! a List tab and Search toolbar to search the database for records
! a main record tab
! as many additional tabs as are required by the type of record

NOTE: The majority of Maximo�s applications are standard applications.

Searching the Maximo Database

Maximo stores entered information in a database. Requests to find 
information in the database are called queries. When you open a Maximo 
application, Maximo displays the List tab which displays the result of your 
default saved query. If you do not have a default saved query Maximo does not 
display a result set. 
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Because most applications open to the List tab, you can execute several 
actions from the tab:

! execute a saved query from the Query menu.

! perform a key field search with Find field.

! create a new record by clicking the New <Record> button on the toolbar, 
for example New Work Order.

! create reports for one or more records

! perform any of the actions available via the Search Toolbar. For more 
information, see �Using the Search Toolbar,� on page 2-7.

! click any tab to view the first record in the result set. 

! select the Select Records check box, select one or more records, and 
select an action from the Select Action menu to perform on the record(s), 
for example to perform a status change on a group of records.

NOTE: Some applications may include additional actions available from the 
List tab.

Using the Search Toolbar

The Search Toolbar appears on the List tab, allowing you to perform several 
different search related actions. When you enter a query, Maximo uses 
Structured Query Language (SQL) to retrieve the data from the database. You 
do not need to know SQL to conduct basic searches of the Maximo database. 
The Search Toolbar contains actions that allow for both SQL and non-SQL 
based queries. The results of your query are displayed in a table window below 
the Search Toolbar.

The Search Toolbar

The triangle next to the Advanced Search button activates a menu of 
additional Advanced Search options:

! More Search Fields � Click to access additional record fields for query 
by example (QBE) searches.

! View Search Tips � Click to view a help topic containing tips for 
searching the Maximo database.

! WHERE Clause � Click to view your current structured query language 
(SQL) WHERE clause or to construct a new WHERE clause to use to 
search the database.

The triangle next to the Save Query button activates a menu of additional 
Saved Query options:
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! Save Current Query � Click to name and save your current query so 
that you can reuse it at a later time.

! View/Manage Queries � Click to view and manage your saved queries 
for the current application.

Basic Searches

This section describes the different ways to search the Maximo database for 
records. You do not need to know SQL to perform these basic searches.

Using Saved Queries to Search

The Query field in the Maximo toolbar contains a menu that includes any 
queries you have created and saved for an application, and two additional 
search options: 

! All Records
! All Bookmarks

When you select a query from this menu, Maximo executes it immediately. 

If you perform a saved query from the List tab the name of the saved query 
shows in the menu, but when a search performed from the List tab is not a 
saved query the menu is empty as no query name exists. 

Saving a Query

If you frequently execute the same searches, you can save time by creating 
saved queries. You can also define a default saved query for Maximo to 
execute every time you open an application. For example, if your job involves 
approving work orders, you might define a default query to find all work 
orders with a status of WAPPR (waiting for approval) when you open the 
Work Order Tracking application. If Maximo does not find any records that 
match your query it displays the message "No records found that match the 
specified query." 

Saved and default queries are specific to each application. For example, a 
query created in the Work Order Tracking application is not available in 
Quick Reporting unless you also create and save it in that application.

To save a query, complete the following steps:

1 Use the List tab to create a query. For more information about 
constructing queries see �Searching the Maximo Database,� on page 2-6.

Maximo displays the query results.

2 Click Save Query in the Search Toolbar.

The Save Current Query dialog box appears.
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3 Enter a name for the query in the Query Name field. You can also enter a 
Description.

NOTE: Each saved query must have a unique name.

4 Select the Public? check box to make the query available to other Maximo 
users. 

5 Select the Default? check box to make the query your default.

NOTE: You can also make a query your default by selecting the Default? 
check box in the View/Manage Saved Queries dialog box.

6 Click OK. 

Maximo saves the query and adds it to the Query menu. If you selected the 
Default? check box, the next time you launch the application, Maximo 
will execute the query.

Managing Saved Queries

The View/Manage Saved Queries dialog box displays all queries that you have 
saved and named. These queries are also available from the Current Query 
menu on the toolbar.

View/Manage Saved Queries Dialog Box

To execute a saved query, click the Query Name.

To delete a saved query, click the Mark Row for Delete button for the query.

Using the Find Field to Search

You can use the Find field in the Maximo toolbar to search for a single record 
by the record ID or key field. For example, in Work Order Tracking, the search 
is by work order number. You can use the Find field to search from any tab in 
the application. 
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NOTE: You must know the exact record ID to search using the Find field. 
Entering a partial record ID will not return any results.

To search using the Find field, complete the following steps:

1 Enter a record ID in the Find field.

2 Click the Quick Key Search button (binoculars).

For more information about key fields, see �Key Fields,� on page 1-7.

Using the Table Filter to Refine Search Results

The List tab displays query results in a table window. For more information 
about table windows see �Table Windows,� on page 2-19. Maximo table 
windows include a filter to help you locate specific rows in large tables by 
reducing the number of rows displayed. 

The table filter appears at the top of the table window as a row of editable 
fields appearing between the column headers and the first row of the table, as 
shown in the following figure.

Table Filter

To filter a table window, complete the following steps:

1 If necessary, click the !Filter icon. 

The filter opens and the Filter Table button appears.

2 Enter a value in one or more of the filter fields. You can enter partial 
values.

TIP: Use the equals sign (=) for an exact match. For example, filtering 
records with a status of "APPR" will also return records that have a 
status of "WAPPR" unless you type "=APPR" in the status field.

3 Click the Filter Table button (binoculars) or press Enter.

Maximo filters the table window and the Clear Filter Fields button 
appears.

If there are no rows that match your filter criteria, a message displays in 
the table window, for example "No work orders found." 

4 To filter using different criteria, click the Clear Filter Fields button to 
return to the original result set.

NOTE: The Clear Filter Fields button only appears when the rows 
displayed in a table has been filtered. 
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Field Buttons

Fields can have actions associated with them. A field can have a long 
description, a select value lookup, or a menu of actions associated with it. In 
all cases, you access these actions via a field button.

Field Buttons    

Special Characters and Maximo

A character is a letter, number, or symbol. Most database programs use a 
selection of special characters as operators. An operator is a symbol that 
represents a specific action that the database program should take. 

The following list contains characters that Maximo uses as operators and 
some guidelines on how to use them when you are constructing queries:

! ampersand (&) � AND. You use the AND operator to search for records 
that contain at least one occurrence of all of your query terms. The 
operator must be placed between two query terms otherwise Maximo will 
display an error message.

! hyphen (-) � MINUS. You use the MINUS operator to search for records 
that contain one query term, but you want the presence of your second 
query term to cause the document to be ranked lower in the result set. The 
operator must be placed between two query terms otherwise Maximo will 
display an error message.

! pipe (|) � OR. You use the OR operator to search for records that contain 
at least one occurrence of any of your query terms. The operator must be 
placed between two query terms otherwise Maximo will display an error 
message.

! semicolon (;) � You use a semicolon to indicate the end of a SQL 
command line. Using a semicolon as part of your query text may generate 
an error message. 

Button Name and Function

Detail Menu� Displays a menu of actions available for the 
field. Specific choices vary by field.

Long Description � Provides room for entering more data 
than can fit in a field. 
After a long description entry is created, the button changes 
color to indicate that more information is available.

Select Date � Displays the Select Date dialog box. Click a 
date to return the selected value to the Date field.

Select Date and Time � Displays the Select Date and Time 
dialog box. Click a date to return the selected date and time to 
the Date field.

Select Value � Displays a page showing available values for 
the fields. Select Value pages are often lists of records created 
in other applications, for example, item records created in the 
Item Master application.
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! tilde (~) � NOT. You use the NOT operator to search for records that 
contain one query term and not another. The operator must be placed 
between two query terms otherwise Maximo will display an error message.

Your database may use additional special characters as operators. For 
additional information about other characters that are used as operators, 
refer to the documentation provided with your database.

Using Wildcard Characters

Sometimes you do not know the exact value for a field you want to use in a 
query. For example, you remember only part of a work order number, but not 
the exact number. When you do not know the exact value, you can search 
using the partial value plus a wildcard character. A wildcard character is a 
special symbol that stands for one or more characters. A character is an 
individual letter or number.

Maximo Wildcard Characters

Maximo uses two wildcard characters:

! Use the underscore (_) to substitute for a single character.

! Use the percent sign (%) to substitute for a string of characters 

A string is any grouping of letters, numbers, or both. A word is an example of 
a string of letters.

Placement of Wildcard Characters

When you use a wildcard character in a search field, place the wildcard 
character exactly where the unknown character(s) would occur. You can use 
more than one wildcard character in a single search.   

Searching for Null Values

A null value is the absence of a value in a field. Nulls indicate missing or 
unknown data, and are not the same thing as the number zero (0) or a blank 
space.

Because a null indicates a lack of data, searching for null values is different 
from searching for other values. When using the List tab or the Advanced 
Search/More Search Fields dialog box to search for records containing null 
values you use the following syntax:

Placement Finds Example

%X all instances where X is the 
last in the string of 
characters

%ing would return all 
instances where a word 
ended in -ing

X% all instances where X is the 
first in a string of characters

M% would return all 
instances where the word 
started with the letter M

%X% all instances where X falls 
anywhere within the string 
of characters

%3% would return all 
records with the number 3 
anywhere in the field
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! To search for records that contain a NULL value for a field enter:     

~null~

! To search for records that do not contain a null value for a field (known as 
a NOT NULL value) enter: 

!=~null~

NOTE: When searching for null values using the WHERE Clause dialog box 
you use the SQL comparison values IS NULL and IS NOT NULL to 
select and compare null values.

Advanced Searching

In addition to searching using the Query field, the Find field, and the table 
filter, you have two additional options for searching the Maximo database. 
You can use the Advanced Search option to search additional fields beyond 
those available in the table window, or if you know Structured Query 
Language (SQL) you can use the WHERE Clause option to construct a SQL 
query.

Using the Advanced Search Option

The More Search Fields dialog box is for querying by example (QBE), meaning 
that you enter values in the on screen fields to provide Maximo with an 
example of the type of records you are searching for. For example, if you want 
to find all work orders with a status of waiting for approval, you would enter 
WAPPR in the Status field. You can enter values for each field that you want 
to have included in your query. 

You can give examples of records you want to find by entering values in one or 
more fields in the dialog box. Doing so narrows your search. If no records 
match your query, Maximo displays a message.

TIP: You can enter more than one value in a field. The values must be 
separated by commas, and cannot exceed the length allowed for the field. 
For example, to find work orders that list either pumps or motors you 
could enter "pump, motor" in the Description field.

Using a SQL WHERE Clause to Search

You use the WHERE Clause dialog box to conduct advanced queries of the 
Maximo database using Structured Query Language (SQL). To perform 
advanced queries, you should be familiar with both SQL and the Maximo 
database. A SQL tutorial is not within the scope of this manual. Constructing 
SQL queries is something that is more commonly performed by system 
administrators and database administrators.

The WHERE Clause dialog box displays the SQL WHERE clause for your 
current query in the Current Query field. You can use any of the search 
methods available to you and see the WHERE clause Maximo created based 
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on your query values in the WHERE Clause dialog box. If you know SQL you 
can also modify the WHERE clause to change your search parameters. 

Viewing Search Results

The List tab displays all records that match the current query in a table 
window. For more information about table windows see �Table Windows,� on 
page 2-19. You can perform the following actions on the Results subtab:

! Use the Filter to filter the results displayed in the table window.

! Click the Next Row or Previous Row buttons to navigate the rows in 
your results set.

! Click the Next Page and Previous Page buttons to navigate the pages of 
your result set.

! Click the Download button to download the result set.

! Click an underlined column header to sort the column. For more 
information, see �Sorting Columns,� on page 2-22.

! Select the Select Records check box, then check the Select Row check 
boxes to select multiple records to perform batch actions from the Select 
Action menu.

! Click the Add to Bookmarks button for a record to include the record in 
your personal list of bookmarks for the application. 

Using Bookmarks

The My Bookmarks dialog box displays all records that you have 
"bookmarked" for later review.    The My Bookmarks dialog includes the 
record ID (key field), the Description of the record, and a Delete button for 
each bookmark.

Bookmarks are associated with your user name. If you were to sign in under a 
different name, you would see a different Bookmarks list. Each application 
has a separate bookmark list. So for example, work orders bookmarked in the 
Work Order Tracking application will not be bookmarked in the Quick 
Reporting application.

Adding a Bookmark

You can add a record to your list of Bookmarks in two ways:

! From the List tab � Click the Add to Bookmarks  button for the 
record.

! From any application tab � Select Add to Bookmarks from the Select 
Action menu to add the current record to your bookmarks.
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Managing Bookmarks

Click Bookmarks on the Search toolbar to view the My Bookmarks dialog 
box, which lists all of the records you have bookmarked for a particular 
application. 

To remove a bookmark, click the Delete  button for the record, The 
bookmark is deleted when you close the dialog box. This does not delete the 
record, only the bookmark.

NOTE: If you choose All Bookmarks from the Current Query menu, Maximo 
does not show a deleted record.

Maximo Application Pages

Most Maximo applications have a similar look and feel. The Maximo 
application page starts below your browser�s address bar and contain the 
following areas:

! Maximo Navigation Bar � Identifies the application and provides 
navigation links. For more information, see �Maximo Navigation Bar,� on 
page 2-3.

! Maximo Toolbar � Contains search options, action menu, and buttons 
for frequently used actions.

! Application Tabs � Contains groupings of similar fields and actions 
within an application. 

! Record Heading � Contains the key field, Description, and one or 
more additional fields that identify the current record. Heading fields 
appear at the top of every tab of the application.

! Sections � Contains groupings of fields that contain similar or related 
data within an application page.

! Table Windows � Displays multiple records from the database 
simultaneously.

Maximo Toolbar

Immediately below the Navigation Bar is the Maximo toolbar. 

WorK Order Tracking Toolbar

The toolbar contains four sections:

! Query menu
! Find field and button (binoculars)
! Select Action menu
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! Toolbar Buttons

Query Menu

The Query menu is described in �Using Saved Queries to Search,� on page 2-8.

Find Field

Using the Find field to perform a quick key search is described in �Using the 
Find Field to Search,� on page 2-9.

Select Action Menu

The Select Action menu contains all application-specific actions that are 
available to you. Select an action from the menu to perform it. These actions 
are listed in chapters that appear later in this guide.

NOTE: Action menu options appear only if your system administrator gives you 
security access.

Toolbar Buttons

The Maximo toolbar contains buttons that are common to most Maximo 
applications, as well as application specific buttons. You see buttons only for 
actions your system administrator has authorized you to perform.

NOTE: The tool tip text for some buttons can change based on the application, 
but the button performs the same function. For example, in the Work 
Order Tracking application the "New Record" button is labeled "New 
Work Order."
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Maximo Toolbar Buttons    

NOTE: Some applications include a subset of these toolbar buttons. And some 
applications include additional application specific toolbar buttons. 
Application specific toolbar buttons are documented with their 
respective applications in the following chapters.   

Tabs and Subtabs

Most applications display two or more tabs at the top of the page�s working 
area. Data entry fields are arranged in logical groupings within each 
application, and tabs organize and display the groupings.    

The List tab appears first for all applications. The second tab contains the 
main information for that application. Subsequent tabs contain secondary, 
related information. The selected tab appears as a lighter color than the 
inactive tabs.

To change application pages, select a tab. A message may appear if you have 
unsaved changes on the current page. 

Tabs in turn can have subtabs that display additional information. Subtabs 
contain data pertinent to their parent tab. For example, the Plans tab of the 
Work Order Tracking application contains four subtabs: Labor, Materials, 
Services, and Tools.

Button Name and Function

New Record � Inserts a new record. 
If your system administrator has set the application to 
automatically create numbers for new records the button 
displays a number sign (#).

Save Record � Saves a record. Maximo displays a message if 
a required field is empty. 

Clear Changes � Clears changes to the page and returns you 
to the List tab. Maximo notifies you if unsaved changes exist 
and gives you the option to save them. 

Previous Record � Takes you to the previous record in the 
result set. Displays a message in the Navigation bar if you are 
at the first record. Maximo notifies you if unsaved changes exist 
and gives you the option to save them.

Next Record � Takes you to the next record in the result set. 
Displays a message in the Navigation bar if you are at the last 
record. Maximo notifies you if unsaved changes exist and gives 
you the option to save them.

Change Status � Displays the Change Status dialog.   

Create KPI Option � Displays the Create KPI dialog box, 
allowing you to create a Key Performance Indicator report.
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Work Order Tracking application, showing tabs and subtabs

Record Heading

Many Maximo applications include more than one application tab in addition 
to the List tab. In order to identify the current record when you move from one 
tab to another, a Maximo record contains a heading section that appears on 
each application tab. This section contains the key field (record ID), 
Description field, and one or more additional fields.

Sections 

The fields on an application page are grouped together into sections. Each of 
these sections contains a button to Minimize the section.     

Minimizing a section hides all of the fields in the section from view. When a 
section is minimized, only the section heading appears with the Maximize 
button as shown in the following image. 

Icon Function

Minimize

Maximize
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Purchase Order Record with Collapsed Dates Section

TIP: If all of the fields in a section appear to be missing on the screen, click the 
Maximize button to display them.

A section can also contain a table window, which are described in the next 
topic.

Table Windows

Maximo uses table windows to display multiple records from the database 
simultaneously. In some cases, for example on the List tab, a table window 
will display a result set. A result set is the set of records that matches the 
criteria specified in a query to the database. For more information about 
queries, see �Searching the Maximo Database,� on page 2-6.

Maximo tables generally contain more rows and columns than a single screen 
can display. For this reason, Maximo table windows include the following 
features:

! Navigation buttons that allow users to navigate the table window
! Table Filter that allows a user to temporarily reduce the number of 

records displayed in the table window
! Expandable Row Details that allow editing of all record fields
! Editable table windows that allow quick data entry on selected fields of 

some tables.
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Assets Application - Spare Parts Tab Showing Two Table Windows

NOTE: Some table windows are read-only; you use them only to view 
information.

Most table windows have a label which is located just above the table window. 
The top row of the table window displays column headings, which are selected 
field labels, designed to give you an overview of each row. The rest of the table 
window displays rows of data, each row representing one record. Maximo 
highlights the record in the table after you select it. By default the first row is 
highlighted.

Navigating Table Rows (Records)

Several navigation aids appear on each Maximo table window. The colored 
heading of the table window contains a table filter which is described in 
�Using the Table Filter to Refine Search Results,� on page 2-10.

Next to the table filter are Previous Row and Next Row buttons that allow 
you to move the focus up and down the rows of the table window. Click the 
Next Row button to move the focus to the next record in the list. Click the 
Previous Row button to return the focus back to the previous record. If you 
are at the first record, you cannot use the Previous Row button. If you are at 
the last record, you cannot use the Next Row button.

The number of records that can be displayed in a table window at one time is 
limited. Next to the Previous Row and Next Row buttons are the Previous 
Page and Next Page buttons which allow you to display additional records in 
a result set. Between these buttons there is a number range indicating the 
records currently being displayed and the number of records in the table or 
current result set.

Table Row Navigation Buttons
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Click Next Page to show the next page of records; click Previous Page to 
show the previous page. If you are at the first set of records, you cannot use 
the Previous button. If you are at the last page of records, you cannot use the 
Next button.

To learn about navigating table rows from the keyboard, see Appendix A, 
"Keyboard Shortcuts," on page A-1.

Table Window Buttons

The following buttons commonly appear on Maximo table windows. Since 
table windows appear as part of the List tab, application screens, value lists, 
and action menu options, the buttons that appear on each table window will 
vary.    

Button Name and Function

 Filter Table Filter � Click to open the table filter. The table filter 
appears as a row of editable fields between the column headings 
and the first row in the table.

Find � Click to filter the table contents based on the entries in 
the filter fields.

Clear � Click to clear the filter fields and restore the original 
rows displayed in the table.

Previous Row � Click to move the focus to the previous 
record in the table. Disabled (gray) if you are at the first row in 
the table or result set.

Next Row � Click to move the focus to the next record in the 
table. Disabled (gray) if you are at the last row in the table or 
result set.

Previous Page � Click to show the previous page of records. 
Disabled (gray) if you are at the first page of records, or if all 
records in the result set are currently displayed.

Next Page � Click to show the next page of records. Disabled 
(gray) if you are at the last page of records, or if all the records 
in the result set are currently displayed.

Download � Click to download the contents of the table.

Hide Table � Click to minimize or hide the table.

Show Table � Click to maximize or show a hidden table 
window.

Help icon � Click to display table window help. Application 
Help is available via the Help link in the Navigation Bar.

View Details � Click to open the Row Details, displaying all 
fields in a record so that you can enter, view, or modify data.

Close Details � When the Row Details are open, the View 
Details button changes to the Close Details button. Click to 
close the Row Details.
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For information about keyboard shortcuts for these buttons, see Appendix A, 
"Keyboard Shortcuts," on page A-1.

Sorting Columns

You can sort columns with underlined headings. To sort a column, click the 
heading.    

You can sort only one column at a time, and that column displays an icon in 
the column header. If you select a second column to sort, the sorting on the 
first column is lost. If no icon appears in the table, you are not sorting. 

Filtering Table Windows

Maximo tables contain a filter to help you locate specific rows in large tables 
by reducing the number of rows being displayed. The table filter appears as a 
row of editable fields between the column headers and the first row of the 
table. If the table filter is hidden, click the click the !Filter icon to display it.

Closed Table Filter

Open Table Filter

Add to Bookmarks � Marks a document or record for later 
viewing. You can access bookmarked records from the 
Bookmarks subtab of the List tab.

Mark Row for Delete � Marks a record for deletion. Maximo 
does not delete the row until you click Save.

Undo Delete � Restores a row that you marked for deletion. 
This button indicates that you marked the row for deletion.

New Row � Inserts a new row and opens the Row Details if it 
is not already open.

Button Name and Function

Click Function

First Sorts the column in ascending order. An arrow pointing up 
appears in the column header.

Second Sorts the column in descending order. An arrow pointing 
down appears in the column header.

Third Returns the column to the database sort default. No icon 
appears.
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Use of the table filter is described in �Using the Table Filter to Refine Search 
Results,� on page 2-10.

Using the Row Details

The number of columns that you can display in a Maximo table window is 
limited, and most records contain more fields than you can display on a page 
at one time. You can access all fields in the record by using the !View 
Details button for an existing record, or the New Row button if adding a 
record.

NOTE: Row Details are not available on some table windows, for example table 
windows on the List tab.

Clicking the !View Details button next to a row opens the Row Details 
beneath the rows in the table window. When the Row Details are open, you 
can enter, view, or modify any data that is not read-only. 

In the following example from a work order work plan, the Tasks table 
window shows an open Row Details. Note the" Close Detail button to the 
left of the third row.

Row Details 

Default Table Data

Some pages containing table windows also include a Default Table Data 
section at the bottom of the page. If you are entering a series of similar entries 
you can speed the data entry process by entering values in the Default Table 
Data fields. Values you enter as default table data are used as field defaults 
when you insert new rows into the table. For example, if you are creating a 
purchase requisition for materials for a work order, you could enter default 
values for the work order number, the asset, location, and storeroom.

Default table data for some table windows might contain system supplied 
values. For example, in the Receiving application, the Received By field 
might default to your user name, and Received Date might default to the 
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system date. When you create a new row in the table window, the default 
values are copied to the appropriate fields, but remain editable, allowing you 
to modify them.

NOTE: Maximo does not save entries in the default table section when you close 
an application. 

Editable Table Windows

Most Maximo tables contain editable table windows, which allow you to edit a 
limited number of columns without opening the Row Details.   

Inventory Reorder Details Showing an Editable Table Window

Clicking anywhere in a row in an editable table will highlight it and put the 
row into "edit mode." When in edit mode, each editable column appears as an 
editable field. If a column is read-only, the column cannot be edited while in 
edit mode. For more information about the buttons that appear next to a field, 
see �Field Buttons,� on page 2-11. When a table window is in edit mode 
existing rows may be edited.

You can navigate an editable table window from the keyboard using the 
following keys:

! Press the Tab key to move through the visible fields in a row. The field 
focus will move through the visible fields from left to right, then move the 
focus to the next row. Press Shift + Tab to move from right to left.

NOTE: Click View Details to edit the fields not currently visible in the 
table window.

! Press Ctrl + " to move down a row in a single column, for example when 
editing the Quantity column.

! Press Ctrl + # to move up a single column in the table window.

CAUTION: Maximo does not automatically save changes made in table 
windows. You must click Save.

Creating New Rows

For a simple record with few fields, you may be able to enter data directly into 
the editable table window. More complex records will require that you to use 
the Row Details section to access all of the possible fields when creating a new 
record.

To add a new row to a table window, complete the following steps:

1 Click New Row at the bottom of the table window. 
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Maximo opens the Row Details if it is not already open. Some fields bay 
display default values.

2 Fill in additional fields as needed. An asterisk (*) indicates a required 
field.

3 If appropriate, click New Row to enter another new row.

NOTE: When you click New Row after adding or modifying a row, Maximo 
automatically updates the previous row changes to the table, but 
does not save them.

4 If appropriate, click Close Details to close the Row Details.

5 Click Save.

CAUTION: Maximo does not automatically save changes made in table 
windows. You must click Save.

Paired Table Windows

The Maximo applications contain a number of paired table windows, where 
the row selected in the first table window determines the records that are 
displayed in the second table window. The name of the second table window in 
a pair is dynamic, and will change to reflect the row that is selected in the first 
table window. 

The Failure Codes application contains two sets of paired table windows. Note 
how the name of the second table window (Causes for) reflects the row 
selected in the first table window, and the name of the third table window 
(Remedies for) reflects the row selected in the second table window.
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Paired Table Windows in the Failure Codes Application

Maximo Fields

Maximo application pages contain multiple fields and check boxes. As you 
work with the applications you will encounter a variety of different types of 
fields.

Field Characteristics

Each Maximo application field has at least three characteristics:

1 A field is either read/write or read-only.

! Read/Write � Data entry fields that allow you to enter, view, modify, 
and delete data.

! Read-only � Fields that allow you to view data, but not enter, 
modify, or delete data. For example, some default values, or values on 
a saved record might be read-only.These fields are indicated by a gray 
background.

2 A field is either a required field or not required.

! Required � Fields where you must enter data before Maximo can 
save the record to the database. The key field is always a required 
field. An application can have one or more required fields in addition to 
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the key field.These fields are indicated by an asterisk (*). If a required 
field is not filled in when you attempt to save a record Maximo displays 
an error message.

CAUTION: Your business processes may also require data entry in fields 
that are not marked with an asterisk. 

! Accepts Nulls � Does not require data entry before the record can be 
saved in the database. The field can be left null or empty.

3 A field will only accept or display a specific type of data:

! Upper � Field accepts alphanumeric text. Text is displayed with all 
letters in uppercase.

! Mixed-case � Field accepts alphanumeric text. Text is displayed with 
both uppercase and lowercase text.

! Integer � Field accepts and displays only positive or negative whole 
numbers. If decimal values are entered, they are rounded to the 
nearest whole number.

! Decimal � Field accepts and displays positive or negative decimal 
values.

! Amount [or cost] � Field accepts or displays currency amounts. Can 
be configured to display a currency symbol, for example the dollar sign 
($).

! Date � Field can contain only dates. The display format of dates is 
determined by your system administrator.

! Date/Time � Field contains date and time. Your system 
administrator can configure Maximo to display times in 12 hour or 24 
hour format.

! Yes/No (YORN) Check Boxes � Field accepts only "yes" value 
(checked) or "no" value (unchecked). When the field is read-only, for 
example in a table, Maximo displays a graphic of a check mark when 
the value is positive (Y), and an empty check box when the value is 
negative (N).

Fields can have additional characteristics, including:

! calculated values � Some fields contain a numeric value that is 
calculated based on data stored in Maximo, for example Total Cost. These 
values are read-only. You cannot modify them.

! default values � Your system administrator can configure Maximo so 
that some fields already have values entered when new records are 
created. For example, the Reported By field might default to your user 
name, and Date fields might default to the current system date and time. 
You might be unable to modify default values.

! long description field � A field may be paired with a long description 
field to accept and display additional data that cannot be displayed in the 
on-screen field due to field size limits.
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NOTE: Although they are paired fields, the on-screen field (for example a 
Description field) and the long description field are not the same 
field. Data that appears in the on-screen field does not appear in the 
long description field, and vice versa.

! value list � A field may only accept or display predefined values, which 
are stored and selected from a value list. Your system administrator can 
modify Maximo�s default value lists to better fit your business needs.

Field Help

Maximo includes context sensitive field help for each on-screen field and check 
box, including fields found in dialog boxes. The field help topics include a brief 
description of the field and database table and column information for each 
field. You access the field help by placing the cursor in the field and pressing 
Alt + F1.

Creating Records

The process for creating new Maximo records is similar for each type of 
application.

Types of Maximo Records

There are three types of Maximo applications (which are discussed briefly in 
�Maximo's Application Types,� on page 2-6). The process for creating a new 
record varies depending on which type of application you are using:

! Self-Service applications � New records are created automatically 
when you open the application, for example when you open the Create 
Service Request application. For more information about creating this 
type of record, see Appendix B, "Maximo�s Self-Service Applications," on 
page B-1.

! Simple applications � New records are created using the New Row 
button at the bottom of the table window to insert a new row into the table 
window. For more information about creating this type of record, see 
�Creating New Rows,� on page 2-24.

! Standard applications � New records are created using the New 
<record> button in the Maximo toolbar. For more information about 
creating this type of record, see �Creating a Record,� on page 2-29.

Automatic Numbering of Records

When you create a new Maximo record, the record needs to have a unique 
value in the key field to identify it. (For more information about key fields, see 
�Key Fields,� on page 1-7.) Record identifiers can be a combination of letters 
and numbers. 
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Your system administrator can configure Maximo to automatically generate a 
new record ID for applications that generate large numbers of records, for 
example the Work Order Tracking and Purchase Requisitions applications, to 
ensure that each new record has a unique ID and to streamline the record 
creation process. 

There are two different Insert New <record> buttons. The button that 
appears indicates if the application has been configured to automatically 
generate record IDs or not.   

Default Field Values

When you create a new record, Maximo may fill in some of the record fields 
with default values. Some common types of default data include the current 
date and time in a Date field, and your user name in a Requested By or 
Reported By field. In most cases you can edit this default data.

When you are creating new rows in a table window, some applications allow 
you to enter default table data to be copied to each new row. For more 
information about default table data, see �Default Table Data,� on page 2-23.

Creating a Record

The basic procedure for creating a record is similar for most applications. The 
most common difference is that some applications automatically generate a 
numbered record ID (key field) value for each new record, while other 
applications let you create the name or number for the record ID.

To create a Maximo record, complete the following steps:

1 Open the application.

2 On the Maximo toolbar, click the New <record> button.

NOTE: The name of this button varies by application. For example, in Work 
Order Tracking it is labeled "New Work Order."

Maximo displays a new record.

3 If the key field is empty, enter a value.

4 Enter a description in the Description field. To enter additional 
information, click the Long Description button.

5 Fill in additional fields as needed. An asterisk (*) indicates a required 
field.

Icon

Maximo automatically creates the record ID for new records.

You must create a unique record ID for new records. Maximo will 
display a message if the record ID you choose has already been 
used.
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NOTE: An asterisk (*) indicates that a field requires a value for Maximo to 
save the record. For more information about any field, refer to the 
field help.

6 You can edit default values that are not read-only. 

7 Click Save.

Entering Values in Fields

Maximo applications are linked, letting you select values from lists of existing 
records when you fill in fields in other applications. For example, when you fill 
in the Asset field on a work order, you can select from the list of asset records 
in the Assets application.

Maximo contains several options for selecting a value for a field. These options 
appear on a separate page that lets you select a value and return it to the 
application where you were working. Your options vary by field. This section 
describes some common ways to select a value for a field.

Entering Partial Field Values

Maximo has a feature that allows you to enter a partial value in a field, and 
Maximo will attempt to find a valid value that matches the portion that you 
entered. When you exit the field, Maximo displays a Select Value dialog box 
that displays records that match the partial value that you entered. You can 
use the table filter in the Select Value dialog to search for additional values if 
Maximo did not match the value exactly.

Partial Value Entered in a Labor Field

Entering Dates

Many Maximo records contain one or more date fields. For example work 
orders contain fields for Target Start, Target Finish, Scheduled Start, 
Scheduled Finish, Actual Start, and Actual Finish dates. Some date 
fields do not require you to enter a value, as Maximo automatically enters the 
current date and time for you. 
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You can use the following keyboard shortcuts to enter a date into any Date 
field:  

You can also click the Select Date button or the Select Date and Time 
button to display the Select Date dialog box. The Select Date dialog displays 
the current month, with the current date highlighted. The Select Date and 
Time dialog box displays the current date and the current system time. You 
use the arrows to navigate forward and backwards by month or year, and by 
hour, minute, or second.

To select a date, complete the following steps:

1 Click Select Date next to a field that requires a date.

The Select Date dialog box appears.

2 If necessary, navigate to the correct date.

TIP: You can use the following keyboard shortcuts when using the Select 
Date dialog. 

3 Click a date to select it.

Maximo returns the value to the field.

Using the Select Value Button

When you click the Select Value button Maximo displays a Select Value list. 
This list consists of either of records created in another Maximo application, 
or created by your system administrator. 

To select field values using the Select Value button, complete the following 
steps:

1 Click Select Value next to a field.

The Select Value dialog box appears.

2 If appropriate, you can use the table filter to locate a record.if there is a 
lengthy list of values.

Function Keyboard Shortcut

Insert today�s date Ctrl +  =

Move back one day Ctrl +  Minus Sign

Move forward one day Ctrl +  Plus Sign

Button Function Keyboard Shortcut

Next Month Ctrl + $

Previous Month Ctrl + %

Next Year Ctrl + "

Previous Year Ctrl + #
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3 Click the Select Record button beside a value.

Maximo returns the value to the field.

Using the Detail Menu Button

When you click the Detail Menu button, Maximo displays a menu of options 
for locating a value for the field. The options vary depending on the 
application and field you are using. Some common Detail Menu options 
include the following:

! Open Drilldown � For more information about the Drilldown, see 
�Using the Drilldown,� on page 2-32.

! Classification � For more information about Classifications, see �Using 
Classifications,� on page 2-35.

! Go To <Application Name> � Allows you to go to another application 
and create a new record or retrieve an existing record as a value for the 
field.

! Move To � Allows you to navigate up a record hierarchy by moving to the 
parent record.

In addition, Detail Menus can contain context specific options that will vary 
by field. For example many Asset and Location fields will include the option 
to View Work Orders and PMs.

Using the Drilldown

The Drilldown is a Maximo feature that allows you to use a graphical tree to 
navigate your location and asset hierarchies, much like Windows Explorer® 
lets you find files on your computer hard drive. The Drilldown is available 
from the Detail Menu on the Asset, Location, and some Belongs To fields 
throughout Maximo, and from the Select Action menu in the Assets and 
Locations applications.

The location hierarchies displayed in the Drilldown are created in the 
Locations application, and the asset assembly structures displayed are built 
in the Assets application. 
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Drilldown

Understanding the Detail Display

The Drilldown contains two tabs, Locations and Assets. Read-only fields in the 
header for each tab display the details of the location or asset currently in 
focus. 
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Locations Tab Details Fields   

Assets Tab Details Fields    

Navigating the Hierarchy

You can switch back and forth between locations and asset by selecting the 
appropriate tab on the Drilldown. You can select a location, then switch tabs 
to view the asset(s) at that location. Or you can drill down to an asset, then 
switch tabs to see its location, and the system(s) that location belongs to.

A plus sign  next to an entry in the Drilldown indicates that there are 
further levels in the hierarchy. Click the plus sign to display the next level of 
the hierarchy.

A minus sign  next to an entry in the Drilldown indicates that the level is 
open and displaying the next hierarchy level. Click the minus sign to close the 
hierarchy level.

Field Description

Location Location ID

Description Description (including long description) of the location.

Status Status of the location (for example planned or operational).

Site Site listed on the location record.

Asset in 
Location

Asset ID of the asset at the location currently in focus. An 
asset ID is only displayed if there is a single asset or a 
single top-level asset at the location. A message is displayed 
if either no asset or more than one top-level asset exists at 
the location. A top-level asset is an asset that does not have 
a parent in the same location.

Description Description (including long description) of the asset. 
Displayed only if an asset ID is displayed.

System Field indicating all the systems that are associated with the 
selected location. The system for the hierarchy tree 
currently displayed is highlighted.

Field Description

Asset Asset ID

Description Description (including long description) of the asset.

Asset Up? Check box indicating if the asset is up and running 
(checked) or experiencing downtime (unchecked).

Site Site listed on the asset record.

Location Location of the asset.

Description Description (including long description) of the location.

Rotating Item Item ID if the asset is a rotating asset.

Failure Class Failure Class for the asset. 
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A dot  indicates that the location or asset does not have any children and 
there are no further levels in the hierarchy.

Actions Available from the Drilldown

The Locations tab of the Drilldown contains the following button:

! Show All Systems � Click to show all systems in the selected Site.

Both the Locations and Assets tabs of the Drilldown contain the following 
buttons: 

! Show Path to Top � Click to display the direct path from the selected 
location or asset to the top of the current hierarchy. 

NOTE: Networked location systems display the Networked Systems icon 
next to the Show Path to Top button, and the button is disabled.

! View Work Orders & PMs � Click to display all work orders, PMs, 
routes, and service contracts for an asset or location.

! Select Record � Click the Select Record icon to select a location or 
asset and return the value to the application page. If the Drilldown is 
called from an application that contains both Location and Asset fields 
you can call the Drilldown from either field, select either a location or an 
asset, and the value will be returned to the appropriate field, regardless of 
which field the Drilldown was launched from. If permitted by the business 
rules of the application, both the location and asset values are returned to 
the application.

Using Classifications

Maximo includes a feature called Classifications which can be used to 
structure records into organized hierarchies. Using classifications helps you to 
more easily locate records, and help to ensure that records are not duplicated 
unintentionally.

Your system administrator creates one or more different classification 
hierarchies using the Classifications application. By default Classifications 
allows you to classify and search the following types of records:

! assets
! items
! locations
! solutions
! tickets (service requests, incidents, problems)
! work orders (activities, changes, releases, work orders)

You can classify solutions, tickets, and work orders by entering a value in the 
Classification field on a record.

You can add new asset, location, or item records to Classifications by 
associating a specification template with the record on the Specifications tab 
in the Assets, Locations, or Item Master applications. After assets, locations, 
and items are associated with specification templates, you can use the 
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Classification Search dialog to search through Maximo to find the records you 
are looking for. 

Multisite and Classifications

The Classification structure exists at the System or database level in 
Multisite. Classification records include an Organization and Site field, 
which are null (empty) by default, but allow classifications to be defined for 
specific Organizations or Sites.   When a classification is defined for an 
Organization or a Site, all of the levels of the classification below that one 
must be for the same Organization or Site.

Searching Classifications

You can use Classifications to locate values when you are creating records. 
For example, when you are creating a work order record if your company has 
created Classifications for assets and locations, you can use Classifications to 
enter values in the Asset and Location field on the work order.

Similar to the Drilldown, the Classification Search dialog box allows you to 
use a graphical tree to navigate classification hierarchies. For more 
information about how to navigate the hierarchy see �Navigating the 
Hierarchy,� on page 2-34.

NOTE: The Classification hierarchy displayed will vary depending on the 
application or field you access the dialog box from, and will only show 
classifications that can be used with a specific type of record, for 
example assets or work orders.

Classification Search - Assets
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To search Classifications from an application field, complete the following 
steps:

1 Click the Detail Menu button and choose Classification.

The Classification Search dialog box appears. 

2 Click a Classification category in the Classification tree on the left.

The next level of the hierarchy opens. Any Attributes defined for the 
classification are displayed in the Attributes table window. Any records 
that have the selected classification are displayed in the table window 
below the Classification tree.

3 If appropriate, open additional levels of the classification until you find the 
record you are searching for.

4 Click a record ID in the table window below the Classification tree to 
return a value to the field.

Classifying a Record

You will need to search Classifications when you want to classify solution, 
ticket, and work order records. The Classification field on a record contains 
a the following options:

! Classify � Click to view the Classify dialog box.

! Clear Classification � Click to clear the current value in the 
Classification field.

! Go To Classifications � Click to go to the Classifications application. 
You might need security authorization to perform this action.

NOTE: The Classification hierarchy displayed will vary depending on the 
application or field you access the dialog box from, and will only show 
classifications that can be used with a specific type of record. 

To classify a record, complete the following steps:

1 In the Classification field, click the Detail Menu button and select 
Classify.

The Classify dialog box appears.

2 Click a Classification category.

The next level of the hierarchy opens. 

3 If appropriate, open additional levels of the classification until you find the 
classification you are searching for.

4 Click the blue Select Record button for the classification to return a 
value to the Classification field.
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Understanding General Ledger Account Codes

Your company creates General Ledger (GL) accounts to track expenses. Your 
company�s accounting department can create GL accounts for various entities 
within a company (locations, assets, tools, and so on). Numeric or 
alphanumeric GL account codes can be used to identify GL accounts. 

Many Maximo records include one or more GL Account fields. The values in 
these fields allow your company�s accounting department to track specific 
costs. For example GL account codes can be used to track total maintenance 
costs for an asset, or to track the variance between purchase order price and 
invoice price for items received into a storeroom. The GL account(s) entered on 
a record specify which account should be charged or credited for financial 
transactions related to the record.

GL account codes are typically used only when Maximo interacts with a 
separate accounting system. If your company uses a separate financial 
system, your system administrator may have configured Maximo to enter 
default values for GL Account fields or if you have security authorization to 
do so, you may enter account codes manually using the Select GL Account 
dialog box. For more information about entering GL account codes, see 
�Selecting GL Account Codes,� on page 2-41.

GL Account Codes and Maximo

GL Account Codes are defined and stored at the Organization level in the 
database.

Since companies typically charge the cost of a work order to the location where 
work is performed, Maximo automatically charges work costs to a location 
rather than to assets at that location. However, if the asset on a work order 
has a GL account specified, Maximo overrides the GL account code for a work 
order location with the code for asset   entered at that location. The 
assumption is that this asset has its own GL account because all work costs 
for it should be charged directly to the asset. 

When you enter a location on a work order, the GL account code that Maximo 
copies to the work order is usually the one established for that location. If your 
company has established GL account codes for assets, however, and you enter 
an asset that has a GL account specified, Maximo uses the asset GL account 
code rather than the location GL account code. 

GL Account Components

Each general ledger account code consists of several distinct segments (also 
called components). Each component relates to a specific part of your 
company�s accounting system and can be used to charge a particular 
transaction, for example the purchase of an item, to a particular cost center, 
department, type of account, or any other category of costs that exists within 
your accounting system.

Your system administrator can create GL account components using the 
Chart of Accounts application, or the components may be imported into the 
Maximo database from an external financial system using the Maximo 
Enterprise Adapter (MEA).
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To simplify identifying account components, a delimiter or special separator 
character is often used between components when account codes appear on 
the page. For example, your company might use hyphens to separate 
components: 6200 - 229 - SAF.

Mandatory and Optional Components

Within an account, a component can be mandatory or optional.

! A mandatory component requires a value to define the account fully. 
When you display an account, any unknown mandatory components 
contain the placeholder character set by the system administrator, for 
example a question mark (?).

! An optional component does not require a value in order to define the 
account fully. When you display an account, no unknown optional 
components appear. For example, in Maximo�s DEMO database, the fourth 
component is optional so there are many account codes in the DEMO 
database consisting of just the first three components.

Valid Account Definitions

When establishing rules for general ledger accounts, your system 
administrator specifies whether an account code is valid if it is only partially 
defined, or whether it must be fully defined for Maximo to accept it as valid. 

! A fully defined account has no unknown characters in mandatory 
components. A fully defined GL account exactly matches an entry in the 
Chart of Accounts table. For example, the account 6100-200-450 in the 
DEMO database is considered fully defined as the fourth component is 
optional.

! A partially defined account can contain an undefined mandatory 
component, that is a mandatory component that consists of placeholder 
characters. For example, the account 6100-???-450 in the DEMO database 
is considered partially defined because while the second component is 
mandatory, placeholder characters are acceptable.

Depending on how your company creates GL accounts and the status of the 
record you are working with, you may or may not be required to define all 
components in a GL Account field. 

For example work order and purchase order records can be created with 
undefined or partially defined GL Account fields, but the GL accounts must 
be fully defined before you can change the status of a work order or a purchase 
order to approved.

Your system administrator uses the Chart of Accounts application to define 
account code components. Your system administrator can also restrict the 
combination of components that you can enter. 

If your system administrator specifies that only certain component 
combinations are valid then even if all of the individual components are valid, 
Maximo will only consider the account code valid if it can match the exact 
combination of components to an existing account in the Chart of Accounts.
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Component Sequences

The various components of a GL account code appear in a set order or 
sequence, with the highest level component appearing first in the sequence. 
For example, the Maximo DEMO database has four component or segment 
levels defined for GL account codes:   

The Select GL Account dialog box guides you through the component 
sequence. When you use the Select GL Account dialog box to find and select 
GL account components, each time you select a component the value in the 
Segment field changes and the dialog box refreshes to display the next level 
of components in your company�s sequence.

Select GL Account Dialog Box

Segment 1 
Cost Center

Segment 2
Activity

Segment 3
Resource 

Segment 4
Element

6200 229 SAF
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Entering GL Account Codes

You use the Select GL Account dialog box to select or modify values in GL 
Account fields on Maximo records.

Selecting GL Account Codes

You use the Select GL Account dialog box to build or edit an account code from 
valid components previously established by your system administrator. To 
enter an account code in a GL Account field, complete the following steps:

1 In the GL Account field click the Select Value button.

The Select GL Account dialog box appears. The GL Account displays 
placeholder values for all components. The name of the first component, 
for example COST CENTER, appears in the Segment field and the table 
window displays all the valid values available for this component.

2 To select a GL Component Value, click the underlined component ID. 

Maximo refreshes the dialog box. The selected component appears in the 
GL Account code, the next component in the sequence, for example 
ACTIVITY, appears in the Segment field, and the table window displays 
all the valid values available for this component.

3 Select a value for each component in the sequence as described in Step 2.

4 Click OK to return the account code to the GL Account field.

NOTE: The number of components required to build a valid account code varies, 
depending on how your company implements its accounting system. 
Also, your system administrator can restrict the account codes you can 
enter to only valid combinations of components�and the values 
displayed in the Search Results table window are only those values that 
form valid combinations with the account code�s other defined 
components. 

Editing GL Account Codes

To edit an account code in a GL Account field, complete the following steps:

1 In the GL Account field click the Select Value button.

The Select GL Account dialog box appears. The GL Account may display 
placeholder values for some components. The name of the component, for 
example COST CENTER, appears in the Segment field and the table 
window displays all the valid values available for this component.

2 To view valid values for a component, select one of the following options:

! Click the underlined component in the GL Account display

! Select the component from the Segment menu.

3 To select a GL Component Value, click the underlined component ID. 
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Maximo refreshes the dialog box. The selected component appears in the 
GL Account code, the next component in the sequence, for example 
ACTIVITY, appears in the Segment field, and the table window displays 
all the valid values available for this component.

4 Select values for the other components you want to edit as described in 
Steps 2 and 3.

5 Click OK to return the account code to the GL Account field.

Using Attached Documents

The Attached Documents feature is found in most Maximo applications. You 
can use Attached Documents to attach many types of relevant information to 
a record in the form of a file or Uniform Resource Locator (URL) address. 
These attached documents can be located on your company�s network, on the 
Internet, or in a Document Management System (DMS) and might include 
text files, spreadsheets, images, or Web pages. 

The Attached Documents feature allows you to:

! attach a copy of a document to a record, for example an owner�s manual 
could be attached to an asset

! attach individual documents to records, for example attaching a permit to 
a work order

! attach an image to a record, for example attach a photo to a service 
request

! view documents attached to a record, or to related records

! print one or more documents attached to a record

! manage the Library of documents available to be attached to records   

Types of Attachments

The Attached Documents feature includes two kinds of attachments:

! Direct Attachments � documents that are attached directly to an 
application record. For example in the Work Order Tracking application 
all of the documents attached to the work order are direct attachments. 
When working with Attached Documents you can attach, view, modify, 
and print documents that are part of the current record�s document 
collection. 

! Referential Attachments � documents that are attached to other 
application records, which are associated with the current record. For 
example a work order record might also display document collections for 
the asset and location associated with the work order. You can view and 
print documents that are referential attachments, but you cannot add or 
modify attachments to related document collections.
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Attached Documents Administrative Actions

If Attached Documents is enabled for an application, there are three actions 
that appear in the Select Action menu:

NOTE: You might need security authorization to perform these actions.

! Attachment/Library Folders > Manage Library � Use to register 
new documents to the Library and manage the document properties of 
existing documents in the Library. 

! Attachment/Library Folders > Manage Folders � Use to create 
document folders and set a default file location for storing documents 
associated with each folder.

! Attachment/Library Folders > Associate Folders � Use to associate 
existing document folders with the current application.

Because creating document folders and associating them with applications are 
functions that are often performed by a system administrator, these 
procedures are described in the Maximo System Administrator�s Guide. 

Attaching Documents

You can attach documents to Maximo records using either of the following 
methods:

! First create a document Library using the Attachment/Library Folders 
> Manage Library action, then attach documents to Maximo records 
using the Add From Library option available from the Attachments 
menu.

! Attach a document using either the Add New File or Add New Web 
Page option available from the Attachments menu. Documents can also 
be added to the Library via these actions.

NOTE: Your system administrator can configure Maximo to connect to a 
Document Management System (DMS). This option is hidden by 
default. Once enabled, documents that physically reside in a DMS can 
be registered to the Library.

For more information about creating and using attachments, refer to the 
Maximo Help.

Managing Records

While the process of creating records is similar for most of Maximo�s 
applications, what happens to the record after it has been saved often varies 
depending on the type of record. 
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Editing an Existing Record

You ability to edit a record after it has been saved depends on your security 
authorizations, the application, and the effect that modifying that record 
could have on business processes. In some cases records must be maintained 
for auditing purposes, and Maximo does not allow you to edit some or all of the 
fields on the record.

The status of a record often dictates which fields on a record may be edited.

Understanding Record Statuses

Some records are created once and remain unchanged, while other undergo 
changes as they move through various stages of a record life cycle, for example 
"record creation," "record approval, " and "record closed." Many Maximo 
records contain a Status field which is used to indicate a record�s position in 
the record�s life cycle.

In some cases there are a very limited number of possible statuses, for 
example, DRAFT, ACTIVE, INACTIVE. In other cases, for example work 
orders and purchase orders, the processing cycle for the record is more 
complicated and therefor includes more statuses. Chapters that appear later 
in this guide describe specific record statuses in more detail.

When you change the status of a record, Maximo records the date and time of 
the status change, and lets you record a memo. In some cases changing the 
status of a record means you can no longer edit certain fields. Changing the 
status of a record to INACTIVE means that the record can no longer be used 
when creating new Maximo records.

NOTE: You might need security authorization to change the status for a record.

Making a Record Inactive

Because of the interaction between Maximo applications, records created in 
one application often appear as values in fields on other applications. There 
may be cases where a record in the database is no longer needed, but it cannot 
be deleted because it is listed on other Maximo records, or you want to retain 
the record for some other reason.

Certain Maximo applications allow you to disable a record by changing its 
status to INACTIVE. Making a record inactive retains the record in the 
database, but the record no longer appears in value lists that display the 
record. For example an inactive labor record no longer appears as part of the 
Select Labor value list.

The following types of records can have their status changed to INACTIVE:

! Labor records
! Job plans 
! Person records
! Qualifications
! Service level agreements (SLAs)
! Ticket templates
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Deleting Records

Much like the ability to edit a record, the ability to delete records varies by 
application, and how the deletion could affect your business processes. In 
some cases you must maintain records for auditing purposes, and you cannot 
delete. 

When an application allows the deletion of records, there are usually rules 
governing when a record may and may not be deleted. For example, hierarchy 
associations affect the ability to delete records. You cannot delete parent 
records if children are associated with the record. You must break the child 
associations before you can delete the record.

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

NOTE: You might need security authorization to delete records.
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You can use Maximo to manage assets from purchase to salvage � from the 
beginning to the end of an asset�s life cycle. You can track assets at a 
temporary location, or even in transit between locations. The Asset module 
contains applications designed to manage the assets and locations owned or 
leased by your company.

The Asset Module consists of the following applications:   

You use the Assets application to create records for any equipment, 
machinery, or technology that your company owns or leases that you will be 
managing and maintaining using Maximo. You use the Locations application 
to create records for any physical location where equipment, machinery, or 
technology is located, or locations that you will be managing and maintaining 
using Maximo.

There are some similarities between asset and location records. For example 
you can define failure codes and safety information for both assets and 
locations, and associate meters with both types of records. But each 
application also includes features designed for either asset management or 
facilities management.

Failure codes allow you to capture data about the reasons why assets or 
locations fail to operate as they should, as well as data about the possible 
causes of those failures.

3 The Assets Module

Application Function

Assets Used to create and store asset numbers and 
corresponding information, such as parent, location, 
vendor, up/down status, and maintenance costs for 
each asset. 

Condition 
Monitoring

Used to define measurement points for assets or 
locations, and to specify alarm limits and associated 
work to be performed after reaching those limits.

Failure Codes Used to define failure codes and define the Problem, 
Cause, Remedy hierarchy.

Locations Used to create location records and track assets 
that exist at the location. Also used to build 
hierarchical or networked systems.

Meters Used to define meters that can be used to track 
asset and location performance.

Meter Groups Used to create groups of meters that can then be 
applied to assets or locations at the same time.
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In order to monitor the performance of assets and locations, you can define 
measurement points in the Condition Monitoring application and meters in the 
Meters application. Measurement points and meters can be used together or 
separately, depending on the needs of your business. Meter groups are a 
simplified way to apply multiple meters to an asset or location.

Assets and Deployed Assets

An asset is any piece of equipment that has either moving parts or circuitry, 
that needs to be maintained, and where you will be using Maximo to track the 
maintenance history. Assets can be either owned or leased by your company. 
You create and manage asset records in the Assets application. For more 
information about assets, see �Asset Records,� on page 3-4.

Deployed assets are information technology (IT) assets that have been 
discovered on a network. Asset discovery tools scan computers, network 
devices, and network printers deployed at your company and record 
information about the hardware and software installed on those assets. 
Maximo Fusion assembles the collected data and imports it into Maximo 
which creates deployed asset records from the imported data. Each deployed 
asset record should have a corresponding record in the Assets application. You 
use the Reconciliation Results application to view the discrepancies found 
when your deployed asset records are compared to asset records. Deployed 
asset records are managed using the applications in the Deployed Assets 
module. For more information about deployed assets, see Chapter 5, "The 
Deployed Assets Module," on page 5-1.

Using Classifications

The Specifications tab on asset and location records can be used to add 
Classification information to asset and location records. Using Classifications 
lets you structure your assets and locations in organized hierarchies so that:

! records can be easily located via Classifications.
! records are not duplicated unintentionally.
! your company�s asset and item lists are consistent with vendors� lists.

Classifications use attributes to define the classification category. When you 
list a rotating item that has a classification on an asset or location record, 
Maximo copies the Classification and Attributes to the Specifications tab of 
the asset or location record.

For more information about Classifications, see �Using Classifications,� on 
page 2-35.

Interaction Between Asset and Location Records

There are several different ways that the applications in the Assets module 
can be implemented. When choosing how to classify their assets and locations 
different companies choose different strategies depending on their needs. The 
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correlation between asset and location records depends on how your company 
implements Maximo. Possible implementations include creating records for 
the following:

! A mix of asset and location records � one or more asset records may exist 
for each location record.

! A one to one correlation between asset and location records � each asset 
has a matching location record.

! All asset records, no location records � no correlation between asset and 
location records.

! All location records, no asset records � no correlation between asset and 
location records.

The Drilldown

The Drilldown is a graphical tool available from the Asset or Location fields 
of an application. You use it to view and navigate asset and location 
hierarchies, and to select a record to be returned as a value to the field. 

The Locations tab on the Drilldown is built by creating location hierarchies in 
the Locations application. The Asset tab on the Drilldown is built by creating 
asset assembly structures in the Assets application. When some correlation 
exists between asset and location records it allows you to use the Drilldown to 
navigate to a location, then click the Assets tab to view the assets at the 
location, or to locate an asset, then click the Locations tab to view its location.

NOTE: Spare parts are not displayed as part of the Drilldown.

For more information about using the Drilldown, see �Using the Drilldown,� 
on page 2-32.

Asset/Location Priority

Maximo uses values between 0 and 999 to indicate priority for work orders, 
assets, and locations. Maximo can use these different priority values to 
generate a calculated priority to help schedulers determine the overall 
priority of a work order among "competing" work orders for similar assets or 
locations. 

You should assign a higher priority value to assets and locations you can least 
afford to have down. Assign a lower priority value to those assets or locations 
whose repairs can wait until more important work is finished. 

When assigning priorities to assets that may move between different locations 
("rotating assets") note that in Maximo asset priority supersedes location 
priority. The Asset/Location Priority value that Maximo uses when 
calculating work priority uses the location priority only if there is no value 
specified for asset priority. 

For more information about recommended priority values, see �Work Order 
Priority,� on page 14-4.
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Asset Records

An asset is any equipment, machinery, or technology that your company owns 
or leases that you will be managing and maintaining using Maximo. Some 
examples might include:

! Production � motors, pumps, winches, presses, and so on.
! Facilities � plumbing, lighting, fire extinguishers, and so on.
! Fleet � forklifts, trucks, buses, trains, aircraft, and so on.
! Technology � computers, routers, hubs, servers, and so on.

The Assets application stores asset numbers and other related information, 
such as location, parents and children, vendor or manufacturer, up/down 
status, and maintenance costs for the asset.

Tabs on the Assets application let you build an asset hierarchy, which is an 
arrangement of assets, subassemblies, and spare parts that make up the 
asset. The asset hierarchy provides a convenient way to roll up maintenance 
costs so that you can check accumulated costs at any level, at any time. It also 
makes it easy to find a particular asset number.

NOTE: This application was known as the Equipment application in previous 
releases.

Multisite and Asset Records

Asset records are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Assets and Classifications

Using Classifications allows you to sort your assets into organized categories 
of assets. The categories of classifications used by your company are created in 
the Classifications application. For more information about creating 
classifications, refer to the Maximo System Administrator�s Guide.

You use the Specifications tab on an asset record to add Classification 
information to an asset record. 

NOTE: The Classification of a rotating asset record is copied from the 
Rotating Item record.

CAUTION: If you are using Maximo to manage IT assets, there must be a value 
in the Classification field to allow Maximo to filter for IT assets 
when performing reconciliation.

For more information about Classifications, see �Using Classifications,� on 
page 2-35. 
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Assets and Companies

Asset records contain a Vendor field. Before you can list a company as a 
vendor on an asset record you must first create a record for the company in 
the Company Master application.

Assets and Condition Monitoring

Maximo uses measurement points as one possible criteria for generating PM 
work orders. If a measurement is entered that reaches an upper or lower 
action limit, a PM work order can be generated for the asset, either 
automatically via a cron task, or manually via the Generate Work Order 
action in the Condition Monitoring application.

You create measurement points in the Condition Monitoring application. Each 
measurement point is associated with a meter. Meters are created in the 
Meters application. When you create a measurement point for an asset 
Maximo copies the measurement point to the Meters tab of the asset record. 
You can record readings using the Enter Meter Readings and Manage 
Meter Reading History actions available from the Select Action menu.

For more information about creating measurement points, see �Using the 
Condition Monitoring Application,� on page 3-17.

Assets and Contracts

Asset records can be associated with the following types of contracts:

! Lease Contracts
! Pricing Contract
! Purchase Contracts
! Rental Contract
! Service Contract
! Software License Contract
! Warranty Contracts

For more information about contract types, see �Contract Types,� on page 4-2.

You can view all contracts associated with an asset using the View 
Contracts action in the Assets application.

Assets and Deployed Assets

An asset record can represent any type of strategic asset: production, 
facilities, fleet, or technology. The term "deployed assets" refers specifically to 
information technology (IT) assets, for example computers, network devices, 
and network printers, that are discovered on the network by an asset 
discovery and tracking tool. You use Maximo Fusion to import the discovered 
data into Maximo and create records for your deployed assets. You use 
Reconciliation to match asset records to deployed asset records and to identify 
any discrepancies or variances.
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You can use the Asset Details action available from the Select Action menu 
to compare the record in the Assets application with the record for the same 
asset in the Deployed Assets module.

Records for IT assets must always include a value in the Rotating Item field 
and the Classification field. Your company may also require that IT asset 
records contain a value in the Serial # field.

NOTE: Maximo copies the Classification and Attributes from the Rotating 
Item to the Specifications tab of the asset record.

Assets and Items

Rotating assets are a special category of asset records, used to refer an any 
asset record that contains a value in the Rotating Item field. Rotating assets 
consist of multiple interchangeable assets, with each asset having the same 
item number and a different asset number. 

These items are tracked both by their item numbers in the Inventory module 
and by their individual asset numbers in the Assets module. The term 
rotating item is used when referring to inventory records and management, 
and the term rotating asset is used when referring to asset records and 
maintenance. 

Once you save an asset record the Rotating Item field becomes read-only. 
You must use the Change Item Number action to change the value in the 
Rotating Item field.

Assets and Locations

If an asset is associated with a particular location you can indicate that by 
entering a value in the Location field on the asset record. 

You use the Move/Modify Assets action to make changes to an asset�s 
location, including it�s parent/child relationship with other assets, modify 
existing Users and Custodians for the asset, and modify Attributes for the 
asset.

You use the Swap Assets action to replace one or more assets with a 
replacement asset.

NOTE: You cannot use the Swap Assets or the Move/Modify Assets action to 
move rotating assets from inventory locations; you must use the Issues 
and Transfers application.

You use the View Asset Move History action to view the history of the 
assets movement within and between Sites, hierarchies, and locations.

Assets and Meters

Maximo uses meters as one possible criteria for generating PM work orders. 
PM frequency is based on elapsed time in days or in meter units since the last 
work order was completed or targeted to start. 
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Once meters have been created in the Meters and Meter Groups applications, 
you can associate individual meters or meter groups with an asset record on 
the Meters tab. An initial meter reading may be entered when the meter is 
attached to the asset record. The Meters tab lets you track readings for an 
unlimited number of meters per asset record. 

You use the Enter Meter Readings action to record meter readings for an 
asset. You use the Manage Meter Reading History action to view or update 
historical meter readings. You use the Reset/Replace Meters action to reset 
a meter�s readings, for example when you replace a continuous meter.

Assets and Preventive Maintenance

You use the Preventive Maintenance application to create PM records for 
periodic maintenance and inspections to be performed on an asset.

You can use the View WO and PMs action to view all of the PM records that 
list the asset.

Assets and Safety

You use the Safety tab to record safety information for an asset, including 
safety related assets. Safety related assets are assets and locations in the 
general vicinity of the asset that may also pose a safety hazard to workers.

You use the applications in the Safety module to create records that can be 
associated with asset records to provide safety information to workers. You 
create hazard records in the Hazards application. You create precaution 
records in the Precautions application, and associate them with hazard 
records in the Hazards application. You use the Lock Out/Tag Out application 
to write tag out procedures to eliminate a specific hazard for a specific asset. 
You can associate records from all of these applications with an asset on the 
Safety tab of the asset record.

! You use the Hazards and Precautions subtab to associate precaution 
enabled hazards with the asset record. Maximo automatically copies the 
precautions associated with the hazard to the record. If you list a hazard 
that is also hazardous material enabled, Maximo automatically copies the 
hazardous materials data to the record.

! You use the Hazardous Materials subtab to associate hazardous material 
enabled hazards with the asset record. If you list a hazard on that is also 
precaution enabled, Maximo automatically copies the precautions to the 
record.

! You use the Lock Out / Tag Out subtab to associate tag out enabled 
hazards with the asset record. Once you have created a tag out for the 
asset and hazard, you can associate it with the asset record.

! You use the 
 that are in the immediate vicinity that have safety implications for 
workers. For example, if you must shut down another machine to be able 
to safely work on an asset.
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Assets and Work Orders

You can use several different methods to create work orders for assets:

! Maximo can generate work orders based on condition monitoring data
! Maximo can generate PM work orders for preventive maintenance or 

periodic inspections
! You can create work orders manually using one of Maximo�s work order 

applications. For more information about the applications that can be used 
to create work orders, see �Creating Work Orders Using Maximo,� on 
page 14-2.

You can use the View WO and PMs action to view all of the work order 
records that list the asset.

Asset Types

Maximo supports a wide variety of industries and asset types. If you are using 
Maximo to track a variety of asset types, you may find it useful to include a 
value in the Type field when adding asset records. The Type field is an 
optional field, and is null by default, but Maximo can use the value in the 
Type field to filter asset records during searches.

Maximo has four default asset types:

! Facilities � building assets, for example lighting, plumbing, heating, 
ventilation, and air conditioning (HVAC) systems.

! Fleet � transportation assets, for example trucks, buses, trains, and 
aircraft.

! IT � information technology (IT) assets, for example computers, routers, 
and printers.

! Production � production assets, for example assembly lines, conveyor 
belts, and packaging machinery. 

Your system administration can create any number of additional asset types, 
for example "computer hardware" and "computer software."

NOTE: You should enter a value in the Type field when you are creating asset 
records that will be managed using the applications in the Service Desk 
module.

Using the Assets Application

To access the Assets application, click the application link on your Start 
Center, or select Assets > Assets from the Go To menu.

The Assets application contains the following tabs:

! List � to search Maximo for asset records.
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! Asset � to enter, view, or modify the main record for an asset.

! Spare Parts � to create the asset hierarchy and view the subassemblies 
and spare parts of an asset.

! Safety � to add, view, modify, or delete safety information associated 
with an asset.

! Meters � to add, view, modify, or delete meters for an asset.

! Specifications � to classify an asset and add, view, modify, or delete 
specifications that give details about the attributes of the asset.

Asset Buttons

The following table lists application specific buttons that appear in the Assets 
application. 

Assets Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Assets application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Assets Help.      

Icon Function Location

Move/Modify Asset ! Toolbar

Swap Assets ! Toolbar

Associate Users and Custodians ! Toolbar

How Do I...

apply an item assembly structure to an asset 
record?

Select Apply Item Assembly Structure from 
the Select Action menu.

associate a service or service group with an 
asset?

Select Associate Services from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

compare asset and deployed asset records for 
information technology (IT) assets?

Select Asset Details from the Select Action 
menu.

create an asset record? Click the New Asset button in the toolbar.

delete an asset record? Select Delete Asset from the Select Action 
menu.
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designate one or more people as a custodian for 
an asset?

Select Associate Users and Custodians from 
the Select Action menu.

designate one or more people as a user for an 
asset?

Select Associate Users and Custodians from 
the Select Action menu.

duplicate an asset record? Select Duplicate Asset from the Select Action 
menu.

enter meter readings for an asset? Select Enter Meter Readings from the Select 
Action menu.

modify the attributes for one or more assets? Select Move/Modify Assets from the Select 
Action menu.

modify the rotating item ID listed on an asset 
record?

Select Change Item Number from the Select 
Action menu.

modify the users or custodians for one or more 
assets?

Select Move/Modify Assets from the Select 
Action menu.

move one or more assets to another bin, 
location, parent, Site, or storeroom?

Select Move/Modify Assets from the Select 
Action menu.

replace one asset with another asset? Select Swap Assets from the Select Action 
menu.

replace meters on an asset record? Select Reset/Replace Meters from the Select 
Action menu.

reset a meter on an asset record? Select Reset/Replace Meters from the Select 
Action menu.

reset the year-to-date and/or total costs for an 
asset?

Select Zero Asset Costs from the Select Action 
menu.

run reports? Select Run Reports from the Select Action 
menu.

update the meter history on an asset record? Select Manage Meter Reading History from 
the Select Action menu.

view the asset downtime history for an asset? Select View Asset Downtime History from 
the Select Action menu.

view asset and location hierarchies displayed 
graphically?

Select Open Drilldown from the Select Action 
menu.

view contracts associated with the asset? Select View Contracts from the Select Action 
menu.

view the history of an asset�s movements? Select View Asset Move History from the 
Select Action menu.

view reconciliation details for an information 
technology (IT) asset?

Select Asset Details from the Select Action 
menu.

view work orders and PMs associated with the 
asset record?

Select View Work Orders and PMs from the 
Select Action menu.

How Do I...
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Creating Asset Records

The Assets application lets you create and maintain records for assets leased, 
managed, or owned by your company You can specify the location of an asset, 
its vendor, and its manufacturer. You can also associate an asset with an 
asset hierarchy, define safety information and meters, and classify an asset.

You use the Assets application to create asset records. When you create asset 
records, they fall into one of two categories: 

! Standard assets � assets that you want to keep a repair history for, but 
that will not be stored in inventory.

! Rotating assets � assets that are interchangeable, for example, motors, 
pumps, or computers. Rotating assets have both an asset number and an 
inventory item number. This lets you track the asset as it moves from an 
operating location to a storeroom and vice versa.

NOTE: You can also create asset records for rotating items in the Receiving 
application via the Receive Rotating Items action.

Understanding Rotating Assets

Rotating assets are interchangeable assets that are moved in and out of 
service as needed. The term is generally applied to assets that can be repaired 
or refurbished rather than replaced, and can be used interchangeably at 
different locations or as subassemblies on different assets. Some examples of 
rotating assets might include the following:

! Production � pumps, motors
! Facilities � fire extinguishers
! Fleet � motors, transmissions, aircraft engines
! Technology � laptops, network printers

Other terms for this kind of asset include "rotating equipment," "rotating 
parts," "stocked equipment," "serialized equipment," "serialized assets," 
"rotables," and "rotatable spares."

Rotating asset records also have a Rotating Item number to track the asset 
as it moves from a storeroom to an asset or location, to repair, and so forth. 
Having both an asset and item number lets you track identical assets both 
individually, via their unique asset numbers, and as a group, via their shared 
item number.

For example, a company might have fifty identical fire extinguishers (same 
manufacturer, same model), so all fifty have the same item number. However, 
each fire extinguisher has a unique history of when it was purchased, placed 
in the facility, inspected, used, and recharged, so each extinguisher has a 
unique asset number to let you track it individually.

NOTE: Before creating rotating asset records, the rotating item first must be 
defined in the Item Master application.

NOTE: Once you have saved a rotating asset record, you must use the Change 
Item Number action to change the value in the Rotating Item field.
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Understanding Asset Hierarchies

You use the Spare Parts tab of an asset record to define the asset assembly 
structure or asset hierarchy for an asset record. You create asset 
hierarchies when you want the records you create in Maximo to reflect the 
physical connection of the actual assets.

Building an asset hierarchy serves the following functions:

! It lets you track maintenance costs. Costs get "rolled up" the hierarchy to 
the asset responsible for assuming the maintenance cost.

! It builds the Asset/Location hierarchy, letting you use the Drilldown to 
visually navigate the hierarchy to locate a specific asset. 

Asset hierarchies consist of asset records and item records for spare parts and 
other inventory items.

Asset Assembly Structure Elements

Three kinds of possible elements exist in an asset assembly structure:

! Top Level Elements � A single record is at the top level of each asset 
assembly structure. Any asset record in the ASSET table that does not 
have a value in its Parent field (that is, any record that is not the child of 
another asset record) is a top level element.

! Subassemblies � Subassemblies are entities that �belong to� another 
asset. A subassembly can have one or more other subassemblies belonging 
to it. This type of relationship is referred to as a �parent-child 
relationship.� A parent asset can have one or more subassemblies 
(children) belonging to it, but a subassembly belongs to only one parent.

! Spare Parts � An inventory item can belong to any asset � the top level 
element or a subassembly, or both. Unlike individual assets spare parts 
can be entered multiple times in an asset assembly structure. For 
example, both a motor and the motor housing might require two half-inch 
nuts as parts.   
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Simple Asset Assembly Structure  

Creating Asset Assembly Structures

Asset assembly structures can be built on either the Asset tab or the Spare 
Parts tab in the Assets application.

! Asset Tab � Use the Detail Menu button to specify an asset in the 
Belongs To field. This makes the asset shown in the Asset field a child of 
the asset in the Belongs To field, thereby building a hierarchy for new 
asset records.

! Spare Parts Tab � Use the New Row button in the Subassemblies or 
Spare Parts table window to add existing assets or item records to the 
asset assembly structure for a new asset record.

! Move/Modify Assets action � Use the Move/Modify Assets action to 
specify a new parent for an existing asset record. You can also use this 
action to modify the parent for a saved asset record.

Applying Item Assembly Structures

Item assembly structures (IAS) are created in the Item Master application 
and can be used as templates for creating asset assembly structures. After you 
apply an IAS to an asset record, the rotating and non-rotating items are 
copied into the asset�s Spare Parts tab. 

You typically apply an item assembly structure to assets when you first create 
the asset record. You can apply an IAS to an asset by specifying the top-level 
item number in the Rotating Item field, then choosing the Apply Item 
Assembly Structure action. The rotating item at the top level of the IAS 
becomes a rotating asset after the IAS is applied to an asset record. 

Any lower-level elements in the IAS that are themselves rotating items must 
be given asset identifiers after the IAS is applied. Any children of nonrotating 
items in the IAS are treated in the asset hierarchy as belonging to the closest 
rotating asset above the item in the IAS. 

NOTE: While the IAS can have multiple levels of nonrotating items, the asset 
assembly structure can have only one level of nonrotating items below 
an asset number.

Top Level Element

Spare Part Subassembly

Spare Part
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Viewing Asset Hierarchies

Using the Spare Parts tab on the Assets application you can see the parents 
and the children of the current record. You can also see the spare parts that 
have been defined for the asset.   

Instead of viewing the current asset record, you might want to view the record 
for its parent or for one of the subassemblies.

! To view the parent record, click the Detail Menu button in the Belongs 
To field (if that field has an entry) and select Move To. Maximo moves up 
the hierarchy to the parent record. 

! To view the record for a subassembly, click the View Details button 
(triangle) for the subassembly. Click the Detail Menu button in the Asset 
field and select Move To. Maximo moves down the hierarchy to the 
subassembly record.

Managing Asset Records

Once you have created asset records and changed their status to ACTIVE, you 
use a number of different applications to manage your assets including 
Condition Monitoring and Preventive Maintenance. You can use the View 
Asset Downtime History action to view a history of when the asset has been 
out of service for maintenance or other reasons.

Asset Users and Custodians

In the context of asset records a user is someone who uses an asset and a 
custodian is someone who is responsible for the care of the asset. In the 
Assets module you can use the Associate Users and Custodians action to 
associate a person record with an asset as a user, a custodian, or as both user 
and custodian.By default the first person record associated with an asset is 
designated as the primary user or custodian, but this can be modified if 
necessary.

If an asset does not have a user or custodian specified for it, it is considered a 
public asset. You can only use the Create Service Request application to 
create a self-service service request for public assets or assets where you are 
listed as the user or custodian.

Deleting Meters

If a meter is attached to an asset in error the meter can be deleted, but only if 
there have not been any readings entered for the asset/meter combination. To 
delete a meter, click the Mark Row for Delete button next to the row in the 
Meters table window, then click Save. Meters can only be deleted if there are 

To view the: Look in the: 

Current asset Asset field

Parent of the asset Parent field

Subassemblies Subassemblies table window

Spare Parts Spare Parts table window
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no readings for the asset/meter combination recorded on any of the following 
tables:

! METERREADING
! WOMETER
! PMMETER 
! MEASUREMENTS

Asset Statuses

Assets have an associated status to designate whether or not they are 
operational. An asset record can have one of the following statuses:

! NOT READY � Default status for new asset records. Asset records can 
be created before assets have been received, installed, configured, 
inspected, or otherwise approved for their intended use.

! OPERATING � Asset has been received, installed, configured, inspected, 
or otherwise approved for use or operation. 

! DECOMMISSIONED � Asset has been retired from service and moved 
to scrap or salvage.

CAUTION: You should only select DECOMMISSIONED as the new status if 
you intend that status change to be permanent. 

Decommissioning an Asset

If an asset is going to be permanently retired from service, you can change it�s 
status to DECOMMISSIONED. Decommissioned asset do not appear in select 
value lists or in the drilldown, but are still maintained in the Maximo 
database as historical records. 

Before an asset record can be decommissioned, the following must be true:

! The asset cannot be referenced on any open work orders.
! The asset cannot be referenced on any open desktop requisitions, purchase 

requisitions, requests for quotation or purchase orders.
! The asset cannot be referenced on any job plans.

CAUTION: You should only select DECOMMISSIONED as the new status if you 
intend that status change to be permanent. 

Once an asset record has had its status changed to DECOMMISSIONED the 
following actions are not allowed:

! adding children, subassemblies, or spare parts
! updating meter readings
! modifying the Rotating Item or apply an item assembly structure
! associating specifications or specification values
! referencing the asset on new desktop requisitions, purchase requisitions, 

requests for quotation, or purchase order lines
! issuing items that will be charged to the asset
! creating work orders for the asset
! adding the asset to job plans or preventive maintenance records.

You can, however, still perform the following actions for a decommissioned 
asset:
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! Return items issued or charged to the asset.
! Move/Modify the asset record using the Move/Modify Assets action.
! Zero the Year to Date costs for the asset.

The Change Status dialog box allows you the following options when 
decommissioning an asset:

! Roll New Status to All Child Assets? � Checked by default when you 
are changing the status of an asset to DECOMMISSIONED. 
Automatically changes the status of all child assets to 
DECOMMISSIONED.

! Remove asset reference from active routes? � Select to remove the 
asset record from all routes with a status of ACTIVE.

! Remove asset reference from active safety plans? � Select to 
remove the asset record from all safety plans with a status of ACTIVE.

! Change status of all associated PMs to inactive? � Select to change 
the status of all PMs associated with the asset record to INACTIVE.

Asset Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Condition Monitoring

Condition monitoring is tracking measured data for an asset or location 
and using that data to predict when preventive maintenance needs to be 
performed. The type of data, for example, vibration, pressure, or temperature, 
depends on the asset or location.

You use the Condition Monitoring application to create and view 
measurement point records for your assets and locations. A measurement 
point record defines the acceptable limits for condition and performance 
measurements for a point or place on an asset or location. You can generate 
preventive maintenance (PM) work orders for assets or locations whose 
measurements are outside acceptable limits.

Multisite and Condition Monitoring

You create measurement points for assets and locations, which are at the Site 
level. Thus Condition Monitoring is at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.
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Condition Monitoring and Assets/Locations

You can have an unlimited number of measurement points for each asset or 
location record, but you can only create one measurement point for each meter 
that exists for the asset or location.

Condition Monitoring and Meters

Gauge and characteristic meters can be used to drive condition monitoring. 
Continuous meters can not be used with condition monitoring.

When you create measurement points, each meter can only be used once on an 
asset or location. You may need to create duplicate meters with different 
names if you have multiples of the same meter on an asset or location. For 
example, if a piece of equipment has three temperature gauges, you would 
need to create three meters that measured temperature, TEMP1, TEMP2, and 
TEMP3, to be able to create three temperature measurement points for the 
asset.

Condition Monitoring and Preventive Maintenance

You can create PMs that describe the preventive maintenance that should be 
performed when the readings for a measurement point reach a certain limit or 
value. You use the Preventive Maintenance application to create PM records.

Conditions measured by gauge and continuous meters might require different 
maintenance at the upper and lower action limits. You can specify a different 
PM in the Upper Limit PM field and the Lower Limit PM field.

Conditions measured by characteristic meters can have a different PM 
specified for each characteristic value by entering a row for each value in the 
Characteristic Action Value table window.

Condition Monitoring and Work Orders

You can generate a work order from a measurement point using the 
Generate Work Order action available from the Select Action menu. You 
can also select multiple measurement points on the List tab and generate 
work orders as a batch action.

Work orders generated by condition monitoring have a work type of CM 
(corrective maintenance).

Using the Condition Monitoring Application

To access the Condition Monitoring application, click the application link on 
your Start Center, or select Assets > Condition Monitoring from the Go To 
menu.

The Condition Monitoring application contains the following tabs:
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! List � to search Maximo for condition monitoring records.

! Condition Monitoring � to create, view and modify measurement 
points, and to generate PM work orders. 

Condition Monitoring Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Condition Monitoring application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Condition Monitoring Help.      

Creating Measurement Points Records

Measurement points are records that you create in the Condition 
Monitoring application that define the acceptable limits for condition and 
performance measurements for a point or place on an asset or location. The 
measurement data and acceptable conditions depend on the type of asset or 
location. For example you might measure vibration, pressure, and 
temperature on two different pieces of equipment, but the acceptable 
measurements might be different for each machine.

You create a measurement point for a specific asset or location. Each 
measurement point has an associated Meter. Before you can create 
measurement points in the Condition Monitoring application you must create 
meters in the Meters application. 

You can only create one measurement point using a particular meter record 
for each asset or location. For example, if you have a PRESSURE meter, you 
can only use it to create one measurement point for a particular asset. If you 
have multiples of the same type of meter on an asset or location, you must 
create duplicate meters with different names. For example if you want to 
create three measurement points for pressure gauges on the same asset, you 
would need to create three separate meters, PRESSURE1, PRESSURE2, and 
PRESSURE3.

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a measurement point record? Click the New Measurement Point button in 
the toolbar.

delete a record? Select the Delete Measure Point action from 
the Select Action menu.

generate a work order from a measurement 
point record?

Select Generate Work Order from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.
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Measurement Point Limits - Gauge Meters

A measurement point record for a gauge meter contains a range of values. 
There is an acceptable, safe operating range, as well as the upper and lower 
warning and action limits. The upper and lower limits are defined as follows:

! Lower Warning Limit � indicates potential trouble and a need for 
closer monitoring. This value always should be higher than the Lower 
Action Limit.

! Lower Action Limit � indicates a need for corrective action. Maximo 
can generate a PM work order after this point is reached.

! Upper Warning Limit � indicates potential trouble and a need for 
closer monitoring. This value always should be lower than the Upper 
Action Limit.

! Upper Action Limit � indicates a need for corrective action. Maximo 
can generate a PM work order after this point is reached.

You can specify a different PM in the Upper Limit PM field and the Lower 
Limit PM field. You can specify a different job plan in the Upper Limit Job 
Plan field and the Lower Limit Job Plan field. When Maximo generates 
work orders, the work order will be based on the PM and job plan for the 
appropriate action limit.

NOTE: PMs are created in the Preventive Maintenance application.

Measurement Point Limits - Characteristic Meters

A measurement point record for a characteristic meter contains a specific list 
of values. One or more of the values represents an acceptable, safe operating 
range. To indicate that a characteristic value requires maintenance, you enter 
a value in the PM field. Maximo can generate a PM work order when readings 
are entered that match the characteristic value.

NOTE: PMs are created in the Preventive Maintenance application.

Managing Condition Monitoring Records

You use the Condition Monitoring application to modify and delete 
measurement points.

You enter meter readings using the Enter Meter Readings action available 
from the Select Action menu in the Assets, Locations, Quick Reporting, and 
Work Order Tracking applications.

Generating a Work Order from a Measurement Point

You can generate PM work orders from a measurement point in two ways:

! automatically via a cron task. Cron tasks are created in the Cron Task 
application.

! manually via the Generate Work Order action available from the Select 
Action menu.



Failure Codes

3-20 Maximo 6, 08/2006

The History table window displays work orders that have been generated from 
the Condition Monitoring application in response to measurements that have 
been recorded that fall outside of the acceptable limits. The History table is 
read-only. All work orders shown were generated from the Condition 
Monitoring application. This table does not display work orders generated 
from anywhere else, even if they involve work on the measurement point.

TIP: You can generate work orders for multiple measurement points from the 
List tab.

Condition Monitoring Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Failure Codes

A failure code is an element of a failure hierarchy. In Maximo a failure 
hierarchy consists of Problems, Causes, and Remedies. An individual failure 
code can be used at more than one level of a failure hierarchy. For example 
"high temperature" could appear in one failure hierarchy as a Problem, and in 
another as a Cause.

You use the Failure Codes application to build and display failure hierarchies. 
A failure hierarchy is identified on other Maximo records by a Failure Class 
name. Failure classes can be associated with assets, locations, and work 
orders. 

Using failure hierarchies can help you to construct an accurate history of the 
problems that lead to asset and location failures. You can also use failure 
hierarchies to record the different solutions to failures. After reporting and 
analyzing failure trends, you can take preventive measures to help reduce 
future failures.

Understanding the Failure Code Hierarchy

A Failure Class is the name used to identify a failure hierarchy. By default 
Maximo uses a three level hierarchy that is built on a Problem�Cause�
Remedy framework. 

! The PROBLEM is the symptom. What looks or feels broken? Problem 
failure codes are added, viewed, modified, and deleted in the Problems 
table window on the Failure Codes tab.

! The CAUSE creates the problem. Why did the problem occur? Cause 
failure codes are added, viewed, modified, and deleted in the Causes for 
table window on the Failure Codes tab. Note that the Causes for table 
window is paired with the Problems table window.

! The REMEDY is the correction. What will fix the problem? Remedy 
failure codes are added, viewed, modified, and deleted in the Remedies for 
table window on the Failure Codes tab. Note that the Remedies for table 
window is paired with the Causes for table window.
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Each level in the failure hierarchy beneath the failure class can contain one or 
more failure codes, which "belong to" the failure code in the next higher level. 
An individual failure code can have multiple children; each child in turn can 
have one or more child failure codes.

NOTE: You company may choose to use a different structure for its failure 
hierarchies. 

Multisite and Failure Codes

Failure Codes are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

Failure Codes and Assets/Locations

You can associate a Failure Class with an asset or location record. 

Failure Codes and Work Orders

When work orders are created for the asset or location that has a Failure 
Class specified on the record, the Failure Class data is copied to the work 
order. You can then select a Problem Code for the work order. You can 
specify a Failure Class for a work order even if the asset or location record 
does not specify one.

TIP: Using failure codes on work orders can help reduce the number of 
duplicate work orders that are entered in the system. Maximo displays a 
message if a work order with the same Problem Code already exists for 
the asset or location.

You use the Failure Reporting subtab of the Quick Reporting application, and 
the Failure Reporting tab of the Work Order Tracking application to record 
failure data.

Using the Failure Codes Application

To access the Failure Codes application, click the application link on your 
Start Center, or select Assets > Failure Codes from the Go To menu.

The Failure Codes application contains the following tabs:

! List � to search Maximo for failure code records.

! Failure Codes � to create, view, modify, and delete failure hierarchies. 



Using the Failure Codes Application

3-22 Maximo 6, 08/2006

Failure Codes Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Failure Codes application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Failure Codes Help.       

Creating Failure Codes

You use the Failure Codes application to create and view failure hierarchies. 
These hierarchies represent the identified causes of asset and location 
failures, and the identified solutions to these failures.

TIP: Because failure codes include data about known problems, causes, and 
remedies for asset failures, maintenance workers can use a failure 
hierarchy as a troubleshooting checklist. 

Building a Failure Hierarchy

Failure hierarchies are built from the top down. You navigate the failure 
hierarchy from top to bottom. A Failure Hierarchy can be created all at once, 
or completed partially and added to later as necessary. You can use existing 
failure codes and/or create new ones to build the hierarchy. 

! You can select existing failure codes by clicking the Select Value icon 
next to the field. 

! You can create new failure codes by typing a value into the field. Maximo 
will attempt to match the value you entered with an existing failure code 
value. If one already exists, Maximo copies it into the field. If one does not 
exist, Maximo displays the Select Value dialog box. Click Continue to 
accept the value.

NOTE: Failure codes can be used at any level of the hierarchy. For example, 
"jammed" could be both a Problem and a Cause.

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

copy one or more existing failure hierarchies to 
a failure code record?

Select Copy Failure Hierarchy from the 
Select Action menu.

create a failure code record? Click the New Failure Code button in the 
toolbar.

delete a record? Select Delete Failure Code from the Select 
Action menu.

duplicate a record? Select Duplicate Failure Code from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.
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The procedures for adding Problem, Cause, and Remedy level failure codes are 
the same with one exception: selecting the parent for Causes and Remedies. 
All Problem failure codes are children of the Failure Class, but note the labels 
for the Cause and Remedy tables, which indicate the parent levels for the 
records in each table window. The Cause and Remedy table windows are both 
paired table windows, their labels reflect the selected row in the table above. 
For more information about paired table windows, see �Paired Table 
Windows,� on page 2-25.

CAUTION: Before entering Causes or Remedies, check that the table window 
label reflects the correct parent for the failure code you are about to 
enter. To change the table label, click the appropriate row in the 
parent table window.

Managing Failure Codes

Failure reporting lets you identify and track asset and location failures. 
Entering Failure Class and Problem Code data on work orders provides 
data that can be used for failure analysis. You use the Failure Reporting 
subtab of the Quick Reporting application, and the Failure Reporting tab of 
the Work Order Tracking application to record failure data.

Failure analysis is how you examine your failure history data, reported over 
a significant period of time. You use asset or location failure reports to look for 
breakdown trends, average time between failures, and so on. 

By correlating this failure information with other data available to you, for 
instance, preventive maintenance schedules for an asset or location, you can 
develop ways to reduce or limit future failures. For example, you might want 
to review your preventive maintenance schedule, or you might be able to 
identify a branch of faulty inventory items.

Failure Codes Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Locations

A location is generally defined as a place where assets are operated, stored, 
or repaired. Generally locations are defined as a means of tracking assets, but 
if your company does not use asset records to track equipment, you may define 
a location as any facility (or portion of a facility) that you want to create a 
maintenance record for using Maximo.

You use the Locations application to add, view, modify, and delete location 
records for assets, and organize these locations into logical hierarchical or 
network systems. Using systems of locations and specifying the location for 
assets on asset records provides the groundwork for gathering and tracking 
valuable information on the history of assets, including asset performance at 
specific sites, and as an asset is moved from location to location. When you 
organize your locations into systems, you can quickly find a location using the 
Drilldown and then identify the assets at a specific location. 
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You also can use the Locations application to create repair locations, courier 
locations, salvage locations, vendor locations, and labor locations.

Multisite and Locations

Locations are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations. For example, if each 
facility is a separate Site, you could have a location record named "Second 
Floor" at each Site.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Locations and Assets

You use the Assets tab of a location record to view a read-only list of assets 
that have the current record listed as a value in their Location field.

Locations and Condition Monitoring

Maximo uses measurement points as one possible criteria for generating PM 
work orders. If a measurement is entered that reaches an upper or lower 
action limit, a PM work order can be generated for the location, either 
automatically via a cron task, or manually via the Generate Work Order 
action in the Condition Monitoring application.

You create measurement points in the Condition Monitoring application. Each 
measurement point is associated with a meter. Meters are created in the 
Meters application. When you create a measurement point for a location 
Maximo copies the measurement point to the Meters tab of the location 
record. You can record readings using the Enter Meter Readings and 
Manage Meter Reading History actions available from the Select Action 
menu.

For more information about creating measurement points, see �Using the 
Condition Monitoring Application,� on page 3-17.

Locations and Contracts

Location records can be associated with the following types of contracts:

! Service Contract
! Warranty Contracts

For more information about contract types, see �Contract Types,� on page 4-2.

You can view all contracts associated with a location using the View 
Contracts action in the Locations application.
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Locations and Inventory

Location records are generally defined to track assets, but sometimes you 
create location records to track inventory when it is not in a storeroom. For 
more information about locations and inventory, see �Location Types,� on 
page 3-26.

Locations and Meters

Maximo uses meters as one possible criteria for generating PM work orders. 
PM frequency is based on elapsed time in days or in meter units since the last 
work order was completed or targeted to start. 

Once meters have been created in the Meters and Meter Groups applications, 
you can associate individual meters or meter groups with a location record on 
the Meters tab. An initial meter reading may be entered when the meter is 
attached to the location record. The Meters tab lets you track readings for an 
unlimited number of meters per location. 

You use the Enter Meter Readings action to record meter readings for a 
location. You use the Manage Meter Reading History action to view or 
update historical meter readings. You use the Reset/Replace Meters action 
to reset a meter�s readings, for example when you replace a continuous meter.

Locations and Preventive Maintenance

You use the Preventive Maintenance application to create PM records for 
periodic maintenance and inspections to be performed at a location.

You can use the View WO and PMs action to view all of the PM records that 
list the location.

Locations and Safety

You use the Safety tab to record safety information for a location, including 
safety related assets. Safety related assets are assets and locations in the 
general vicinity of the location that may also pose a safety hazard to workers.

You use the applications in the Safety module to create records that can be 
associated with location records to provide safety information to workers. You 
create hazard records in the Hazards application. You create precaution 
records in the Precautions application, and associate them with hazard 
records in the Hazards application. You use the Lock Out/Tag Out application 
to write tag out procedures to eliminate a specific hazard for a specific 
location. You can associate records from all of these applications with a 
location on the Safety tab of the location record.

! You use the Hazards and Precautions subtab to associate precaution 
enabled hazards with the location record. Maximo automatically copies 
the precautions associated with the hazard to the record. If you list a 
hazard that is also hazardous material enabled, Maximo automatically 
copies the hazardous materials data to the record.
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! You use the Hazardous Materials subtab to associate hazardous material 
enabled hazards with the location record. If you list a hazard on that is 
also precaution enabled, Maximo automatically copies the precautions to 
the record.

! You use the Lock Out / Tag Out subtab to associate tag out enabled 
hazards with the location record. Once you have created a tag out for the 
asset and hazard, you can associate it with the location record.

You use the Safety Related Assets subtab to associate assets and locations 
that are in the immediate vicinity that have safety implications for workers. 
For example, if you must shut down another machine to be able to safety work 
on a location.

Locations and Work Orders

You can use several different methods to create work orders for locations:

! Maximo can generate work orders based on condition monitoring data
! Maximo can generate PM work orders for preventive maintenance or 

periodic inspections
! You can create work orders manually using one of Maximo�s work order 

applications. For more information about the applications that can be used 
to create work orders, see �Creating Work Orders Using Maximo,� on 
page 14-2.

You can use the View WO and PMs action to view all of the work order 
records that list the location.

Location Types

You can create the following types of locations using Maximo:

! Courier � Courier location. This is an inventory location, used to indicate 
an individual who is responsible for inventory items while in transit from 
one inventory location to another.

! Holding � Holding location. This is an inventory location, used to hold 
items received with a status of WINSP (waiting for inspection). You can 
only create one holding location per Site.

! Labor � Labor location. This is an inventory location, used when 
inventory is issued to a worker, for example a mobile repair worker.

! Operating � Operating location. This is an asset location, used to 
indicate a location where assets are located or equipment is operated.

! Repair � Repair location. This is an asset location, used to indicate a 
location where assets are repaired or refurbished.

! Salvage � Salvage location. This is an asset location, used to indicate a 
location used to store retired or decommissioned assets.

! Vendor � Vendor location. This is an inventory location, used to indicate 
the source of items, materials, and rotating assets, and may be used to 
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indicate the location of an asset returned to the vendor for repair or 
refurbishment.

Using the Locations Application

To access the Locations application, click the application link on your Start 
Center, or select Assets > Locations from the Go To menu.

The Locations application contains the following tabs:

! List � to search Maximo for location records.

! Location � to enter, view, or modify detailed information specific to a 
location.

! Assets � to view assets at the location.

! History � to view the history of move transactions into and out of the 
location.

! Safety � to add, view, modify, or delete safety information associated 
with a location.

! Meters � to add, view, modify, or delete meters for a location.

! Specifications � to classify a location and add, view, modify, or delete 
specifications that give details about the attributes of the location.

Locations Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Locations application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Locations Help.      

How Do I...

add a new system? Select Manage Systems from the Select Action 
menu.

apply an item assembly structure to a location 
record containing a rotating item ID?

Select Apply Item Assembly Structure from 
the Select Action menu.

associate a location with a system? Select Associate Systems with Location 
from the Select Action menu.

associate a service or service group with an 
asset?

Select Associate Services from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a hierarchical system to a network 
system?

Select Manage Systems from the Select Action 
menu.
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Creating Locations

Locations are typically the places where assets operate, but include any 
building, place, or position that contains assets, or where maintenance work 
might need to be performed. For example, a hallway might include lighting 
fixtures and a fire extinguisher, and would need to be painted periodically. 

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a location record? Click the New Location button in the toolbar.

delete a record? Select Delete Location from the Select Action 
menu.

designate one or more people as a custodian for 
a location?

Select Associate Users and Custodians from 
the Select Action menu.

designate one or more people as a user for a 
location?

Select Associate Users and Custodians from 
the Select Action menu.

disassociate a location from a system? Select Associate Systems with Location 
from the Select Action menu.

duplicate a record? Select Duplicate Location from the Select 
Action menu.

enter meter readings for a location? Select Enter Meter Readings from the Select 
Action menu.

modify the parent for a location in one or more 
systems?

Select View/Modify Parents from the Select 
Action menu.

replace meters on a location record? Select Reset/Replace Meters from the Select 
Action menu.

reset a meter on a location record? Select Reset/Replace Meters from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

select a system to be the primary system? Select Manage Systems from the Select Action 
menu.

update the meter history on a location record? Select Manage Meter Reading History from 
the Select Action menu.

view asset and location hierarchies displayed 
graphically?

Select Open Drilldown from the Select Action 
menu.

view the parents for a location across systems? Select View/Modify Parents from the Select 
Action menu.

view the status history of a location? Select View History from the Select Action 
menu.

view work orders and PMs associated with the 
location record?

Select View Work Orders and PMs from the 
Select Action menu.

How Do I...
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Work order costs are typically charged to the location itself or to the asset at a 
location. 

In addition to operating locations, assets can be located in other "asset type" 
locations. Other asset type locations are vendor locations, salvage locations, 
and repair locations. You can track an asset not only as it moves from one 
location to another, but also as it moves to a vendor or repair location, and 
eventually, to salvage.

Along with "asset type" locations, there are "inventory type" locations such as 
labor and courier. Like a storeroom, these "locations" can maintain a balance 
of items issued from a storeroom. For example, if a courier is holding a 
number of parts, he is responsible for them until they are received into 
another location.

Understanding Locations Terms

The following are some common terms that are used when discussing location 
hierarchies:

! hierarchy � Any system of places ranked one above another. Each 
parent location can have many child locations, but each child location can 
have only one parent location.

! location � Locations are typically the places where assets operate, but 
include any building, place, or position that contains assets, or where 
maintenance work might need to be performed. 

! network � Any system of interconnected locations. Unlike hierarchies, in 
a network each location can have multiple parents and children.

! operating location � In Maximo, the places where equipment operates. 

! primary system � The default hierarchy of locations. Each Site may 
have only one primary system. Your primary system must be hierarchical, 
that is there must be a single top-level location that is the parent of all 
other locations in the system. If assets in different locations are part of an 
asset hierarchy, their locations must exist in the primary system.

! Site � Term used to define a work location in Maximo, such as a plant or 
facility. A Site belongs to a single Organization, but more than one Site 
can share the data defined for the Organization. For more information 
about Sites, see �Multisite Levels,� on page 1-9.

! system � A grouping of locations, organized into either hierarchical or 
network relationships. A hierarchical system could define location 
relationships of a plant, having a plant site as a parent to plant buildings, 
which are parents of sublocations within the building areas. A network 
system could define the location relationships of a system of pipes or ducts, 
where there are some locations that feed back into others.

Preparing to Create Locations

Carefully review all topics on locations and systems in this guide and in the 
Locations Help before creating locations. Inserting location records and 
specifying parents and systems for the new locations creates relationships 
that are not easily undone after you establish them. 
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The time and thought you invest in planning your locations and systems 
simplifies creating them, and makes it easier for users to navigate the 
Drilldown.

CAUTION: The first location you create in a hierarchical system becomes the top 
level location. You cannot change this.

Operating locations are most useful when organized into systems. A location 
can be in more than one system at the same time. If you have selected a 
system you can specify a parent for the location. If you are specifying both a 
system and a parent, the parent must belong to the system.

Understanding Location Systems

Location hierarchies let you group assets and locations into areas of 
responsibility. A location hierarchy can be designed to include all locations in 
your plant against which work orders are written, and can track the 
movement of assets into and out of locations. Maximo calls location 
hierarchies systems.

Establishing one or more systems lets you build a logical model of the 
locations at your site by specifying their parent(s) and/or children. Locations 
can be placed into more than one system. Your primary system might divide 
an office building into floors, and the floors into offices. In this example, an 
office might belong to the primary system, the heating system, and the 
electrical system. 

You can add location records without organizing them into systems. However, 
organizing locations into named systems can help you manage your 
maintenance work more effectively by letting you see how a work order can 
affect assets, locations, or systems beyond the specific asset or location the 
work is to be done on.

With operating locations organized into systems, you can find a location 
quickly via the Drilldown and identify the assets at that location. 

CAUTION: Plan carefully before creating systems.

Planning Location Hierarchies

If the Drilldown is intended to be a primary means of accessing location data, 
proper planning of location hierarchies is necessary. While a large number of 
location or asset records will not necessarily affect the performance of the 
Drilldown, a poorly constructed hierarchy can have a negative impact on 
Drilldown performance.

A perfectly symmetrical hierarchy, containing 10 children at each level, and 
containing five levels below the top level could have over 100,000 records and 
have very good performance. But performance can be negatively affected if 
there are hundreds of children for any given parent. In addition, users may 
have difficulty finding locations if there are a large number of records at any 
given level of the hierarchy.

When planning the shape of your location hierarchies, consider how your 
locations can be subdivided and categorized. For example, a large building 
could be divided into floors. A floor containing a large number of offices could 
be divided into wings, or quartered into North, South, East, and West 
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quadrants. And consider how future growth will be accommodated, for 
example if a large space were to be partitioned to create several new offices.

Creating Hierarchical Systems

If you are entering location records for the first time, and no systems currently 
exist, you must create one. You use the Manage Systems action to create a 
new system, and also to designate your primary system.

In general, first create the primary system for each Site. If assets in 
different locations are part of an asset hierarchy, their locations must exist in 
the primary system. Having all your operating locations tied together in one 
complete primary system provides a solid foundation for using locations and 
systems. It might be the only system your site needs for tracking assets. 

The primary system must be hierarchical, that is, it must have one top-level 
location as the �ancestor� of all other locations in the system. You can call this 
system Primary, Main, Plant, or whatever is appropriate for your site.

NOTE: The first location you add to a new hierarchical system becomes the top-
level location in the system; for every location you add to the system 
after that, you must specify a parent location. Plan carefully before 
adding the first location to any new system.

After defining the location, you can use the Associate Systems with 
Location action to specify each system that the location is associated with.

Building a Location Hierarchy from an Item Assembly Structure

You can use an item�s item assembly structure to create location records for 
rotating assets associated with the item. When the same IAS is applied to 
both a location and an asset, a location hierarchy is created that matches the 
asset hierarchy. An IAS can be applied multiple times, to different locations 
that require the same kind of assets. 

To apply an IAS to a location, specify the top-level item number in the Item 
field on a location record, then choose the Apply Item Assembly Structure 
action. You then can create location records for any rotating items in the 
structure. Non-rotating items in the IAS are ignored in the location hierarchy.

NOTE: You can only apply an item assembly structure (IAS) to a location if the 
location belongs to the primary system. 

Creating Network Systems

When you define a system using the Manage Systems action, you can specify 
whether it is Hierarchical or Network using the Network? check box. If an 
association requires the system to be networked, Maximo does not 
automatically change the system to network. You must change the property of 
the system using the Manage Systems action, and then associate the 
location with the system.

Examples of locations that might be organized as a network include a 
ventilation system or piping system.

NOTE: You can change a system from a hierarchy to a network but not from a 
network back to a hierarchy.
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Viewing Location Hierarchies

The Locations tab displays three table windows:

! Systems � displays the systems associated with the location. Click a 
system to populate the other two table windows. 

! Parent of � displays the location�s parent in the selected system. 
Additional parents can be added using the New Row button only if the 
selected system is a network.

! Children of � displays the location�s children that belong to the selected 
system. New children can be added using the New Row button.

If a system is a network, the Network column of the System table window 
contains a check. If a system is hierarchical, the Network column is not 
checked.

Managing Locations

When you disassociate a location from a system, the location should not have 
any children that are associated with the same system. Delete the children 
from the Children table window present in the Locations main page, and then 
disassociate the system.

NOTE: Deleting children from the Children table window removes the 
association between the child and parent records, it does not delete the 
child location records from Maximo.

You can delete a system only when it is not associated with any locations. 

Location Statuses

A location record can have one of the following statuses:

! NOT READY � Location records can be created before locations have 
been built, leased, or purchased.

! OPERATING � Default status for new location records. 

! DECOMMISSIONED � Location is no longer in use.

CAUTION: You should only select DECOMMISSIONED as the new status if 
you intend that status change to be permanent. 

Decommissioning a Location Record

If a location is going to be permanently retired from service, you can change 
it�s status to DECOMMISSIONED. Decommissioned locations do not appear 
in select value lists or in the drilldown, but are still maintained in the Maximo 
database as historical records. 

Before a location record can be decommissioned, the following must be true:

! The location cannot be referenced on any open work orders.
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! The location cannot be referenced on any open desktop requisitions, 
purchase requisitions, requests for quotation or purchase orders.

! The location cannot be referenced on any job plans or routes.
! The location cannot be reference on any preventive maintenance record.

Once a location record has had its status changed to DECOMMISSIONED the 
following actions are not allowed:

! adding children to the location
! associate systems with the location
! updating meter readings
! modifying the Rotating Item value or apply an item assembly structure
! associating specifications or specification values
! referencing the location on any new desktop requisitions, purchase 

requisitions, requests for quotation or purchase order lines.
! issuing items that will be charged to the location
! creating work orders for the location
! adding the location to job plans or preventive maintenance records.

Locations Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Meters

A meter record in Maximo is a virtual identifier used to record 
measurements. You associate meter records with assets and locations to 
record measurements, for example run hours, temperature, or pressure, that 
are used to track asset and location performance. You use the Meters 
application to add, view, modify, and delete meter records.

Meter readings may be recorded for a variety of reasons, including:

! determining the next time an asset is due for maintenance

! performing efficiency comparisons between similar asset performing 
similar work

! tracking production costs, for example tons per hour in the mining 
industry

! tracking service costs, for example odometer readings for a trucking fleet

! tracking efficiency indicators, for example miles per gallon

! conforming to regulatory requirements, for example maintaining cradle to 
grave details of time controlled components in the aviation industry

When you use the Meters application to define a meter record you can define 
the type of meter, the unit of measure used by the meter, and the type of 
reading (delta or actual) that the meter should record. Meter records can be 
associated with assets, inventory items, and locations, and can be used to 
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drive condition monitoring and preventive maintenance. Meters can be 
applied individually, or as part of a meter group.

Multisite and Meter Records

Meters are at the System, or database level. This means that:

! Key fields for new records must be unique within the Maximo database.

! Records are available to all users of the database who have security 
permissions to the application. 

Meters and Assets/Locations

You can associate one or more meters with an asset or location record. Meters 
are associated with assets in the Assets application, and with locations in the 
Locations application. 

You use the Enter Meter Readings action to record meter readings for an 
asset or location. You use the Manage Meter Reading History action to 
view or update historical meter readings. You use the Reset/Replace Meters 
action to reset a meter�s readings, for example when you replace a continuous 
meter.

Meters and Condition Monitoring

When you create a measurement point in the Condition Monitoring 
application you associate it with a meter. Gauge and characteristic meters can 
be used to drive condition monitoring. Continuous meters can not be used 
with condition monitoring.

When you create measurement points, each meter can only be used once on an 
asset or location. You may need to create duplicate meters with different 
names if you have multiples of the same meter on an asset or location. For 
example, if a piece of equipment has three temperature gauges, you would 
need to create three meters that measured temperature, TEMP1, TEMP2, 
andTEMP3, to be able to create three temperature measurement points for 
the asset.

Meters and Inventory

You can associate a single meter with an inventory item. Individual meters 
can not be associated with rotating items unless it is via a meter group.

When you issue an item that has a meter associated with it to an asset that 
has a corresponding meter, Maximo automatically enters a meter reading for 
the asset. For example, if you create an item record for fuel, and attach a fuel 
gauge to the item, when you issue fuel to assets that also include a fuel gauge, 
Maximo will automatically enter meter readings for the fuel gauge on the 
asset.
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Meters and Meter Groups

Meter records can be associated with assets, rotating items, and locations, and 
can be used to drive condition monitoring and preventive maintenance. Often 
more than one meter might be applied to a particular type of record. For 
example, a truck might include meters for temperature, pressure, odometer 
readings, and fuel consumption. Rather than apply each meter individually, 
you can group them together in a meter group. When a meter group is applied 
to a record, Maximo copies all of the data about individual meters in the group 
to the record.

Meter groups are created in the Meter Groups application, and meter records 
are assigned to groups in the Meter Groups application.

Meters and PMs

Meters can be used as a criteria for how often Maximo should generate 
preventive maintenance work orders from a PM record. When you associate 
one or more meters with a PM Maximo generates work orders based on the 
meter readings and the frequency settings on the Meter Based Frequency 
subtab of the PM record.

Meters are associated with PMs in the Preventive Maintenance application. 
For more information about creating PMs with meter based frequency, refer 
to the PM Help.

Meter Types

Meters can have one of three types:

! Continuous � Meters where the readings increase continuously, for 
example odometers. These meters might be used to track miles, hours, 
engine starts, pieces produced, fuel consumed, and other continuous 
readings.

! Gauge � Meters where the readings may fluctuate, for example 
thermometers or pressure gauges. These meters might be used to track 
temperature, pressure, noise levels, oil levels, and other readings that 
fluctuate.

! Characteristic � Meters where an observed state is being tracked, for 
example a color change. These meters might be used to track Brick/
Refractory Color (Yellow, orange, white), or oil color (Clear, Turbid, Dark).

Using the Meters Application

To access the Meters application, click the application link on your Start 
Center, or select Assets > Meters from the Go To menu.

The Meters application contains the following tabs:

! List � to search Maximo for meter records.
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! Meter � to add, view, modify, or delete meter definitions.

! Where Used � to view a read-only list of any asset, locations, PMs, items, 
or Condition Monitoring points that use the meter.

Meters Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Meters application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Meters Help.     

Creating a Meter Record

You can use the Duplicate Meter action to create a copy of an existing meter, 
for example if you need to create multiple measurement points with similar 
meters. Once you duplicate a meter you can then modify it as needed.

Managing Meters

The only fields that may be modified after a Meter Definition has been saved 
are the Description and Unit of Measure.

Deleting a Meter Definition

You can delete a meter record using the Delete Meter action available from 
the Select Action menu. A meter may not be deleted if it is associated with 
records in any of the following applications:

! Assets
! Condition Monitoring
! Item Master
! Locations
! Master PM
! Meter Group
! Preventive Maintenance

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a meter record? Click the New Meter button in the toolbar.

delete a record? Select Delete Meter from the Select Action 
menu.

duplicate a record? Select Duplicate Meter from the Select Action 
menu.

run reports? Select Run Reports from the Select Action 
menu.

view the meter groups that the meter belongs 
to?

Select View Meter in Groups from the Select 
Action menu.
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For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Meters Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Meter Groups

A meter group is two or more meters that are commonly used on the same 
types of assets or locations. You use the Meter Groups application to create 
groups for meters that are commonly used together. For example all of the 
vehicles in your fleet use meters to track mileage, usage, fuel, and oil 
consumption. Rather than attach these four meters to a vehicle one at a time, 
you can define a meter group and use it to associate all four meters to the 
vehicle at the same time.

Meter Groups can also be associated with rotating items in the Item Master 
application to designate the meters commonly associated with a rotating item.

Multisite and Meter Groups

Meter Groups are at the System, or database level. This means that:

! Key fields for new records must be unique within the Maximo database.

! Records are available to all users of the database who have security 
permissions to the application. 

Meter Groups and Assets/Locations

Meter groups can be associated with asset or location records in one of the 
following ways:

! the record includes a Rotating Item that has an associated meter group
! you enter a value in the Meter Group field for the record
! an item assembly structure that contains rotating items with an 

associated meter group is applied to the record

When a meter group is associated with an asset or location record Maximo 
copies the meters in the group to the Meters table window on the record.

Meter Groups and Items

You can associated meter groups with rotating items records in the Item 
Master application. When you list that rotating item record on an asset or 
location record, Maximo copies all of the meters associated with the rotating 
item to the asset or location record.
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Meter Groups and Meters

For information about Meter Groups and the Meters application, see �Meters 
and Meter Groups,� on page 3-35.

Using the Meter Groups Application

To access the Meter Groups application, click the application link on your 
Start Center, or select Assets > Meter Groups from the Go To menu.

The Meter Groups application contains the following tabs:

! List � to search Maximo for meter group records.

! Meter Group � to enter, view, or modify meter groups.

Meter Groups Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Meter Groups application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Meter Groups Help.      

Creating Meter Groups

NOTE: Meters must be defined in the Meters application before they can be 
added to a meter group.

You can use the Meter Groups application to create groups of two or more 
meters. You cannot add an individual meter to a group more than once. If 
there is a requirement for more than one of the same type of meter you will 
need to create duplicate meters with different names. For example, if a meter 
group requires three temperature gauges, you would need to create three 
meters that measured temperature, TEMP1, TEMP2, and TEMP3, to be able 
to create a meter group with three temperature gauges.

NOTE: A Meter Group can be created that has no meters in the group.

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a meter group? Click the New Meter Group button in the 
toolbar.

delete a record? Select Delete Meter Group from the Select 
Action menu.

duplicate a record? Select Duplicate Meter Group from the Select 
Action menu.
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You can use the Duplicate Meter Group action to create a copy of an 
existing meter group. Once you duplicate a meter you can then modify it as 
needed.

Managing Meter Groups

Once you have defined a meter group you can add or remove meters from the 
group as needed.

Modifying Meter Groups

When you add meters to an existing meter group you can select the Apply 
New Meter to Existing Assets? check box if you want to add the new meter 
to existing assets or locations that use the meter group. If you do not select the 
box then the new meter will only be added to assets or locations that use this 
meter group in the future. 

To delete a meter from a group, click the Mark Row for Delete button next 
to the row in the table window, then click Save. 

Deleting a Meter Group

If a meter group record is not listed on any asset, location, or rotating item 
records it can be deleted by selecting Delete Meter Group from the Select 
Action menu. Maximo will display an error message if the meter group can not 
be deleted.

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Meter Groups Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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The Contracts Module is one of the Maximo modules devoted to financial and 
purchasing functions. The Financial Module allows administrators to set up 
currency codes, exchange rates, the Chart of Accounts that users access via 
the GL Account Navigator, and to perform cost management. The Purchasing 
Module tracks requests for and purchases of materials and services. And the 
Contracts Module allows you to create a variety of different types of contracts.

The Contracts Module consists of the following applications:    

You use the Terms and Conditions application to define the terms and 
conditions that apply to contracts and purchasing interactions between your 
company and vendors. 

You use the Master Contracts application to create a master contract that 
defines the relationship between your company and a vendor, for example 

4 The Contracts Module

Application Function

Labor Rate 
Contracts

Used to define labor rates to be paid to specific 
crafts and skills when hiring workers.

Lease/Rental 
Contracts

Used to define the terms and conditions and 
payment information for lease or rental agreements 
for rotating assets, including information 
technology assets.

Master Contracts Used to define the contractual relationship with a 
vendor. A master contract links all contracts with 
the vendor, as well as containing the terms and 
conditions that apply to the associated contracts.

Purchase 
Contracts

Used to create, modify, and view contracts for items 
or services with outside vendors. You can include 
detailed information about a contract's shipping 
and financial terms, contact information, item and 
service pricing, and delivery times. 

Terms and 
Conditions

Used to enter and maintain a library of terms and 
conditions to be used on contracts and purchasing 
documents. These terms can contain information 
such as liability concerns, shipping and handling 
details, or delivery time expectations.

Warranty 
Contracts

Used to create warranty and service contracts 
where vendors maintain one or more assets for a 
fixed fee, or regularly scheduled payment over a 
time period; or to track warranty information for 
multiple assets or locations by time or meter.
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whether contracts can be extended, cancelled by the vendor, or cancelled by 
the customer. 

Once you have defined the master contract, you can create associated 
contracts of any type from within the Master Contracts application. Maximo 
copies the properties from the master contract to the associated contract. You 
can then use the Labor Rate Contracts, Lease/Rental Contracts, Purchasing 
Contracts, or Warranties Contracts application to fill in the specific details of 
each associated contract.

NOTE: Your ability to enter, view, or modify contracts is determined by your 
system administrator.

Contract Types

You use the Contracts application to create different types of contracts, and to 
define the rules that govern the contracts. The default Maximo installation 
contains the following types of contracts:

! Blanket (volume) contract � A blanket contract is an agreement that 
specifies a vendor, a total dollar amount, and valid dates for the 
agreement. Typically a blanket is used to purchase services and/or 
materials at an agreed upon price and terms. You can create release 
purchase orders in the Purchase Orders application that reference the 
blanket contract. Blanket contracts are created in the Purchase Contracts 
application.

! Labor contract � A labor contract is a way to define the rates that will 
be paid for craft and skill combinations, and also rates to be paid to specific 
contract laborers. You can set up a labor rate contract to create invoices for 
all approved labor transactions within a specified time period, for example 
every month. Labor contracts are created in the Labor Rate Contracts 
application.

! Lease contract � A lease contract is an agreement to lease one or more 
assets from a vendor. Lease contracts specify lease period, payment 
schedules, and other conditions of the contract. Maximo can generate 
invoices based on the payment schedule intervals. This type of agreement 
may involve more than two parties, as one vendor may sell the assets and 
another may hold the lease. Lease contracts are created in the Lease/
Rental Contracts application.

! Pricing contract � A price agreement contract specifies the prices to be 
paid for specific items purchased from a specific vendor. Typically a price 
agreement is used to purchase services and/or materials at agreed upon 
prices and terms. Pricing contracts are created in the Purchase Contracts 
application.

! Purchase contract � A purchase contract specifies the terms and 
conditions for a purchase. Purchase contracts are created in the Purchase 
Contracts application.

! Rental contract � A rental contract is similar to a lease contract. Rental 
contracts specify the time period for the rental, payment schedules, and 
other conditions of the contract. Unlike a lease, a rental contract can be 
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terminated at will, and does not include a buy-out option in the terms of 
the contract. Rental contracts are created in the Lease/Rental Contracts 
application.

! Service contract � A service contract is similar to a warranty except 
that some of the items are billed on a per-incident basis. This contract will 
contain the details of the services to be provided, and if a payment 
schedule is associated with the contract. Service contracts are created in 
the Warranty Contracts application.

! Software license contract � Master contract � A master contract is 
a way to associate many contract types together for the same vendor and 
define terms and conditions for the relationship with the vendor. A master 
contract lists all contracts that you have with a particular vendor. For 
example, a master contract might list rental contracts for tools or 
equipment, purchase contracts for materials, a labor rate contract, and a 
warranty on parts and labor. Master contracts are created in the Master 
Contracts application.

! Warranty contract � A warranty contract is created in conjunction with 
the purchase of an asset and generally has no cost associated with it. This 
contract will contain the details of what is covered by the warranty. If a 
warranty contract is purchased, this is considered an extended warranty 
by Maximo. Warranty contracts are created in the Warranty Contracts 
application.

NOTE: Your system administrator can define an unlimited number of contract 
types using the Organizations application.

Contract Details

When you enter a contract in Maximo, you can include the following general 
information about the contract:

! Contract identifier and Description
! Contract Type
! Status
! Vendor Reference # and details about the vendor
! Buyer
! Start Date and End Date
! Total Cost or Maximum Amount
! Contract lines 
! Terms and conditions

In addition, you can specify properties that are specific to each contract type.

NOTE: The applications in the Contracts Module are not intended for contract 
negotiation. Contracts should not be entered into Maximo until the 
contract is final.

Contracts and Terms and Conditions

You use the Terms and Conditions application to create and maintain a 
library of terms and conditions that describe the legal obligations between a 
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buyer and a seller. Terms and conditions appear on records in the following 
applications:

! All contracts (Contracts Module)
! Invoices
! Purchase Requisitions 
! Purchase Orders
! Requests for Quotation

NOTE: If the Editable on Use? check box is selected for a term you cannot edit 
the term once it has been copied to a record.

The terms and conditions in the library can be added to a contract from the 
Terms and Conditions tab of the individual applications. You can also create 
terms via the New Row button on the Terms and Conditions tab, but terms 
created in this manner are saved to the record and are not added to library.

For more information about terms and conditions, see �Terms and 
Conditions,� on page 4-20.

Contract Statuses

Contract records have a status to indicate where the record is in a contract life 
cycle. Because contract records have statuses, you can create Workflow 
processes for contracts to manage approvals, expirations, renewals and so 
forth.

NOTE: You might need security authorization to perform status changes. 

A contract record can have one of the following statuses:

! DRAFT � Draft. Default status for new contracts. All fields can be edited 
when a contract is in a status of DRAFT. You can change a contract�s 
status from DRAFT to APPR, CLOSE, or CAN.

! WAPPR � Waiting on Approval. All fields can be edited when a contract 
is in a status of WAPPR. You can change a contract�s status from WAPPR 
to APPR, CLOSE, or CAN.

! APPR � Approved. You must specify a Company and a Start Date for a 
contract before you can change its status to APPR. Maximo does not 
require an End Date for contract approval. A master contract must be 
approved before you can associate other contracts with it. Lease/rental, 
purchase, and warranty contracts require at least one authorized Site be 
associated with the contract prior to contract approval. If you need to 
modify an approved contract, you use the Revise Contract action. You 
can change a contract�s status from APPR to SUSPEND, EXPIRE, 
CANCEL, or CLOSE. 

! WSTART � Waiting to Start. Maximo automatically assigns a contract to 
a status of WSTART when a contract has been approved and the Start 
Date is in the future. You can change a contract�s status from WSTART to 
APPR. 

! PNDREV � Pending Revision. Default status for contract revisions 
created via the Revise Contract action. This status is similar to DRAFT, 
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except that only a portion of the contract fields can be edited. You can 
change a contract�s status from PNDREV to WAPPR or APPR.

! REVISD � Revised. When you change the status of a contract revision 
from PNDREV to APPR, the previous version of the contract changes 
status to REVISD and that version of contract becomes a history record 
and cannot be edited. Receipts and invoices can still be processed against a 
contract with a status of REVISD. You cannot change a contract�s status 
from REVISD to any other status.

! SUSPND � Suspended. The contract cannot be edited. You can change a 
contract�s status from SUSPND to APPR, CAN, or CLOSE.

! EXPIRD � Expired. The End Date of the contract has passed without 
the contract being renewed. The contract cannot be edited, but a revision 
can be created against an expired contract. You cannot change a contract�s 
status from EXPIRD to any other status.

! CAN � Canceled. You cannot cancel a lease/rental or purchase contract if 
it has any outstanding scheduled payments or approved purchase orders 
against it. Maximo notifies you if unapproved purchase orders exist 
against a contract. Unapproved purchase orders cannot have their status 
changed to approved once the contract is cancelled. Cancelling a lease/
rental or warranty contract cancels any outstanding scheduled payments 
for the contract. You can only cancel a master contract if all of its 
associated contracts are closed or cancelled. When you change a contracts 
status to CAN the contract becomes a history record and cannot be edited.

! CLOSE � Closed. You cannot close a lease/rental or purchase contract if 
it has any outstanding scheduled payments or approved purchase orders 
against it. Maximo notifies you if unapproved purchase orders exist 
against a contract. Unapproved purchase orders cannot have their status 
changed to approved once the contract is closed. Closing a lease/rental or 
warranty contract cancels any outstanding scheduled payments for the 
contract. You can only close a master contract if all of its associated 
contracts are closed or cancelled. When you change a contracts status to 
CLOSE the contract becomes a history record and cannot be edited.

When you change the status of a contract, Maximo records the date and time 
of the status change and lets you record a memo. This information can be 
viewed using the View History action.

Revising Contracts

Once you have changed the status of a contract to APPR (approved) the only 
field that can be edited on the contract is the Status field. You cannot "un-
approve" a contract you need to make changes to the contract, you must use 
the Revise Contract action. The Revise Contract action is available for 
contracts with a status of APPR that do not already have an existing revision 
(that is, a revision with a status of PNDREV).

The Revise Contract action creates a copy of the current contract. Maximo 
copies all of the information from the original contract, including contract 
lines, terms and conditions, associated service level agreements, commodities, 
and authorized Sites. The Contract number is the same as the original 
contract, and the value in the Revision field is the Revision number of the 
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original contract plus one. For example, the original contract has a Revision 
number of zero, so the first revision has a Revision number of 1 (0+1=1). The 
Status of the revision is PNDREV.

The status of the original contract does not change when you create a revision. 
The original contract is available for use and can have new transactions 
created against it. When you change the status of the revision from PNDREV 
to APPR, Maximo changes the status of the original contract from APPR to 
REVISD and that version of the contract becomes a history record. 

NOTE: If you approve a contract revision whose Start Date is in the future, 
Maximo will change the revision status to WSTRART and the original 
contract will not change status from APPR to REVISD. Maximo 
includes escalations that check for contracts in a status of WSTART 
whose start date is the current date and automatically changes the 
status of the contract to APPR. 

You can use the View Revision History action to view every revision that 
has been made to the current contract via the revision process. The Contract 
Details table window displays every version of the contract. Maximo displays 
the most current revisions first. The Contract Line Details table window 
displays contract lines that have been changed or added in the version of the 
contract that is highlighted in the Contract Details table window and the 
previous version of the contract. Each changed line is followed by the previous 
version of that line, so that you can see the changes.

TIP: When searching the database for a contract record, the contract with the 
highest Revision number is the most recent version of the contract.

Labor Rate Contracts

A Labor Rate Contract is a contract for outside labor that specifies the rates 
to be paid for crafts and skill levels, and any laborers associated with the 
contract. You use the Labor Rate Contracts application to define multiple 
labor rates for specific crafts and skills, and optionally for laborers. 

You can only create contracts where Type = LABOR in the Labor Rate 
Contracts application. For more information about contract types, see 
�Contract Types,� on page 4-2.

Multisite and Labor Rate Contracts

Labor and craft records are at the Organization level, so labor rate contracts 
are at the Organization level as well. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.
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Labor Rate Contracts and Company Records

Before you can create a contract for a company you must create a record for 
the company in the Company Master application.

You can view all contracts associated with a vendor using the View 
Contracts action in the Companies application.

Labor Rate Contracts and Crafts

You use the Rate Schedule tab in the Labor Rate Contracts application to 
establish the contracted Standard Rates for any Craft or Craft / Skill Level 
that has been defined in the Craft application. Standard Rates for contracts 
may also be established within the Craft application in the Outside Rates 
table window. The business rules for establishing rates is the same in both the 
Labor Rate Contracts and Crafts applications.

Labor Rate Contracts and Invoices

You can create invoices from labor transactions reporting using the Labor 
Reporting application when the labor transaction references a labor rate 
contract.

Labor Rate Contracts and Labor

You can use the Labor application to create labor records for contract labor. 
When you associate labor records with a labor rate contract you can either 
select the Inherit Rate from Contract? check box, or specify a specific rate 
for the laborer.

Labor Rate Contracts and Labor Reporting

You can enter labor transactions by contract or vendor in the Labor Reporting 
application.

Labor Rate Contracts and Work Orders

You can create work order plans and report actuals that reference contract 
labor. When Maximo calculates work order costs for contract labor, it uses the 
rates listed on the labor rate contract.

Maximo also uses the Start Date and End Date on the contract when it 
validates labor rates on work orders. Labor rates associated with a contract 
whose status is WSTART (waiting to start) can be used for planning purposes. 
Labor actuals can be reported against a contract whose status is EXPIRD 
(expired) only if the reported labor hours are for work time that occurred prior 
to the contract expiration.
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Using the Labor Rate Contracts Application

To access the Labor Rate Contracts application, click the application link on 
your Start Center, or select Contracts > Labor Rate Contracts from the Go 
To menu.

The Labor Rate Contracts application contains the following tabs:

! List � to search Maximo for labor rate contract records.

! Contract � to create, view, or modify labor rate contract records.

! Properties � to enable or disable properties for the contract.

! Rate Schedule � to add, view, or modify standard rates of pay for crafts 
and skill levels.

! Associated Labor � to add, view, or modify the labor records associated 
with the contract.

! Terms and Conditions � to add, view, or delete terms and conditions 
that have been associated with the contract.

Labor Rate Contracts Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Labor Rate Contracts application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Labor Rate Contract Help.      

How Do I...

associate service level agreements (SLAs) with 
a contract?

Select Associate SLAs from the Select Action 
menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a labor rate contract record? Click the New Labor Rate Contract button in 
the toolbar.

duplicate a record? Select Duplicate Labor Rate Contract from 
the Select Action menu.

modify an approved contract? Select Revise Contract from the Select Action 
menu.

modify the rate for one or more lines on a 
contract?

Select Apply Price Adjustment from the 
Select Action menu.
NOTE: A contract must have a status of DRAFT, 

WAPPR, or PNDREV to use this action.
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Creating Labor Rate Contracts

You create labor rate contract records in Maximo once the negotiations for the 
contract are complete and you are ready to record the details of the final 
contract.

You can use the Duplicate Contract action to create a copy of an existing 
labor rate contract, for example if you have negotiated similar contracts with 
more than one vendor. Once you duplicate a contract you can then modify it as 
needed.

Creating a Rate Schedule

You use the Rate Schedule tab to create, view, and modify the standard rates 
that are paid for contract labor. You can use the Select Crafts button to 
select from crafts and skill levels that have been defined in the Crafts 
application. 

Associating Labor with a Contract

You use the Associated Labor tab to list the laborers whose rates are 
determined by the contract. Labor records are created in the Labor 
application. The craft and skill levels for the associated labor must be listed   
on the Rate Schedule tab for you to be able to add a laborer.

NOTE: Revising a contract does not break the association between laborers and 
the contract. The laborers listed in the Associated Labor table window 
are associated with the contract and not a specific revision.

Managing Labor Rate Contracts

Once a contract record is approved, if you need to make modifications to it, 
you will need to use the Revise Contract action. For more information about 
creating revisions, see �Revising Contracts,� on page 4-5.

If the contract has a status of APPR the Rate Schedule table window is read -
only. Lines may not be added, modified, or deleted. A contract rate may not be 
deleted if it is referenced by a labor record.

You can use Apply Price Adjustment action to modify the pay rates 
associated with one or more lines in a labor rate contract that has a status of 
DRAFT, WAPPR, or PNDREV. You use the Revise Contract action to 
change the contract status to PNDREV.

You can use the View History action to view the status change history for a 
contract.

run reports? Select Run Reports from the Select Action 
menu.

view the status change history for a contract? Select View History from the Select Action 
menu.

How Do I...
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NOTE: Contract records cannot be deleted.

Labor Rate Contracts Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Lease/Rental Contracts

A Lease/Rental contract defines the agreement between a vendor and a 
customer regarding the lease or rental of assets or locations. You use the 
Lease/Rental Contracts application to define the terms and conditions of the 
agreement and the assets or locations to be leased or rented.

You can create the following types of contracts using the Lease/Rental 
Contracts application:

! LEASE
! RENTAL

For more information about contract types, see �Contract Types,� on page 4-2.

Multisite and Lease/Rental Contracts

Lease/Rental contracts are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

A contract cannot be utilized until you use the Authorize Sites action to 
indicate that the contract may be used by one or more Sites. You can add Sites 
from other Organizations to the contract so long as they use the same 
Company Set and Item Set. If your company uses a single Company Set and 
Item Set contracts can be used by all of your Organizations.

Lease/Rental Contracts and Companies

Before you can create a contract for a company you must create a record for 
the company in the Company Master application. You can view all contracts 
associated with a vendor using the View Contracts action in the Companies 
application.

Lease/Rental Contracts and Invoices

When you set up a payment schedule for a contract, Maximo automatically 
generates an invoice with a status of SCHED (scheduled) for each Payment 
Period listed on the contract. Maximo includes an escalation to change the 
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status of the invoice to WAPPR (waiting on approval) when the invoice 
reaches its Due Date.

Using the Lease/Rental Contracts Application

To access the Lease/Rental Contracts application, click the application link on 
your Start Center, or select Contracts > Lease/Rental Contracts from the 
Go To menu.

The Lease/Rental Contracts application contains the following tabs:

! List � to search Maximo for lease/rental contract records.

! Contract� to create, view, or modify lease/rental records.

! Properties � to enable or disable properties for the contract.

! Contract Lines � to create, view, modify, or delete line items listed on a 
contract. 

! Associated Assets � to add, modify, or delete asset records associated 
with a lease or rental contract.

! Terms and Conditions � to add, view, or delete terms and conditions 
that have been associated with the contract.

Lease/Rental Contracts Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Lease/Rental Contracts application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Lease/Rental Contract Help.     

How Do I...

associate commodity codes with a contract? Select Associate Commodities from the 
Select Action menu.

associate service level agreements (SLAs) with 
a contract?

Select Associate SLAs from the Select Action 
menu.

authorize a Site to use a contract? Select Authorize Sites from the Select Action 
menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

change the status of one or more lines on a 
contract?

Select Change Line Status from the Select 
Action menu.
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Creating Lease/Rental Contracts

You create lease/rental contract records in Maximo once the negotiations for 
the contract are complete and you are ready to record the details of the final 
contract.

Associating Assets with a Contract

A lease/rental contract must be approved before you can associate assets or 
locations with it. You associate assets and locations with a lease or rental 
contract on the Associated Assets tab.

Setting up Payment Schedules

Maximo requires values in the following fields when creating a schedule for a 
contract:

! Term in Months � Length of the lease or rental in months. For example 
a two year lease would be entered as 24 months. Lease contracts must 
have a term specified before they can be approved.

! Number of Payments � Number of payments to be made during the 
term of the loan. For example, if the term of the loan is 24 months, and the 
payment schedule is quarterly, the number of payments would be 8. 
Maximo uses this value to determine the estimated Lease Rate Factor 
for the contract.

! Payment Period � Specifies when the payment is due, for example on 
the first of every month. You use the Set Schedule dialog box to select a 
schedule for when payments are due.

! Lease Rate Factor � Maximo calculates the lease rate factor as 1 
divided by the number of payments. Maximo multiplies the Lease Rate 
Factor by the cost of the contract when calculating the periodic payment 
amount.

You use the Manage Payments action to schedule payments, generate 
invoices, and view payment information.

create a lease/rental contract record? Click the New Lease/Rental Contract button 
in the toolbar.

create a payment schedule for a contract? Select Manage Payments from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

view the status change history for a contract? Select View History from the Select Action 
menu.

How Do I...
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Lease/Rental Contracts Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Master Contracts

A master contract is a means of creating one document that defines your 
relationship with a vendor for all contract types. 

The information that can be included on a master contract includes vendor 
information, effective dates, cost information, and the terms and conditions 
that will apply to all contracts that are created as associated contracts from 
the master contract. 

You can only create contracts where Type = MASTER in the Master 
Contracts application. For more information about contract types, see 
�Contract Types,� on page 4-2.

Multisite and Master Contracts

Master Contracts are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

A contract cannot be utilized until you use the Authorize Sites action to 
indicate that the contract may be used by one or more Sites. You can add Sites 
from other Organizations to the contract so long as they use the same 
Company Set and Item Set. If your company uses a single Company Set and 
Item Set contracts can be used by all of your Organizations.

Using the Master Contracts Application

To access the Master Contracts application, click the application link on your 
Start Center, or select Contracts > Master Contracts from the Go To menu.

The Master Contracts application contains the following tabs:

! List � to search Maximo for master contract records.

! Contract � to create, view, or modify master contact records.

! Properties � to enable or disable properties for the contract.

! Associated Contracts � to view contracts associated with the master 
contract.
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! Terms and Conditions � to add, view, or delete terms and conditions 
that have been associated with the contract.

Master Contracts Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Master Contracts application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Master Contracts Help.    

Creating Master Contracts

You create master contract records in Maximo once the negotiations for the 
contract are complete and you are ready to record the details of the final 
contract.

You can use the Duplicate Contract action to create a copy of an existing 
master contract, for example if you have negotiated similar contracts with 
more than one vendor or use the same terms and conditions with multiple 
vendors. Once you duplicate a contract you can then modify it as needed.

How Do I...

associate commodity codes with a contract? Select Associate Commodities from the 
Select Action menu.

associate service level agreements (SLAs) with 
a contract?

Select Associate SLAs from the Select Action 
menu.

authorize a Site to use a contract? Select Authorize Sites from the Select Action 
menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a master contract record? Click the New Master Contract button in the 
toolbar.

create a contract that will be automatically 
associated with the master contract?

Select Create Associated Contract from the 
Select Action menu.

duplicate a record? Select Duplicate Master Contract from the 
Select Action menu.

modify a contract? Select Revise Contract from the Select Action 
menu.

run reports? Select Run Reports from the Select Action 
menu.

view the revision history for a contract? Select View Revision History from the Select 
Action menu.

view the status change history for a contract? Select View History from the Select Action 
menu.
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Creating Associated Contracts

Master Contracts can have one or more child contracts and can contain 
multiples of a particular type of contract. Once a master contract is approved, 
you can use the Create Associated Contract action to create child 
contracts. When you create associated contracts from a master contract, 
Maximo copies the following information to the new contract:

! Vendor information � Maximo copies all vendor information from the 
master contract to the child contract.

! Authorized Sites � Maximo copies authorized Sites from the master 
contract to the new contract. You can modify this Site information on the 
child contract.

! Commodities � Any associated commodities are copied from the master 
contract to the new contract. You can modify this commodity information 
on the child contract.

! Effective Dates � Maximo copies the Start Date from the master 
contract to the new contract. The Start Date for the child contract cannot 
be before the Start Date or after the End Date of the master contract. 
You can edit the End Date on the child contract, but it cannot be after the 
End Date on the master contract.

! Extensions � Maximo copies the values in the Extendable? check box, 
Condition for Extension and Extension Period fields to the new 
contract. You can modify the values in these fields on the child contract. 

! SLAs � Any associated service level agreements are copied from the 
master contract to the new contract.

! Terms and conditions � Maximo does not copy terms and conditions 
from the master contract to the new contract.

NOTE: When a purchase order references a contract, Maximo copies the 
terms and conditions from both the contract and its master contract 
to the purchase order.

You can view associated child contracts on the Associated Contracts tab of the 
Master Contracts application. You can view and modify each associated 
contract in the appropriate contract application.

Managing Master Contracts

Once a contract record is approved, if you need to make modifications to it, 
you will need to use the Revise Contract action. This creates a duplicate 
copy of the original contract with a different Revision number and a status of 
PNDREV, maintaining the original contract for auditing purposes. Once the 
status of the new revision is changed to approved, Maximo changes the status 
of the previous version of the contract to REVISD.

You can use the View History action to view the status change history for a 
contract.

NOTE: Contract records cannot be deleted.
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Master Contracts Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Purchase Contracts

A purchase contract is a contract that details the terms for the purchase of 
assets, items, materials, services, or tools. You use the Purchase Contracts 
application to create, modify, and view contracts with outside vendors. 

You can create the following types of contracts using the Purchase Contracts 
application:

! PRICE
! BLANKET
! SWLICENSE
! PURCHASE

For more information about contract types, see �Contract Types,� on page 4-2.

Multisite and Purchase Contracts

Purchase Contracts are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

A contract cannot be utilized until you use the Authorize Sites action to 
indicate that the contract may be used by one or more Sites. You can add Sites 
from other Organizations to the contract so long as they use the same 
Company Set and Item Set. If your company uses a single Company Set and 
Item Set contracts can be used by all of your Organizations.

Purchase Contracts and Companies

Before you can create a contract for a company you must create a record for 
the company in the Company Master application. You can view all contracts 
associated with a vendor using the View Contracts action in the Companies 
application.

Purchase Contracts and Invoices

When you set up a payment schedule for a contract and purchases are made 
against the contract, Maximo automatically generates an invoice with a status 
of SCHED (scheduled) for each Payment Period listed on the contract. 
Maximo includes an escalation to change the status of the invoice to WAPPR 
(waiting on approval) when the invoice reaches its Due Date.
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Purchase Contracts and Purchasing

You can use the View Contracts button on the PR Lines tab of the Purchase 
Requisitions application and the PO Lines tab of the Purchase Orders 
application to view a list of contracts for the line item. If you have not 
specified a vendor on the record, the View Contracts dialog box lists all 
vendors with whom you have a contract for the line item. If there is a vendor 
specified on the record, the View Contracts dialog box lists only contracts that 
contain that item/vendor combination.

When you are creating a purchase requisition or purchase order that lists a 
purchase contact in the Reference Contract field you can use the Contract 
Items button on the PR Lines or PO Lines tab. The Contract Items dialog box 
allows you to view and select from the line items listed on the contract.

You can create contracts based on information contained on records in the 
Purchasing module. 

! You can create Blanket (Volume), Pricing, and Purchase type contracts via 
the Create Contract action in the Purchase Requisitions and Purchase 
Orders application.

! You can create Blanket (Volume), Pricing, and Purchase type contracts via 
the Create Contract button in the Request for Quotations application.

Using the Purchase Contracts Application

To access the Purchase Contracts application, click the application link on 
your Start Center, or select Contracts > Purchase Contracts from the Go 
To menu.

The Purchase Contracts application contains the following tabs:

! List � to search Maximo for purchase contract records.

! Contract � to create, view, or modify purchase contract records.

! Properties � to enable or disable properties for the contract.

! Contract Lines � to create, view, modify, or delete line items listed on a 
contract. 

! Terms and Conditions � to add, view, or delete terms and conditions 
that have been associated with the contract.

Purchase Contracts Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Purchase Contracts application. For more detailed information, 
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including prerequisites to performing an action and detailed procedures, refer 
to the Purchase Contracts Help.      

How Do I...

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Units of Measure from the 
Select Action menu.

associate commodity codes with a contract? Select Associate Commodities from the 
Select Action menu.

associate service level agreements (SLAs) with 
a contract?

Select Associate SLAs from the Select Action 
menu.

authorize a Site to use a contract? Select Authorize Sites from the Select Action 
menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

change the status of one or more lines on a 
contract?

Select Change Line Status from the Select 
Action menu.

copy line items from a purchase order (PO) to a 
contract?

Select Copy PO Lines to Contract from the 
Select Action menu.

copy line items from a purchase requisition (PR) 
to a contract?

Select Copy PR Lines to Contract from the 
Select Action menu.

create a purchase contract record? Click the New Purchase Contract button in 
the toolbar.

create a release purchase order from a contract? Select Create Release PO from the Select 
Action menu.
NOTE: The Create Release check box on the 

contract must be selected to be able to 
perform this action.

create a request for quotation (RFQ) from a 
contract?

Select Create RFQ from the Select Action 
menu.

duplicate a record? Select Duplicate Purchase Contract from 
the Select Action menu.

modify a contract? Select Revise Contract from the Select Action 
menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Units of Measure from the 
Select Action menu.
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Creating Purchase Contracts

You create purchase contract records in Maximo once the negotiations for the 
contract are complete and you are ready to record the details of the final 
contract. Purchase contract records can be created in more than one 
application:

! Purchase Contracts application � Click New Purchase Contract on 
the toolbar.

! Purchase Requisitions application � Select Create Contract from 
the Select Action menu.

! Purchase Orders application� Select Create Contract from the 
Select Action menu.

You can also use the Duplicate Contract action to create a copy of an 
existing purchase contract, for example if you have negotiated similar 
contracts with more than one vendor. Once you duplicate a contract you can 
then modify it as needed.

modify the price for one or more lines on a 
contract?

Select Apply Price Adjustment from the 
Select Action menu.
NOTE: A contract must have a status of DRAFT, 

WAPPR, or PNDREV to use this action.

record additional details for a software license 
contract?

Select Software License Details from the 
Select Action menu.

run reports? Select Run Reports from the Select Action 
menu.

view additional details for a software license 
contract?

Select Software License Details from the 
Select Action menu.

view all PR lines that were used to create the 
purchase contract?

Select View PR Line Items from the Select 
Action menu.

view related invoice lines for a contract? Select View Invoice Lines from the Select 
Action menu.

view all RFQ lines that were used to create the 
purchase contract?

Select View RFQ Line Items from the Select 
Action menu.

view the revision history for a contract? Select View Revision History from the Select 
Action menu.

view the total costs for release purchase orders 
(POs) generated from a purchase contract?

Select View Release Costs from the Select 
Action menu.

view the status change history for a contract? Select View History from the Select Action 
menu.

How Do I...
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Adding Lines to a Contract

You use the Contract Lines tab to define the items, materials, services, and/or 
tools that can be purchased under the terms of the contract. You create a 
separate line for each item, material, service, or tool listed on the contract.

You can use the Copy PR Lines to Contract action to use existing PR lines 
as the basis for contract lines or you can use the Copy PO Lines to Contract 
action to use existing PO lines as the basis for contract lines.

Creating Software License Contracts

For information about Software License Contracts, see �Managing Software 
Licenses,� on page C-18.

Managing Purchase Contracts

Once a contract record is approved, if you need to make modifications to it, 
you will need to use the Revise Contract action. This creates a duplicate 
copy of the original contract with a different Revision number and a status of 
PNDREV, maintaining the original contract for auditing purposes. Once the 
status of the new revision is changed to approved, Maximo changes the status 
of the previous version of the contract to REVISD.

You can change the status of individual lines on an approved contract using 
the Change Line Status action available from the Select Action menu.

If you need to modify the prices associated with one or more lines on a 
purchase contract you can use the Apply Price Adjustment action to do so. 
(Note that you must first use the Revise Contract action to change the 
contract status to PNDREV.)

You can use the View Revision History action to view the dates and 
contract lines that were changed in each revision of the contract.

You can use the View History action to view the status change history for a 
contract.

NOTE: Contract records cannot be deleted.

Purchase Contracts Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Terms and Conditions

Terms and conditions are requirements that are defined for contracts and 
purchasing records, often by a legal department. You use the Terms and 
Conditions application to enter and maintain a library of terms and conditions 
that can be added to a purchasing record or contract. These terms can contain 
information such as liability concerns, shipping and handling details, or 
delivery time expectations.
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The terms entered in the Terms and Conditions application are available from 
the Terms and Conditions tabs in purchasing and contract applications. From 
the tabs, you can select a term from the library to associate with that 
purchasing or contract record.

Multisite and Terms and Conditions

Terms and Conditions are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

Terms and Conditions and Contracts

Each of the contracts applications contains a Terms and Conditions tab, 
allowing you to list the terms and conditions that will apply to that contract. 
When you list terms and conditions on a contract, Maximo copies them to 
records generated from the contract.

Terms and Conditions and Purchasing

The Invoices, Purchase Requisitions, Request for Quotations, and Purchase 
Orders applications each contains a Terms and Conditions tab, allowing you 
to list the terms and conditions that will apply to the purchase.

Using the Terms and Conditions Application

To access the Terms and Conditions application, click the application link on 
your Start Center, or select either 

! Contracts> Terms and Conditions 
! Purchasing > Terms and Conditions 

from the Go To menu. 

The Terms and Conditions application contains a single page with two table 
windows.

Terms and Conditions Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Terms and Conditions application. For more detailed information, 
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including prerequisites to performing an action and detailed procedures, refer 
to the Terms and Conditions Help.      

Creating Terms and Conditions

When creating terms you have the option to enter a Type for the term.This 
gives you the ability to filter records in the Terms and Conditions library by 
Type.

The Editable? check box specifies whether the term can be edited once it has 
been applied to a contract or purchasing record. If the check box is selected, 
you can edit the term once it has been applied to a record. If the check box is 
cleared you cannot edit the term when it is copied to records.

The Default on PO? check box specifies whether the new term will appear on 
new purchase orders by default. If the check box is selected, Maximo will copy 
the term to new purchase orders automatically. If the check box is cleared, the 
term will not appear by default on new purchase orders.

Managing Terms and Conditions

You can modify an existing term in the Terms and Conditions application at 
any time. Modifying a term will not update existing contracts or purchasing 
documents that reference the term. 

You can delete a term from the library at any time by using the Mark Row 
for Delete button next to the term.   This does not remove the term from any 
contracts or purchasing documents.

Terms and Conditions Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Warranty Contracts

A warranty contract is a contract that details the maintenance of one or 
more assets or locations by a manufacturer, or an outside service provider. 

You can create the following types of contracts using the Warranty Contracts 
application:

How Do I...

create a term or condition? Click an Organization, then click New Row in 
the Terms and Conditions for <Organization> 
table window.

delete a term or condition? Click the Mark Row for Delete button next to 
the row in the table window, then click Save.



Chapter 4: The Contracts Module

Maximo 6, 08/2006 4-23

! SERVICE
! WARRANTY

For more information about contract types, see �Contract Types,� on page 4-2.

Multisite and Warranty Contracts

Warranty contracts are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

A contract cannot be utilized until you use the Authorize Sites action to 
indicate that the contract may be used by one or more Sites. You can add Sites 
from other Organizations to the contract so long as they use the same 
Company Set and Item Set. If your company uses a single Company Set and 
Item Set contracts can be used by all of your Organizations.

Warranty Contracts and Companies

Before you can create a contract for a company you must create a record for 
the company in the Company Master application. You can view all contracts 
associated with a vendor using the View Contracts action in the Companies 
application.

Warranty Contracts and Invoices

When you set up a payment schedule for a contract, Maximo automatically 
generates an invoice with a status of SCHED (scheduled) for each Payment 
Period listed on the contract. Maximo includes an escalation to change the 
status of the invoice to WAPPR (waiting on approval) when the invoice 
reaches its Due Date.

Warranty Contracts and Work Orders

Your system administrator can configure Maximo to display the warranty 
status of work assets when you create work orders. When you create a new 
work order for a work asset that is covered by a warranty contract Maximo 
displays a message that the asset or location is under warranty. You can use 
the View > Warranties action to view the warranty contracts that reference 
the asset or location.

Using the Warranty Contracts Application

To access the Warranty Contracts application, click the application link on 
your Start Center, or select Contracts > Warranty Contracts from the Go 
To menu.
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The Warranty Contracts application contains the following tabs:

! List � to search Maximo for service contract records.

! Contract � to create, view, or modify warranty contract records.

! Properties � to enable or disable properties for the contract.

! Contract Lines � to create, view, modify, or delete line items listed on a 
contract. 

! Associated Assets � to add, modify, or delete asset or location records 
associated with a warranty or service contract.

! Terms and Conditions � to add, view, or delete terms and conditions 
that have been associated with the contract.

Warranty Contracts Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Service Contracts application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Warranty Contracts Help.    

Creating Warranty Contracts

You create service contract records in Maximo once the negotiations for the 
contract are complete and you are ready to record the details of the final 

How Do I...

authorize a Site to use a contract? Select Authorize Sites from the Select Action 
menu.

associate service level agreements (SLAs) with 
a contract?

Select Associate SLAs from the Select Action 
menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a warranty contract record? Click the New Warranty Contract button in 
the toolbar.

duplicate a record? Select Duplicate Warranty Contract from 
the Select Action menu.

manage payments for a contract? Select Manage Payments from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

view the status change history for a contract? Select View History from the Select Action 
menu.
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contract. You create warranty contracts when you purchase assets that 
include a warranty from the manufacturer.

Defining Contract Lines / Meter Lines

Contract lines can only be added to service or warranty contracts that have a 
status of DRAFT, PNDREV, or WAPPR.

CAUTION: Once the contract has been approved contract lines and meter lines 
are read-only and new contract lines can be added to the contract.

You use the Contract Lines tab to define all of the services and standard 
services that are provided under the terms of the service or warranty contract. 
You can define the duration of the coverage, if child assets are covered, and 
the coverage percent or amount for labor, materials, and tools.   If there is a 
meter associated with the coverage, for example a warranty for 5 years or 
50,000 miles, you can list the meter in the Meter Lines for Contract Line table 
window.

Associating Assets with a Contract

Once you have defined Contract Lines and Meter Lines for the contract and it 
has been approved, you can associate assets or locations with the contract. 
When you associated an asset or location with a contract, Maximo 
automatically associates all of the contract lines with that asset or location 
record.

Maximo only copies meter lines to the associated asset or location if the meter 
has the same Unit of Measure as an existing meter for the asset or location. 
For example, if you have a metered asset where the Unit of Measure for the 
meter is "miles", Maximo will copy all of the contract lines that have a meter 
where Unit of Measure = "miles" to the Contract Lines for Asset/Location 
table window.

Duplicating Warranty Contracts

You can use the Duplicate Contract action to create a copy of an existing 
warranty contract, for example if you have similar contracts for more than one 
asset. When you duplicate a service or warranty contract, Maximo copies all 
contract lines, authorized Sites, associated service level agreements, and 
terms and conditions to the new contract. Maximo does not copy associated 
assets or meters to the new contract. Once you duplicate a contract you must 
specify the Start Date for each asset or location, and the Start Reading for 
any meters associated with the assets or locations.

Managing Warranty Contracts

You cannot edit or revise a service or warranty contract once it has been 
approved.

You can use the View History action to view the status change history for a 
contract.

NOTE: Contract records cannot be deleted.
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Warranty Contracts Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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The applications in the Deployed Assets module let you search the Maximo 
database and view information collected by an asset discovery tool about 
hardware and software installed on computers, network printers, and 
network devices deployed at your company.

The Deployed Assets Module consists of the following applications:  

Maximo maintains two distinct sets of data about information technology (IT) 
assets in two different Maximo modules, the Assets module and the Deployed 
Assets module.

! Assets Module � Asset records for purchased or leased IT assets are 
created in the Assets application or via the Receive Rotating Items 
action in the Receiving application.   Asset records for IT assets are 
rotating assets, that is they contain a value in their Rotating Item field, 
and should be created with a value in the Classification field on the 
Specifications tab to allow the reconciliation function to distinguish them 
from other types of asset records. IT asset records in the Assets application 
are considered authorized assets.

! Deployed Assets Module � Computer, network device, and network 
printer records are created automatically from data collected about your 
IT assets. To gather this data, asset discovery tools (Maximo® Discovery, 
or another tool, such as Microsoft® SMS or IBM® Tivoli Inventory) scan 
computers, network devices, and network printers deployed at your 
company and record information about the hardware and software 
installed on those assets. Maximo Fusion assembles the collected data and 
imports it into Maximo. The records that you view in the Deployed Asset 
applications list discovered or deployed IT assets. 

NOTE: There are several different discovery tools that can be used with 
Maximo.

Administrators use the applications in the Deployed Asset Administration 
module to control how Maximo displays data about deployed IT assets.

5 The Deployed Assets 
Module

Application Function

Computers Used to view data about specific computers 
deployed at your company.

Network Devices Used to view information about deployed network 
devices such as routers, switches, and hubs. 

Network Printers Used to view information about deployed network 
printers. 
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After Maximo Fusion imports deployed asset data into Maximo, an 
administrator uses the Reconciliation module applications to set up rules for 
comparing authorized with deployed assets, to define a reconciliation task 
that can be run as a cron task, and to view the results of the reconciliation.

Deployed Asset Administration

Because of variable hardware and software naming conventions, data 
collected by asset discovery tools is often inconsistent. For example, 
sometimes a computer may be described as a Computer Type 4 and sometimes 
as a Computer Type IV. In addition, sometimes asset discovery tools include 
version and release numbers in product names, such as Maximo 4.1 or 
Maximo 5.2. Your organization may only want to track instances of a product 
without specifying a version number. 

The Deployed Assets Administration module applications let you control how 
Maximo displays the data collected by your asset discovery tool in the 
Deployed Assets module applications. Deployed Assets Administration 
includes five conversion applications that let you translate inconsistent names 
used by asset discovery tools to standard naming conventions, a Software 
Suite Setup application that lets you assemble software applications into 
software application suites, and a Software Usage Setup application to control 
how Maximo displays data about software usage frequency.

The Deployed Assets Administration module consists of the following 
applications:   

Application Function

Adapter 
Conversion

Use to establish standard adapter naming conventions for adapters used in 
computers, both media adapters (such as video and sound cards) and network 
adapters. 
The Adapter Conversion application determines how Maximo displays deployed 
asset adapter data in reports and in the Computers and Network Devices 
applications. 

Manufacturer 
Conversion 

Use to establish standard manufacturer naming conventions for hardware and 
software manufacturers. 
The Manufacturer Conversion application determines how Maximo displays 
deployed asset manufacturer data in reports and in the Computers, Network 
Devices, and Network Printers applications.

Operating System 
Conversion

Use to establish standard naming conventions for operating systems used in 
computers. 
The Operating System Conversion application determines how Maximo displays 
deployed asset operating system data in reports and in the Computers 
application. 

Processor 
Conversion

Use to establish standard processor naming conventions for central processors 
(CPUs) used in computers. 
The Processor Conversion application determines how Maximo displays deployed 
asset processor data in reports and in the Computers application. 
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NOTE: Access to the Deployed Asset Administration module is generally 
restricted to system administrators. Refer to the Maximo System 
Administrator�s Guide or the Maximo Help for more information about 
this module.

Reconciliation Administration

The Reconciliation module includes five applications that allow you to 
configure a behind-the-scenes process, executed via a cron task, that compares 
the IT asset information maintained in the Assets application with the data 
maintained in the Deployed Assets module applications, and then view the 
results of the comparison.

NOTE: Maximo only applies the reconciliation process to assets that have a 
Classification that indicates they are IT assets.

The reconciliation process compares the authorized assets records in the 
Maximo database with the deployed assets records and identifies 
discrepancies and variances between the two. Your enterprise can use this 
reconciliation to determine whether the IT assets actually deployed comply 
with corporate plans and whether the changes over an asset's life cycle are in 
compliance with corporate policies. 

Discrepancies you discover can result from a variety of factors, including:

! incorrect data entry
! reconfigured equipment
! retired equipment
! theft
! unauthorized use of hardware and software 

Software 
Conversion

Use to establish standard naming conventions for software applications used in 
computers. 
The Software Conversion application determines how Maximo displays deployed 
asset software names in the Computers application. 

Software Suite 
Setup

Use to define which software applications should be considered part of a suite. A 
software suite is a group of software applications licensed as a single unit.
Maximo displays data about software suites on the Suites subtab of the Software 
tab in the Computers application. 

Software Usage 
Setup

Use to specify a range for usage frequency and to assign that range a user-
friendly, textual description that is displayed in the Computers application. For 
example, administrators can use the word "frequently" to describe software that 
is used between 10 and 20 times or "rarely" to describe software that is used 
between 0 and 4 times.
Maximo provides usage frequency data for both individual software applications 
and application suites. The frequency for a software suite is determined based on 
the component application with the highest usage count. 

Application Function
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The Reconciliation module consists of the following applications:   

NOTE: Access to the Reconciliation module is generally restricted to system 
administrators. Refer to the Maximo System Administrator�s Guide or 
the Maximo Help for more information about this module.

Computers

A computer record is a record of information about a specific computer 
deployed at your company. A computer record contains information collected 
by an asset discovery tool and imported into Maximo using Maximo Fusion.

Information contained on a computer record includes data about the following:

! random access memory (RAM)

Application Function

Reconciliation 
Tasks 

Use to define the task to be performed as part of a reconciliation. You use 
this application to combine one or more link rules and, if necessary, a task 
filter, and one or more comparison rules into a reconciliation task. The task 
filter and comparison rules are optional. This application also lets you 
specify how Maximo displays results for comparison rule evaluations: all 
results, failed reconciliations, or successful reconciliations. You use the 
Cron Task Setup application to create a cron task to schedule the execution 
of a reconciliation task. 

Task Filters Use to define the subset of either assets or deployed assets that should be 
included in a reconciliation, for example only reconcile network printers. 
Setting up a task filter is optional. If you do not define a task filter, Maximo 
compares all IT assets in authorized assets with deployed assets.

Link Rules Use to define the link rule that establishes a basis for comparison between 
a top-level authorized IT asset and a computer, network printer, or network 
device in deployed assets. A link rule is generally based on serial number or 
asset tag.

Comparison Rules Use to identify attribute(s) of parent or child IT assets to compare with 
attributes of parent or child deployed assets when a reconciliation task is 
executed.

Link Results Use to view all successful one-to-one links between a top-level authorized 
IT asset and a computer, network printer, or network device in deployed 
assets.

Reconciliation 
Results

Use to view results of a reconciliation. This application lists link failures 
and the results of comparison rule evaluations. A link failure occurs when 
Maximo applies a link rule and finds no link or finds multiple links between 
a top-level IT asset and a deployed asset. Based on specifications defined in 
the Reconciliation Tasks application, this application also displays one of 
the following sets comparison rule results: 
! all reconciliation results (both failed and successful)
! instances where authorized IT assets successfully reconciled against 

deployed assets
! instances where authorized IT assets failed to reconcile against 

deployed assets
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! basic input/output system (BIOS)
! motherboard 
! software applications
! storage devices (such as hard disks and floppy drives)
! central processing unit (CPU)
! media adapters (such as sound and video cards)
! communication devices (such as modems and network adapters)
! network settings for TCP/IP and IPX protocols
! image devices (such as printers and scanners)
! displays
! individual users

A computer record also displays information about the hardware and software 
discovery tools used to collect data and the last date on which the hardware 
and software data was gathered. In addition, the record displays the Site at 
which the computer is located and the Role or function assigned to the 
computer, such as desktop, notebook, server, and so forth.

NOTE: Empty fields on a computer record indicate that the data for the field 
was not provided by the asset discovery tool or that administrators did 
not map the data for import into Maximo.

Multisite and Computer Records

Computer records are at the System, or database level. The Deployed Asset 
applications contain a Site field, but not an Organization field. In most 
cases the Site field will be empty.

NOTE: Most asset discovery tools do not provide data about Sites and 
Organizations. In order to be able to differentiate computers, network 
devices, and network printers by Sites and/or Organizations, your 
system administrator must specifically set these values when creating a 
mapping in the Maximo Fusion application. 

Computer Records and Maximo Fusion

Computer records are created when data gathered by an asset discovery tool 
is imported into Maximo using Maximo Fusion.

Computer Records and Deployed Asset Administration

The applications in the Deployed Assets Administration module determine 
how Maximo displays values in certain computer record fields. Because 
discovery tools do not use consistent naming conventions when they collect 
data about deployed assets, the Deployed Assets Administration module 
includes conversion applications that let an administrator configure how 
Maximo displays adapter, manufacturer, operating system, processor, and 
software names.

For example, the discovery tool might encounter variations such as MRO 
Software, MRO Software, Inc. and MRO Software Incorporated in the 
manufacturer name. Your company may want to use only the name MRO 
Software. The Manufacturer Conversion application can be used to control 
how this data is recorded on a computer record.
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In addition to the conversion applications, the Deployed Assets 
Administration module also lets administrators define which applications are 
combined into the software suites displayed on the Suites subtab on the 
Software tab and how Maximo displays data about software usage frequency 
on the Applications subtab on the Software tab.   

Computers Records and Reconciliation

The applications in the Reconciliation module determine how authorized asset 
and deployed asset records are matched during the reconciliation process. For 
more information, see �Reconciliation Administration,� on page 5-3.

Using the Computers Application

To access the Computers application, click the application link on your Start 
Center, or select Assets > Deployed Assets > Computers from the Go To 
menu.

The Computers application contains the following tabs:

! List � to search Maximo for computer records.

! Computer � to view computer records.

! Processors � to view information about central processing units (CPUs) 
associated with the computer.

! Storage � to view information about physical storage components such 
as hard disks, floppy drives, tape devices, and Universal Serial Bus (USB) 
removable storage, as well as data about logical drives, for example local 

This administrative application Determines the value in this field

Manufacturer Conversion Manufacturer field on the 
Computer tab

Adapter Conversion Media Adapter Type field on the 
Media Adapters tab

Operating System Conversion Operating System field on the 
Operating Systems subtab of the 
Software tab

Processor Conversion Make/Model field on the Processors 
tab

Software Conversion Application field on the 
Applications subtab of the Software 
tab

Software Suites Setup Suite field on the Suites subtab of 
the Software tab

Software Usage Setup Usage field on the Application 
subtab of the Software tab
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partitions or mapped network drives, that are associated with the 
computer.

! Software � to view information about installed software applications, 
operating systems, software suites, and files.

! Network � to view information about network adapter settings 
(Transmission Control Protocol/Internet Protocol (TCP/IP) and 
Internetwork Packet Exchange (IPX) settings) for the computer.

! Communication � to view information about network adapters and 
communication devices, for example modems, installed on the computer.

! Media Adapters � to view information about media adapters, such as 
sound and video cards, associated with the computer.

! Displays � to view information about monitors associated with the 
computer.

! Image Devices � to view information about image devices, such as 
printers or scanners, associated with the computer.

! Users � to view information about the users associated with the 
computer.

Computers Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Computers application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Computers Help.      

Creating Computer Records

Computer records are not created using the Computers application; they are 
created when data collected by an asset discovery tool is imported into 
Maximo using Maximo Fusion.

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a computer record? Computer records are created from data 
collected by an asset discovery tool and 
imported into Maximo using Maximo Fusion.

delete a record? Select Delete Computer from the Select 
Action menu.

match a computer record to an asset record? Use the Reconciliation module to define a 
reconciliation task for the match and run the 
reconciliation cron task.

run reports? Select Run Reports from the Select Action 
menu.
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Managing Computer Records

Computer records displayed in the Computers application are read-only; they 
cannot be edited. 

A computer record can be deleted using the Delete Computer action in the 
Select Action menu.

NOTE: If you delete a computer record and the same computer is detected by 
your asset discovery tool at a later date when Maximo Fusion imports 
data into Maximo, the computer record will be re-created in the 
database.

Computers Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Network Devices

A network device record is a record of information about a specific network 
device, for example a router, hub, or switch. Network device records contain 
information collected by an asset discovery tool and imported into Maximo 
using Maximo Fusion.

A network device record contains information collected about the device, 
device cards installed on the network device, the Role or function assigned to 
the device (such as router, switch, or hub), the hardware discovery tool used to 
collect data, and the last date on which data was gathered. 

NOTE: Empty fields on a network device record indicate that the data for the 
field was not provided by the asset discovery tool or that administrators 
did not map the data for import into Maximo.

Multisite and Network Devices

Network Devices are at the System, or database level. The Deployed Asset 
applications contain a Site field, but not an Organization field. In most 
cases the Site field will be empty.

NOTE: Most asset discovery tools do not provide data about Sites and 
Organizations. In order to be able to differentiate computers, network 
devices, and network printers by Sites and/or Organizations, your 
system administrator must specifically set these values when creating a 
mapping in the Maximo Fusion application. 

Network Devices and Deployed Asset Administration

The value displayed in the Manufacturer field on the Device Cards tab and 
on the Network Device tab is determined by parameters defined by an 
administrator in the Manufacturer Conversion application. The value 
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displayed in the Make/Model field on the Device Cards tab is determined by 
parameters defined by an administrator in the Adapter Conversion 
application.

Network Devices and the Reconciliation Application

The applications in the Reconciliation module determine how authorized asset 
and deployed asset records are matched during the reconciliation process. For 
more information, see �Reconciliation Administration,� on page 5-3. 

Using the Network Devices Application

To access the Network Devices application, click the application link on your 
Start Center, or select Assets > Deployed Assets > Network Devices from 
the Go To menu.

The Network Devices application contains the following tabs:

! List � to search Maximo for network device records.

! Network Device � to view information about a network device, such as 
a hub, router, or switch. 

! Device Cards � to view information about cards, such as Ethernet or 
Token Ring cards, that are installed on the network device.

Network Devices Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Network Devices application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Network Devices Help.      

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a Network Device record? Network Device records are created from data 
collected by an asset discover tool and imported 
into Maximo using Maximo Fusion.

delete a Network Device record? Select the Delete Network Device action from 
the Select Action menu.

run Network Device Reports? Select Run Reports from the Select Action 
menu.
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Creating Network Device Records

Network device records are not created in the Network Devices application; 
they are created when data collected by an asset discovery tool is imported 
into Maximo using Maximo Fusion.

Managing Network Device Records

Network device records displayed in the Network Devices application are 
read-only; they cannot be edited. 

A network device record can be deleted using the Delete Network Device 
action in the Select Action menu.

NOTE: If you delete a network device record and the same network device is 
detected by your asset discovery tool at a later date when Maximo 
Fusion imports data into Maximo, the network device record will be re-
created in the database.

Network Devices Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Network Printers

A network printer record is a record of a network printer that has been 
discovered on the company network via an asset discovery tool. Network 
printers service more than one computer. A printer connected to only one 
computer will be listed as part of the record for that computer on the Image 
Devices tab of the Computers application.

A network printer record also contains information about the Role or function 
assigned to the printer, the hardware discovery tool used to collect data, and 
the last date on which hardware data was gathered. 

NOTE: Empty fields on a network printer record indicate that the data for the 
field was not provided by the asset discovery tool or that administrators 
did not map the data for import into Maximo.

Multisite and Network Printers

Network Printers are at the System, or database level. The Deployed Asset 
applications contain a Site field, but not an Organization field. In most 
cases the Site field will be empty.

NOTE: Most asset discovery tools do not provide data about Sites and 
Organizations. In order to be able to differentiate computers, network 
devices, and network printers by Sites and/or Organizations, your 
system administrator must specifically set these values when creating a 
mapping in the Maximo Fusion application. 
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Network Printers and Deployed Asset Administration

The value displayed in the Manufacturer field in a network printer record is 
determined by parameters defined by an administrator in the Manufacturer 
Conversion application in the Deployed Assets Administration module.

Network Printers and the Reconciliation Application

The applications in the Reconciliation module determine how authorized asset 
and deployed asset records are matched during the reconciliation process. For 
more information, see �Reconciliation Administration,� on page 5-3.

Network Printers and the Computers Application

Only network-based printers are included in the Network Printers 
application. Information about printers installed locally on specific computers 
is displayed in the Computers application on the Image Devices tab.

Using the Network Printers Application

To access the Network Printers application, click the application link on your 
Start Center, or select Assets > Deployed Assets > Network Printers from 
the Go To menu.

The Network Printers application contains the following tabs:

! List � to search Maximo for network printer records.

! Network Printer � to view information about a network printer. 

Network Printers Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Network Printers application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Network Printers Help.       

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a Network Printer record? Computer records are created from data 
collected by an asset discover tool and imported 
into Maximo using Maximo Fusion.

delete a Network Printer record? Select the Delete Network Printer action 
from the Select Action menu.

run Network Printer Reports? Select Run Reports from the Select Action 
menu.
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Creating Network Printer Records

Network printer records are not created in the Network Printers application; 
they are created when data collected by an asset discovery tool is imported 
into Maximo using Maximo Fusion.

Managing Network Printer Records

Network printer records displayed in the Network Printers application are 
read-only; they cannot be edited. 

A network printer record can be deleted using the Delete Network Printer 
action in the Select Action menu.

NOTE: If you delete a network printer record and the same network printer is 
detected by your asset discovery tool at a later date when Maximo 
Fusion imports data into Maximo the network printer record will be re-
created in the database.

Network Printers Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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Managing your spare parts inventory is an important part of maintaining any 
asset. The Inventory module in Maximo tracks materials needed for 
maintenance. Maximo keeps track of items in stock, indicates when stock falls 
below user-defined reorder points, creates purchase requisitions and purchase 
orders to restock needed items, and reports items received. 

The Maximo Inventory module works to balance two opposing objectives:

! maximizing the availability of items for upcoming work tasks

! reducing excess inventory balances and related carrying costs

The goal is to find a balance of inventory stock that lets maintenance work be 
performed with minimum delays due to unavailable materials, without 
keeping unnecessary or seldom used items in stock.

The Inventory Module consists of the following applications:   

Inventory is a central module in Maximo. It functions in a dynamic 
relationship with the Preventive Maintenance, Work Orders, Contracts, 
Purchasing, and Assets modules, and with the Companies and Company 

6 The Inventory Module

Application Function

Condition Codes Used to define the codes used to describe the 
condition of items.

Inventory Used to manage items in inventory, including 
tracking stock levels, reordering items, and 
tracking rotating assets.

Issues and 
Transfers

Used to issue stock from inventory (with or without 
a work order), and to transfer stock from one 
storeroom location to another.

Item Master Used to define inventory items, and add them to a 
storeroom�s stock list.

Service Items Used to define services that your company 
requisitions, either as part of the purchasing 
process, or as part of a work order.

Stocked Tools Used to manage tool inventory.

Storerooms Used to define storeroom locations, and view a read-
only list of items stocked at each storeroom location.

Tools Used to define tools and add them to storerooms.
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Master applications in the Resources module. These other modules affect the 
quantity of items in inventory, identify where those items are used, and the 
vendors who supply them to your company.

System administrator privileges are required for the necessary setup in the 
administrative Chart of Accounts, Organizations, and Cron Task Setup 
applications. Refer to the Maximo System Administrator�s Guide and the 
Organizations Help for additional information about these applications.

Maximo�s inventory management applications include applications for 
creating item records and separate applications for managing those items in 
storerooms.

You use the Storerooms application to define financial and billing information 
for storeroom locations, for example the General Ledger (GL) account codes 
and Ship To Address for each storeroom location. Storerooms can be 
physical locations, or employees who are responsible for transporting or 
holding inventory item, for example a mobile worker who stores spare parts in 
their vehicle.

Before you create item records you should define all of the units of 
measurement and the conversion values for those units of measurement. And 
if you are using condition codes for inventory items, you should also define the 
master list of conditions for each Item Set before creating item records. 

You use the Item Master application to create records for items and materials 
that your company uses for maintenance purposes. You also use the Item 
Master application to define the characteristics and specifications of rotating 
items that can be used to create rotating asset records, for example 
information technology (IT) assets. Items are added to the master stock list for 
a storeroom in the Item Master application. 
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Item balances are managed in the Inventory application. Maximo�s reorder 
process can automatically reorder items when item balances reach a specified 
point. When the receipt of ordered items is recorded in the Receiving 
application, Maximo updates inventory balances for the items.

You use the Service Items application to create records for the standard 
services that your company purchases. Service items can be used on job plans, 
work orders, purchase requisitions, and purchase orders.

You use the Tools application to create records for tools that will be issued 
from and managed in a tool storeroom. Tool balances are managed in the 
Stocked Tools application.

You can list items, services, and tools on job plans and work orders. Inventory 
reservations are created for items and tools when a work order status is 
changed to approved (APPR). You use the Issues and Transfers application to 
issue and transfer items, and the Stocked Tools application to issue and 
transfer tools. Items and tools can be issued to an individual if they are listed 
in the Locations application as a labor type location. Costs for items and tools 
can be charged to a work order, asset, location, or GL account code. 

Inventory and Multisite - Item Sets

Inventory items and materials, service items, and tools are created as part of 
an Item Set. An Item Set consists of an ID that identifies a list of items that 
can be shared by one or more Organizations. Only one Item Set can be 
specified for an Organization, but more than one Organization may use the 
same Item Set. Items and tools can be transferred between Organizations that 
share the same Item Set.

When creating item records, all item identifiers must be unique within an 
Item Set. Everywhere that an item ID is referenced on a Maximo record there 
is also an Item Set ID.

Conversion values between Order Units and Issue Units are defined at the 
Item Set level via the Add/Modify Conversions action available from the 
Select Action menu of several of the inventory and purchasing applications.

Units of measurement for Order Units and Issue Units are defined at the 
Organization level via the Add/Modify Units of Measure action available 
from the Select Action menu of several of the inventory and purchasing 
applications. 

NOTE: It is recommended that all possible combinations of units of measure 
and their conversion values be defined before creating item master 
records.

Commodity Groups

A commodity is a thing or product that you purchase. Some companies 
organize their purchasing departments by commodity. Purchasing managers 
may create budgets, create and manage purchase orders, and manage vendor 
relationships based on commodities.
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You can create commodity group and commodity code records in Maximo that 
can be applied to item, company, and contract records. When you associated a 
Commodity Group and Commodity Code with an item record it allows 
users, for example planners or purchasing agents, to search for items by 
commodity code. 

Commodity codes are defined and managed using the Add/Modify 
Commodity Codes action available from the Select Action menu of the 
following applications:

! Companies
! Item Master
! Purchase Orders
! Service Items 
! Tools

Commodity codes are defined at the Item Set level. Commodity group names 
must be unique for the Item Set. A commodity code can only belong to a single 
commodity group. You cannot delete commodity groups or codes if they are 
associated with other Maximo records.

You can also create service type commodities to help you categorize and 
manage services. For more information about service type commodities, see 
�Service Catalog,� on page 13-1.

Kits

A kit is a collection of items that can be issued as a single unit. A kit record is 
created in the Item Master application, and consists of a parent item record, 
and associated child item records that are listed on the Item Assembly 
Structure tab. Using kits allows you to put all the items needed for a job plan 
or maintenance task into one container and manage them as a single unit.

Kits are defined in the Item Master application, and managed in the 
Inventory application. You cannot create kits that contain items that are 
condition-enabled, lotted, or are defined as rotating items.

NOTE: The individual items that make up a kit are considered part of the kit, 
and are not tracked separately in inventory once they have been 
assembled into a kit. This means that balances for an item record do not 
include any instances of that item that have been assembled into a kit.

Condition Codes

A condition code enables you to specify that an item record has a different 
value depending on the physical condition of an item. For example, an item 
that has been damaged, worn, used, or rebuilt would not have the same value 
as a new item. A condition code has a rate associated with it, which can be 
used to calculate the value of non-new inventory items. For example, you 
might create two conditions for an item, "new" where the value of the item is 
100%, and "used" where the value of the item is 50% of the full value.

You use the Condition Codes application to create a master list of condition 
codes for each Item Set defined in your database. For more information about 
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Item Sets refer to the Maximo System Administrator�s Guide. The condition 
codes you create can be applied to the following types of Maximo records:

! item records created in the Item Master application
! rotating asset records created in the Assets application

Multisite and Condition Codes

Condition Codes are defined at the Item Set level. Item Sets exist below the 
System level, but above the Organization level so that Organizations can 
share data. This means that:

! Key fields for new records must be unique within the Item Set.

! Records are available to all users in the Organizations that share the Item 
Set and who have security permissions to the application. 

Each Item Set has a separate list of condition codes. Item Sets can be shared 
by more than one Organization.

Condition Codes and Assets

Condition codes are an inventory function, but they can be applied to rotating 
assets, since rotating asset records include a value in the Rotating Item 
field. 

For more information about rotating items, see �Item Master Records and 
Assets,� on page 6-20.

For more information about rotating assets, see �Understanding Rotating 
Assets,� on page 3-11.

Condition Codes and Inventory

Condition codes are used to indicate the value of inventory items in various 
physical conditions. They are also used to help calculate the value of worn or 
used items that have been returned to inventory. 

When you are managing a condition enabled item record, entering a condition 
code value is mandatory when using the following inventory actions:

! Issue Current Item
! Transfer Current Item
! Inventory Adjustments > Current Balance
! Inventory Adjustments > Physical Count

NOTE: You cannot apply a condition code to a kit, because each item in the kit 
could potentially have a different condition.

Condition Codes and Issues and Transfers

A new item received into inventory in the Receiving application has a 
condition code equivalent to "new" with a rate of 100%. The item can be 
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issued, used, and returned to inventory, at which point the condition would no 
longer be "new" and the value or rate would no longer be 100%. When an item 
is returned (issued back to) to a storeroom, the existing condition code is 
displayed in the From Condition Code field for the item, and the new 
condition can be entered in the To Condition Code field.

Condition Codes and Item Records

When you create item records that will have condition codes applied to them 
you must first select the Condition Enabled? check box, then enter a row in 
the Condition Codes table window for each condition you want to apply to the 
item.

Condition Codes and Tools

You cannot apply a condition code to a tool record.

Using the Condition Codes Application

To access the Condition Codes application, click the application link on your 
Start Center, or select Inventory > Condition Codes from the Go To menu.

Condition Codes Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Condition Codes application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Condition Codes Help.    

Creating Condition Codes

When you create a condition code the code is added to a master value list that 
can be applied to all items in the Item Set. 

Managing Condition Codes

You cannot modify a condition code after it has been saved. 

To delete a condition code, click the Mark Row for Delete button next to the 
row in the table window, then click Save. You cannot delete a condition code if 
it is associated with an item record.

How Do I...

create a new condition code? Click the Item Set, then click New Row in the 
Condition Codes table window.

delete a condition code? Click the Mark Row for Delete button next to 
the row in the table window, then click Save.
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Condition Codes Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Inventory

An inventory is a listing of all items, materials, and rotating assets that are 
stored in your storerooms. With Maximo you create item records in the Item 
Master application, and you create storeroom records in the Storerooms 
application, but you manage your inventory in the Inventory application. 

Using the Inventory application you can track item balances down to the bin 
and lot level for a storeroom, as well as item costs using condition codes. You 
can track vendors that supply an item as well as reorder details such as price 
and lead time for orders. You can view rotating assets that list a rotating item 
record, as well as assets that list the item as a spare part.

You use the Inventory application to view information about a specific item at 
a specific storeroom location. The fields on an inventory record refer to item/
location records. Current Balance, for example, means the current balance 
of the item at the storeroom in the Storeroom field. Like Current Balance, 
the fields listed under Balance Summary, Issue History, and Balances all 
apply to the item in a specific storeroom.

Multisite and Inventory

The Inventory application tracks items and materials in storerooms, which 
are at the Site level. Thus the Inventory application is managed at the Site 
level. 

Inventory and Condition Codes

Condition codes are created in the Condition Codes application, and applied to 
item records in the Item Master application.

When you are managing a condition enabled item record, entering a condition 
code value is mandatory when using the following inventory actions:

! Issue Current Item
! Transfer Current Item
! Inventory Adjustments > Current Balance
! Inventory Adjustments > Physical Count

Inventory and Item Records

With Maximo you create item records in the Item Master application, but you 
manage your inventory in the Inventory application. 
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Inventory and Purchasing (Reordering)

When you reorder items either manually (using one of the reorder actions in 
the Inventory application), or automatically (via a reorder cron task set up by 
your system administrator), Maximo automatically creates one or more 
purchasing records for the reorder. Exactly what type of purchasing records 
are created is based on settings controlled by your system administrator. Your 
system administrator can configure Maximo so that when purchase requests 
are received one of the following types of records is created:

! Unapproved purchase requisitions (PRs)
! Approved purchase requisitions (PRs)
! Unapproved purchase orders (POs)
! Approved purchase orders (POs)

Inventory and Storerooms

Inventory records refer to an item/location combination, usually an item at a 
storeroom location. Storeroom records are created using the Storerooms 
application. Items are added to storerooms using the Add Item to 
Storeroom action in the Item Master application.

Using the Inventory Application

To access the Inventory application, click the application link on your Start 
Center, or select Inventory > Inventory from the Go To menu.

The Inventory application contains the following tabs:

! List � to search Maximo for inventory records.

! Inventory � to enter, view, or modify item balances, costs, balances, bins 
and lots, and to view storeroom locations where the item is stocked.

! Reorder Details � to enter, view, or modify reorder details, such as the 
reorder point, lead time, and issue units of an item. In addition, you can 
enter or view information about one or more vendors for a item, as well as 
information about multiple manufacturers or models for each vendor. 

! Rotating Asset � to identify and track rotating assets associated with a 
rotating item record.

! Where Used � to list all assets on which an item is listed as a 
subassembly or spare part.

Inventory Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Inventory application. For more detailed information, including 
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prerequisites to performing an action and detailed procedures, refer to the 
Inventory Help.     

How Do I...

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Units of Measure from the 
Select Action menu.

adjust the current balance in a storeroom based 
on a physical count of the item?

Select Inventory Adjustments > Reconcile 
Balances from the Select Action menu.

assemble items into a kit? Select Assemble Kit from the Select Action 
menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

break up a kit into individual items? Select Disassemble Kit from the Select Action 
menu.

clear a lock on the reorder process associated 
with my user name?

Select Reorder > Clear Reorder Locks from 
the Select Action menu.

compare information for multiple vendors for an 
item?

Select View Vendor Analysis from the Select 
Action menu.

create an inventory record? Item records are created in the Item Master 
application. Storeroom records are created in 
the Storerooms application. You add items to 
storerooms using the Add Items to 
Storerooms action in the Item Masters 
application.

enter a physical count for an item? Select Inventory Adjustments > Physical 
Count from the Select Action menu. 

issue an item to an asset, general ledger 
account, location, or work order?

Select Issue Current Item from the Select 
Action menu.

modify the average cost for the item at this 
storeroom location?

Select Inventory Adjustments > Average 
Cost from the Select Action menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

modify the current balance of an item at this 
storeroom location? 

Select Inventory Adjustments > Current 
Balance from the Select Action menu.

modify the standard cost for the item at this 
storeroom location?

Select Inventory Adjustments > Standard 
Cost from the Select Action menu.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Units of Measure from the 
Select Action menu.

reorder items that will be issued without being 
received into inventory?

Select Reorder > Reorder Direct Issue Itms/
Svcs from the Select Action menu.
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Using the Inventory Application

You use the Inventory application to enter, display, and update information 
for a specific item at a specific storeroom location. With Maximo you create 
item records in the Item Master application, and you create storeroom records 
in the Storerooms application, but you manage your inventory in the 
Inventory application.

Stocked, Nonstocked, and Special Order Items

Maximo uses the Stock Category field as part of the reorder process, as a 
means of determining which items should be reordered on a regular basis.By 
default Maximo recognizes three categories of inventory items:

! NS �Non-stocked item. Nonstocked items are items you do not stock on a 
regular basis, need only occasionally, or do not want to maintain in your 
storerooms throughout the year. Nonstocked items are not automatically 
reordered, but because you order these items as needed you want to retain 
the item records in the database. These records are useful both for cost 
tracking purposes and for future reference (for example, the vendor's 
name, the price, and so on).

Example of non-stocked items include items needed once a year for 
inspections, or items that are only stocked during certain seasons of the 
year.For example, each spring you replace your air filters. Since you only 
need the air filters once a year, you do not stock them in your storerooms, 
you only order them just before they need to be replaced. But because you 
order the air filters every year, you want to keep the record for the item in 
your database for reference next spring.

reorder stocked items? Select Reorder > Reorder Items from the 
Select Action menu.

reset the year-to-date issue history for an item? Select Inventory Adjustments > Zero Year 
to Date Quantities from the Select Action 
menu.

run reports? Select Run Reports from the Select Action 
menu.

transfer items from one bin to another? Select Transfer Current Item from the Select 
Action menu.

transfer items from one Site to another Site? Select Transfer Current Item from the Select 
Action menu.

transfer items from one storeroom to another? Select Transfer Current Item from the Select 
Action menu.

view all of the storerooms that stock an item? Select View Item Availability from the Select 
Action menu.

view inventory transactions (adjustments, 
issues and transfers, receipts, and returns) 
related to the current record?

Select View Inventory Transactions from 
the Select Action menu.

How Do I...
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! SP� Special Order Item. Special order items are typically items that are 
ordered only once, often for unexpected needs or for a one-time work order. 
These items are not kept in stock, and you do not expect to order them 
again, thus you do not need a permanent record of the item in your 
database. In most cases, after the item is received, you want to delete 
special order item records from the database. For more information about 
deleting item records, see �Managing Item Master Records,� on page 6-26.

! STK � Stocked Item. This is the default value for a new item added to a 
storeroom. A stocked item is an item that you stock on a regular basis, and 
want to keep on hand because it has a regular turnover rate and is 
frequently needed. Stocked items are automatically included in Maximo�s 
reorder process. Stocked items have a reorder criteria (for example, a 
reorder point and an economic order quantity) which is specific to each 
storeroom location. 

Examples of stock items include bearings, gaskets, valves, and belts. 

Creating Inventory Records

You use the Inventory application to view information about a specific item at 
a specific storeroom location. Item records are created in the Item Master 
application. Storeroom records are created in the Storerooms application. You 
add items to storerooms using the Add Items to Storerooms action in the 
Item Masters application.

Creating Kits

A kit is a collection of items that can be issued as a single unit. Kits are 
defined in the Item Master application, and managed in the Inventory 
application.

After you define the contents of a kit in the Item Master application, you use 
the Assemble Kit action in the Inventory application to create kit records for 
a single storeroom location. Maximo calculates the number of kits that can be 
build based on current balances for the kit components, and allows you to 
enter the quantity of kits you want to assemble.

NOTE: You cannot assemble kits from items located in different storerooms.

Managing Inventory

Many companies are moving to a just-in-time system to reduce their inventory 
levels and associated carrying costs. When using a just-in-time system for 
maintenance, you base your purchasing and stock levels on upcoming work, 
rather than on past usage. Because parts and assets can become obsolete and 
your company�s process can change, looking back might not be as useful as 
looking forward when considering your inventory needs.

Maximo can accommodate a just-in-time system by letting you set reorder 
quantities. Using the Preventive Maintenance application to plan upcoming 
maintenance and inspection work also can help to determine which items will 
be needed in the future.
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Viewing Item Availability

The Inventory application displays separate item records for each storeroom 
location.

If you are trying to locate stock for an item or material you can use the View 
Item Availability action to view balances for all storeroom locations that 
stock the item, all lots of the item, all PRs and POs that list the item, 
alternate items that can be substituted for the item, and approved work 
orders that have created reservations for the item.

NOTE: Items that have been assembled into kits do not appear in item balances 
displayed in this dialog box.

Maximo�s Reorder Process

When Maximo reorders inventory stock, the amount to be ordered is based on 
Maximo�s reorder logic, which uses the following formula:

(current balance + quantity on current purchase requisitions and purchase 
orders) � (quantity reserved for work orders and internal purchase orders 
+ quantity expired) < = Reorder point

"Current Purchase Requisitions and Purchase Orders" are any PRs and POs 
with a status of waiting for approval (WAPPR), approved (APPR), or in 
progress (INPRG). Maximo checks to see how many units of this item are 
listed on current PRs and POs, adds this number to the current balance, then 
subtracts any items on approved work orders, internal POs, and any expired 
items. If the resulting number does not exceed the reorder point (ROP), 
Maximo will reorder the item.

You can reorder items either manually by using on of the reorder actions in 
the Inventory module, or via a reorder cron task set up by your system 
administrator. A cron task is a software command to execute a task at a 
particular time. For more information about configuring the reorder cron task, 
refer to the Maximo System Administrator�s Guide.

CAUTION: The reorder process does not check to see if items appear inside kits 
when reordering an item.

Determining the Reorder Point

The reorder point (ROP) is the point when items should be reordered so that 
the item balance does not fall below the number designated as safety stock 
during the lead time for the order. Ideally the calculation of the ROP is based 
on the following variables:

! Safety stock is the minimum number of the item that you must have on 
hand at all times.

! Lead time is the amount of time it takes between placing an order and 
receiving it.
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! Economic Order Quantity (EOQ) is the number of an item that should 
be reordered at one time, usually based on the vendor�s price for a 
particular quantity ordered. For example, buying a case of an item can 
cost less per item than buying the item individually.

Reordering Items

Reordering is done separately for each individual storeroom. Your system 
administrator can use the Cron Task Setup application to create a cron task to 
automatically reorder items or you can reorder items manually using one of 
the reorder actions available from the Inventory Select Action menu:

! Reorder > Reorder Items � Use to reorder one or more inventory items. 
All items selected must be from the same storeroom location.

! Reorder > Reorder Direct Issue Itms/Svcs � Use to reorder items or 
service items listed on approved work orders.

! Reorder > Clear Reorder Locks � Use to remove a lock on the reorder 
process logged against your user name.

When a user runs the reorder process (even if preview mode). Maximo 
places a lock on the process against the storeroom being reordered. This is 
to prevent other users from running reorder against the same storeroom at 
the same time. Occasionally, users running the reorder process in preview 
mode may inadvertently lock the reorder process and prevent themselves 
and others from running reorder against a certain storeroom. 

NOTE: This action only clears Preview Mode reorder locks, created by the 
current user. Users running the full reorder process are not affected.

TIP: You can set the reorder process to run in the background and notify you by 
e-mail after the process ends. This lets you do other work while running a 
lengthy reorder process.

TIP: You can repeat the reorder process for additional storerooms without 
exiting the Reorder Items page.

Managing Inventory Item Counts and Costs

The balances and costs fields on an inventory record are calculated fields, and 
are read-only. You may occasionally need to adjust the balances or costs for an 
inventory item to accommodate a variety of circumstances. For example:

! after a routine physical count
! at the end of the year
! when items have entered or left a storeroom without a Maximo 

transaction 
! when item costs have changed due to inflation

You use the following inventory adjustment actions available from the Select 
Action menu to make modifications to item balances or costs for a storeroom.

! Inventory Adjustments > Reconcile Balances � Use to adjust the 
current balance for an item based on a physical count of the item. This 
action updates only the selected item in the selected Storeroom.
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! Inventory Adjustments > Zero Year to Date Quantities� Use to 
change the values in the Issue History section of an item record. This 
action moves all Year to Date quantities back one year and changes the 
current Year to Date quantity to zero. Typically this action is used only at 
the end of a fiscal year. This action updates only the selected item in the 
selected Storeroom.

! Inventory Adjustments > Current Balance � Use to change the 
Current Balance of an item listed in the Balance Summary section of an 
item record. Maximo automatically adjusts balances when items are 
issued, transferred, received, assembled into kits, and so forth. However, 
you can use this action if you are aware of a change in the current balance 
that has not been reflected in any other inventory transaction. This action 
updates only the selected item in the selected Storeroom.

! Inventory Adjustments > Physical Count � Use to change the 
Physical Count of an item listed in the Inventory Balance table window. 
This action updates only the selected item in the selected Storeroom, 
Bin, and/or Lot.

! Inventory Adjustments > Standard Cost � Use to adjust the read-
only Standard Cost listed in the Inventory Costs table window. 

! Inventory Adjustments > Average Cost � Use to adjust the read-only 
Average Cost listed in the Inventory Costs table window. You might 
want to adjust the average cost value if you issue items at average cost 
and want any price increases reflected immediately in the issue cost. This 
action updates only the selected item in the selected Storeroom.

Managing Kits

A kit is an item record that "contains" other item records and can be issued as 
a single unit. Item kit records are created in the Item Master application. You 
use the Assemble Kit action in the Inventory application to record changes to 
item balances when you assemble all of the components and create a kit. Kits 
can only be assembled from components stored in the same storeroom.

Likewise you use the Disassemble Kit action when you need to break a kit 
into its individual items, for example when you need to return a partially used 
kit. The parts from a disassembled kit must be returned to a single storeroom, 
Maximo will not allow kits to be disassembled across storerooms.

Inventory Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Issues and Transfers

You use the Issues and Transfers application to manage the movement of 
inventory items out of your storerooms. You issue an item when it is moving 
out of a storeroom to be used. You transfer an item when it is moving 
between storerooms.
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Using the Issues and Transfers application you can

! issue items directly to a work order, asset, location, or charge to a GL 
Account.

! return previously issued items to a storeroom

! transfer items out of one storeroom and into another storeroom location

! transfer items to a courier location or a labor location

! receive items previously issued to a courier location or a labor location for 
transport

Multisite and Issues and Transfers

Since the Inventory and Storerooms applications are at the Site level, Issues 
and Transfers are also managed at the Site level.

You can issue or transfer items within a single Site, or between any Sites and 
Organizations that share the same Item Set.

Issues and Transfers and Condition Codes

When you issue, return, or transfer a condition enabled item Maximo prompts 
you to specify the condition of the item. Maximo calculates the cost of the item 
based on the condition code and rate.

Issues and Transfers and Inventory

After you create a job plan for a work order, the materials needed for the work 
order are reserved in inventory. After the work order is approved, you can 
issue the reserved items.

When you issue an item, Maximo updates the balance for the issuing 
storeroom. When you transfer items: 

! If the item is transferred out to or in from a courier location or a labor 
location, Maximo only updates the storeroom balance. 

! If the item is transferred out to or in from another storeroom, Maximo 
updates the item balances for both storerooms.

You can issue or return an item from the Inventory application using the 
Issue Current Item action.

You can record physical counts for items when issuing or transferring by 
entering a value in the New Physical Count field. Maximo updates the 
physical count information for the item in the specified storeroom.
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Issues and Transfers and Purchasing

You can transfer items between storerooms with the same Site or between 
Sites within the same Organization without creating an internal purchase 
order.

If you are transferring items across Organizations, Maximo requires that the 
Organizations share the same Item Set, and that you create an internal 
purchase order.

Issues and Transfers and Work Orders

When you record item use on a work order, Maximo creates a material 
transaction record in the database. Item usage on work orders can be recorded 
in one of two ways:

! record material issue to work order using the Issues and Transfers 
application.

! record material usage using the Actuals tab of the Work Order Tracking 
application.

Because Maximo updates inventory balances when you perform either of 
these actions, it is possible for the same item to be subtracted from inventory 
twice, thereby causing inaccurate item counts. To ensure accurate inventory 
records, your company should establish a policy for each site regarding 
whether item use will be recorded in the Issues and Transfers application or 
in the Work Orders module.

No matter where the materials issues/usage are originally recorded, the 
information is copied to the Materials subtab on the Actuals tab in Work 
Order Tracking.

Using the Issues and Transfers Application

To access the Issues and Transfers application, click the application link on 
your Start Center, or select Inventory > Issues and Transfers from the Go 
To menu.

The Issues and Transfers application contains the following tabs:

! List � to search Maximo for storeroom records.

! Issue � to issue items directly to a work order, asset, location, or against 
a general ledger account. Also used for returning items to the storeroom.

! Transfer Out � to transfer items out of your storeroom to another 
storeroom, a courier location, or a labor location.

! Transfer In � to transfer items from another storeroom, a courier 
location, or a labor location.
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Issues and Transfers Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Issues and Transfers application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Issues and Transfers Help.     

Direct Issue Items

A direct issue item is an item that you have ordered that will be issued 
immediately upon receipt to an asset, location, or work order rather than 
stocked in the storeroom. These items might be special order items, or regular 
stock that is needed immediately to complete maintenance work.

NOTE: Service item records are always direct issue items.

Because they are issued directly upon receipt, direct issue items are managed 
in the Receiving application, not the Issues and Transfers application.

Creating Issue Transactions

In order to be able to issue items using the Issues and Transfers application 
you must specify which storeroom you want to issue from, and you must be 
authorized to issue items from the selected storeroom.

Although items are generally specified in a job plan and issued in conjunction 
with specific work orders, it is also sometimes necessary to issue them directly 
to a location, or against an asset, or against a General Ledger account, 
without a work order number. For example, you might want to charge the cost 
of items such as soap, grease, or rags to a location or GL account rather than 
to a work order or specific asset.

To allow Maximo to track inventory costs, you must make an entry in at least 
one of the following fields when issuing items:

! Asset
! GL Debit Account
! Location
! Work Order

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a new inventory reservation? Select Add/Modify Reservations from the 
Select Action menu.

modify an existing inventory reservation? Select Add/Modify Reservations from the 
Select Action menu.

run reports? Select Run Reports from the Select Action 
menu.
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In general, after you make an entry in one field, one or more other fields are 
filled in with default values associated with the first specified field. For 
example, if you specify a work order, the asset and/or location and/or GL 
account named on the work order are also filled in.

! Select Items for Return � Click to select from a list of items and 
materials previously issued from the selected storeroom.

! Select Reserved Items � Click to select items to issue from a list of 
items that have been reserved for approved work orders.

! Select Asset Spare Parts � Click to select from the spare parts 
associated with a particular asset. 

! New Row � Click to issue items directly to an asset, location, or charge 
against a General Ledger account, or issue unreserved items (items that 
are not included in a work order work plan).

Creating Transfer Transactions

Items can be transferred from one storeroom location to another inventory 
location using the Transfer Out and Transfer In tabs. Transfers can be made 
within a Site, or to another Site within your Organization. You also can 
transfer items from a storeroom to a courier location or a labor location.

Transferring items to another storeroom is done on the Transfer Out tab. You 
have the following options for selecting items for transfer out to another 
storeroom:

! Select PO Items � allows several options to filter your search when you 
transfer items on an internal PO to another company storeroom.

! Select Items for Transfer � allows you to filter your search by Item, 
Bin, and Lot.

! Select Asset Spare Parts � allows you to select from the spare parts 
associated with a particular asset. 

! New Row � allows you to enter items to be transferred individually.

Receiving the transfer into a storeroom is done on the Transfer In tab. 

You have the following options available when transferring items into a 
storeroom:

! Select PO Items � allows several options to filter your search when you 
transfer items on an internal PO to another company storeroom

! Select PO Items in Transit � allows you to select items from internal 
purchase orders that are in transit with a courier. 

! Select Items for Transfer � allows you to filter your search by Item, 
Bin, and Lot.

! Select Asset Spare Parts � allows you to select from the spare parts 
associated with a particular asset. 
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! New Row � allows you to enter items to be transferred individually.

Managing Issues and Transfers

You use the Issues tab to return previously issued items and materials, for 
example, if some parts on a work order were not needed. Note the following 
restrictions on returns:

! You cannot return rotating asset that has been modified (moved or worked 
on) since its original issue.

! You cannot return a partial kit. The remaining kit components should be 
returned as individual items.

Issues and Transfers Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Item Master

An item record defines an item or material that is stocked in a company 
storeroom.

When you use the Item Master application to create an item record you can 
define the type of stock the item is, whether it is lotted or nonlotted, associate 
hazards and Material Safety Data Sheets (MSDS) with the item, define the 
item as a rotating item that can be listed on rotating assets, and identify 
alternate items that can be used as substitutes for the item.

You also can define other information related to items, such as the storeroom 
locations that stock the item, vendor information for the item, Classification 
and Specifications for the item, item assembly structures, and documents 
outside of Maximo that relate to the item record. 

Multisite and Item Master Records

Item master records are defined at the Item Set level. Item Sets exist below 
the System level, but above the Organization level so that Organizations can 
share data. This means that:

! Key fields for new records must be unique within the Item Set.

! Records are available to all users in the Organizations that share the Item 
Set and who have security permissions to the application. 

Some of the data on an item record may be specific to a single Organization or 
Site. For example, storerooms listed on the Storerooms tab are at the Site 
level, and the companies listed on the Vendor tab are at the Organization 
level.
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You use the Item/Organization Details action available from the Select 
Action menu to specify Organization specific data such as Hazards and Tax 
Codes for each Organization that uses the Item Set.

Commodity codes are also defined at the Item Set level. For more information 
about commodity codes, see �Item Master Records and Commodity Codes,� on 
page 6-20.

Item Master Records and Assets

Item records are usually created for consumable items or materials. But you 
can also create item records for items that can be reused or refurbished, and 
therefore must also be tracked as assets so that you can keep a maintenance 
history for the item. Maximo accomplishes this by allowing you to create 
rotating item records that can be used to create rotating asset records.

A rotating item is a special category of item record, used to indicate items that 
can be used interchangeably as a replacement for a like item, for example, fire 
extinguishers, motors, or pumps, but that are repaired or refurbished when 
they are removed from service. Rotating items can be managed like any other 
item record; they can be stocked in storerooms, issued and transferred, 
reordered and so forth.

Rotating assets are a special category of asset records, used to refer an any 
asset record that contains a value in the Rotating Item field. Rotating assets 
consist of multiple interchangeable assets, with each asset having the same 
item number and a different asset number. 

These items are tracked both by their item numbers in the Inventory module 
and by their individual asset numbers in the Assets module. The term 
rotating item is used when referring to inventory records and management, 
and the term rotating asset is used when referring to asset records and 
maintenance. 

To illustrate how a rotating item record is used, let�s imagine that your 
company purchases a dozen identical fire extinguishers. You would create a 
single rotating item record for the model that you purchased, then create a 
separate asset record for each individual fire extinguisher. All twelve asset 
records would have the same item number in the Rotating Item field, but 
different asset numbers. The asset records allow you to keep a maintenance 
record for each extinguisher; you can list each fire extinguisher location on an 
inspection route, record meter readings, generate preventive maintenance 
work orders and so forth. The fact that the asset records share the same item 
number allows you to easily find replacement fire extinguishers in your 
storerooms when they are needed.

NOTE: An item cannot be both a spare part and a rotating item.

Item Master Records and Commodity Codes

The term commodity is used to describe classifications of inventory. 
Commodity codes are used to distinguish groups of inventory items that can 
be used for reporting and analysis. Your purchasing department might 
include Commodities Managers who track spending by commodity and make 
decisions about vendor relationships based on that data.
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When you create an item record you can associate the item with an existing 
Commodity Group and Commodity Code by listing them on the item 
record. Commodity codes can be defined and managed using the Add/Modify 
Commodity Codes action available from the Select Action menu of the 
following applications:

! Companies
! Item Master
! Purchase Orders
! Service Items 
! Tools

NOTE: Commodity Codes are defined at the Item Set level.

Item Master Records and Condition Codes

A condition code specifies the physical condition of an item, and is used to 
indicate that an item is not new. Condition codes are also used to help 
calculate the value of worn or used items that have been returned to 
inventory. You use the Condition Enabled? check box on an item record to 
indicate if condition codes can be applied to inventory records for the item. 
Before saving a condition-enabled item record you must assign at least one 
full value (100%) condition code to the item. You can assign multiple condition 
codes to an item record, but only one can have a rate of 100%. 

When an item is added to a storeroom via the Add Items to Storerooms 
action in the Item Master application the condition code always defaults to the 
100% rate. 

When you are managing a condition enabled item record, entering a condition 
code value is mandatory when using the following Inventory actions:

! Issue Current Item
! Transfer Current Item 
! Inventory Adjustments > Current Balance 
! Inventory Adjustments > Physical Count

NOTE: You cannot apply a condition code to a kit, because each item in the kit 
could potentially have a different condition.

Item Master Records and Contracts

Item records may be specifically listed on purchase or lease contracts, or they 
may be covered under a generic agreement with a vendor where you company 
has agreed to spend an specific amount on purchases from the vendor.

Item Master Records and Inventory

Item records are created in the Item Master application, but item balances are 
tracked in the Inventory application.
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Item Master and Safety

If an item record is for a hazardous material, you can list the Material Safety 
Data Sheet number issued by the Occupational Safety and Health Association 
(OSHA) in the MSDS field of the item record.

Because item records are at the Item Set level in Multisite and hazard records 
are at the Organization level, you use the Item/Organization Details action 
to associate hazards with an item record. The Can Have Hazardous 
Materials? check box on the hazard record must be checked before it can be 
associated with an item record. Associating a hazard record with an item 
record allows warehouse and storeroom workers to view the hazard 
information for the item. When an item with an associated hazard is listed on 
a work order, Maximo automatically displays safety information to the work 
order�s Safety Plan tab.

Item Master Records and Storerooms

You use the Storerooms tab of an item record to view storeroom information 
about the item, including a list of all storerooms that have the item on their 
stock list, balances, and costs for the item.

You use the Add Item to Storeroom action in the Item Master application to 
add an item record to a storeroom location�s stock list. Adding an item to a 
storeroom is one of the few times you make an entry in the Current Balance 
field. Usually, this field is either calculated by Maximo or updated after 
inventory is received in the Receiving application. Rotating item balances are 
zero until an asset record is created for the rotating item number.

You can delete an item from a storeroom�s stock list if the item balance in the 
storeroom is zero by deleting the storeroom on the Storerooms tab of the item 
record. 

Using the Item Master Application

To access the Item Master application, click the application link on your Start 
Center, or select Inventory > Item Master from the Go To menu.

The Item Master application contains the following tabs:

! List � to search Maximo for item records.

! Item � to enter, view, or modify items, and to specify alternate items.

! Storerooms � to view a read-only list of information about storerooms 
that stock the item. 

! Vendors � to enter, view, modify, or delete information about vendors 
and manufacturers for an item.

! Specifications � to classify an item and add, view, modify, or delete 
specifications that give details about the attributes of the item.
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! Item Assembly Structure � to enter, view, or modify item assembly 
structures.

Item Master Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Item Master application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Item Master Help.     

How Do I...

add an item to the stock list for a storeroom? Select Add Items to Storeroom from the 
Select Action menu.

add a commodity group to the database? Select Add/Modify Commodity Codes from 
the Select Action menu.

add or modify a commodity code in a commodity 
group?

Select Add/Modify Commodity Codes from 
the Select Action menu.

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change the capitalized status of an item? Select Change Capitalized Status from the 
Select Action menu.

copy an existing item assembly structure to an 
item record?

Select Copy Item Assembly Structure from 
the Select Action menu.

create an item record? Click the New Item button in the toolbar.

delete a record? Select Delete Item from the Select Action 
menu.

duplicate a record? Select Duplicate Item from the Select Action 
menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

specify hazards for an item? Select Item/Organization Details from the 
Select Action menu.
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Creating Item Master Records

MRO Software recommends that all possible combinations of units of measure 
and their conversion values be defined before you create item master records. 
You use the Add/Modify Units of Measure action and the Add/Modify 
Conversions action available from the Select Action menu to define these 
values.

You can use the Duplicate Item action to create a copy of an existing item 
record, for example if you have similar items with different specifications. 
Once you duplicate an item you can then modify it as needed.

Designating Alternate Items

Alternate items are items that can be used interchangeably with other 
inventory items, for example, two different brands of motor oil. You use the 
Alternate Items table window to list any items that can be used as an 
alternate for the current item.

In many cases, one item can be an alternate for another, but the oppose 
relationship might not be desired. As a result, Maximo does not automatically 
created matching rows in the Alternate Items table window when an item 
record is listed as an alternate. If you want two items to be listed as alternates 
for each other, you must go into both item records separately and assign each 
item as an alternate for the other.

Creating Rotating Items

A rotating item is a special category of item record, used to indicate items 
that can be used interchangeably as a replacement for a like item, for 
example, fire extinguishers, motors, or pumps, but that are repaired or 
refurbished as assets when they are removed from service. Rotating items can 
be managed like any other item record; they can be stocked in storerooms, 
issued and transferred, reordered and so forth.

You create a rotating item by selecting the Rotating? check box on an item 
record. After you create and save an item record, the Rotating? field becomes 
read-only and cannot be edited, and the Current Balance field becomes 
read-only. If an item is defined as rotating, the values in the Balances fields 
are controlled by the movement of the rotating items in and out of a 
storeroom. 

When you list a Rotating Item on an asset record, Maximo copies the 
Classification and Attributes that are listed on the Specifications tab of the 
item record to the Specifications tab of the asset record. 

CAUTION: When you create rotating item records that will be used to create 
information technology (IT) asset records, you must enter a value in 

specify tax codes for an item? Select Item/Organization Details from the 
Select Action menu.

view contract information related to the item? Select View Contracts from the Select Action 
menu.

How Do I...
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the Classifications field to allow Maximo to filter for IT assets 
when performing reconciliation.

Understanding Item Assembly Structures

An item assembly structure (IAS) is a list of individual items and 
subassemblies that are required to build an asset or define the requirements 
of a location. Rather than specify its components each time you enter an 
individual asset or a location, you create an item assembly structure as a 
template. You can use an IAS as a template when building multiple asset 
assembly structures and their related location systems.

The IAS is built on an item record, and the IAS is then identified by the item 
number at the top of the hierarchy. You can apply an item assembly structure 
to an asset or to a location by specifying the top-level item number in the 
Rotating Item field on an asset or location record, then choosing the Apply 
Item Assembly Structure action.

For example, a five-horsepower motor and its associated spare parts can be 
used in 10 asset assembly structures in a plant. Rather than entering 10 asset 
records and specifying the spare parts for each one, you enter the asset 
records and apply (copy) the IAS for a five-horsepower motor to the records. 
The entire IAS is applied to the asset assembly structure. Similarly, you could 
apply the same IAS to the 10 operating locations in the plant that require the 
motor and its spare parts.

NOTE: Note that while you can use any item as the top level of an IAS, you can 
only apply an IAS to asset or operating locations if the top level is a 
rotating item. 

Using Item Assembly Structures

Item assembly structures are applied to asset and location records in the 
Assets and Locations applications. 

Item assembly structures can be applied when you create new asset records in 
the Receiving application.

You also use item assembly structures when creating item kits in the Item 
Master application.

Creating Item Kits

A kit is an item record that contains other item records and can be issued as a 
single unit. 

Item records contain a Kit? check box that is used to indicate that the item 
record will act as the virtual "container" for all of the other items contained 
within the kit. After you create the item record for the kit "container" you then 
define the components of the kit using the Item Assembly Structure tab. On 
this tab you list items, and quantities for each item that are to be included in 
the kit. Kits can be included as components of other kits.

NOTE: Maximo does not allow items that are condition-enabled, rotating, or 
lotted to be added to a kit. 

And item record cannot be included as part of a kit if it has any of the 
following properties:
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! Condition Enabled? = Yes
! Rotating? = Yes
! Lot Type = LOT

NOTE: Kits are assembled in Inventory via the Assemble Kits action. 

TIP: As a best practice you should include an Issue Unit for any item record 
that may be included as part of a kit.

Managing Item Master Records

You manage data about an item record, for example vendors and 
classifications, in the Item Master application, but you manage item balances 
in the Inventory application.

Managing Vendors

You use the Vendors tab of an item record to view or manage a list of vendors 
or companies that supply the item. The list can include vendors you have 
previously ordered from, as well as vendors you have not purchased the item 
from. You can use the vendor data to compare prices and delivery information. 

Managing Kits

You use the Assemble Kit and Disassemble Kit actions available in the 
Inventory application to create and dismantle kits. You can only assemble kits 
from components available in an individual storeroom. 

Kits can be issued and transferred using the Issues and Transfers application. 
When returning kits you can only return complete kits. If some of the 
components have been consumed, you should return the remaining items as 
individual items, since Maximo does not recognize partial kits.

Linking Items to Classifications

Maximo includes a feature called Classifications which can be used to 
structure records into organized hierarchies. Using classifications helps you to 
more easily locate records, and help to ensure that records are not duplicated 
unintentionally.

You can add new item records to Classifications by associating a specification 
template with the record on the Specifications tab. After items are associated 
with specification templates, you can use the Classification Search dialog to 
search through Maximo to find the records you are looking for. 

For more information about Classifications, see �Using Classifications,� on 
page 2-35.

Deleting Items

You can delete an item record using the Delete Item action available from 
the Select Action menu. You cannot delete an item record if any of the 
following are true:

! inventory balances or reservations exist for the item.
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! the item is associated with an asset record as a Rotating Item or as a 
spare part.

! the item is listed on a master PM record.

! the item is listed as planned materials on a job plan or work order.

! the item is listed on a desktop requisition, purchase requisition, or 
purchase order.

Maximo displays a message if the item cannot be deleted.

Item Master Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Service Items

A service item is a special type of item used to define services that your 
company utilizes. Service items cannot be issued, transferred, or contain 
balances, but they can be used as part of job plans, work orders, and can be 
used in the purchasing applications when creating purchase requisitions, 
purchase orders, and so forth. Another way to think of service items is that 
they are "planned services" or services that you plan to use or purchase.

You use the Service Items application to create records for any type of service 
that your company uses or purchases on either a frequent or infrequent basis. 
Some examples of service items include standard services associated with 
purchasing such as freight or installation, or regular maintenance services 
that you might purchase from a vendor, such as landscaping or janitorial 
services.

Multisite and Service Items

Service Items are defined at the Item Set level. Item Sets exist below the 
System level, but above the Organization level so that Organizations can 
share data. This means that:

! Key fields for new records must be unique within the Item Set.

! Records are available to all users in the Organizations that share the Item 
Set and who have security permissions to the application. 

Some of the data on a service item record may be specific to a single 
Organization or Site. For example the companies listed on the Vendors table 
window are at the Organization level.

You use the Service Item/Organization Details action available from the 
Select Action menu to specify Organization specific data such as GL Account 
and Tax Codes for each Organization that uses the Item Set.
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Service Items and Job Plans

The Job Plans application includes a Services subtab on the Job Plan tab, 
allowing you to include service items as part of a job plan.

Service Items and Purchasing

Service items can be requisitioned using Desktop Requisitions or the 
Purchase Requisitions (PR) applications, and ordered using the Purchase 
Orders (PO) application. When you order a service item, the PR or PO line 
Type = STDSERVICE. Service items are always direct issue items because 
they cannot be "stored" in a storeroom location. 

Service Items and Work Orders

The Work Order Tracking application includes a Services subtab on both the 
Plans and Actuals tabs. This allows you to plan for services when creating a 
work plan, and record the actual costs for service items needed to complete the 
work order.

Using the Service Items Application

To access the Service Items application, click the application link on your 
Start Center, or select Inventory > Service Items from the Go To menu.

The Service Items application contains the following tabs:

! List � to search Maximo for service item records.

! Service � to create, view, or modify service item records.

Service Items Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Service Items application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Service Items Help.      

How Do I...

add a commodity group to the database? Select Add/ Modify Commodity Codes from 
the Select Action menu.

add or modify a commodity code in a commodity 
group?

Select Add/ Modify Commodity Codes from 
the Select Action menu.

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.
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Creating Service Item Records

You can create a service item record for any type of service that your company 
uses or purchases on either a frequent or infrequent basis. You can list the 
vendors that you purchase the service from in the Vendors table window.

If you want to associate a GL Account or a Tax Code with a service item, you 
can use the Service Item/Organization Details action available from the 
Select Action menu to do so.

You can use the Duplicate Service Item action to create a copy of an 
existing service item, for example if purchase different services from the same 
vendor. Once you duplicate a service item you can then modify it as needed.

Managing Service Item Records

Because they cannot be received into inventory or stored in a storeroom, 
service items are always categorized as direct issue items. You can reorder a 

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

clear a lock on the reorder process associated 
with my user name?

Select Reorder > Clear Reorder Locks from 
the Select Action menu.

create a service item record? Click the New Service Item button in the 
toolbar.

delete a record? Select Delete Service Item from the Select 
Action menu.

duplicate a record? Select Duplicate Service Item from the Select 
Action menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

reorder items that will be issued without being 
received into inventory?

Select Reorder > Reorder Direct Issue Itms/
Svcs from the Select Action menu.

run reports? Select Run Reports from the Select Action 
menu.

specify GL Account codes for a service item? Select Service Item/Organization Details 
from the Select Action menu.

specify tax codes for an item? Select Service Item/Organization Details 
from the Select Action menu.

How Do I...
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service item using the Reorder Direct Issue Itms/Svcs action available 
from the Select Action menu. 

You can delete a service item record using the Delete Service Item action 
available from the Select Action menu. For more information about the record 
deletion rules, refer to the Maximo System Administrator�s Guide.

Service Items Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Stocked Tools

A stocked tool is a tool that is tracked as inventory and stored on a 
storeroom or tool crib. With Maximo you create tool records in the Tools 
application, and create storeroom records in the Storerooms application, but 
you manage the tools stocked in your storerooms using the Stocked Tools 
application.

Using the Stocked Tools application you can track tool balances down to the 
bin and lot level for a storeroom. You can track vendors that supply a tool, as 
well as reorder details such as price and lead time for orders. You can view 
rotating assets that list the tool as the rotating item on the asset, as well as 
assets that list the tool as a spare part. 

You use the Stocked Tools application to view information about a specific tool 
at a specific storeroom location. The fields on a stocked tool record refer to 
tool/location records. Current Balance, for example, means the current 
balance of the tool at the storeroom in the Storeroom field. Like Current 
Balance, the fields listed under Balance Summary, Issue History, and 
Balances all apply to the tool in a specific storeroom.

Multisite and Stocked Tools

Like the Inventory application, the Stocked Tools application manages tool 
inventory at the Site level.

Using the Stocked Tools Application

To access the Stocked Tools application, click the application link on your 
Start Center, or select Inventory > Stocked Tools from the Go To menu.

The Stocked Tools application contains the following tabs:

! List � to search Maximo for tool/storeroom records.

! Stocked Tool � to enter, view, and modify information on the tools used 
for maintenance work.
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! Vendors � to enter, view, modify, or delete information about vendors 
and manufacturers for an item.

! Rotating Tool Assets � to identify and track rotating assets associated 
with a rotating tool record.

! Where Used � to list all assets on which a tool is listed as a subassembly 
or spare part.

Stocked Tools Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Stocked Tools application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Stocked Tools Help.        

How Do I...

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Units of Measure from the 
Select Action menu.

adjust the current balance in a storeroom based 
on a physical count of the tool?

Select Adjustments > Reconcile Balances 
from the Select Action menu.

compare information for multiple vendors for a 
tool?

Select View Vendor Analysis from the Select 
Action menu.

create a tool record? Tool records are created in the Tools 
application.

enter a physical count for a tool? Select Adjustments > Physical Count from 
the Select Action menu.

issue a tool to an asset, general ledger account, 
location, or work order?

Select Issue Current Tool from the Select 
Action menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

modify the current balance of a tool at this 
storeroom location? 

Select Adjustments > Current Balance from 
the Select Action menu.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Units of Measure from the 
Select Action menu.

reset the year-to-date issue history for a tool? Select Adjustments > Zero Year to Date 
Quantities from the Select Action menu.

run reports? Select Run Reports from the Select Action 
menu.

transfer tools from one bin to another? Select Transfer Current Tool from the Select 
Action menu.
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Creating Stocked Tool Records

You use the Stocked Tools application to enter, display, and update 
information for a specific tools at a specific storeroom location. With Maximo 
you create tool records in the Tools application, and you create storeroom 
records in the Storerooms application, but you manage your tool inventory in 
the Stocked Tools application.

Stocked tool records can be created in any of the following ways:

! Tools can be added to a storeroom using the Add Tool to Storeroom 
action available in the Tools application.

! Tools can be transferring from one storeroom to another using the Issues 
and Transfers application.

! Newly purchased tools can be receiving into a storeroom using the 
Receiving application.

Managing Stocked Tool Records

You can issue and transfer tool balances from a storeroom using the Issue 
Current Tool and Transfer Current Tool actions available from the Select 
Action menu. When you issue or transfer a tool, Maximo updates the tool 
balances accordingly.

If you are trying to locate a tool in your inventory you can use the View Tool 
Availability action to view balances for all storeroom locations that stock the 
tool, all lots of the tool, all PRs and POs that list the tool, alternate tools that 
can be substituted for the tool, and approved work orders that have created 
reservations for the tool.

Stocked tool records may need to be adjusted from time to time, due to 
damage, theft, or data entry errors. The following actions are available from 
the Select Action menu that allow you to make adjustments to a stocked tool 
record:

! Zero Year to Date Quantities
! Reconcile Balances
! Physical Count 
! Current Balance 

transfer tools from one Site to another Site? Select Transfer Current Tool from the Select 
Action menu.

transfer tools from one storeroom to another? Select Transfer Current Tool from the Select 
Action menu.

view all of the storerooms that stock a tool? Select View Tool Availability from the Select 
Action menu.

view inventory transactions (adjustments, 
issues and transfers, receipts, and returns) 
related to the current record?

Select View Inventory Transactions from 
the Select Action menu.

How Do I...
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NOTE: You might need security authorization to perform this action.

Stocked Tools Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Storerooms

A storeroom is a location that contains inventory items. Storerooms have 
General Ledger account codes associated with them to help track inventory 
costs.

You use the Storerooms application to create new Storeroom records, define 
the GL account codes to be associated with a storeroom, and view a read-only 
list of items stocked at that storeroom location.

NOTE: Inventory stock can be issued to a courier or labor location, but these 
"inventory type" locations are not considered storerooms.

Multisite and Storerooms

Storeroom records are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations. For example, you could 
have a storeroom named "Central" at each Site.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Storerooms and Inventory

The records in the Inventory application are for an item/storeroom 
combination. Balances for each item record are tracked separately for each 
storeroom that stocks the item. Balances for all storerooms can be viewed 
using the View Item Availability action in the Inventory application.

Items at Different Storeroom Locations

Storerooms and Item Records

After a storeroom has been created you can create a master stock list by 
associating items with the storeroom in the Item Master application using the 
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Add Item to Storeroom action. Items are also deleted from a storeroom�s 
master stock list in the Item Master application by deleting the storeroom 
from the item records Storerooms tab.

Storerooms and Purchasing

Some companies do all of their purchasing at a central storeroom, and have all 
other storerooms "purchase" their stock from that storeroom. Maximo refers to 
this type of transfer as an internal purchase requisition or purchase order. 
You select the Use in PO/PR? check box to indicate that a storeroom can be 
used as a "vendor" for internal purchases. 

Using the Storerooms Application

To access the Storerooms application, click the application link on your Start 
Center, or select Inventory > Storerooms from the Go To menu.

The Storerooms application contains the following tabs:

! List � to search Maximo for storeroom records.

! Storeroom� to define storeroom locations and provide default GL 
account code information. 

! Items � to view a read-only list of items associated with the storeroom. 

Storerooms Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Storerooms application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Storerooms Help.      

Creating Storerooms

The Storerooms application lets you add new storeroom location records. 
Storeroom locations are the names of your inventory storerooms, the places 
inventory items are stored in and issued from. 

This application is used to set the general ledger accounts to be associated 
with each new storeroom location. You can indicate which GL Account code is 

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a storeroom record? Click the New Storeroom button in the 
toolbar.

delete a record? Select Delete Storeroom from the Select 
Action menu.
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to be charged for each type of inventory transaction associated with the 
location. Check with your accounting department if you need information on 
providing the proper GL account codes. 

NOTE: Depending on your company�s business practices, you might need 
security authorization to create storeroom locations and/or to provide 
GL account code information for storeroom locations.

The Ship to and Bill to fields on a storeroom record are used as default 
shipping and billing information by Maximo�s reorder process.

Managing Storerooms

Items are added to and deleted from a storeroom�s master stock list in the 
Item Master application.

You can delete a storeroom record using the Delete Storeroom action 
available from the Select Action menu. You cannot delete a storeroom if there 
are items or tools stocked in it.

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Storerooms Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Tool Records

A tool is a special type of item record, where the item Type = TOOL. Because 
tools are items, they can be managed in the same way that items are managed 
in Maximo, that is, tracked in inventory, reserved in storerooms, issued and 
transferred, charged to work orders, and so forth. The Tools application lets 
you store information about the tools your company uses, both those tools 
owned by your company and those leased from outside vendors.

Tools are typically non-consumable items that have an hourly rate charged 
against them for their use. Some examples of tools include air compressors, 
nail guns, calibration equipment, and heavy equipment such as cranes and 
excavators. 

Multisite and Tool Records

Tools are item records, which are defined at the Item Set level. Item Sets exist 
below the System level, but above the Organization level so that 
Organizations can share data. This means that:

! Key fields for new records must be unique within the Item Set.
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! Records are available to all users in the Organizations that share the Item 
Set and who have security permissions to the application. 

Some of the data on a tool record may be specific to a single Organization or 
Site. For example, storerooms listed on the Storerooms tab are at the Site 
level, and the companies listed on the Vendor tab are at the Organization 
level.

You use the Tool/Organization Details action available from the Select 
Action menu to specify Organization specific data such as Tool Rates, GL 
Account, and Tax Codes for each Organization that uses the Item Set.

Tool Records and Assets

Tool records can be listed as a rotating item on an asset record. Asset records 
where the value in the Rotating Item field is a tool can have a maintenance 
record kept for them in the Assets application, and be tracked as tool 
inventory using the Stocked Tools application.

For more information about rotating item records, see �Item Master Records 
and Assets,� on page 6-20.

For more information about rotating asset records, see �Understanding 
Rotating Assets,� on page 3-11.

Tool Records and Stocked Tools

You create tool records in the Tools application, but tool balances are tracked 
using the Stocked Tools application.

Tool Records and Work Orders

Tools can be listed on job plans and work plans when you are estimating the 
resources that will be required to perform specific work. Tools can also be 
listed on work order actuals, when you are recording the actual costs for labor, 
materials and so on that were required to complete the work order. 

If you want Maximo to create a reservation for a tool listed on a work order, 
check the Reservation Required? check box on the plans tab, and indicate 
which Storeroom the reservation should be made against. All tool 
reservations are deleted when the status of the work order changes to CLOSE.

Using the Tools Application

To access the Tools application, click the application link on your Start 
Center, or select Inventory > Tools from the Go To menu.

The Tools application contains the following tabs:

! List� to search Maximo for tool records.



Chapter 6: The Inventory Module

Maximo 6, 08/2006 6-37

! Tool � to enter, view, or modify tool records, and to specify alternate 
tools.

! Storerooms � to view a read-only list of information about storerooms 
that stock the tool.

! Vendors � to enter, view, modify, or delete information about vendors 
and manufacturers for an item.

! Specifications � to classify a tool and add, view, modify, or delete 
specifications that give details about the attributes of the tool.

Tools Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Rotating Tools application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Tools Help.      

How Do I...

add a commodity group to the database? Select Add/Modify Commodity Codes from 
the Select Action menu.

add or modify a commodity code in a commodity 
group?

Select Add/Modify Commodity Codes from 
the Select Action menu.

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

add a tool to the tool list for a storeroom? Select Add Tools to Storeroom from the 
Select Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a tool record? Click the New Tool button in the toolbar.

delete a record? Select Delete Tool from the Select Action 
menu.

duplicate a record? Select Duplicate Tool from the Select Action 
menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.
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Creating Tool Records

When creating tool records you can:

! add the tool to the tool list for one or more storerooms

! specify the tool rate, GL accounts, associated vendor, and tax codes to be 
used by each Organization

! add a list of vendors that carry the tool

! list the specifications for the tool

! attach documents outside of Maximo that relate to the tool

Duplicating Tools

You can use the Duplicate Tool action to create a copy of an existing tool 
record, for example if you own similar tools with different manufacturers. 
Once you duplicate a tool you can then modify it as needed.

Managing Tool Records

You create tool records using the Tools application, but you manage tool 
balances using the Stocked Tools application. Tools are added to storerooms 
using the Add Tools to Storeroom action in the Tools application.

Deleting Tools

You can delete a tool record using the Delete Tool action available from the 
Select Action menu. 

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Tools Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

specify GL Account codes for a tool? Select Tool/Organization Details from the 
Select Action menu.

specify rates for a tool? Select Tool/Organization Details from the 
Select Action menu.

specify tax codes for a tool? Select Tool/Organization Details from the 
Select Action menu.

How Do I...
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The Planning Module consists of applications used to plan work and create 
templates that can be copied to other Maximo records. 

The Planning Module consists of the following applications:   

You use the Job Plans application to create templates for preventive 
maintenance, repairs, inspections, and other tasks. You include: 

! the steps that must be performed to complete the work 
! the number of workers needed to complete the work and the job skills they 

must have
! the supplies and parts that will be needed
! the services required to complete the work
! the tools that must be available to complete the work 

After these templates are created, they can be useful for planning worker 
schedules, inventory stocks, and budgets.

You use the Safety Plans application to define the safety information that is 
necessary to follow a specific job plan on a work asset. By identifying hazards, 
precautions to be taken against those hazards, and any specified Tag Out 
procedures for the asset or location, you can provide as much safety 
information as possible for your maintenance personnel.

You use the Routes application to list related assets and/or locations that 
require work to be performed along an inspection or maintenance circuit, for 
example listing all the fire extinguishers in a building that require an annual 
inspection. The stops along a route do not need to have the same job plan. A 
route can also act as a simple list of assets or locations.

7 The Planning Module

Application Function

Job Plans Used to create a detailed description of how a job is 
to be performed and the resources required to 
complete it.

Routes Used to list related work assets (assets and/or 
locations) that are considered "stops" along an 
inspection or maintenance route.

Safety Plans Used to create a detailed plan of how to service 
assets or locations safely.

NOTE: The Safety Plans application is documented 
in Chapter 11, "The Safety Module," on page 
11-12.
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Job Plans

A job plan is a template, with detailed description of work to be performed on 
an asset, item, or location. If you use job plans you do not have to enter the 
same information every time you create a work order for similar work. A job 
plan can be applied to an unlimited number of work orders. After you apply a 
job plan to a work order, its resource estimates and tasks are copied into a 
work plan for the work order. You then can modify the work plan so that the 
procedures, labor, materials, services, and tools are more specific to the work 
order, without affecting the original job plan template. 

You use the Job Plans application to create, view, modify, or delete job plan 
records. A job plan typically includes procedural descriptions and lists of 
estimated labor, items and materials, services, and tools to be used on the job. 
To ensure that a job plan is performed in a safe manner, you can add safety 
plan information to the job plan via the assets that use the safety plan.

Multisite and Job Plans

Job Plans are at the System, or database level, but contain optional 
Organization and Site fields that allow you to create job plans at the 
Organization and Site levels.

The Job Plans application allows duplication of key fields, as long as it doesn�t 
create conflicts. The Job Plan application uses the following rules to define 
uniqueness:

1 If there is a job plan at the system level (that is with null values for the 
Organization and Site fields) then no other job plan can share the 
same job plan ID.

2 If there is a job plan at the Organization level (that has a value in the 
Organization field but the Site field is null) no other job plan within 
that Organization can share the same job plan ID.

3 If there is a job plan at the Site level (that has a value in both the 
Organization and Site fields) all other job plans within that 
Organization must have a Site specified if they share the same job plan 
ID.

Job plan records contain optional Organization and Site fields for the job 
plan, and for each job plan task. These fields may be used to specify that a job 
plan or a task has been written for a particular Organization or Site. You can 
use the Organization and Site fields when writing job plans where the task 
details vary by Site. For example you can specify different laborers for 
different Organizations, that materials should come from a different 
storeroom depending on the Site, or that there are different tasks that must 
be performed at a particular Site.

When the Organization and Site fields are null, the information is copied to 
every work order that uses the job plan. When there is Organization and/or 
Site information specified for all or part of the job plan, Maximo copies only 
the job plan information that either matches the work order�s Organization 
and Site or has a null Organization and Site.
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NOTE: Your access to Organizations and Sites determine how much of a job 
plan record you can view. You cannot view job plan lines for 
Organizations and Sites that you do not have security authorization for.

Job Plans and Preventive Maintenance

A job plan can be assigned to an unlimited number of preventive maintenance 
(PM) or master PM records.

A job plan that does not have an Organization or Site specified for it may be 
used on any PM. If the job plan has an Organization and/or Site specified, 
then it can only be used for PMs for that Organization or Site, and cannot be 
used for master PM records (which are at the System level).

Job Plans and Work Orders

A job plan can be applied to an unlimited number of work orders. After you 
apply a job plan to a work order, its resource estimates and tasks are copied 
into a work plan for the work order. You then can modify a work plan so that 
the procedures, labor, materials, services, and tools are more specific to the 
work order, without affecting the original job plan template. 

A job plan that does not have an Organization or Site specified for it may be 
used on any work order. If the job plan has an Organization and/or Site 
specified, then it can only be used for work orders for that Organization or 
Site.

Using the Job Plans Application

To access the Job Plans application, click the application link on your Start 
Center, or select Plans > Job Plans from the Go To menu.

The Job Plans application contains the following tabs:

! List � to search Maximo for job plan records.

! Job Plan � to enter, view, or modify a job plan record. This tab displays 
basic information about the job plan and is the tab where you specify the 
job plan tasks, labor, materials, and tools.

! Work Assets � to associate work assets and their corresponding safety 
plans with job plans.

Job Plans Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Job Plans application. For more detailed information, including 



Using the Job Plans Application

7-4 Maximo 6, 08/2006

prerequisites to performing an action and detailed procedures, refer to the Job 
Plans Help.     

Creating Job Plans

Defining a Job Plan consists of the following steps:

! Defining the tasks by breaking the job down into steps in the Job Plan 
Tasks table window.

! Defining the labor craft/skills and hours on the Labor subtab.

! Defining the materials needed on the Materials subtab.

! Defining the services needed on the Services subtab.

! Defining the tools needed on the Tools subtab.

How Do I...

add steps or tasks to a job plan? On the Job Plan tab, click New Row in the Job 
Plan Tasks table window.

associate the job plan with an asset or location? On the Work Assets tab, click New Row in the 
Work Assets and Safety Plans table window.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a job plan record? Click the New Job Plan button in the toolbar.

delete a record? Select Delete Job Plan from the Select Action 
menu.

duplicate a record? Select Duplicate Job Plan from the Select 
Action menu.

list the labor required for a job plan? On the Labor subtab of the Job Plan tab, click 
New Row to add a laborer or craft to the job 
plan.

list the materials required for a job plan? On the Materials subtab of the Job Plan tab, 
click New Row or Select Spare Parts.

list services required for a job plan? On the Services subtab of the Job Plan tab, click 
New Row.

list tools required for a job plan? On the Tools subtab of the Job Plan tab, click 
New Row.

run reports? Select Run Reports from the Select Action 
menu.

view the estimated costs for a job plan based on 
the labor, materials, services, and tools listed on 
the plan?

Select View Costs from the Select Action 
menu.
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After examining your company�s maintenance activities to identify the kinds 
of work orders that are repeatedly generated, you can create job plans that 
describe these common maintenance jobs. This can help you create estimates 
for the labor, materials, services, and tools that are required for preventive 
maintenance and periodic inspections.

Defining Job Plan Tasks

Each maintenance job can be broken down into a series of steps that must be 
performed to complete the job. Maximo calls these numbered steps or 
operations tasks. The Tasks table window on the Job Plans page contains a 
list of numbered tasks that have been defined for a job plan, along with a 
description of the work to be done for that step, and the estimated time for its 
completion. 

For example, inspecting a fire extinguisher might include the following tasks:

! Check pressure
! Inspect gauge
! Complete inspection tag

You can assign the task�s number to any estimated labor, materials, services, 
and tools that are associated with the task. This is helpful if you want to track 
and report information by task.

Each maintenance job can be broken down into a series of steps that must be 
performed to complete the job. You use the Job Plan Tasks table window to 
define a list of numbered tasks for the job plan, along with a description of the 
work to be done at that step and the estimated hours for its completion. Each 
job plan task can include the following information: 

! Sequence � Used to identify the order in which tasks should be 
performed. Tasks can have the same sequence number if they should or 
could be performed simultaneously. After you apply a job plan to a work 
order, Maximo copies the sequence numbers to the work order's tasks. 
This sequence number can then be used in Maximo Project Manager.

! Task ID � Unique identifier of the task. The default is for Maximo to 
increment task numbers by 10, for example, 10, 20, 30, and so on. This 
gives you the flexibility to add new tasks between existing ones.

! Description � Description of the work to be done for the task.

! Duration � Estimated number of hours to perform the task.

! Meter � The meter associated with the measurement point on an asset, 
for example a pressure gauge. 

Maximo sorts job plan tasks by Sequence, then by Task ID. If a job plan does 
not have a Sequence indicated, the system sorts tasks in numerically 
ascending order by Task ID, making the task with the lowest number the first 
step of your job plan.

You can enter task numbers for estimated labor, materials, services, and 
tools, although you are not required to do so. Task numbers on the subtabs do 
not need to be unique, but must match existing tasks in the job plan.
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The task number you use for estimated labor, materials, services, or tools 
corresponds to the job plan task where it is used. This lets you track estimates 
by task through the use of reports, which can be valuable when the job plan is 
lengthy or complicated.

Defining Job Plan Labor

Some tasks might be performed by any maintenance worker, while others can 
require specialized skills to be performed safely, for example, working with 
electrical current. You use the Labor subtab to define the labor and craft 
needs of a job plan, including the required skill levels, vendor and contract, 
number or workers needed, and estimated hours to complete the work. You 
can specify either a labor or a craft on a line, but not both. 

TIP: Since job plans are templates that can be reused, most planners specify 
crafts rather than laborers when planning labor. This allows planners to 
assign the work to laborers when work orders are created from the job 
plan.

NOTE: Labor records are created in the Labor application. Craft records are 
created in the Crafts application.

Defining Job Plan Materials

If you know that a job requires certain items or materials, for example 
replacement parts, you can record them as part of the job plan. You use the 
Materials subtab to define a materials list for the job plan, including items 
needed, quantity needed, and issuing storeroom and Site.

Each time you add, modify, or delete items or quantities on the Materials 
subtab, Maximo updates the following fields automatically

! Line Cost (Materials subtab)
! Estimated Total Material Cost (View Costs action)
! Total Cost (View Costs action)

NOTE: Item records are created in the Item Master application.

Defining Job Plan Services

If a job plan requires services that your company cannot provide and must 
purchase from an outside vendor, you can record them as part of the job plan. 
You use the Services subtab to define the services that must be purchased for 
the job plan, including the service, quantity, and vendor.

Each time you add, modify, or delete a service or quantity on the Services 
subtab, Maximo updates the following fields automatically

! Line Cost (Services subtab)
! Estimated Total Service Cost (View Costs action)
! Total Cost (View Costs action)

NOTE: Standard service records are created in the Service Items application.

Defining Job Plan Tools

If you know that specific tools are required for a job, you can record that 
information as part of a job plan. You use the Tools subtab to define a list of 
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tools needed by the job plan, including the number of tools needed, tool rate, 
and estimated line costs.

Each time you add, modify, or delete a tool, quantity, hours, or rate on the 
Tools subtab Maximo updates the following fields automatically

! Line Cost (Tools subtab)
! Estimated Total Tool Cost (View Costs action)
! Total Cost (View Costs action)

If you want Maximo to create a reservation for a tool listed on a job plan, 
check the Reservation Required? check box. You do not need to indicate 
which Storeroom the reservation should be made against, since job plans can 
be used by different Sites.

NOTE: Tool records are created in the Tools application.

Associating Work Assets with a Job Plan

You use the Work Assets tab to associate locations, assets, and items to job 
plans. You can assign Safety Plans to individual work assets at the same time. 
The table window displays the assets that have been associated with the Job 
Plan.

You can associate rotating items with a job plan.If you select the Create WO 
When Purchasing This Rotating Asset? check box, Maximo will create a 
work order each time the item is purchased, for example if the rotating asset 
requires installation.

Ownership of Job Plans

Individuals or groups can assume responsibility, or "ownership" of a work 
order in Maximo. You can specify the Owner or Owner Group for a work 
order when you create a job plan.

When a job plan is applied to a work order, the Owner or Owner Group field 
is copied from the job plan to the work order if the Owner or Owner Group 
field on the work order does not already contain a value.

The ownership value listed on a job plan has precedence over any ownership 
value listed on a PM when you generate work orders from a PM.

For more information about ownership of work orders, see �Ownership of 
Work Orders,� on page 14-5.

Duplicating Job Plans

You can use the Duplicate Job Plan action to create a copy of an existing job 
plan, for example if you want to create a similar job plan for two different 
Sites. Once you duplicate a job plan you can then modify it as needed. 

NOTE: When you duplicate a job plan, Maximo duplicates only the portions of 
the job plan that you have security access to view based on your security 
authorizations.
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Managing Job Plans

As a best practice, job plan records that are no longer needed should be 
disabled by having their status changed rather than deleted.

Job Plan Statuses

A Job Plan record can have one of the following statuses:

! DRAFT � Default status for new records. Job plan is still being created 
and has not yet been approved for use on work orders. Job plan records 
with a status of DRAFT cannot be associated with PMs, routes, or work 
orders.

! ACTIVE � Job plans that have been approved for use on work orders. A 
job plan record must be active to be associated with PMs, routes, or work 
orders

! INACTIVE � Job plans that are no longer required, for example one that 
has been replaced by a different job plan. Inactive job plan records do not 
appear in select value lists. Job plan records with a status of INACTIVE 
cannot be associated with PMs, routes, or work orders

Before you can change the status of a job plan record to INACTIVE, the 
following must be true:

! The job plan cannot be referenced on any PMs.
! The job plan cannot be referenced on any routes.

NOTE: When you are searching for a job plan to apply to a work order, job plans 
that have a status of DRAFT and INACTIVE will not be visible. Only 
ACTIVE job plans can be applied to PMs, routes, or work orders

Deleting a Job Plan

If a job plan record is not listed on any other Maximo record (for example 
listed on a work order) it can be deleted by selecting Delete Job Plan from 
the Select Action menu. Maximo will display an error message if the job plan 
can not be deleted.

NOTE: You can only delete a job plan if you have security authorization to view 
all of the job plan, that is access to all Organizations and Sites listed on 
the job plan.

Job Plan Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Routes

A route is a list of related work assets, which can be considered �stops� along 
the route. These route stops can be assets or locations, or a combination of the 
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two. A route can be a simple asset list. You can also create a route that lists 
assets that are related by location, for example all of the servers in a computer 
lab, or by type of asset, such as all fire extinguishers located throughout the 
site. Routes simplify building hierarchies of work orders for inspections. 

You can use a route in the following ways:

! Apply the route to a preventive maintenance record to generate 
inspection-type work orders for all work assets listed as stops on the route. 

! Apply the route to a work order and generate child work orders for each 
work asset listed as a stop on the route. 

Multisite and Routes

Assets and Locations are defined at the Site level. Since Routes are a list of 
assets and or locations, routes are defined at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Routes and Other Applications

You can simplify your maintenance routines by creating a list of assets or 
locations that require the same types of periodic maintenance. You also might 
generate work orders for a list of assets or locations, so that the work can be 
done at the same time, while the labor, materials, and tools are available. In 
Maximo, this list of assets or locations is called a route.

Routes can be applied to records created in the following applications: 

! Changes
! Preventive Maintenance
! Quick Reporting
! Releases
! Work Order Tracking

Using the Routes Application

To access the Routes application, click the application link on your Start 
Center, or select Plans > Routes from the Go To menu. 

The Routes application contains the following tabs:

! List � to search Maximo for route records.

! Route � to enter, view, or modify routes.
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Routes Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Routes application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Routes Help.     

Creating Routes

Before you can apply a route to a work order or PM, you must create it in the 
Routes application. You can list both assets and locations on a single route. 
You can also enter a Sequence number to indicate that the stops should be 
worked on in a certain order.

NOTE: Before you can add assets or locations to a route, you must first create 
records for them in the Assets or Locations applications.

TIP: Routes for rotating assets (for example fire extinguishers) should be 
created by location, since actual assets at each location may change over 
time.

Managing Routes

You can add, modify, or delete route stops at any time. You can modify or 
delete routes at any time.

Routes Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide. 

How Do I...

add an asset or a location as a route stop? Click New Row in the Route Stops table 
window.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a route record? Click the New Route button in the toolbar.

delete a record? Select Delete Route from the Select Action 
menu.

duplicate a record? Select Duplicate Route from the Select Action 
menu.

remove an asset or location as a route stop? In the Route Stops table window, click Mark 
Row for Delete next to the stop you want to 
remove.

run reports? Select Run Reports from the Select Action 
menu.
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Preventive maintenance (PM) work is maintenance work performed on a 
regular schedule in order to keep assets running efficiently. The applications 
in the Preventive Maintenance module can help you to plan and budget for 
regular maintenance work by planning the labor, material, service, and tool 
needs of your regularly scheduled maintenance and inspection work orders.

The Preventive Maintenance module consists of the following applications:    

You use the Master PM application to create generic maintenance templates. 
These can be for preventive maintenance, inspections, or any other type of 
periodic work. You can specify the frequency that the work should be 
performed, seasonal dates that apply to the PM, and one or more job plans 
that apply to the PM. Job plans are created in the Job Plans application. Job 
plans list tasks, labor, materials, service, and tool requirements needed to 
complete preventive maintenance, inspection, or other work that can be 
planned in advance.

Once you have created a Master PM you can use it to create associated PMs. 
Associated PMs are non-master PMs that are created and managed in the 
Preventive Maintenance application and are for a specific asset or location. 
Non-master PMs are used to generate preventive maintenance work orders 
for assets and locations.

Master PMs vs. Preventive Maintenance Records

Master PM records are defined at the System, or database level in Multisite. 
You use the Master PM application to define generic preventive maintenance 
records, either for general maintenance, or for rotating items (For more 
information about rotating items, see �Item Master Records and Assets,� on 
page 6-20).   You do not generate work orders with Master PMs or include 
them in PM hierarchies. Master PM records can be used to create Site specific 
associated PM records. When you use a Master PM to create an associated 
PM, Maximo copies the data to the associated PM, which can then be modified 
as needed.

8 The Preventive 
Maintenance Module

Application Function

Master PM Used to create generic preventive maintenance 
templates.

Preventive 
Maintenance

Used to plan periodic, preventive maintenance, and 
inspections for assets and locations.
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Preventive Maintenance (PM) records are defined at the Site level You create 
PM records for a specific asset or location, at a specific Site. PM records can 
only be used to generate PM work orders at their specified Site. You can group 
PM records into hierarchies that reflect asset or location hierarchies.

Master PM Records

A Master PM is a template used to create other PM records. You can create 
generic Master PMs for general preventive maintenance or inspection tasks, 
for example a generic list to be used for a facilities inspection. You can also 
create Master PM records for rotating items, which can be used to create 
associated PM records for assets and locations that have the rotating item 
listed on their records.

A Master PM record is not used to generate work orders, it is used to create 
associated PM records, which are managed in the Preventive Maintenance 
application. Associated PM records contain Site specific information and are 
used to generate work orders for assets and locations. You can also use Master 
PMs to automatically update information on associated PMs.

Multisite and Master PM Records

Master PMs are at the System, or database level. This means that:

! Key fields for new records must be unique within the Maximo database.

! Records are available to all users of the database who have security 
permissions to the application. 

When you list a rotating Item on a Master PM, you must specify which Item 
Set the item belongs to. The same item record may appear in more than one 
Item Set, but the selected Item Set will determine which Organizations can 
use the Master PM. For more information about Item Sets, see �Inventory and 
Multisite - Item Sets,� on page 6-3.

Master PM Records and Items

When you create new Master PMs Maximo enters a value in the Item Set 
field based on the Site listed on your person record. You have the option of 
specifying a rotating Item for the Master PM.   By default Maximo checks the 
Create Associated PMs for Item�s Location? and Create Associated 
PMs for Item�s Asset? check boxes, which allows you to create associated 
PMs for any asset or location record that lists the item in the record�s 
Rotating Item field.

Master PM Records and Job Plans

You can specify one or more job plans on a Master PM record. A job plan 
describes the tasks that need to be performed on a work order, and the labor, 
materials, services, and tools that will be needed. Job plans are created in the 
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Job Plans application. Job plans are usually asset specific, they are written for 
a specific asset, item, or location.

Job plans are defined at the System level in Multisite, but can contain Site 
specific details. When Maximo copies job plan data to a PM work order, it 
copies the information on the job plan that applies to the work order Site.

NOTE: Job plans that have a Site specified for the record cannot be associated 
with a Master PM because they are Site specific.

Master PM Records and Preventive Maintenance

Master PM records are templates, that are used to create other PM records 
via the Create Associated PMs action in the Master PM Select Action menu. 
Associated or non-master PM records are viewed and managed in the 
Preventive Maintenance application. You can use the Update Associated 
PM action in the Master PM application to copy updated information from a 
Master PM to it�s associated PMs.

NOTE: The information that can be copied when you use the Update 
Associated PM action is governed by settings on both the Master PM 
and associated PM records. For more information, see �Updating 
Associated PMs,� on page 8-7.

Using the Master PM Application

To access the Master PM application, click the application link on your Start 
Center, or select Preventive Maintenance> Master PM from the Go To 
menu.

The Master PM application contains the following tabs:

! List � to search Maximo for master PM records.

! Master PM � to enter, view, or modify master PM records.

! Frequency � to enter, view, or modify scheduling criteria to use when 
generating work orders.

! Seasonal Dates � to specify a PM's active months or seasons.

! Job Plan Sequence � to add, view, modify, and sequence a progression 
of job plans for PM work.

Master PM Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Master PM application. For more detailed information, including 
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prerequisites to performing an action and detailed procedures, refer to the 
Master PM Help.    

Creating Master PMs

Master PMs are templates for other PM records. You can create generic 
Master PMs for general preventive maintenance or inspection tasks, for 
example a generic list to be used for a facilities inspection. You can also create 
Master PM records for rotating items, which can be used to create associated 
PM records for assets and locations that have the rotating item listed on their 
records.

When you create a Master PM you can specify 

! how frequently work orders should be generated from the PM, based on 
either elapsed time or meter readings

! the active days and dates when work orders can be generated

! one or more job plans that should be used when work orders are generated 
from the PM, and the sequence be followed when applying multiple job 
plans to work orders

Setting PM Frequency

You use the Frequency tab to specify how often work orders should be 
generated from a PM. You must specify a frequency for a PM before Maximo 
can use it to generate work orders. You do not generate work orders from a 
Master PM, but the frequency data is copied to associated PMs created from 
the Master PM.

The Frequency tab contains two subtabs

! Time Based Frequency � Used to define the Frequency Units (days, 
weeks, months, and years) and Frequency that should be used when 
generating time based PM work orders.

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

copy updated information from a Master PM 
record to its associated PMs?

Select Update Associated PMs from the 
Select Action menu.

create associated PM from a Master PM record? Select Create Associated PMs from the Select 
Action menu.

create a master PM record? Click the New Master PM button in the 
toolbar.

delete a record? Select Delete Master PM from the Select 
Action menu.

duplicate a record? Select Duplicate Master PM from the Select 
Action menu.
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! Meter Based Frequency � Used to define one or more Meters and the 
criteria that determines when PM work orders should be generated based 
on meter readings.

NOTE: You can only list continuous type meters on a Master PM. For more 
information about types of meters, see �Meter Types,� on page 3-35.

You can create PMs that generate work orders based on elapsed time between 
work orders, or meter readings, or both. Typically PMs for assets measure 
both elapsed time between work orders and changes to meter readings. 
Although locations also support meters, typically PMs for locations are based 
solely on elapsed time between work orders.

Setting Seasonal Dates

You use the Seasonal Dates tab to specify the active days, dates, or seasons for 
a PM. For example, your plant runs a five day week, and does not run on 
Saturday or Sunday. If you do not want Maximo to generate PM work orders 
that are due on the weekend you would clear the Saturday? and Sunday? 
check boxes.

If the PM is for seasonal work such as air conditioning maintenance, or 
servicing snow removal equipment, you can use the Active Dates table 
window to indicate the start and end dates for the period of time that the PM 
should be active. You can list multiple active periods. When Maximo 
generates PM work orders, it checks the active dates listed on the Seasonal 
Dates tab.

CAUTION: Maximo only considers seasonal dates for PMs that are time based. 
Meter based frequencies are not affected by seasonal dates.

Job Plan Sequencing

You use the Job Plan Sequence tab to specify the order that job plans should 
be applied to PM work orders. The value in the Sequence field indicates that 
Maximo should use the job plan every Nth time that work orders are 
generated, where n = the sequence number. For example, if you have a job 
plan for monthly maintenance and a different job plan to be used once a 
quarter, the sequence for the monthly job plan would be "1" (every month) and 
the sequence for the quarterly job plan would be "3" (every three months). The 
following table contains some examples of sequencing for time based monthly 
maintenance.     

Monthly 
maintenance.

Monthly 
maintenance 
with a separate 
job plan for 
quarterly 
maintenance.

Monthly 
maintenance, 
with a separate 
job plan for six 
month and 
twelve month 
maintenance.

Month Sequence Sequence Sequence

January 1 1 1

February 1 1 1

March 1 3 1
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Managing Master PMs

Once you have created a Master PM, you can create and update associated 
PMs based on information on the Master PM.

Creating Associated PMs

Associate PM records are records for specific assets or locations that are 
created from a Master PM or contain a reference to the Master PM. For 
example, you could create a master PM for regular oil changes for a certain 
model truck. Using that master PM, you could then create one associate PM 
for each truck of that model in your fleet.

Associate PMs can be created in two ways:

! Create associate PMs from a master PM using the Create Associated 
PMs action.

! Associate existing PMs with a master PM by entering an identifier in the 
record�s Master PM field.

The Create Associated PMs dialog box contains two tabs, assets and locations. 
The tabs display all assets and locations that 

! contain the rotating item listed on the Master PM
! do not already have a PM that references this Master PM
! have a status of NOT READY or ACTIVE
! belong to Sites that you have permission to view

NOTE: If the Create Associated PMs for Item�s Location? check box has 
been cleared, you cannot create associated PMs for locations. If the 

April 1 1 1

May 1 1 1

June 1 3 6

July 1 1 1

August 1 1 1

September 1 3 1

October 1 1 1

November 1 1 1

December 1 3 12

Monthly 
maintenance.

Monthly 
maintenance 
with a separate 
job plan for 
quarterly 
maintenance.

Monthly 
maintenance, 
with a separate 
job plan for six 
month and 
twelve month 
maintenance.

Month Sequence Sequence Sequence
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Create Associated PMs for Item�s Asset? check box has been 
cleared, you cannot create associated PMs for assets.

Updating Associated PMs

A Master PM can be associated with PMs at more than one Site. When you 
use the Update Associated PMs action to update PM records, you can select 
which Sites you want to update.

Maximo updates the associated PMs if the PM references the Master PM and 
the Override Updates from the Master PM? check box on the associated 
PM record is cleared 

NOTE: Maximo only updates PMs for an asset or location if the meters on the 
asset or location record match all of the meters listed on the Master PM. 

Maximo copies information from the Master PM to the associated PM under 
the following conditions:

! If the Update Existing PMs? check box on the Frequency tab of the 
Master PM is selected, Maximo copies the values from the Extended 
Date and Adjust Next Due Date? fields to the associated PM.

! If the Update Time Based Information on Existing PMs? check box 
on the Time Based Frequency subtab of the Master PM is selected, 
Maximo updates the Frequency, Frequency Units, and Alert Lead 
(Days) fields.

! If the Update Meter Based Information on Existing PMs? check box 
on the Time Based Frequency subtab of the Master PM is selected, 
Maximo updates the Frequency, Alert Lead, and Generate WO Ahead 
By fields.

! If the Update Existing PMs Seasonal Dates? check box on the Seasonal 
Dates tab of the Master PM is selected, Maximo updates seasonal date 
information.

! If the Update Job Plan Sequence in Existing PMs? check box on the 
Job Plan Sequence tab of the Master PM is selected, Maximo updates the 
job plan sequence. 

Deleting Master PMs

If a Master PM record does not have any associated PMs it can be deleted by 
selecting Delete Master PM from the Select Action menu. Maximo will 
display an error message if the Master PM can not be deleted.

Master PM Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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Preventive Maintenance Records

A Preventive Maintenance (PM) record is a plan to perform periodic work 
on an asset or location, or a group of assets and locations that are listed on a 
route.

Many assets and locations require regular maintenance to ensure 
uninterrupted efficiency and to guard against breakdowns. Assets and 
locations may also require other non-preventive maintenance work that must 
also be figured into maintenance schedules, for example, periodic inspections.

You use the Preventive Maintenance (PM) application to create PM records 
for preventive maintenance, periodic maintenance, or periodic inspections or 
certifications. You define how often work should be performed based on the 
elapsed time and meter readings and seasonal dates. You can list job plans on 
the PM, which estimate the labor, materials, services, and tools needed to 
complete the work. When you generate work orders from the PM, Maximo 
copies job plan and safety plan information to the work order.

You can also group PMs into hierarchies that match your asset or location 
hierarchies. When you generate work orders from the PM, Maximo creates a 
work order hierarchy from the PM hierarchy.

Ownership of Preventive Maintenance Records

Individuals or groups can assume responsibility, or "ownership" of a work 
order in Maximo. When a group owns a work order, all members of that group 
see the work order in their Work View. If a member of a group takes 
ownership of a work order, they are responsible for managing the work order 
until it is complete, or delegated to another group or person.

Job plan and preventive maintenance records contain Owner and Group 
Owner fields, and when you generate a PM work order or apply a job plan to 
a work order, Maximo automatically copies the values in these fields to the 
work order. You can also assign ownership to a work order using the Select 
Owner and Take Ownership actions available in the Work Order Tracking 
application. Your company may also design a Workflow process that assigns 
ownership of work orders.

NOTE: When you generate a work order from a PM, the Owner or Owner 
Group listed on a Job Plan takes precedence over the Owner or 
Owner Group listed on a PM record.

Multisite and Preventive Maintenance

PM records are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.
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Preventive Maintenance Records and Assets/Locations

You create PM records for a specific asset or location record. You can create 
multiple PMs for identical assets or locations using one of two methods:

! If the asset or location record lists a Rotating Item you can create a 
Master PM with the same Item. You can use the Master PM to create 
associated PMs for each individual asset or location.

! If the asset or location record does not list a Rotating Item you can create 
a PM record for one of the assets or location, then use the Duplicate PM 
action to create a PM for each additional asset or location.

Preventive Maintenance Records and Job Plans

You can specify one or more job plans on a PM record. A job plan describes the 
tasks that need to be performed on a work order, and the labor, materials, 
services, and tools that will be needed. Job plans are created in the Job Plans 
application. Job plans are usually asset specific, they are written for a specific 
asset, item, or location.

Job plans are defined at the System level in Multisite, but can contain 
Organization and Site specific details. When Maximo copies job plan data to a 
PM work order, it copies the information on the job plan that applies to the 
work order Site.

Preventive Maintenance Records and Master PMs

You can create PM records from a Master PM, or associate existing PMs with 
a Master PM. Master PMs can update information on associated PMs based 
on settings on both the PM and the Master PM record. For more information, 
see �Updating Associated PMs,� on page 8-7.

Preventive Maintenance Records and Routes

You use the Routes application to create lists of related work assets, which are 
considered �stops� along the route. These route stops can be assets or 
locations, or a combination of the two. When you list a route on a PM record 
and generate work orders, Maximo creates a work order hierarchy with a top 
level work order, and child work orders for each of the route stops.

Preventive Maintenance Records and Safety Plans

You do not define safety information on a PM record. Safety information is 
defined on asset, item, and location records. You can also define safety 
information on job plans. 

When you include asset, item, job plan, or location records that contain safety 
information on a PM, when you generate work orders Maximo copies the 
safety information to the work order.
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Preventive Maintenance Records and Work Orders

You use PM records to generate work orders. Maximo generates work orders 
based on options set by your system administrator and the frequency, date 
criteria, and meters listed on the PM record. When Maximo creates work 
orders, it copies job plans to the work orders based on the data entered on the 
Job Plan Sequence tab of the PM.

Using the Preventive Maintenance Application

To access the Preventive Maintenance application, click the application link 
on your Start Center, or select Preventive Maintenance > Preventive 
Maintenance from the Go To menu.

The Preventive Maintenance application contains the following tabs:

! List � to search Maximo for PM records.

! PM � to enter, view, or modify Preventive Maintenance records and 
associate them with assets, locations, or GL accounts. 

! Frequency � to enter, view, or modify scheduling criteria for the 
generation of work orders. 

! Seasonal Dates � to specify a PM's active months or seasons.

! Job Plan Sequence � to add, view, modify, and sequence a progression 
of job plans for PM work.

! PM Hierarchy � to enter, view, or modify PM hierarchies to generate 
scheduled work order hierarchies.

Preventive Maintenance Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Preventive Maintenance application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Preventive Maintenance Help.      

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

change the value in the Counter field? Select Set PM Counter from the Select Action 
menu.

create a preventive maintenance (PM) record? Click the New PM button in the toolbar.

delete a record? Select Delete PM from the Select Action menu.
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Creating PMs

You use the Preventive Maintenance application to create PM records. You 
can also create PM records in the Master PM application via the Create 
Associated PMs action. 

When you create a PM record you specify an Asset, Location, or Route for 
the PM. You can create a PM record for either an asset or location, but not 
both. You define how often work should be performed based on the elapsed 
time and meter readings and seasonal dates. You can list job plans on the PM, 
which estimate the labor, materials, services, and tools needed to complete the 
work.

CAUTION: You must set a frequency for a PM before Maximo can generate work 
orders from it.

Setting Priority for PMs

Maximo uses values between 0 and 999 to indicate priority for work orders, 
assets, and locations. Since preventive maintenance is designed to reduce 
corrective work orders, the priority values set for PM records should be higher 
than the values used for corrective maintenance. For information about 
recommended priority values, see �Work Order Priority,� on page 14-4.

Priority values specified for PMs are copied to the work orders that are 
generated from the PM in the following manner:

! When there is a PM hierarchy and the child PMs have priorities, the 
priority of the parent PM is copied to the parent work order, and the 
priorities of the child PMs are copied to the child work orders.

! When a PM has a job plan the PM priority is copied to the work order, and 
the job plan priority is copied to the work order tasks. 

! If the PM does not have a priority, the job plan priority will be copied to 
the work order as well as the tasks.

duplicate a record? Select Duplicate PM from the Select Action 
menu.

enter a meter reading after a work order has 
been completed?

Select Set Reading at Last WO from the 
Select Action menu.

generate a work order based on one or more 
PMs?

Select Generate Work Orders from the Select 
Action menu.
TIP: You can use the List tab to generate work 

orders from multiple PMs.

run reports? Select Run Reports from the Select Action 
menu.

view the job plan sequence for work orders 
generated based on the PM?

Select View Sequence from the Select Action 
menu.

How Do I...
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! If the job plan does not have a priority, the PM priority will be copied to 
the tasks as well as the work order.

When a PM has a route with priorities from a job plan, the PM priority will be 
copied to the work order, and the job plan priorities will be copied to the child 
work orders created for each route stop.

Setting PM Frequency

You use the Frequency tab to define the schedule for how often Maximo 
should generate work orders for the PM. You can create a PM schedule to 
generate work orders based on elapsed time between work orders or changes 
to asset meter readings over time, or both. For example, you might want to 
change the oil in a vehicle every three months or 3,000 miles, whichever comes 
first. 

For time based PMs you specify the number of days between generating PM 
work orders using the following fields:

! Frequency � Number of time units (days, weeks, months, or years) to 
elapse between work orders you generate from this PM. 

! Frequency Units � Defines the time units (days, weeks, months, or 
years) for the Frequency field. 

! Estimated Next Due Date � Date the next work order is scheduled to 
be generated from the PM. This field should contain a value for Maximo to 
be able to generate work orders.

A typical PM schedule for an asset measures both elapsed time between work 
orders and changes to meter readings. The Generate WO Based on Meter 
Reading (Do Not Estimate)? check box allows you the option to generate 
work orders based on either an estimated next due date, or on the actual 
meter reading.

! checked (Yes) � This option does not allow Maximo to generate work 
orders until the specified meter reading has been reached. This is useful 
when the asset use schedule fluctuates, for example seasonal assets or 
fleet vehicles.

! empty (No) � This option allows Maximo to use an estimated due date to 
generate work orders. This estimate is based on elapsed time and average 
changes in meter readings. This option allows work orders to be generated 
even if meter readings are not entered as often as they should be. This is 
useful if the asset is in continuous operation, for example manufacturing 
plants.

Setting Seasonal Dates

For information about setting seasonal dates, see �Setting Seasonal Dates,� on 
page 8-5.

Job Plan Sequencing

For information about job plan sequencing, see �Job Plan Sequencing,� on 
page 8-5.
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PM Hierarchies

A PM hierarchy is a group of PMs arranged in parent-child relationships. At 
the highest level of a PM hierarchy, one PM that is the parent. This top-level 
PM can have one or more child PMs. Each child PM can have one or more 
children, and so on. A child PM can have only one parent PM. You can create 
PM hierarchies that mirror your asset and location hierarchies.

You use PM hierarchies to generate hierarchies of scheduled work orders. 
When one PM in the hierarchy is due to be generated, Maximo generates PM 
work orders for every PM in the hierarchy. You can add a sequence number to 
each PM in a PM hierarchy; the sequence number is copied to work orders you 
generate from the PM. 

You cannot delete a PM record that is part of a hierarchy. PM records that 
have a parent or child PMs must be removed from their hierarchies before you 
can delete them. 

Managing PMs

Managing PMs includes generating PM work orders and keeping track of the 
status of assets and locations. 

Generating PM Work Orders

You can generate work orders from a PM record in one of three ways:

! Automatically (Time based) � Your system administrator can use the 
Cron Task application to set up a PM cron task. A cron task is a software 
command to execute a task at a particular time.

! Automatically (Meter based) � If you select the Generate WO When 
Meter Frequency is Reached? check box, Maximo automatically checks 
to see if PM work orders should be generated every time meter readings 
are entered for an asset or location.

! Manually � Use the Generate Work Orders action available from the 
Select Action menu to generate work orders from one or more PM records. 
You can use the List tab to select multiple PMs to use to generate work 
orders.

When you generate work orders from a PM, Maximo checks the frequency 
criteria and determines if a work order should be generated. If the frequency 
criteria has not been met, no work orders are generated. If the asset or 
location does not have a status of ACTIVE, no work orders are generated. If 
the frequency criteria have been met, Maximo creates PM work orders, which 
can be viewed and managed using the Work Order Tracking application.

NOTE: Frequency must be set for a PM before work orders can be generated 
from it.

PM Statuses

A PM record can have one of the following statuses:
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! DRAFT � Default status for new records. PM is still being created and 
has not yet been approved for use. PM records with a status of DRAFT 
cannot be used to generate work order records.

! ACTIVE � A PM record must be active before it can be used to generate 
work orders.When you change a PM�s status to ACTIVE, Maximo 
automatically checks to make sure that the asset or location listed on the 
PM is in a status of either NOT READY or ACTIVE. You cannot change a 
PM status to ACTIVE if the asset or location listed on the PM is 
DECOMMISSIONED.

! INACTIVE � PM records with a status of INACTIVE cannot be used to 
generate work orders. 

TIP: When you change the status of a PM record that is the top level of a PM 
hierarchy, you can also change the status of all of the records in the 
hierarchy by selecting the Roll new status to all child PMs? check box 
in the Change Status dialog box.

Preventive Maintenance Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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The Purchasing Module is one of the Maximo modules devoted to financial 
and purchasing functions. The Financial Module allows administrators to set 
up currency codes, exchange rates, the Chart of Accounts that users access via 
the GL Account Navigator, and to perform cost management. The Contracts 
Module allows you to create master contracts, purchase contracts, lease/rental 
contracts, labor rate contracts, and warranty contracts. The Purchasing 
Module tracks requests for and purchases of materials and services, receipt of 
the purchases, and invoices for the purchases.

The Purchasing Module consists of the following applications:   

9 The Purchasing Module

Application Function

Companies Used to manage records for manufacturers, 
vendors, and other companies that do business with 
you.

Company Masters Used to define companies that belong to a Company 
Set that can be shared by one or more 
Organizations.

Invoices Used to record invoices and match against purchase 
orders and receipts for approval.

Purchase Orders Used to purchase materials or services from an 
internal supplier or an external vendor. 

Purchase 
Requisitions

Used to request the ordering of materials or 
services.

Receiving Used to receive materials into inventory and record 
the receipt of services.

Request for 
Quotation

Used to request and manage vendor quotations for 
prices and delivery information for goods and 
services.

Terms and 
Conditions

Used to enter and maintain a library of terms and 
conditions to be used on contracts and purchasing 
documents. These terms can contain information 
such as liability concerns, shipping and handling 
details, or delivery time expectations.

NOTE: The Terms and Conditions application is 
documented in "Terms and Conditions," in 
Chapter 4, "The Contracts Module," on page 
4-20.
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Obtaining the materials and services required to complete work is an 
important part of any maintenance process. As inventory balances decrease in 
the storerooms, you must replenish these balances. 

You use the Company Master and Companies applications to create records 
for the vendors that provide you with goods and contract labor, other service 
providers, and asset manufacturers. Any value appearing in a Company or 
Vendor field on a Maximo record should have a company record associated 
with it.

You can use the Terms and Conditions application to create a library of terms 
that can be used on purchasing records. These terms and conditions can also 
be used in the Contracts module when you are creating records for labor rate, 
lease/rental, master, purchasing, or warranty contracts.

You use the Purchase Requisitions application to request the purchase or 
goods or services. Purchase requisitions created automatically via the 
inventory reorder process are also visible in the Purchase Requisitions 
application. Purchase requisitions can also be created via Workflow from 
material requisitions (MRs) created in the Desktop Requisitions application 
described in �Desktop Requisitions Module,� on page B-9.

Depending on your business processes, Maximo may automatically create 
purchase orders (POs) from PRs, or a purchasing agent may need to review 
and approve the PR before creating a PO. Large purchases may require the 
creation of a request for quotation (RFQ). You use the Request for Quotations 
application to create RFQs, record the vendors that the RFQ is sent to and the 
quotations received, and to award the quotation lines to one or more vendors. 
Once you have awarded quotation lines, you can create purchase contracts 
and POs from an RFQ.

You use the Purchase Orders application to create and manage purchase 
orders for items, materials, services, tools, and so forth. Purchase orders 



Chapter 9: The Purchasing Module

Maximo 6, 08/2006 9-3

created automatically via the inventory reorder process are also visible in the 
Purchase Orders application.

You use the Receiving application to record the receipt of ordered items and 
materials. When you receive items, Maximo increases balances in the 
Inventory application or issues direct issue items directly to an asset, location, 
or work order. You can use the Receive Rotating Items action to create 
records in the Assets application for rotating assets.

You use the Invoices application to record invoices received from vendors, 
which can be matched to POs. You can also manage scheduled payments for a 
contract in the Invoices application.

Purchasing and Inventory

The Purchasing module works closely with the Inventory module to maintain 
balances of items and materials in company storerooms. 

When you reorder items either manually (using one of the reorder actions in 
the Inventory application), or automatically (via a reorder cron task set up by 
your system administrator), Maximo automatically creates one or more 
purchasing records for the reorder. Exactly what type of purchasing records 
are created is based on settings controlled by your system administrator. Your 
system administrator can configure Maximo so that when purchase requests 
are received one of the following types of records is created:

! Unapproved purchase requisitions (PRs)
! Approved purchase requisitions (PRs)
! Unapproved purchase orders (POs)
! Approved purchase orders (POs)

Internal vs. External Purchases

In order to centralize purchasing all inventory purchasing might be done 
through a central storeroom with all other storerooms "purchasing" their 
stock from that central storeroom. 

Maximo supports this type of purchasing by allowing you to create two 
different types of purchase requisitions and purchase orders. Both PR and PO 
records contain an Internal? check box in the Vendor section of the record 
which is used to indicate if the PR/PO is an internal or external purchase.

! Internal PR/PO � requesting the transfer of materials from another 
company storeroom. When making internal purchases select the 
Internal? check box and enter Storeroom and Storeroom Site 
information.

! External PR/PO � requesting the purchase of the necessary materials or 
services from an outside vendor. When creating external PRs/POs you 
should leave the Internal? check box empty and enter Company 
information. 

When creating a PR/PO you can fill in either the Vendor or the Storeroom 
field, but you can not enter data in both fields. When the Internal? check box 
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is empty the Company field is editable and the Storeroom field is read-only. 
Selecting this check box makes the Storeroom field editable and the 
Company field read-only. You must specify either a Vendor or a Storeroom 
on a purchase order.

You can create internal PRs and POs that specify a storeroom in a different 
Site and Organization within Maximo. You use the Issues and Transfers 
application in the Inventory module to transfer items from the "vendor" 
storeroom to the "purchasing" storeroom. When you transfer items across 
Organizations that require inspection, a courier must be used.

If your company uses a centralized purchasing department you can create 
purchase orders from purchase requisitions created at different Sites in an 
Organization. Maximo stores the Ship To information for an individual line 
item on the PO line. When you combine multiple purchase requisitions into a 
single PO, Maximo copies the Ship To information for each line from the PR. 

Line Types

Purchase requisitions (PRs) and purchase orders (POs) list each item or 
service to be purchased on a separate line. Each PR or PO line must have a 
Line Type specified for it. Maximo allows you to select from the following 
default Line Types:

! ITEM � (the default) Use to order inventory items, that is items that 
have item records created for them in the Item Master application.

! MATERIAL � Use to order items or materials on a one time basis, that is 
items that do not have item records created for them in the Item Master 
application. You must enter a description, quantity, cost, and charge 
value. The charge value can be a work order, location, asset, or GL 
Account code.

! SERVICE � Use to order services on a one time basis, that is services 
that do not have records created for them in the Service Items application. 
Services require a description, line cost, and charge value. The charge 
value can be a work order, location, asset, or GL Account code. 

! STDSERVICE � Use to order service items, that is services that have 
records created for them in the Service Items application.

! TOOL � Use to order tools, that is tools that have records created for 
them in the Tools application.

In addition there is one additional line type:

! SPORDER � Use to special order items or materials AND create an item 
record in the Item Master application for the item.

NOTE: Your system administrator determines if this option is enabled.
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Commodity Codes

Commodity codes can be defined and managed using the Add/Modify 
Commodity Codes action available from the Select Action menu of the 
following applications:

! Companies
! Item Master
! Purchase Orders
! Service Items 
! Tools

Classifying items and services with commodity groups and commodity codes 
provides a way for you to analyze spending by item type.   Once you have 
defined commodities you can associate them with company, contract, and item 
records. You can also associate commodities with individual PR or PO lines for 
items, service items, or tools that do not have commodity codes assigned to 
them, including special order materials or services.

NOTE: Commodity group or commodity code information added to a PR Line or 
PO Line is not copied to item records. 

Purchasing and Contracts

The Purchasing module works closely with the Contracts module to define the 
specific financial relationship between buyer and seller.

Company records and contracts are both defined at the Organization level, 
whereas most purchasing is done at the Site level. When you enter a contract 
in one of the contracts applications, you must use the Authorize Sites action 
to authorize each Site that you want to be able to use the contract.

Terms and Conditions

You use the Terms and Conditions application to create and maintain a 
library of terms and conditions that describe the legal obligations between a 
buyer and a seller. Terms and conditions appear on records in the following 
applications:

! All contracts (Contracts Module)
! Invoices
! Purchase Requisitions 
! Purchase Orders
! Requests for Quotation

NOTE: If the Editable on Use? check box is selected for a term you cannot edit 
the term once it has been copied to a record.

The terms and conditions in the library can be added to a contract from the 
Terms and Conditions tab of the individual applications. You can also create 
terms via the New Row button on the Terms and Conditions tab, but terms 
created in this manner are saved to the record and are not added to library.
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For more information about terms and conditions, see �Terms and 
Conditions,� on page 4-20.

Purchase Contracts

You can use the View Contracts button on the PR Lines tab of the Purchase 
Requisitions application and the PO Lines tab of the Purchase Orders 
application to view a list of contracts for the line item. If you have not 
specified a vendor on the record, the View Contracts dialog box lists all 
vendors with whom you have a contract for the line item. If there is a vendor 
specified on the record, the View Contracts dialog box lists only contracts that 
contain that item/vendor combination.

When you are creating a purchase requisition or purchase order that lists a 
lease/rental or purchase contact in the Reference Contract field you can use 
the Contract Items button on the PR Lines or PO Lines tab. The Contract 
Items dialog box allows you to view and select from the line items listed on the 
contract.

You use the applications in the Contracts module to create contract records, 
but you can also create contracts based on information contained on records in 
the Purchasing module. 

! You can create Blanket (Volume), Pricing, and Purchase type contracts via 
the Create Contract action in the Purchase Requisitions and Purchase 
Orders application.

! You can create Blanket (Volume), Pricing, and Purchase type contracts via 
the Create Contract button in the Request for Quotations application.

Creating Purchasing Records from Contracts

Purchasing records can be created in the Contracts module. You can create 
purchasing records using the following actions available in the Purchase 
Contracts application:

! Create RFQ action
! Create Release PO action

Types of Purchase Orders

Maximo uses the following types of purchase orders:

! CHG � Change. A change order is a duplicate purchase order generated 
from an approved purchase order. If you must change an approved PO that 
has no receipts, you might prefer to do so by creating a change order. The 
change order preserves the audit trail by retaining the original PO while 
you make the necessary changes to the change order PO.

! PARTS � Parts. Used to indicate that the purchase order is for work 
order parts.

! REL � Released. Maximo creates a release type PO when you use the 
Create Release PO action available in the Purchase Contracts 
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application. A blanket release is a purchase order that you generate 
from a purchase contract. Your system administrator can set Maximo so it 
automatically approves REL type POs generated from valid contracts. 

NOTE: Release type POs cannot be duplicated using the Duplicate 
Purchase Order action. They also cannot be changed to a change 
(CHG) type PO.

! SERV � Service. Used to indicate the purchase order is for services.

! STD � Standard. This is the default type for purchase orders created in 
the Purchase Orders application.

NOTE: You might need security authorization to change a PO type.

Payment Schedules

A payment schedule is a planned payment, usually a payment set up for a 
leased or rented asset or location, or a payment for a service or warranty 
contract. When you create a contract that requires a series of scheduled 
payments you first define the Payment Period using the Set Schedule dialog 
box. Then you use the Manage Payments action available in the Lease/
Rental Contract and Warranty Contracts applications to generate a payment 
schedule for each asset listed on the contract.   Maximo creates an invoice 
with a status of SCHED (scheduled) for each installment payment in the 
schedule.

If the Payment Schedule? check box on a purchase contract is selected, the 
Payment Schedule button can be used to create a payment schedule for 
purchases made against the contract. For example, if a purchase contract 
requires a 50% down payment, with the remaining 50% due upon receipt of 
the order.

If your system administrator activates the "invoice due" escalation, Maximo 
automatically changes the status of an invoice from SCHED to either WAPPR 
or APPR when the Due Date on the invoice is reached.

Company Records

A company master record in Maximo represents a vendor from whom you 
purchase goods or services, asset manufacturers, and other companies that 
you do business with.

A company record contains Organization specific information about a 
vendor, such as contact names and addresses. If a company has multiple 
locations you can create separate records for each branch location and 
associate them with a parent company record.

NOTE: Company information must be entered in the Companies application 
before other applications, such as Inventory and Purchasing, can access 
it.
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Multisite and Company Records

Company records are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

Company Records vs. Company Master Records

Company Master records define the records that belong to a Company Set. 
Company Sets exist below the System level, but above the Organization level 
so that Organizations can share data. Each Organization is associated with a 
Company Set. 

If your company has implemented a Multisite configuration that includes 
multiple Organizations, using Company Sets allows your Organizations to 
share master company data on the records created in the Company Masters 
application, and record Organization specific data, for example contacts and 
branches, on the records in the Companies application.

When creating a complex Multisite implementation you would create 
company records in the following order:

1 Create one or more Company Sets in the administrative Sets application.

2 Create company master records in the Company Master application.

3 Add company master records to one or more Organizations.

4 Use the Companies application to add Organization specific data to the 
company records.

5 If appropriate, create company branch records and associate them with a 
parent company record to create a hierarchy.

TIP: If your company�s Multisite implementation consists of a single 
Organization, your system administrator can configure your Company Set 
so that records created in the Companies application are automatically 
added to the Company Masters application.

Company Records and Other Applications

Generally when a Company or Vendor field appears on a Maximo record, 
the value in the field represents a company record created in the Companies 
application.

Company Records and Contracts

Before you can create contract records you must first create company records 
for each vendor or company that will be listed on a contract. 
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You can use the View Contracts action available from the Select Action 
menu of the Companies application to view a read-only list of contracts 
associated with a company record.

Company Records and Purchasing

Before you can create purchasing records (PRs, RFQs, or POs) you must first 
create company records for each vendor or company that will be listed on a 
purchasing record. 

Using the Companies Application

To access the Companies application, click the application link on your Start 
Center, or select Purchasing > Companies from the Go To menu.

The Companies application contains the following tabs:

! List � to search Maximo for company records. 

! Company � to enter, view, and modify information on vendors, 
manufacturers, and other companies.

! Contacts � to enter, view, and modify contact information for multiple 
contacts.

! Addresses � to enter, view, and modify information about a single 
contact, company mailing address, and remit to information for a 
company. 

! Branches � to enter, view, and modify information about multiple 
locations for the company.

Companies Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Companies application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Companies Help.     

How Do I...

associate commodity codes with a vendor? Select Associate Commodities from the 
Select Action menu.

add a commodity group to the database? Select Add/Modify Commodity Codes from 
the Select Action menu.

add or modify a commodity code in a commodity 
group?

Select Add/Modify Commodity Codes from 
the Select Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a company record? Click the New Company button in the toolbar.
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Creating Company Records

You can only use the Companies application to create a new company record if 
your system administrator has selected the Automatically Add Companies 
to Company Master? check box in the Sets application. When this check box 
is selected Maximo automatically creates a company master record when you 
create company records in the Companies application. If Maximo does not 
allow you to crate company records in the Companies application, you must 
use the Company Master application to create company records. 

You can use the Company tab to enter information about a company, 
including purchasing and payment information, and information about 
whether the vendor is e-commerce enabled through Maximo. Your system 
administrator enables a company�s Maximo e-commerce purchasing options.

You can categorize companies by type for reporting purposes. Maximo uses 
three defaults for company types:

! Courier � transit company
! Manufacturer � manufacturer of items or assets
! Vendor � vendor of items or assets

Your system administrator might have created customized company types 
specific to your business.

NOTE: The Customer # field in the Companies application stores the number 
used by the company to identify your company in their database.

You use the Contacts tab to add, view, and modify information about the 
people you need to contact at the company. 

You use the Addresses tab to view and modify a company's general and Remit 
To contact information.

Using Company Branches

Many national vendors have local offices in major cities. If your company is 
large enough to have more than one location, locations in different cities 
might make their purchases from the local branch of the same national 
vendor. Maximo allows you to create branch records for a vendor company and 
track purchasing either at the branch level, or with the vendor as a whole. 

For example, each plant location might purchase office supplies at the local 
office of a national chain, and do their shipping with the local office of an 
international shipping company. By entering company branches in Maximo, 

delete a record? Select Delete Company from the Select Action 
menu.

duplicate a record? Select Duplicate Company from the Select 
Action menu.

view contract information related to the 
company?

Select View Contracts from the Select Action 
menu.

How Do I...
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you can track purchases for each plant location via its branch record, as well 
as the total purchases for all plant locations via the parent vendor record. 

Company Branch Hierarchies

The branch hierarchy can be only one level deep, with a parent company 
record, and child branch records. Child records cannot be parents of other 
records, and parent records cannot be children of other records.

You use the Branches tab to create and remove associations between child and 
parent records. You can enter a company record manually, or use the Detail 
Menu button to look up companies. The Select Company page includes only 
companies that are not already parent or child records. 

NOTE: You can associate only existing company records with the parent record. 
You cannot insert a new company record by adding a row to the 
Branches table window.

Duplicating Company Records

You can use the Duplicate Company action to create a copy of an existing 
company record, for example if you are creating records for company branches. 
Once you duplicate a company record you can then modify it as needed.

Managing Company Records

Once company master records have been created in the Company Master 
application and added to Organizations, you can add, view, or modify 
Organization specific information on a company record.

Disqualifying a Vendor

If your company decides to stop doing business with a vendor, you can mark 
the record to indicate that the vendor is disqualified from doing business with 
your company.

The Disqualified Vendor? check box on the Company tab is a Yes/No field. 
The default is "No": the box is not checked. Selecting this box disqualifies this 
company as a vendor, which means that you cannot create new RFQs, PRs, 
POs or invoices using this company as a vendor. 

Disqualifying a vendor has no effect on existing transactions (POs and 
receipts) that already reference the vendor. A disqualified vendor affects only 
those records created after you disqualify the vendor. Therefore, Maximo no 
longer allows new POs to be created from PRs for the vendor, but POs 
approved before the vendor was disqualified are still valid.

Deleting Company Records

You can delete a company record using the Delete Company action available 
from the Select Action menu. 

Company records cannot be deleted if branch records are associated with 
them. In order to delete a parent company record with associated child 
(branch) records, you first must sever all child relationships before you can 
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delete the record. To sever child relationships, delete all the branches listed in 
the Branches table window. 

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Companies Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Company Master Records

A company master record in Maximo represents a vendor from whom you 
purchase goods or services, asset manufacturers, and other companies that 
you do business with. 

You use the Company Master application to create company master records 
that belong to a particular Company Set. Company master records contain 
information pertaining to companies such as the default contact person of the 
company, purchasing, e-commerce, and payment details of the company. 

A company record contains Organization specific information about a 
vendor, such as contact names and addresses. 

Multisite and Company Master Records

Company Master records are defined at the Company Set level. Company Sets 
exist below the System level, but above the Organization level so that 
Organizations can share data. This means that:

! Key fields for new company master records must be unique within the 
Company Set.

! Records are available to all users in the Organizations that share the 
Company Set and who have security permissions to the application. 

All company master records belong to a Company Set. Company Sets enable 
you to share information about companies between multiple Organizations. 
Each Organization is associated with a Company Set. 

Company Master Records vs. Company Records

For more information about the relationship between company master and 
company records, see �Company Records vs. Company Master Records,� on 
page 9-8.
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Using the Company Master Application

To access the Company Master application, click the application link on your 
Start Center, or select Purchasing > Company Master from the Go To 
menu.

The Company Master application contains the following tabs:

! List � to search Maximo for company master records.

! Company Master � to add, view, or modify company master records.

! Contacts � to enter, view, and modify contact information for multiple 
contacts.

! Addresses � to enter, view, and modify addresses for the company.

Company Master Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Company Master application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Company Master Help.     

Creating Company Master Records

You create company master records for any company that you do business 
with including vendors, service providers, and asset manufacturers. Once you 
create a company master you use the Add Company Master to 
Organization action to associate the company master record with one or 
more Organizations.

If your company�s Multisite implementation consists of a single Organization, 
your system administrator can configure your Company Set so that records 
created in the Companies application are automatically added to the 
Company Masters application.

How Do I...

add a company master record to an 
Organization?

Select Add Company Master to 
Organization from the Select Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a company master record? Click the New Company Master button in the 
toolbar.

delete a record? Select Delete Company Master from the 
Select Action menu.
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Managing Company Master Records

Once company master records have been created and associated with at least 
one Organization, you use the Companies application to record Organization 
specific data.

Disqualifying a Company Master

If your company decides to stop doing business with a vendor, you can check 
the Disqualified Vendor? check box on the record to indicate that the 
vendor is disqualified from doing business with your company.

Deleting Company Master Records

You can delete a company master record using the Delete Company Master 
action available from the Select Action menu. You cannot delete a company 
record if it has been associated with an Organization.

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Company Master Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Invoices

An invoice is a bill from a vendor for delivered products or services. 

The Invoices application lets you record invoices as well as debit and credit 
notes from vendors, and match invoice details against purchase orders (POs) 
and receipts. It also lets you create invoices for which there are no receipts. In 
addition, you can create an invoice for a parent company for goods and 
services rendered through any of its branches, and you can create an invoice 
for a branch company for goods and services rendered through its parent 
company.

After you purchase materials and services, your company receives bills, or 
invoices, from the vendors. Using Maximo to manage invoices lets you match 
invoice information against purchase orders and receipts of materials and 
services, so that the invoice can be approved and routed to Accounts Payable.

Multisite and Invoice Records

Invoices are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.
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Invoice Records and Contracts

When you have contracts that contain a payment schedule, Maximo creates 
an invoice with a status of SCHED (scheduled) for each installment payment 
in the schedule.

If your system administrator activates the "invoice due" escalation, Maximo 
automatically changes the status of an invoice from SCHED to either WAPPR 
or APPR when the Due Date on the invoice is reached.

Invoice Records and Purchase Orders

After you purchase materials and services, your company receives bills, or 
invoices, from the vendors. You use the Invoices application to record vendor 
invoices as you receive them. When you create invoice records you can list 
purchase order (PO) details on the invoice if it is appropriate.

The invoice you create in Maximo may represent one of these invoice types:

! An invoice related to a single purchase order�you enter information such 
as the invoice number, corresponding PO number, any receipts recorded 
for the PO, and information specific to the invoice.

! An invoice related to many purchase orders for a single vendor�you enter 
general invoice data on the Invoice tab, including the vendor, then list the 
related POs on the Invoice Lines tab. 

! An invoice without a related purchase order�typically, such an invoice 
represents a bill for which there is no purchase requisition or purchase 
order. You just enter invoice-specific information. This could be 
appropriate if, for example, you receive an invoice for rent or a phone bill.

When you list a purchase order on an invoice, Maximo automatically copies 
information from the purchase order to the PO Details section of the receipt, 
including the status of the PO in the Receiving application.

NOTE: Items, materials, and services do not need to be received in the 
Receiving application to have invoices created for them in the Invoices 
application.

Using the Invoices Application

To access the Invoices application, click the application link on your Start 
Center, or select Purchasing > Invoices from the Go To menu.

The Invoices application contains the following tabs:

! List � to search Maximo for invoice records.

! Invoice � to enter, view, or modify invoices, credit notes, or debit notes.

! Invoice Lines � to enter line items on the invoice.
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! Terms and Conditions � to add, view, or delete terms and conditions 
that have been associated with the record.

Invoices Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Invoices application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Invoices Help.       

Creating Invoices

You use the Invoices application to record vendor invoices as you receive 
them. Invoice records can be created for the following types of payments:

! An invoice related to a single purchase order
! An invoice related to multiple purchase orders for a single vendor
! An invoice for a scheduled payment on a lease or rental contract
! An invoice without a related purchase order, for example for bills that do 

not require purchase orders or receipts, such as rent or phone bills.

Invoice Types

Maximo allows you to create the following types of invoices:

! INVOICE � (the default) Use to indicate a payment to a vendor.

! CREDIT � Use to indicate a credit issued by your company to a vendor, 
for example for returned items.

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

change the vendor on the invoice from the one 
listed on the purchase order?

Select Change Vendor from PO from the 
Select Action menu.

create an invoice record? Click the New Invoice button in the toolbar.

delete a record? Select Delete Invoice from the Select Action 
menu.

distribute standard service costs across all 
invoice line items?

Select Allocate Services from the Select 
Action menu.

duplicate a record? Select Duplicate Invoice from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

view the status change history for a record? Select View History from the Select Action 
menu.
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! DEBIT � Use to indicate a charge to your company from a vendor, for 
example additional charges not listed on a invoice.

Entering Invoice Lines

Maximo lets you select any purchase order, material receipt, or service receipt 
line items and copy them directly to the Invoice Lines tab. To copy PO line 
items to an invoice, the following conditions must be met:

! You must have security authorization to perform the function. 

! The invoice status must be ENTERED, WAPPR (Waiting for Approval), or 
HOLD. For more information on invoice statuses, see �Invoice Statuses,� 
on page 9-17.

! An approved PO must be identified in the PO field, or a vendor must be 
specified in the Company field on the Invoice tab.

! If the Receipt Required? check box is selected on any PO line item, the 
item must be received before it can be copied to the invoice.

You use the Copy PO Lines button to import the data from the purchase 
order to the Invoices application. 

From the Invoice Lines tab, you can match the vendor invoice information to 
the PO and copy the appropriate lines from the PO to the Invoice Lines tab. 

Not all invoices from vendors have a one-to-one correspondence of invoice to 
PO. And at times, you might receive an invoice, such as a phone bill, which 
has no PO. When you receive an invoice which has no PO, you must create the 
invoice and enter the information manually.

Duplicating an Invoice

You can use the Duplicate Invoice action to create a copy of an existing 
invoice, for example if you have similar standard orders from a vendor. When 
you duplicate an invoice, Maximo copies all of the information from the 
existing invoice, including line items. Once you duplicate an invoice you can 
then modify it as needed.

Managing Invoices

Once an invoice has been created, you use the invoice Status to indicate 
where it is in the processing cycle.

Invoice Statuses

An invoice can have one of the following statuses:

! ENTERED � Invoice has been entered. New invoices are created with a 
status of ENTERED. Some default fields are read-only.

! WAPPR � Invoice is waiting for approval. An invoice waiting for 
approval can be edited, but some default fields are read-only.
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The WAPPR option is available only if the current invoice status is 
ENTERED or HOLD. Use this option to indicate that an invoice has been 
submitted for approval, perhaps to a higher level of management. 

! APPR � Invoice has been approved. All fields are read-only.

The APPROVE option is available only if the current invoice status is 
ENTERED, WAPPR, or HOLD. In addition, if you change the status 
directly to PAID without first approving the invoice, Maximo 
automatically approves the invoice. 

! HOLD � Invoice is on hold for approval. An invoice on hold can be edited, 
but some default fields are read-only.

The HOLD option is available only if the current invoice status is 
ENTERED or WAPPR. Use this option for any invoice that should not yet 
be approved or paid. 

! SCHED � Scheduled. An invoice with a status of SCHED has been 
generated from a contract and is due on the date listed in the Due Date 
field.

! CANCEL � Invoice has been canceled. All fields are read-only, and 
record can no longer be modified.

The CANCEL option is available only if the current invoice status is 
ENTERED, WAPPR, APPR, or HOLD. A canceled invoice is stored as a 
history record and cannot be modified.

! PAID � Invoice has been paid. All fields are read-only, and record can no 
longer be modified.

The PAID option is available only if the current invoice status is 
ENTERED, WAPPR, APPR, or HOLD. In addition, if you change the 
status directly to Paid without first approving the invoice, Maximo 
automatically approves the invoice. 

Deleting an Invoice

You can delete an invoice using the Delete Invoice action available from the 
Select Action menu. You can only delete an invoice if the status is ENTERED 
or WAPPR (waiting for approval).

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Invoices Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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Purchase Orders

A purchase order (PO) is an authorized order from a purchasing agent or 
department to an internal supplier or external vendor. 

You can use the Purchase Orders application to create purchase orders, either 
from purchase requisitions (PRs), requests for quotation (RFQs), or from 
scratch. 

Multisite and Purchase Orders

Purchase Orders are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Purchase orders store Ship To and Site information at the line level, 
allowing you to create POs that combine requisition lines from one or more 
Sites in the same Organization on the same PO.

When you are creating an internal PO, the Site listed in the Delivery Details 
section of the line should meet at least one of the following conditions:

! requesting Site is the same as the PO Site (Site listed in the PO header)
! requesting Site and the PO Site belong to the same Organization
! requesting Site�s Organization and the PO Site�s Organization share the 

same Item Set

When you are creating an external PO, the Site listed in the Delivery Details 
section of the line should meet at least one of the following conditions:

! PO line's Site is the same as PO Site
! PO line's Site and the PO Site belong to the same Organization

For more information about internal and external purchase orders, see 
�Internal vs. External Purchases,� on page 9-3.

Purchase Orders and Purchase Contracts

You can use the Contract Items button to view a list of items listed on 
contracts with the vendor specified in the Company field on the PO. If the PO 
Type = REL the Contract Items dialog box only displays contract items from 
the Reference Contract.

Maximo displays a message if more than one valid contract exists for an item 
or service item. You can use the View Contracts button to view a list of all 
valid contracts for the item. If the Company field on the PO is empty, 
Maximo displays all valid contracts for the item. If there is a value in the 
Company field, Maximo displays all valid contracts for the item/vendor 
combination.
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Release purchase orders can be created via the Create Release PO action 
available in the Purchase Contracts application.

You can create contracts based on information contained on purchase orders. 
You can create Blanket (Volume), Pricing, and Purchase type contracts via the 
Create Contract action in the Purchase Orders application.

NOTE: Creating a contract from a PO does not affect the PO record, for example 
Maximo does not enter a value in the Reference Contract field.

Purchase Orders and Purchase Requisitions

You can create a purchase order (PO) from a purchase requisition (PR), but a 
PR is not required for the creation of a PO.

Purchase Orders and Storerooms

Some companies centralize their purchasing and use a central storeroom to 
supply other storerooms in the company. Maximo�s Purchase Orders 
application allows you to generate a purchase order against another 
storeroom. Storeroom records contain a Use on PR/PO? check box that 
allows them to be used as the vendor for internal purchase orders. 

You can think of a storeroom-to-storeroom purchase as a �transfer order,� or 
an �internal PO," since Maximo uses the Purchase Orders and Issues and 
Transfers applications to track these types of item movements. For more 
information about internal and external purchase orders, see �Internal vs. 
External Purchases,� on page 9-3.

Using the Purchase Orders Application

To access the Purchase Orders application, click the application link on your 
Start Center, or select Purchasing > Purchase Orders from the Go To 
menu.

The Purchase Orders application contains the following tabs:

! List � to search Maximo for purchase order records.

! PO � to enter, view, or modify POs, either from PRs, RFQs, or from 
scratch.

! PO Lines � to enter, view, or modify line items on the PO; also to view 
summary information from the Material Receipts and Service Receipts 
tabs in the Receiving application.

! Ship To/Bill To � to enter, view, or modify shipping information that 
will be used as a default on each line, and billing information for the entire 
order.

! Terms and Conditions � to add, view, or delete terms and conditions 
that have been associated with the record.
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Purchase Orders Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Purchase Orders application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Purchase Orders Help.   

How Do I...

add a commodity group to the database? Select Add/Modify Commodity Codes from 
the Select Action menu.

add or modify a commodity code in a commodity 
group?

Select Add/Modify Commodity Codes from 
the Select Action menu.

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

change the attributes for an asset? Select Move/Modify Assets from the Select 
Action menu.

change the location of one or more assets? Select Move/Modify Assets from the Select 
Action menu.

change the user or custodian for an asset? Select Move/Modify Assets from the Select 
Action menu.

complete receipts for a PO when there are still 
items outstanding that you do not expect to 
receive?

Select Complete Receipts from the Select 
Action menu.

copy line items from a purchase requisition (PR) 
to a purchase order?

Select Copy PR Line Items to PO from the 
Select Action menu.

create a contract from a purchase order? Select Create Contract from the Select Action 
menu.

create a purchase order? Click the New Purchase Order button in the 
toolbar.

duplicate a record? Select Duplicate Purchase Order from the 
Select Action menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.
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Creating Purchase Orders

You can use a number of different methods to create a purchase order. You 
can create a purchase order in the following ways:

! click the New Purchase Order button in the Purchase Orders 
application

! select the Create PO action in the Purchase Requisitions application to 
create a PO from a PR

! click the Create PO button on the Vendors or Quotations tab of the 
Request for Quotation application to create a PO from an RFQ

! select the Create Release PO action in the Purchase Contracts 
application to create a PO from a purchase contract

! select one of the reorder actions in the Inventory application. 

A purchase order can list items or services for a single vendor only. If you have 
multiple purchase requisitions for the same vendor, you can combine them in 
a single PO.

Adding PO Lines

When you create a purchase order, you list each item, material, service, or tool 
to be purchased on a separate line on the PO Lines tab. For information about 
the different line types, see �Line Types,� on page 9-4.

modify a purchase order that has a status of 
approved (APPR)?

Select Create Change Order from the Select 
Action menu.
NOTE: You cannot create a change order if there 

are receipts against the PO.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

view advance ship notice information for a PO? Select View History from the Select Action 
menu.

view purchase requisition information for a PO 
line?

Select View PR Line Items from the Select 
Action menu.

view related invoice lines for a PO? Select View Invoice Lines from the Select 
Action menu.

view the status change history for a record? Select View History from the Select Action 
menu.

view the vendor status information for a PO? Select View History from the Select Action 
menu.

How Do I...
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You can create PO lines using any of the following methods:

! Select the Copy PR Line Items to PO action to copy lines from one or 
more purchase requisitions

! Click the Vendor Items button to choose from a list of items associated 
with the vendor listed on the PO.

! Click the Contract Items button to choose from a list of items that 
appear on contracts with the vendor listed on the PO.

! Click the Select Spare Parts button to choose from a list of spare parts 
for a particular asset.

! Click the New Row button to manually enter a new PO line.

TIP: If you are manually entering a series of items with similar information, 
you can speed data entry by entering values in one or more of the fields in 
the Default Table Data area.

Understanding Standard Services

Standard services are costs that are incurred on the purchase order as a 
whole, for example, taxes and shipping. While standard services can be 
recorded on the PO Lines tab, Maximo does not required them to be recorded, 
since the costs might not be known at the time the PO is created.

Standard costs can be entered on a purchase order or on an invoice. Some 
companies might require estimates of standard services for PO approvals. You 
can enter the estimate on the PO and update the information after the invoice 
is received.

Duplicating a Purchase Order

You can use the Duplicate Purchase Order action to create a copy of an 
existing purchase order, for example if you are making a similar order to one 
made in the past. Once you duplicate a PO you can then modify it as needed.

Managing Purchase Orders

Once a purchase order has been sent to the vendor the items on the PO are 
received in the Receiving application, and the PO is matched to invoices in the 
Invoices application.

You can use the Complete Receipts action to complete receipts for a PO 
when there are still outstanding line items on the PO that you do not expect to 
receive.

You can use the View Invoice Lines action to view invoice lines related to a 
purchase order.

Creating a Change Order

A change order is a duplicate purchase order generated from an approved 
purchase order. You preserve the audit trail by keeping the original PO, and 
making the necessary changes to the change order. 
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You can create a change order only if the following conditions are met:

! The status of the PO is APPR or INPRG.

! The PO type is not REL (a blanket release).

! If none of the line items on the original PO have been received.

! You have security authorization to perform the action.

Creating a change order does two things:

! Cancels the original PO.

! Creates a new, duplicate PO with the status of WAPPR. 

You use the Create Change Order action to create a change order. 

Purchase Order Statuses

Once a purchase order has been created, it usually must receive some type of 
approval before it is sent to the vendor. Every purchase order in Maximo has a 
status that indicates its position in the PO processing cycle. After you change 
a PO�s status, Maximo records the date and time of the status change, and lets 
you record a memo. 

A purchase order (PO) can have one of the following statuses:

! WAPPR � Waiting for Approval. New POs are created with a status of 
WAPPR. Some default fields are read-only.

! INPRG � In progress. All fields are read-only.

! APPR � Approved. All fields are read-only.

! CAN � Canceled.   All fields are read-only, and the record can no longer 
be modified.

! CLOSE � Closed. All fields are read-only, and the record can no longer be 
modified. POs can be closed only if all lines have been received, and if lines 
that require inspection have been approved.

Purchase Orders Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Purchase Requisitions

A purchase requisition (PR) is a written request issued internally to a 
purchasing department to order items or services. Sometimes maintenance 
work requires parts, materials, or services that you cannot supply from your 
own storerooms or labor pool. In this case, you must create a purchase 
requisition (PR).
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You use the Purchase Requisitions application to create purchase requisitions 
for items, supplies, and services, or to create a purchase order (PO) from a 
purchase requisition.

Your purchasing department uses the purchase requisition to create either a 
request for quotation (RFQ) for the items or services, or a purchase order (PO) 
after the purchase is approved.

Multisite and Purchase Requisitions

Purchase Requisitions are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Purchase Requisitions and Contracts

You can use the Contract Items button to view a list of items listed on 
contracts with the vendor specified in the Company field on the PR. 

Maximo displays a message if more than one valid contract exists for an item 
or service item. You can use the View Contracts button to view a list of all 
valid contracts for the item. If the Company field on the PR is empty, 
Maximo displays all valid contracts for the item. If there is a value in the 
Company field, Maximo displays all valid contracts for the item/vendor 
combination.

You can create contracts based on information contained on purchase 
requisitions. You can create Blanket (Volume), Pricing, and Purchase type 
contracts via the Create Contract action in the Purchase Requisitions 
application.

NOTE: If you select the Copy to Contract? check box, the PR line cannot be 
copied to a purchase order.

Purchase Requisitions and Purchase Orders

You can create a purchase order (PO) from a purchase requisition (PR), but a 
PR is not required for the creation of a PO.

Purchase orders store Ship To and Site information at the line level, 
allowing you to create POs that combine requisition lines from one or more 
Sites in the same Organization on the same PO.

NOTE: A PR line can be converted to either a contract, a request for quotation, 
or a purchase order. If you select the Copy to Contract? or Copy to 
RFQ? check box, the PR line cannot be copied to a purchase order.
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Purchase Requisitions and Storerooms

Some companies centralize their purchasing and use a central storeroom to 
supply other storerooms in the company. Storeroom records contain a Use on 
PR/PO? check box that allows them to be used as the vendor for internal 
purchase requisitions. 

Using the Purchase Requisitions Application

To access the Purchase Requisitions application, click the application link on 
your Start Center, or select Purchasing > Purchase Requisitions from the 
Go To menu.

The Purchase Requisitions application contains the following tabs:

! List � to search Maximo for PR records.

! PR � to enter, view, or modify purchase requisitions.

! PR Lines � to enter, view, or modify line items for a purchase 
requisition. A line can be an item or material from inventory, an item or 
material not from inventory, or a service.

! Ship To/Bill To � to enter, view, or modify shipping information that 
will be used as a default on each line, and billing information for the entire 
order.

! Terms and Conditions � to add, view, or delete terms and conditions 
that have been associated with the record.

Purchase Requisitions Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Purchase Requisitions application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Purchase Requisitions Help.    

How Do I...

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Units of Measure from the 
Select Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.
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Creating Purchase Requisitions

Creating a purchase requisition is a two part process:

! Creating a PR � Recording the details of the requisition: who is 
requesting the purchase, when it is needed, where it should be shipped, 
and so forth.

! Adding Line Items � Listing the materials, services, or tools you are 
requesting.

NOTE: You also can create PRs from the Inventory application using the 
Reorder Items action.

If you are creating an external PR, enter a value in the Company field. If you 
are creating an internal PR, enter a value in the Storeroom and Storeroom 
Site fields. You are not required to specify a vendor on a purchase requisition. 
Check the No Vendor? check box if you do not want to specify either a vendor 
or a storeroom for the PR. For more information about internal and external 
PRs, see �Internal vs. External Purchases,� on page 9-3.

Entering PR Line Items

When you create a purchase requisitions, you list each item, material, or 
service to be purchased on a separate line on the PR Lines tab. For 
information about the different line types, see �Line Types,� on page 9-4.

After the purchase requisition has been approved, you can assign its line 
items to one or more purchase orders. A purchase requisition can be closed 
after all its line items are assigned to a purchase order. A single purchase 

create a contract from a purchase requisition? Select Create Contract from the Select Action 
menu.

create a purchase requisition (PR)? Click the New Purchase Requisition button 
in the toolbar.

create a purchase order (PO) from a purchase 
requisition?

Select Create PO from the Select Action menu.

duplicate a record? Select Duplicate Purchase Requisition from 
the Select Action menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Units of Measure from the 
Select Action menu.

run reports? Select Run Reports from the Select Action 
menu.

view the status change history for a record? Select View History from the Select Action 
menu.

How Do I...
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requisition can list items or services for several vendors, as vendors are not 
required to be specified on a PR.

TIP: If you are entering a series of items with similar information, you can 
speed data entry by entering values in one or more of the fields in the 
Default Table Data area.

Requisitioning Spare Parts

If you know the asset that parts are being requisitioned for, you can use the 
Select Spare Parts button on the PR Lines table window to facilitate 
creating your requisition.

You have two options when using the Select Spare Parts button. 

! Enter the asset number to view the list of spare parts defined in the asset 
record. 

! If you have purchased the Illustrated Parts Catalog (IPC), you can 
navigate a list of parts that make up the asset, or use interactive exploded 
diagrams of the asset to select parts. 

For more information about the IPC refer to the IPC Help.

Requisitioning Vendor Items

If the requisition is for a specific vendor, you can use the Vendor Items 
button on the PR Lines table window to facilitate creating your purchase 
requisition. This button displays all items that have been purchased from the 
selected vendor in the past.

Managing Purchase Requisitions

Once a purchase requisition has been submitted to the purchasing 
department a request for quotation might be created in the Request for 
Quotations application before the creation of a purchase order in the Purchase 
Orders application. 

Maximo lets you create a purchase order directly from a single purchase 
requisition. When creating a PO from a PR, Maximo copies all of the line 
items and other relevant information from the PR to a single PO. 

NOTE: Your system administrator can configure Maximo to automatically close 
a PR once all its lines have been copied to a PO.

Purchase Requisitions Statuses

Once a purchase requisition has been created, it usually must receive some 
type of approval. Every purchase requisition in Maximo has a status that 
indicates its position in the PR processing cycle.

A purchase requisition (PR) can have one of the following statuses:

! WAPPR � Waiting for Approval. New PRs are created with a status of 
WAPPR. Some default fields are read-only.
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After a line is assigned to a purchase order (PO)s, the line becomes read-
only and can no longer be modified.

! APPR � Approved. Maximo�s default configuration does not require 
approvals for PRs and PR line items that you transfer to POs. Your 
business rules might require approvals. All fields are read-only.

! CLOSE � Closed. Closing a PR indicates that all its line items have been 
assigned to one or more purchase orders. All fields are read-only, and the 
record can no longer be modified.

If you try to close a PR and a line item has not yet been assigned, Maximo 
displays a message. Your system administrator can set Maximo to close 
PRs automatically after you transfer all the line items to POs. 

! CAN � Canceled. An approved PR can be canceled only if none of its line 
items have been assigned to a purchase order. All fields are read-only, and 
the record can no longer be modified.

Purchase Requisitions Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Receipts

A receipt is a record of goods or services received from a vendor. You use the 
Receiving application to receive materials into inventory. You can use the 
Material Receipts tab to receive materials that have arrived as ordered, record 
partial shipments, and records items returned to vendors, for example items 
that have failed an inspection and been rejected.   You can also create asset 
records when you receive rotating items.

If your company requires receipts for services, you can use the Service 
Receipts tab to record services received against an approved purchase order.

Multisite and Receiving

In a large company, you might have a centralized purchasing department for 
several locations. Maximo stores Ship To information on the PO line, 
allowing you to create purchase orders for more than one Site, but material 
and service receipts are managed at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Receiving and Assets

Assets that are also considered items, such as pumps and motors, can be 
stocked in inventory and rotated in and out of use in different locations. A 
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rotating asset has both an asset number and a rotating item number, allowing 
it to be tracked as an asset and as an inventory item, depending on its location 
at any given time. For more information about rotating assets, see �Item 
Master Records and Assets,� on page 6-20.

If you purchase a new item that will act as a rotating asset, it must have an 
asset identifier specified for it when it is received. You create and save a 
receipt, then use the Receive Rotating Items action to specify an asset 
identifier and to record serial numbers for the items.

The Receive Rotating Items page includes an Apply IAS button for each line, 
allowing you to apply an existing item assembly structure the each new asset 
record as it is received.

Receiving and Companies

If the Inspection Required? check box is selected on a company record then 
goods ordered from the vendor will always require an inspection. When you 
record material receipts from the vendor in the Receiving application, each 
line will be received with a status of WINSP (waiting for inspection) to 
indicate that an inspection is required. 

Receiving and Inventory

When you receive ordered items or materials listed on a purchase order 
Maximo updates the item balances for the storeroom.

If you receive an item into a storeroom that is not part of the storeroom�s stock 
list Maximo adds the new item to the storeroom�s stock list automatically.

Receiving and Invoices

By default, when Maximo creates PR or PO lines for services, the Receipt 
Required? check box is clear and you do not need to receive the service lines. 
When these service lines are recorded in the Invoices application Maximo 
automatically generates the receipt.

If your company requires receipts for services, you can use the Service 
Receipts tab to record services received against an approved purchase order. 
You can copy all the PO line items to the Service Receipts table window if all 
services have been received, or you can enter partial receipts.

Using the Receiving Application

To access the Receiving application, click the application link on your Start 
Center, or select Purchasing > Receiving from the Go To menu.

The Receiving application contains the following tabs:

! List � to search Maximo for purchase order records.
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! Material Receipts � to report materials received on a purchase order.

! Service Receipts � to report services received on a purchase order.

Receiving Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Receiving application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Receiving Help.    

Creating Receipts

Receipts are created from approved purchase order records.

Receiving Materials

You use the Material Receipts tab to enter information about items received 
on an approved PO. You can copy all the PO line items to the Material 
Receipts table window if the entire order has been received, or you can enter 
partial receipts. For example, if items are back ordered, or parts of a large 
shipment arrive separately you can record partial receipts. You also can 
record receipt of the materials ordered on the PO and note any discrepancies 
between what you ordered, received, and rejected. 

How Do I...

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

approve the receipt of an item that requires 
inspection?

Select Change Inspection Status from the 
Select Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

enter asset numbers and other asset data when 
receiving rotating items?

Select Receive Rotating Items from the 
Select Action menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.
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You also can receive materials not tracked in inventory, but that require a 
purchase order. For example, you might order a catered lunch or a new desk, 
neither of which would be stored in inventory or tracked by an item number. 
You would want, however, to track them on purchase orders and receipts.

When you record an item receipt, Maximo creates an inventory transaction for 
that item or charges the work order, asset, or location if the item is a direct 
issue. Maximo increases the balance of the item for the indicated storeroom by 
the quantity of the receipt and decreases the quantity on order by the quantity 
received.

After you save the receipt, the fields on the Material Receipts tab become 
read-only.

NOTE: Lotted items require that a lot number be specified before the line is 
saved.

Modifying Material Receipts

You might need to make changes when recording an item's receipt on the 
Material Receipts tab, for example, you might need to:

! Change the number in the Quantity field to record a partial shipment.

! Change the number in the Rejected Quantity field and provide a reason 
in the Reject Code field to represent rejected items, for example, 
damaged goods.

You use the Row Details to modify the receiving details for each line item that 
is received.

NOTE: If you record an item as rejected, your entry in the Quantity field for 
the same line item represents the items you are keeping (that is, the 
good items), not the total number of items in the shipment.

Returning Materials

Sometimes items that have been received must be returned. This might occur 
when items are rejected and are being shipped back to the vendor. You use the 
Select Items for Return button on the Material Receipts tab to return 
received items, creating a receipt with a negative quantity.

NOTE: You can return materials as long as the purchase order for the items is 
not a history record (status = CLOSE).

Receiving Services

Service receipts refers to data associated with any service provided by a 
vendor or contractor, such as repairs to assets. The service can be performed 
on or off site. You specify service purchases either in terms of a quantity and a 
unit cost, or as a single lump sum amount. Whichever terms you use on the 
service PO must be the same on the corresponding receipt transaction, which 
you record on the Service Receipts tab.

By default, when Maximo creates PR or PO lines for services, the Receipt 
Required? check box is clear and you do not need to receive the service lines. 
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When these service lines are recorded in the Invoices application Maximo 
automatically generates the receipt.

If your company requires receipts for services, you use the Service Receipts 
tab to record services received against an approved purchase order. You can 
copy all the PO line items to the Service Receipts table window if all services 
have been received, or you can enter partial receipts.

When managing service receipts, in general two things happen:

! Receipt of services is recorded in Maximo after a contractor or vendor 
submits a claim.

! An authorized individual checks the costs of the services and approves the 
receipt. Services always require approval.

NOTE: You also can record the receipt of services using Labor Reporting if the 
services are performed by a contractor listed in the Labor application. 

Managing Receipts

Some items are simply received into inventory, and other require either 
inspection or serialization (creation of asset numbers), or both. All items 
requiring inspection are received into a holding location and transferred to 
their final destination after the inspection is performed. You define a single 
holding location for each Site using the Locations application.

You use the Change Inspection Status action available from the Select 
Action menu to change the inspection status of a line item from WINSP 
(waiting for inspection) to WASSET (waiting for asset) if the item is a rotating 
item, or to COMP (complete). 

You use the Receive Rotating Items action available from the Select Action 
menu to create asset records for rotating items. Maximo changes the status of 
the receipt line from WASSET (waiting for asset) to COMP (complete).

Receiving Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Requests for Quotations

A request for quotation (RFQ) is a request that is sent out to one or more 
potential vendors. In the request, you can ask for specific costs and conditions 
for the delivery of an item or service. In the RFQ record you can specify line 
items, required delivery dates, and other conditions you want the vendor to 
meet for the delivery of the item or service.

A request for proposal (RFP) is similar to an RFQ, but is generally used for 
a large number of items or services. You can use the RFQ application to 
process RFPs. Within Maximo Requests for Proposals are referred to as 
Requests For Quotations. 
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Circumstances at your company might require you to obtain quotations from 
several vendors before deciding from whom to purchase materials or services. 
With the Request for Quotation application, you can:

! Create requests for quotations.

! Store quotations received from vendors

! Analyze quotations in order to make more informed purchasing decisions.

! Use the information you collect to create purchase orders

! Use the information you collect to create purchase contracts

Multisite and Requests for Quotations

RFQs are defined at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Request for Quotations and Companies

Before you can include a vendor on a request for quotation record, the vendor 
must have a record in the Company Master application. 

Request for Quotations and Contracts

Request for Quotation records can be created via the Create RFQ action 
available in the Purchase Contracts application.

You can create contracts based on information contained on requests for 
quotation. Once you have awarded lines to vendors, you can create Blanket 
(Volume), Pricing, and Purchase type contracts via the Create Contract 
button in the Request for Quotations application.

Request for Quotations and Purchase Orders

Once you have received quotations from vendors and awarded quotation lines 
to one or more vendors, you can create a purchase order directly from the RFQ 
record using the Create PO button on the Vendors or Quotations tab of the 
record.

Request for Quotations and Purchase Requisitions

If you are creating a request for quotation for items on a particular purchase 
requisition, you can use the Copy PR Line Items to RFQ action to copy one 
or more lines from the PR to the RFQ.
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Using the Request for Quotations Application

To access the Request for Quotations application, click the application link on 
your Start Center, or select Purchasing > Request for Quotations from 
the Go To menu.

The Request for Quotations application contains the following tabs:

! List � to search Maximo for RFQ records.

! RFQ � to enter, view, or modify general information about the RFQ, 
including a description of the RFQ, the desired date of the response, the 
close date of the RFQ, and other information pertinent to this specific 
quotation

! RFQ Lines � to enter the line items or services that require quotations, 
including the items, quantities desired, and other specific information.

! Vendors � to enter information about vendors to whom you intend to 
send the request for quotation. 

! Quotations � to record, compare, and award quotations received from 
vendors. 

! Terms and Conditions � to add, view, or delete terms and conditions 
that have been associated with the record.

Request for Quotations Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Request for Quotations application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Request for Quotations Help.      

How Do I...

add a conversion factor, for example from �case� 
to �each,� to the database?

Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

add a unit of measure, for example feet or 
gallons, to the database?

Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

copy line items from an existing purchase 
requisition (PR) to a request for quotation?

Select Copy PR Line Items to RFQ from the 
Select Action menu.

create an RFQ record? Click the New RFQ button in the toolbar.
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Creating Requests for Quotations

You create an RFQ under the following circumstances:

! The stock count of a stocked item drop below a certain level and you must 
make another bulk order.

! A requisition is received for an item or service that requires a quotation 
each time the item or service is ordered, due to price or other 
requirements.

! Someone at your site requests a quote for an item or service. It can be for a 
typically stocked item or for a unique item not usually ordered, such as a 
special order or non-stocked item.

! Commodity bulk buying must be done for a certain period of time. This is 
typical for many items with common commodity codes. The quotation 
might not be copied to a PO immediately, but the pricing is set.

You create a separate RFQ line for each different item or service that you 
want to request quotations for. You can create new RFQ lines in one of the 
following manners:

! by manually entering the necessary information in the RFQ application.

! by copying lines from one or more existing purchase requisitions to the 
RFQ using the Copy PR Line Items to RFQ action.

NOTE: The RFQ must have a status of INPRG to copy PR lines to it.

! by using the Create RFQ action available in the Purchases Contracts 
application.

Adding Vendors to an RFQ

When you create an RFQ, you typically list the vendor or vendors who will 
receive the RFQ. If you intend to enter quotations from vendors on the 

duplicate a record? Select Duplicate RFQ from the Select Action 
menu.

modify a conversion factor? Select Unit of Measure and Conversion > 
Add/Modify Conversions from the Select 
Action menu.

modify a unit of measure? Select Unit of Measure and Conversion > 
Add/Modify Measure Units from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

view the status change history for a record? Select View History from the Select Action 
menu.

How Do I...
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Quotations tab, you must enter the vendors on the Vendors tab prior to 
changing the status of the RFQ to SENT. 

NOTE: The RFQ status must be INPRG in order to add vendors. Vendor 
records must exist in the Company Master application before they can 
be listed on an RFQ.

Managing Requests for Quotations

Once an RFQ has been created the RFQ process has the following stages:

1 Sending the RFQ to vendors listed on the RFQ

2 Recording and analyzing the quotations received from vendors.

3 Awarding the quotation for each item or service to a vendor.

Recording Quotation Lines

After you create an RFQ and send it to vendors, you receive responses from 
them including price, quantity, and other relevant information. The vendor 
can return a quotation for all lines, some lines, or just one line. The next step 
in the RFQ process is to record the information you receive from vendors, 
analyze that information, and then award each RFQ line to the vendor of your 
choice.

When recording vendor information and awarding quotation lines to vendors, 
you use both the Vendor and the Quotations tabs. 

Awarding Quotation Lines to Vendors

After all quotations are received, they can be compared against one another to 
select the one that best meets your criteria. You can use the Item subtab of the 
Quotations tab to view all vendor quotations for a single item. 

You can award quotations to make the conversion from an RFQ to a PO 
easier. You can award quotations on a line-by-line basis. However, an RFQ 
does not require that you award quotations. 

Quotations are awarded on the Quotations tab, in the Quotations for Vendor 
table window of the Vendor subtab.

TIP: The Awarded? field of the Quotations for Vendor table window can be 
edited from the table window, without opening the Row Details. 

Creating a PO from an RFQ

Before a PO can be created from an RFQ, the vendor�s quotations must be 
recorded and RFQ lines must be awarded. POs can be created for one vendor 
at a time. 

RFQ Statuses

RFQ records include a status to indicate its position in the RFQ processing 
cycle. A request for quotation (RFQ) can have one of the following statuses:
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! INPRG � New RFQs are created with a status of INPRG. Some default 
fields are read-only.

! READY � Ready to be sent to vendors. You no longer can edit 
information on the RFQ or RFQ Lines tabs. All fields are read-only.

! SENT � Sent to vendors. The RFQ and RFQ Lines tabs are read-only. 
The Vendor tab can be edited, to allow recording of quotations, but new 
vendors cannot be added.

! COMP � Completed, meaning all quotations have been received. This 
status is used to prevent changes to the RFQ between awarding RFQ lines 
and creating POs. All fields are read-only except Quotation Lines.

! CLOSE � Closed, meaning all RFQ lines have been copied to POs. All 
fields are read-only, and records can no longer be modified.

! CANCEL � The RFQ has been canceled. You cannot delete an RFQ after 
you save it, but you can cancel it as long as no quotations have been 
awarded and no POs have been created. All fields are read-only, and 
records can no longer be modified.

Request for Quotations Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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The Resources Module is used to create Maximo records for workers, both 
internal and external, and other people whose names or IDs might be listed on 
Maximo records. 

The Resources Module consists of the following applications: 

There are several different Maximo applications used to manage records for 
individuals whose data appears on Maximo records.

! User � Used to create and manage records for all Maximo users, that is 
people who will be logging into Maximo to create and manage records. 
System administrators use the User application to manage user names, 
passwords, and security profiles. 

! People � Used to create and manage records for people whose names 
may appear anywhere on a Maximo record.    For example on a service 
request the values in the Reported By and Affected Person fields might 
be linked to person records.

! Labor � Used to create and manage records for all employees and 
contractors who will be performing work on tickets or work orders.

You use the People application to create records for a variety of workers at 
your company. Some companies may choose to create person records for all of 
their employees as a way to manage employee information (name, address, 
hire date and so forth). Others may choose to just create person records for 
laborers and other workers who will be using Maximo as part of their jobs.

You use the Person Group application to create groups of person records. 
Maximo uses person groups when performing automated tasks that require 

10 The Resources Module

Application Function

Crafts Used to create and manage craft records.

Labor Used to create and manage laborer and contractor 
records.

People Used to create and manage records for people who 
are listed on Maximo records in any capacity.

Person Groups Used to create and manage Person Group records 
that can be used on escalation, Workflow process 
and other records.

Qualifications Used to create and manage certificate and 
qualification records.
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user action on a record, for example escalations and Workflow. Assigning a 
record to a person group rather than an individual person ensures that the 
record will be acted on in a timely manner.   

You use the Labor application to create records for workers and contractors 
who will be performing work on tickets and work orders. 

You use the Crafts application to define skill levels, standard rates, and 
premium pay codes for crafts. You can associate labor records with one or 
more crafts to indicate their various job skills.

You use the Qualifications application to define the qualifications or 
certifications that employees have earned through training or educational 
programs. You can associate qualifications with labor records to verify that 
workers are qualified to perform specialized work.

Interaction Between Labor, Person, and User Records

When you create records for individuals, Maximo requires the creation of 
additional records in the following cases:

! Labor � A labor record must have a person record associated with it. A 
labor record should have a user record if the laborer is going to use 
Maximo to view work orders, report labor hours, and so forth. Other 
resources records are optional, but not required. For example a labor 
record can have 

! one or more crafts
! one or more skill levels associated with a craft 
! one or more qualifications

! Person � A person record does not require any other resource records. A 
person can be a user and a laborer or neither. For example, someone 
calling the service desk to make a service request would not necessarily 
need to be a Maximo user, but your company might require that a person 
record exist for them. 

! User � A Maximo user must have a person record. Other resource 
records (labor, craft and so forth) are optional, but not required. 

Crafts

A craft represents an occupation or trade, and typically the craft name 
reflects the type of work done by members of the trade. If pay rates differ 
based on expertise you can create multiple skill levels and assign different pay 
rates to each skill level. For example, to make a distinction between a junior 
level mechanic and a senior level mechanic, you do not need to create two 
separate craft records. You can create a single craft record of MECHANIC and 
create two skill levels (JUNIOR and SENIOR) within the MECHANIC craft. 
Each skill level within a craft can have different standard pay rates.
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Multisite and Craft Records

Craft records are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

Crafts and Job Plans

Job plans are created at the system level, meaning that they can be used 
anywhere in your organization. For this reason, you probably will want to list 
the more general craft instead of specific laborers when listing the labor 
requirements for a job plan, since you cannot predict when or where the job 
plan will be utilized on a preventive maintenance record or work order. 

Crafts and Labor Records

You can associate a labor record with a craft from either the Labor application 
or the Crafts application. 

A single laborer might have many different job skills. The Crafts table window 
on a labor record allows you to list multiple crafts and skill levels for a laborer.

NOTE: You break the association between a labor record and a craft by deleting 
the labor record from the Associated Labor table window. When you do 
this, you are not deleting the labor record from the database, only 
removing the relationship between that labor record and the craft. 

Craft Records and Work Orders

As with job plans, you may choose to list crafts instead of laborers when 
creating work plans on work orders. This allows the work order to be assigned 
to any available laborer in the craft, on any shift.

Crafts vs. Person Groups

A craft represents an occupation or trade. The members of a craft have the 
same job skills and can be assigned to perform a specific type of work on a 
ticket or work order. Crafts may include contract laborers. Examples of crafts 
include mechanics, electricians, plumbers, and so forth. 

Person groups are a way to group individuals by job responsibilities as 
opposed to craft skills, for example supervisors or managers. The members of 
a person group can be assigned to perform similar types of tasks as part of an 
escalation or a Workflow process, for example approving status changes for 
records. Person groups might include individuals with different job skills, job 
titles, or from different departments within a company. 
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You can also use the Person Groups application to create groups of individuals 
who do not share job skills or responsibilities, but might work as a team on a 
project. For example a safety review team might include members from 
several different departments, crafts, or skill levels.

Using the Crafts Application

To access the Crafts application, click the application link on your Start 
Center, or select Resources > Crafts from the Go To menu. 

The Crafts application contains the following tabs:

! List � to search Maximo for craft records.

! Craft � to create, view, modify, or delete craft records.

! Associated Labor � to add, view, modify, or delete the association 
between labor cords and crafts.

Crafts Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Crafts application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Crafts Help.    

How Do I...?

add outside rates for a craft? On the Crafts tab, click New Row in the 
Outside Rates table window.

add premium pay codes for a craft? On the Crafts tab, click New Row in the 
Premium Pay table window.

add skill levels for a craft? On the Crafts tab, click New Row in the Skill 
Levels table window.

associate labor with a craft? On the Associated Labor tab, click New Row in 
the Associated Labor table window.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a craft record? Click the New Craft button in the toolbar.

delete a record? Select Delete Craft from the Select Action 
menu.

disassociate a laborer from a craft? On the Associated Labor tab, click the Mark 
Row for Delete button for the laborer in the 
Associated Labor table window.

duplicate a record Select Duplicate Craft from the Select Action 
menu.
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Creating Craft Records

You use the Crafts application to create, view, modify, and manage craft 
records. 

You can add one or more skill levels to a craft as a way to indicate which craft 
members have more experience.   You add skill levels by creating new rows in 
the Skill Levels table window. Skill levels are defined by an administrator in 
the Domains application.

You use the Outside Rates table window to record and view the standard rates 
charged by vendors for contract labor for the craft and skill level.

NOTE: Outside rates associated with a labor rate contract can not be modified 
once the contract has been approved.

You use the Premium Pay table window to list premiums paid in addition to 
standard rates, for example premiums paid for working particular shifts, for 
working on holidays, or for possessing a particular qualification or 
certification. You create, view, modify and delete premium pay codes from the 
a master list of premium pay codes using the Manage Premium Pay Codes 
action in the Select Action menu. If the Apply to New Crafts? check box is 
selected for a pay code, Maximo automatically copies the pay code to a new 
craft record when the record is saved. You can add additional premium pay 
codes to a craft by creating new rows in the Premium pay table window. 

You can associate a labor record with a craft from either the Labor application 
or the Crafts application. In the Crafts application you associate labor with a 
craft by creating new rows in Associated Labor table window on the 
Associated Labor tab.

If you are creating craft records with similar skill levels and pay codes you can 
simplify the record creation process by using the Duplicate Craft action 
available from the Select Action menu. When you duplicate a craft record 
Maximo copies the values listed on the record (skill levels, pay codes, laborers 
and so forth).

Managing Craft Records

You can break the association between a labor record and a craft by clicking 
the Mark Row for Delete button for the labor in the Associated Labor table 
window. You must click Save for the deletion to take effect. When you delete a 
labor record from the Associated Labor table window you are not deleting the 
labor record from the database, only removing the relationship between that 
labor record and the craft. 

manage the list of codes for premium pay? Select Manage Premium Pay Codes from the 
Select Action menu.

run reports Select Run Reports from the Select Action 
menu.

How Do I...?
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If a craft record is not listed on any other Maximo record (for example listed on 
a labor record, job plan, or work order) it can be deleted by selecting Delete 
Craft from the Select Action menu. Maximo will display an error message if 
the craft can not be deleted. For more information about the record deletion 
rules, refer to the Maximo System Administrator�s Guide.

Crafts Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Labor Records

A labor record represents an employee or contract laborer. Labor records are 
created for workers who will spend time working on tickets and/or work 
orders, where you want to track either their work hours, or the cost for the 
time they spend working.

You use the Labor application to create, modify, view, and delete labor records 
for employees and contractors. You can provide personal information, as well 
as work related information about a laborer such as their regular and 
premium hours worked, and overtime refused. 

In addition, you can also specify crafts, skill levels, pay rates, qualifications 
and certifications associated with a labor record. 

Multisite and Labor Records

Labor records are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

Labor Records and Assignment Manager

In order to use Assignment Manager to schedule and dispatch work, labor 
records must have a calendar and shift specified. Click the Show/Manage 
Values button next to the Calendar field to access the Calendars dialog box 
to enter, view, or modify this information for a labor record.

Labor Records and Contracts

Labor records for contract labor can be associated with labor rate contracts. 
You use the Labor Rate Contracts application to create records for labor rate 
contracts. If the rate for the laborer is specified by a contract, the Contract 
field will contain a value.
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Labor Records and Crafts

You can associate Labor records to Crafts in either the Labor application or 
the Craft application. 

A single laborer might have many different job skills. The Crafts table window 
on a labor record allows you to list multiple crafts and skill levels for a laborer.

Labor Records and Person Records

Person records contain general personal information, and other information 
needed on Maximo records for non-labor records, such as Workflow and 
purchasing information. Labor records also contain personal information, but 
they are primarily designed to store information about the worker, for 
example craft, skill level, hours worked, certifications, and so forth.

A person record does not require any other resource records. Labor records 
however, cannot be created without a corresponding person record. When you 
create new labor records if you do not specify a value in the Person field, 
Maximo will prompt you to create a matching person record for the labor 
record.

The personal information (name, address, and so forth) in the People 
application is stored in database columns that are shared with the Labor 
application. The data in these fields can be entered or modified from either 
application.

Because person records are stored at the System level, but labor records are 
stored at the Organization level, a single person record can be listed on labor 
records in multiple Organizations. However a person record may only be listed 
on a single labor record within each Organization.

Labor Records and Work Orders

Although you can list labor records on job plans and work orders, you have 
more flexibility if you list craft records instead. Activities, tasks, and work 
orders can be assigned to individual laborers using the Assignment Manager 
application. 

Time spent working on a work order can be recorded while work is being 
performed using the Timer, or after work has been completed using the Labor 
Reporting application. When you enter a labor code in a transaction in the 
Labor Reporting application, Maximo copies data from the labor record to the 
labor transaction. If a laborer has more than one craft, skill level, or rate 
listed on their labor record, you must indicate which craft, skill level, rate, or 
contract applies to the hours you are reporting.

Using the Labor Application

To access the Labor application, click the application link on your Start 
Center, or select Resources > Labor from the Go To menu. 
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The Labor application contains the following tabs:

! List � to search Maximo for labor records.

! Labor � to add, view, and modify data on labor records for employees and 
contractors, including personal information, year-to-date hours, and 
procurement card information.

! Crafts � to add, view, modify, and delete crafts, skill levels, and premium 
pay codes.

! Qualifications � to add, view, modify, and update qualifications and 
certifications for labor records.

Labor Buttons

The following table lists application specific buttons that appear in the Labor 
application. 

Labor Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Labor application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Labor Help.    

Icon Function Location

Change Qualification Status ! Table rows in the Qualifications 
table window

NOTE: The Change Status icon that 
appears in the Toolbar is used 
to change the status of the 
Labor record.

Extend/Renew Qualification ! Table rows in the Qualifications 
table window

View History ! Table rows in the Qualifications 
table window

How Do I...?

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a new courier or labor location to allow 
this laborer to receive issued and transferred 
inventory items?

Select Create Labor Inventory Location 
from the Select Action menu.

create a Labor record? Click the New Labor button in the toolbar.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.
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Creating Labor Records

You create records for laborers and contractors in the Labor application. 
Labor records cannot be created without a corresponding person record. When 
you create new labor records if you do not specify a value in the Person field, 
Maximo will prompt you to create a matching person record for the labor 
record.

You can associate a labor record with one or more crafts from either the Labor 
application or the Crafts application. In the Labor application you associate a 
labor with a craft by creating a new row in the Crafts table window on the 
Crafts tab. Maximo then copies the premium pay codes for that craft to the 
Premium Pay for table window.

If a laborer performs work that required special training you can note their 
qualifications on their labor record. You add, view, extend or renew 
qualifications and certifications on the Qualifications tab of a labor record. 
You can also use the Qualifications tab to note general training that may not 
be job related, for example a new employee orientation that covers general 
company procedures, or first aid certifications.

NOTE: Once you have saved a qualification you cannot delete it.

delete a record? Select Delete Labor from the Select Action 
menu.

duplicate a record? Select Duplicate Labor from the Select Action 
menu.

extend or renew a certification or qualification? On the Qualifications tab, click Extend/Renew 
Qualification.

reset the fields in the Year to Date Hours 
section to zero?

Select Zero Year to Date Hours from the 
Select Action menu.

run reports Select Run Reports from the Select Action 
menu.

view the status history and renewal history of a 
certification or qualification for a laborer?

On the Qualifications tab, click View 
Qualification Status History on the 
qualification�s row.

view the status change history for a record? Select View History from the Select Action 
menu.

How Do I...?
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If you are creating labor records with similar employees, for example several 
contract laborers with the same skills hired from the same vendor, you can 
simplify the record creation process by using the Duplicate Labor action 
available from the Select Action menu. 

Managing Labor Records

The information contained in the Personal section of the Labor application is 
stored in database columns that are shared with the People application. The 
data in these fields can be entered or modified from either application. Some 
fields on a labor record, for example, YTD Hours, are read-only and cannot be 
modified.

Deleting Crafts from a Labor Record

Crafts listed on a labor record can be deleted by clicking the Mark Row for 
Delete button for the row. You must click Save for the deletion to take effect. 
When a craft record is deleted from a labor record, the associated rows in the 
Premium Pay table window are also deleted from the labor record.

Crafts may not be deleted from a labor record if any of the following is true:

! if the labor record is referenced on an assignment record for a work order 
that is in any status except CLOSED or CAN (cancelled), the craft 
referenced on the assignment may not be deleted.

! if the labor record is referenced on a work plan for a work order that is in 
any status except CLOSED or CAN (cancelled), the default craft for the 
labor may not be deleted.

! if the listed craft is the Default Craft for Labor it may not be deleted.

NOTE: If the listed craft is the Default Craft for Labor it can only be 
deleted if it is the only craft listed for the labor record.

Modifying Qualifications

Existing qualifications can be extended or renewed using the Extend/Renew 
Qualification button located on the qualification row. 

Saved qualifications cannot be deleted, but they can have their status changed 
to inactive using the Change Qualification Status button located on the 
qualification row.

You can view the status and renewal history for a qualification using the 
View Qualification Status History button located on the qualification row.

Labor Record Statuses

A labor record can have one of the following statuses:

! ACTIVE � Default status for new records. A labor record must be active 
to be assigned to a work order.
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! INACTIVE � Inactive labor records do not appear in select value lists. 
Labor records with a status of INACTIVE cannot be associated with new 
Maximo records.

When an worker or contractor is no longer employed, they should no longer be 
listed as someone who is available to be assigned work. Their labor record 
should not be deleted, since it is listed on existing Maximo records, but you do 
not want their labor ID listed on any future records. 

You can change the status of a labor record to INACTIVE using the Change 
Status action available from the toolbar and the Select Action menu. The 
status of labor records may not be changed to INACTIVE if any of the 
following is true:

! the labor ID is listed on a work plan for a work order that is in any status 
except CLOSED or CAN

! the labor ID is listed on an assignment for a work order that is in any 
status except CLOSED or CAN

! the labor ID is listed on a job plan record

NOTE: The status of user and person records associated with labor records is 
not automatically changed when a labor�s status changes to INACTIVE. 
The status of these records must be changed in the User and People 
applications.

A status change to INACTIVE is not permanent. The labor record�s status can 
be changed back to ACTIVE, for example if historical labor actuals needed to 
be recorded. 

NOTE: The status of a labor record may not be changed from INACTIVE to 
ACTIVE unless their associated person record also has a status of 
ACTIVE.

Deleting Labor Records

Labor records can be deleted using the Delete Labor action available from 
the Select Action menu. 

CAUTION: Labor records that are listed on Maximo records should have their 
status changed to inactive rather than being deleted. Deleting labor 
records is not recommended.

Labor records may not be deleted if any of the following is true:

! the labor ID is listed on a work plan for a work order that is in any status 
except CLOSED or CAN

! the labor ID is listed on an assignment for a work order that is in any 
status except CLOSED or CAN

! the labor ID is listed on a job plan record

! The labor ID is listed as a labor transaction for work order that is in any 
status except CLOSED or CAN
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For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Labor Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Person Records

A person record is a record of an individual who might appear somewhere 
on a Maximo record, for example, in a Reported By or Affected Person 
fields on a service request, as a Supervisor on a labor record, or as the value 
in a Ship To or Bill To Attention field on a purchasing record.

You use the People application to create, modify, view, and delete records for 
individuals. This application stores personal and official information about 
individuals, such as Maximo users, laborers, asset owners, supervisors, and 
individuals who receive Workflow notifications.

Multisite and Person Records

Person records are at the System, or database level. This means that:

! Key fields for new records must be unique within the Maximo database.

! Records are available to all users of the database who have security 
permissions to the application. 

NOTE: User records are at the System level, but labor records are at the 
Organization level.

Person Records and Workflow

Any individual who will be assigned records as part of a Workflow process 
needs to have a record created for them in the People application.

NOTE: As a best practice, Workflow assignments should be made to a person 
group rather than an individual.

If Workflow processes are created that make assignments to person records, 
the following fields on the person record should contain a value:

! Supervisor 
! Primary E-mail 
! Primary Calendar 
! Primary Shift
! Workflow E-mail Notification 
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You use the Workflow Delegate, Delegate From, and Delegate To fields 
to indicate time periods when a Workflow process should route assignments to 
a designated alternate, for example when a worker is on vacation. 

Person Records vs. Labor Records

For information about the difference between person records and labor 
records, see �Labor Records and Person Records,� on page 10-7.

Using the People Application

To access the People application, click the application link on your Start 
Center, or select Resources > People from the Go To menu. 

The People application contains the following tabs:

! List � to search Maximo for person records.

! Person � to add, view, or modify person records.

People Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the People application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
People Help.    

Creating Person Records

Person records can be created in more than one application:

How Do I...?

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create an Person record? Click the New Person button in the toolbar.

change a record�s status? Click the Change Status button in the toolbar.

delete a record? Select Delete Person from the Select Action 
menu.

indicate that a person�s availability doesn�t 
match their calendar?

Select Modify Person Availability from the 
Select Action menu.

view any assets or locations that list this person 
as an owner or custodian?

Select View Related Assets and Locations 
from the Select Action menu.

view the status change history for a record? Select View History from the Select Action 
menu.
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! People application in the Resources module � Click the New Person 
button in the toolbar to create a new person record.

! Users application in the Administration module � User records must 
have an associated person record. When you create new user records if you 
do not specify a value in the Person field, Maximo will prompt you to 
create a matching person record for the user record.

! Labor application in the Resources module � Labor records must have an 
associated person record. When you create new labor records if you do not 
specify a value in the Person field, Maximo will prompt you to create a 
matching person record for the labor record.

When you create person records from either the Labor or Users application, 
all of the information from the Personal section of the labor or user record is 
copied to the new person record.

A person record can not be duplicated regardless of the current status of the 
record.

Managing Person Records

Person records can be deleted under specific circumstances. The recommended 
procedure for person records you no longer need is to change the status of the 
person record to INACTIVE.

Person Record Statuses

A person record can have one of the following statuses:

! ACTIVE � Default status for new records. A person record must be active 
to be assigned to a labor record or a user record.

! INACTIVE � Inactive person records do not appear in select value lists. 
Person records with a status of INACTIVE cannot be assigned to new 
labor records or new user records.

You can change the status of a person record using the Change Status action 
available from the toolbar and the Select Action menu. The status of person 
records may not be changed to INACTIVE if any of the following is true:

! The person ID is listed as a Supervisor on other person records.
! The person ID is listed as a Supervisor on a job plan record.
! The person ID is listed as a Custodian or a User for an asset or location.
! The person ID is listed on a ticket record as an Owner.
! The person ID is listed on a communications template or a ticket template.
! The person ID is listed as a Ship To contact or as a Bill To contact on a 

purchasing record.
! The person ID is listed as a member of a person group.
! The person ID is listed on a assignment or notification on a ac.tive 

Workflow process

CAUTION: Setting the status of a person record to INACTIVE will also set the 
associated labor and user records� statuses to INACTIVE if these 
records were not already INACTIVE. However, changing the status 
of an inactive person record to ACTIVE does not also change the 
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status of the associated labor and user records. The status of these 
records must be changed to ACTIVE in the Labor and User 
applications.

Deleting Person Records

Person records can be deleted using the Delete Person action available from 
the Select Action menu. Person records may not be deleted if any of the 
following is true:

! The person ID is listed on a user record
! The person ID is listed on a labor record
! The person ID is listed as a Supervisor on other person records
! The person ID is listed as a Supervisor on a job plan record
! The person ID is listed as a Custodian or a User on an asset or location
! The person ID is listed on a ticket record as an Owner
! The person ID is listed on a communications template or a ticket template
! The person ID is listed as a Ship To contact or as a Bill To contact on a 

purchasing record
! The person ID is listed as a member of a person group
! The person ID is listed on a assignment or notification on a active 

Workflow process

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

People Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Person Groups

A person group is a list of individuals who may have similar job 
responsibilities, levels of authority, and security clearances. After you define 
person groups, responsibility for records such as work orders, tickets, and 
purchasing records can be assigned to a group rather than an individual. This 
is useful for time sensitive records, since Maximo can determine which 
member of a group to route a record to based on their calendar and shift.

A person group also can receive a record routed by a Workflow process. If 
Maximo routes a record such as a purchase order or a work order to a person 
group, everyone in the group can receive the record unless the Workflow 
process is configured to send it only to the member whose calendar shows that 
they are available. 

Person groups can also listed as the Owner Group on tickets and work 
orders, and as the Work Group on work orders.

Multisite and Person Group Records

Person Groups are at the System, or database level. This means that:
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! Key fields for new records must be unique within the Maximo database.

! Records are available to all users of the database who have security 
permissions to the application. 

You can specify which Organization and Site a member of a person group 
should be used for by entering a value in the Use for Organization or Use 
for Site field when you add a person to a group. 

Person Groups and Workflow

When you create a Workflow process for a record the various tasks and 
decisions can be assigned to individuals or to groups. As a best practice when 
Workflow processes are designed, records should be assigned to person groups 
rather than individuals. Because different workers may fill a particular role 
on different shifts creating person groups for roles such as "supervisor" or 
"safety engineer" can simplify a Workflow process, as well as reduce the need 
for revisions as workers move in and out of roles.

When you create person groups you can also define alternates for each person 
to handle approvals when the lead is unavailable. 

Using the Person Groups Application

To access the Person Groups application, click the application link on your 
Start Center, or select Resources > Person Groups from the Go To menu. 

The Person Groups application contains the following tabs:

! List � to search Maximo for person group records.

! Person Group � to create, view, or modify person groups.

Person Groups Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Person Groups application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Person Groups Help.   

How Do I...?

add a person to a person group? On the Person Group tab, click New Row in the 
People table window.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a Person Group record? Click the New Person Group button in the 
toolbar.

delete a record? Select Delete Person Group from the Select 
Action menu.
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Creating Person Groups

You use the Person Groups application to create, view, modify, and manage 
person group records.

You associate person records with a person group by creating new rows in the 
People table window.

You use the Alternates For table window to list which person or persons 
should receive Workflow notifications if the person listed in the People table 
window is unavailable.

NOTE: The Alternates For table window is paired with the People table 
window. For more information about paired table windows, see �Paired 
Table Windows,� on page 2-25.

If you are creating person group records with similar member lists you can 
simplify the record creation process by using the Duplicate Person Group 
action available from the Select Action menu. Once a group has been 
duplicated you can then add or delete members from the new group as needed.

Managing Person Groups

You can add members to a person group using the New Row button at the 
bottom of the People or Alternates table window.

You can delete members of a person group by clicking the Mark Row for 
Delete button for the row. You must click Save for the deletion to take effect.

NOTE: The Person Group member designated as Group Default may not be 
deleted.

Deleting Person Groups

Person group records can be deleted using the Delete Person Group action 
available from the Select Action menu. Person group records may not be 
deleted if any of the following is true:

designate an alternate for a person? In the People table window, click the person ID, 
then click New Row in the Alternates for table 
window to add an alternate for the selected 
person.

disassociate a person with a group? On the Person Group tab, click Mark Row for 
Delete next to the person�s ID in the People 
table window.

duplicate a record? Select Duplicate Person Group from the 
Select Action menu.

run reports? Select Run Reports from the Select Action 
menu.

How Do I...?
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! The person group ID is listed on a work order that is in any status except 
CLOSED or CAN

! The person group ID is listed on a ticket that is in any status except 
CLOSED or CAN

! The person group ID is listed on any activities on a ticket template that 
has a status of ACTIVE 

! The person group ID is listed on a communications template or a ticket 
template

! The person group ID is listed on a service group as the Contact Group.
! The person group ID is listed on a preventive maintenance (PM) record
! The person group ID is listed on a job plan record
! The person group ID is listed on a assignment or notification on a active 

Workflow process
! The person group ID is listed on an Organization record as the Site 

Contact Group.

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Person Groups Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Qualifications

A qualification is an indication of a particular job skill or specialized 
training. A qualification is often, but not necessarily, indicated by a license or 
certificate, signifying proficiency in a particular skill or skills. A governing 
board can award a certificate. Some certificates have expiration dates and 
those who hold the certificates must renew them periodically.

You use the Qualifications application to create records of qualifications and 
certification requirements for qualifications. Once you have created 
qualification records, you can associate them with labor records in the 
Qualifications or Labor applications. You can also view qualifications 
associated with a particular labor code and can renew and change the status 
of their qualifications. 

Multisite and Qualifications

Qualifications are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

Qualifications and Labor Records

A qualification is often, but not necessarily, indicated by a license or 
certificate, signifying proficiency in a particular skill or skills. You list 
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qualifications on a labor record to show that the worker has completed some 
sort of general or specific training. Some examples of qualifications might 
include the following:

! General qualifications
! Completed new employee orientation
! First aid training
! Cardiopulmonary Resuscitation (CPR)
! Safety certifications

! Production 
! Journeyman Welder
! Senior Reactor Operator License 
! Forklift Operator�s License

! Facilities 
! Master Electrician�s License
! Journeyman Plumber Certification

! Fleet 
! Heavy Equipment Operator�s License
! Pilot�s License
! Certified Mechanic

! Technology 
! Certified Network Expert
! Certified Systems Engineer
! Certified Linux Engineer

Using the Qualifications Application

To access the Qualifications application, click the application link on your 
Start Center, or select Resources > Qualifications from the Go To menu. 

The Qualifications application contains the following tabs:

! List � to search Maximo for Qualification records.

! Qualification � to create, view, or modify a certificate or qualification.

! Associated Labor � to add, view, modify, or delete the association 
between labor codes and the qualification. Note that once a qualification is 
associated with a labor code, the qualification may not be deleted.

Qualifications Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Qualifications application. For more detailed information, including 
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prerequisites to performing an action and detailed procedures, refer to the 
Qualifications Help.    

Creating Qualifications

You use the Qualifications application to create, view, modify, and manage 
qualification and certification records.

If certification is required for a qualification you can check the Certification 
Required? check box in the Certificate Information section of the 
qualification record. Any craft and skill levels that are required for the 
qualification can be listed in the Required Craft and Skill Levels table 
window. For example a 7018 Welder�s certificate would only be issued to a 
laborer who is a journeyman welder. Tools that require the qualification or 
certification can be listed in the Tools That Require This Qualification table 
window.

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a qualification record? Click the New Qualification button in the 
toolbar.

delete a record? Select Delete Qualification from the Select 
Action menu.

extend or renew the qualification for a laborer? On the Associated Labor tab, click Extend/
Renew Qualification.

list crafts and skill levels that are required for 
the qualification?

On the Qualification tab, click New Row in the 
Required Craft and Skill Levels table window.

list laborers who have earned this qualification? On the Associated Labor tab, click New Row in 
the Labor table window.

list tools that require the qualification? On the Qualification tab, click New Row in the 
Tools that Require the Qualification table 
window.

remove crafts and skill levels that are required 
for the qualification?

On the Qualification tab, click the Mark Row 
for Delete button for the craft in the Required 
Craft and Skill Levels table window.

remove tools that require the qualification? On the Qualification tab, click the Mark Row 
for Delete button for the tool in the Tools that 
Require the Qualification table window.

run reports? Select Run Reports from the Select Action 
menu.

view the status history and renewal history of a 
certification or qualification for a laborer?

On the Associated Labor tab, click View 
Qualification Status History on the laborer�s 
row.
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You can associate a qualification with a labor record from either the 
Qualifications application or the Labor application. In the Qualifications 
application you associate a qualification with a labor record by creating new 
rows in the Labor table window on the Associated Labor tab.

Managing Qualifications

Qualification records can be deleted under specific circumstances. The 
recommended procedure for qualification records you no longer need is to 
change the status of the qualification record to INACTIVE.

Qualifications Statuses

A qualification record can have one of the following statuses:

! ACTIVE � Default status for new records. A qualification record must be 
active to be associated with a labor record.

! INACTIVE � Inactive qualification records do not appear in select value 
lists. Qualification records with a status of INACTIVE cannot be 
associated with labor records.

NOTE: A Qualification may not be made INACTIVE if it is referenced by an 
entry in either of the following tables:

! LABORQUAL (in ACTIVE Status)
! TOOLQUAL

Deleting Qualifications

Qualification records may be deleted by selecting Delete Qualification from 
the Select Action menu. A qualification record cannot be deleted if it is listed 
on a labor record or on a tool record.

Maximo will display an error message if the qualification can not be deleted. 
For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Qualifications Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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The Safety module tracks safety information, which then can be supplied to 
workers after it is associated with work order, asset, location, and item 
records. This includes information that you might be required by law to 
provide to your workers. 

The Safety Module consists of the following applications:    

You use the Hazards and Precautions applications to create generic lists of 
possible hazards that exist in your workplace and possible precautions that 
can be taken to mitigate them. These lists then are used when adding safety 
information to assets, locations, and item records, and when creating safety 
plans. You associate hazards with assets in the Assets application and with 
locations in the Locations application. You associate hazards with item 
records in the Item Master application.

The Lock Out/Tag Out application is used to create specific procedures to be 
applied to specific assets or locations. These procedures describe how to 
eliminate a specific hazard. They might be as simple as turning off electrical 
current to an asset, or as complex as shutting down a nuclear reactor.

All the safety information is brought together in the Safety Plans application, 
where you can define the safety information necessary to provide a safe work 
environment. By identifying hazards, precautions to be taken against those 
hazards, and any specified Tag Out procedures for the asset or location, you 
can provide as much safety information as possible for your maintenance 
personnel.

Safety plans are associated with job plans via the work assets listed on the job 
plan. Safety plans can be listed on a work order manually, or can be copied 
automatically when the combination of a work asset (asset or location) and a 
job plan requires a safety plan. The job plan information can be copied to the 

11 The Safety Module

Application Function

Hazards Used to define hazards that exist in the workplace 
and define how to eliminate or mitigate them.

Lock Out/Tag Out Used to create a detailed description of how to 
eliminate hazards associated with related assets or 
locations.

Precautions Used to define precautions that can be taken to 
mitigate hazards in the workplace.

Safety Plans Used to create a detailed plan of how to service 
assets or locations safely.
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work order from either a preventive maintenance record or a route that is 
associated with the work order, or be manually applied to the work order.

Hazards

A safety hazard is any condition that exists or could exist in the workplace 
that might lead to worker injury, property damage, or financial loss.

You use the Hazards application to define a list of hazards that exist in your 
workplace, associate preventive measures (precautions) with these hazards, 
and attach documents or additional information pertinent to the hazard to the 
record. For example, a chemical that causes skin irritation might require 
wearing gloves and eye protection and be linked to a Material Safety Data 
Sheet (MSDS) and a safety video.

Hazards that you define in this application can be associated with a work 
asset and it�s related assets in the Assets or Locations applications. Then, in 
the Safety Plans application, you can define a set of safety information 
necessary to ensure a safe work environment. Finally, in the Job Plans 
application, you can associate defined safety plans with specific job plans.

When you associate hazards with work orders, assets, locations, and items, 
you provide the opportunity for employees to be notified of potential dangers. 
When you associate a precaution or tag out procedures with a hazard, you 
provide another opportunity to reduce or eliminate the risks involved with the 
asset. 

Multisite and Hazard Records

Hazards are at the Organization level. This means that:

! Key fields for new records must be unique for the Organization, but may 
duplicate record IDs used by other Organizations.

! Records can only be viewed by users who have security permission to the 
Organization and the application.

Hazards and Assets/Locations

A hazard record defines a general source of danger that is not specific to any 
particular asset or location.The same hazard may be listed on many different 
Maximo records. The relationship between hazards and work assets is defined 
as follows:

! Hazards are associated with related assets/locations.

! Related assets are associated with work assets on the Safety Related 
Assets subtab of the Safety tab.

! A work asset (asset or location) is always considered a related asset to 
itself.

You list hazards on the Safety tab of an asset or location record.
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! You use the Hazards and Precautions subtab to associate precaution 
enabled hazards with the record. Maximo automatically displays the 
precautions associated with the hazard on the record. If you list a hazard 
that is also hazardous material enabled, Maximo automatically displays 
the hazardous materials data.

! You use the Hazardous Materials subtab to associate hazardous material 
enabled hazards with the record. If you list a hazard that is also 
precaution enabled, Maximo automatically displays the precautions.

! You use the Lock Out / Tag Out subtab to associate tag out enabled 
hazards with the record. Once you have created a tag out for the work 
asset and hazard, you can associate it with the work asset record.

! You use the Safety Related Assets subtab to associate related assets and 
locations whose safety information should be included when creating 
safety plans for the asset or location. A work asset (asset or location) is 
always considered a related asset to itself.

Hazards and Item Records

Hazards can be associated with item records in the Item Master application 
via the Item/Organization Detail action available from the Select Action 
menu. Item records are defined at the Item Set level in Maximo (which exists 
below the System level, but above the Organization level) and Hazards are 
defined at the Organization level. When hazard-associated items are listed on 
work plans, Maximo displays the hazardous material information on the 
record.

The Can Have Hazardous Materials? check box on the hazard record must 
be checked before it can be associated with an item record.

Hazards and Precautions

Precautions that can be taken against a hazard are defined in the Precautions 
application, but are applied in the Hazards application. The Associated 
Hazards table window on a precaution record is a read-only list of the hazard 
records that a precaution has been associated with.

The Can Have Precautions? check box must be selected on a Hazard record 
before you can associate precautions with the hazard. You list precautions on 
the Precautions tab of a hazard record. You can associate multiple precautions 
with a hazard.

Hazards are defined at the Organization level, but precautions are defined at 
the Site level, which allows you to use different precautions against the same 
hazard at different Sites.

Hazards and Safety Plans

You create safety plans to inform workers of hazards they may encounter 
while performing work. 
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! Precaution enabled hazards are listed on the Hazards and Precautions tab 
of a safety plan.

! Hazardous material enabled hazards are listed on the Hazardous 
Materials tab of a safety plan.

! Tag out enabled hazards are listed on the Tag Outs tab of a safety plan.

Hazards and Tag Outs

The Tag Outs tab on a hazard record displays a read-only list of tag outs that 
have been created to eliminate the hazard. The tags outs listed on this tab are 
associated with the hazard record because they are listed on the Lock Out/Tag 
Out subtab of the Safety tab of asset or location records. When a tag out-
enabled hazard is listed on an asset or location record you can use the Lock 
Out/Tag Out application to create a tag out record to eliminate the hazard. 
Tag outs are created for a particular asset or location, but they may be 
associated with more than one hazard if the procedure eliminates more than 
one hazard. For example tagging out an asset might eliminate hazards from 
heat, electrical current, and rotating blades.

Using the Hazards Application

To access the Hazards application, click the application link on your Start 
Center, or select Safety > Hazards from the Go To menu.

The Hazards application contains the following tabs:

! List � to search Maximo for hazard records.

! Hazards � to create, view, or modify a hazard. Use to indicate whether 
the hazard can be associated with precautions, hazardous materials, and 
tag out procedures. Also use to list hazardous material information for the 
hazard.

! Precautions � to create, view, or delete associations with previously 
defined precautions.

! Tag Outs � to view a read-only list of tag out procedures. These tag outs 
have been associated with an asset against the hazard, either in the 
Assets or Locations applications.

Hazards Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Hazards application. For more detailed information, including 
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prerequisites to performing an action and detailed procedures, refer to the 
Hazards Help.    

Creating Hazard Records

You use the Hazards application to define a list of hazards that exist or could 
exist in your workplace. You can define a list of hazards, for example, dust, 
chemicals, and electrical current, which can be applied to many assets or 
locations, or hazards that are specific to only one asset or location.

When you create hazard records you can

! associate the hazard with a Type, for example, "mechanical" or "health."

! define the associations available for the hazard. These associations 
determine where the record can be used.

! record hazardous material information about the health, flammability, 
reactivity, and contact rating for the hazard.

! associate precautions that can mitigate the hazard.

! associate tag outs that can eliminate the hazard.

CAUTION: In order for a hazard to be associated with assets or locations, appear 
in value lists, or have additional safety information associated with 
it, you must define the associations that are available for a hazard. 

! Can Have Precautions? must be selected before you can list 
associated precautions on the Precautions tab. Precautions are defined 
in the Precautions application.

! Can Have Hazardous Materials? must be selected before you can 
enter data in the Hazardous Material Information section of the 
Hazard tab.

How Do I...

associate precautions with the hazard? On the Precautions tab, click New Row in the 
Associated Precautions table window.

associate lock outs or tag outs with a hazard? You associated tag outs records in the Assets or 
Locations applications that list the hazard on 
the record.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a hazard record? Click the New Hazard button in the toolbar.

delete a record? Select Delete Hazard from the Select Action 
menu.

duplicate a record? Select Duplicate Hazard from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.



Lock Out/Tag Outs

11-6 Maximo 6, 08/2006

! Can Have Tag Outs? must be selected before you can associate tag 
outs with assets, locations, and safety plans to eliminate the hazard. 
Tag outs are defined in the Lock Out/Tag Out application. 

NOTE: If a hazard is tag out enabled it can not be precaution enabled or 
hazardous material enabled.

Hazards Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Lock Out/Tag Outs

A tag out procedure is designed to eliminate a hazard to ensure a safe work 
environment. Maximo uses the term tag out to describe the entire procedure, 
and the term lock out to describe the steps in a tag out procedure. Records 
created in the Lock Out/Tag Out application are identified by a tag out ID, 
which is also used to identify the tag out in other applications.

You can create tag out procedures that describe how to control hazardous 
energies, that is energy that if released could cause a serious accident or 
physical harm.   Examples of hazardous energy include: 

! electrical � electrical wiring and outlets, high voltage
! chemical � toxic chemicals, potential chemical reactions, fires, or 

explosions
! kinetic � moving parts, falling objects
! thermal radiation � heat, cold, radiation
! pressure � water pressure, pressurized gases, vacuum pumps

When you create a tag out procedure you provide information about how 
hazardous energies should be controlled. This may involve taking the work 
asset out of service so that the system cannot be accidentally operated. 

Multisite and Lock Out/Tag Out Records

Tag out records are created for either a specific asset or location, Both of 
which are defined at the Site level in Multisite. Thus tag out records are 
defined at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.



Chapter 11: The Safety Module

Maximo 6, 08/2006 11-7

Tag Outs and Assets/Locations

A tag out procedure is associated with a single asset or location. However, an 
asset or location may have multiple tag outs associated with it for eliminating 
different hazards or that correspond to different tasks or operating conditions.

You should create a tag out procedure for any asset or location that has 
hazards which have procedures to eliminate them.

Tag Outs and Hazards

You should create tag out enabled hazard records for all of the potentially 
hazardous energies that exist in your workplace. For some examples of 
hazardous energies, see �Lock Out/Tag Outs,� on page 11-6.

Tag Outs and Safety Plans

When you list tag outs on a Safety Plan, you can only select from tag outs that 
have been created for the safety related assets of the work assets (assets and 
locations) listed on the Safety Plan.

NOTE: A work asset (asset or location) is always considered a related asset to 
itself.

Tag Outs and Work Orders

You use the Select Safety Hazards action in the Work Order Tracking 
application to select hazards that are associated with the related assets for 
the work order�s asset or location. A work asset (asset or location) is always 
considered a related asset to itself. When you select hazards, Maximo displays 
any tag outs associated with the hazard on the Safety Plans tab of the work 
order record.

Using the Lock Out/Tag Out Application

To access the Lock Out/Tag Out application, click the application link on your 
Start Center, or select Safety > Lock Out/Tag Out from the Go To menu. 

The Lock Out/Tag Out application contains the following tabs:

! List � to search Maximo for Lock Out/Tag Out records.

! Lock Out/Tag Out � to create, view, or modify tag out procedures.

Lock Out/Tag Out Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Lock Out/Tag Out application. For more detailed information, 
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including prerequisites to performing an action and detailed procedures, refer 
to the Lock Out/Tag Out Help.      

Creating Tag Outs

You create a tag out procedure to eliminate a defined hazard on a specific 
asset or at a specific location. A tag out procedure can be written to eliminate 
one or more hazards for a specific asset or at a specific location.

To create a tag out procedure, you describe the lock out tasks needed to 
accomplish the tag out. You use the Lock Out Operations table window to 
define the steps to follow to remove a work asset from service and place it in a 
safe condition. A safe condition might be defined as the asset or location has 
been isolated, had power shut down, been vented, been drained, is de-
pressurized, and so on.

These operations can include the following:

! An Asset listed in the Assets application, or a Location listed in the 
Locations application, but not both.

! A Description of a locking device not listed in either the Assets or the 
Locations application, for example, a valve that needs to be opened.

! A Description of an instruction or action to be taken, not referring to any 
device or asset, for example, "Notify control room before performing the 
next operation."

! You can indicate if there is a Locking Device Required State at each 
step, for example, "Circuit breaker closed." 

! The Apply Sequence values indicate the order the steps are to be 
completed in. You also can indicate a Remove Sequence if the order of 
the steps is different when the procedure is reversed.

How Do I...

add lock out operations to a tag out record? Click New Row in the Lock Out Operations 
table window.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a tag out record? Click the New Tag Out button in the toolbar.

delete a record? Select Delete Tag Out from the Select Action 
menu.

duplicate a record? Select Duplicate Tag Out from the Select 
Action menu.

remove a lock out operation from a tag out 
record?

Click the Mark Row for Delete button for the 
row in the Lock Out Operations table window.

run reports? Select Run Reports from the Select Action 
menu.
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You can use the Duplicate Tag Out action to create a copy of an existing tag 
out, for example if you have multiple assets that need the same tag out. Once 
you duplicate a tag out you can then modify it as needed.

Managing Lock Out/Tag Out Records

Because a tag out record is created for a specific asset or location, a tag out 
record cannot be applied to other assets or locations. 

You can delete a tag out record using the Delete Tag Out action available 
from the Select Action menu. A tag out may not be deleted if any of the 
following is true:

! Tag out contains lock out operations.
! Tag out is associated with a hazard.

Lock Out/Tag Out Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Precautions

A safety precaution is a preventive measure that you take to mitigate a 
hazard that cannot be completely eliminated, for example wearing hearing 
protection when working in an area where you are exposed to loud noises.

The Precautions application lets you define precautions against hazards in 
the workplace. You then can associate these precautions with workplace 
hazards in the Hazards application. 

When you define safety precautions and associate them with workplace 
hazards, you provide information about how employees can mitigate or 
eliminate hazards involved with workplace tasks. Using the Attached 
Documents feature, you can also associate a precaution with more information 
in the form of a word processor file, spreadsheet, or Web page.

Multisite and Precaution Records

Precautions are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Hazards are defined at the Organization level, but precautions are defined at 
the Site level, which allows you to use different precautions against the same 
hazard at different Sites.
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Precautions and Assets/Locations

Precautions are not associated with asset or location records. You do not take 
precautions because of an asset or location, you take precautions because of a 
hazard associated with that asset or location. When you list a hazard on the 
Hazards and Precautions subtab of the Safety tab in the Assets or Locations 
application, Maximo displays any precautions associated with the hazard on 
the asset or location record.

Precautions and Hazards

You use precautions to mitigate the effects of a workplace hazard. Whenever a 
precaution-enabled hazard record is associated with a Maximo record, 
Maximo automatically displays the precautions associated with the hazard.

Precautions are associated with hazards in the Hazards application. The Can 
Have Precautions? check box on a hazard record must be selected before 
you can associate precautions with the hazard. The Associated Hazards table 
window on a precaution record shows the hazards that the precaution has 
been associated with. The same precaution could be applied to more than one 
hazard. For example, you might wear gloves to protect you from multiple 
hazards. 

Precautions and Safety Plans

When you list a hazard on the Hazards and Precautions tab of the safety plan, 
Maximo displays any precautions associated with the hazard.

Using the Precautions Application

To access the Precautions application, click the application link on your Start 
Center, or select Safety > Precautions from the Go To menu. 

The Precautions application contains the following tabs:

! List � to search Maximo for precaution records.

! Precaution � to create, view or delete precautions. Also use to view a 
read-only list hazards that the precaution has been associated with in the 
Hazards application.

Precautions Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Precautions application. For more detailed information, including 
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prerequisites to performing an action and detailed procedures, refer to the 
Precautions Help.      

Creating Precaution Records

You can define a list of precautions, for example, wear a hard hat, wear eye 
protection, wear gloves, which can be applied to many hazards, or define 
precautions that are specific to a particular hazard.

When creating precaution records, consider what to name the precautions. For 
example, if your company uses more than one type of protective glove, you 
might name the records GLOVE1 - Latex glove, GLOVE2 - Rubber glove, 
GLOVE3 - Leather glove, and so forth.

You can use the Duplicate Precaution action to create a copy of an existing 
precaution, for example if you are creating a similar list of precautions for 
different Sites. Once you duplicate a precaution you can then modify it as 
needed.

Managing Precaution Records

Once you create and save a precaution record the only field that you can edit 
is the Description. You can delete a precaution record using the Delete 
Precaution action available from the Select Action menu. You cannot delete 
a precaution if it is associated with a hazard. 

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Precaution Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

How Do I...

associate hazards with a precaution? Hazards are associated with precautions in the 
Hazards application.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a precaution record? Click the New Precaution button in the 
toolbar.

delete a record? Select Delete Precaution from the Select 
Action menu.

duplicate a record? Select Duplicate Precaution from the Select 
Action menu.
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Safety Plans

A safety plan contains safety information for an asset or location, including 
hazards, precautions, hazardous materials, and tag out procedures to follow in 
order to perform the work safely. This information can range from the safety 
information necessary to follow a specific job plan on a specific work asset, to a 
general plan for how to handle a hazardous situation. 

For example, an asset, such as a pump, must be shut down in a particular way 
to minimize electric shock, or materials leakage, before any maintenance can 
be performed. Or before maintenance personnel can enter a particular 
location safely they must be notified that they might be exposed to chemicals 
and should wear eye protection and protective clothing. 

You must clearly associate safety requirements and procedures with work 
orders to fulfill regulatory requirements of agencies such as the Occupational 
Safety and Health Administration (OSHA) in the United States. You must 
show that employees have been informed of hazards they might encounter 
while performing work, as well as actions they must take to prevent accidents.

Safety plans provide a means of compiling all safety related information about 
the asset or location in one record, which can then be copied to job plans and 
work orders.

Multisite and Safety Plans

Safety Plans are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Safety Plans and Assets/Locations

A safety plan is created for specific work assets (assets or locations). You can 
list multiple work assets on the same safety plan, for example if your company 
owns several identical pumps or motors, and the work assets require the same 
safety information.

Safety Plans and Hazards

You create a safety plan to inform workers of hazards they may encounter 
while performing work. 

! The list of hazards available on the Hazards and Precautions tab is 
restricted to precaution enabled hazards. Maximo automatically displays 
the precautions associated with the hazard. If you list a hazard that is also 
hazardous material enabled, Maximo automatically displays the 
hazardous materials data.
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! The list of hazards available on the Hazardous Materials tab is restricted 
to hazardous material-enabled hazards. If you list a hazard that is also 
precaution-enabled, Maximo automatically displays the precautions.

NOTE: If a work order�s work plan includes an item that has a hazardous 
material-enabled hazard associated with it, Maximo automatically 
displays the precautions.

! The list of hazards available on the Tag Outs tab is restricted to tag out 
enabled hazards.

! The list of hazards available when you select the Select Hazards action 
from the Select Action menu is restricted to hazards listed on safety 
related assets on the work asset records. A work asset (asset or location) is 
always considered a safety related asset to itself.

Safety Plans and Job Plans

You associate safety plans with a job plan via the work assets (assets and 
locations) that you include on the job plan.

You list assets, items, or locations that the job plan applies to on the Work 
Assets tab. Because a job plan can list more than one work asset, a job plan 
can have more than one safety plan associated with it. When a work asset is 
listed on a work order Maximo checks for a required safety plan for the 
combination of the work asset and the job plan. When the combination of a 
work asset (asset or location) and a job plan requires a safety plan Maximo 
automatically copies the safety plan to the work order.

Safety Plans and Precautions

When you associate hazards with a safety plan, Maximo automatically 
displays the associated precaution information.

Safety Plans and Tag Outs

You can list multiple work assets on the same safety plan, for example if your 
company owns several pumps or motors that share the same safety 
information. Tag out procedures are work asset specific. If you list multiple 
work assets on a safety plan that have tag outs, you would need to list each 
tag out on the safety plan. When you apply the safety plan to a work order, 
Maximo displays the tag out that matches the asset or location to the work 
order.

Safety Plans and Work Orders

A safety plan can be associated with a work order in the following ways:

! You can select a value in the Safety Plan field to apply an existing safety 
plan.

! If the combination of the work asset (asset or location) and the job plan 
listed on the work order requires a safety plan Maximo automatically 
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copies the safety plan to the work order. Job plan data can be copied to a 
work order from a preventive maintenance record or a route.

! You can create a safety plan for the work order on the Safety Plan tab.

When you select safety plans for a work order you can choose to 

! view all safety plans
! view safety plans that match the asset or location on the work order
! view safety plans that are listed on the job plan for the work order

Only one safety plan can be attached to each work order. When you associate 
a safety plan with a work order Maximo displays the following information 
from the safety plan:

! hazards, precautions, and associated work assets from the Hazards and 
Precautions tab.

! hazards and precautions from the Hazardous Materials tab.
! tag outs from the Tag Outs tab. If a safety plan lists multiple work assets, 

Maximo displays the tag out that matches the asset or location on the 
work order.

Using the Safety Plans Application

To access the Safety Plans application, click the application link on your Start 
Center, or select Safety > Safety Plans from the Go To menu. 

The Safety Plans application contains the following tabs:

! List � to search Maximo for safety plan records.

! Safety Plan � to create, view, or modify safety plans and to view work 
assets associated with a selected safety plan.

! Hazards and Precautions � to enter or view hazards associated with 
the selected safety plan and to view precautions against those hazards. 
Precautions are defined in the Precautions application.

! Hazardous Materials � to enter or view details about hazardous 
materials associated with the selected safety plan. Hazardous Materials 
are defined in the Hazards application.

! Tag Outs � to enter or view hazards defined for each work asset and tag 
out procedures associated with each hazard. Tag Outs are created in the 
Lock Out/Tag Out application.

Safety Plans Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Safety Plans application. For more detailed information, including 
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prerequisites to performing an action and detailed procedures, refer to the 
Safety Plans Help.      

Creating Safety Plans

You can create a safety plan any time you have safety information that you 
want to reuse. A safety plan can be applied to more than one asset, location, 
job, or situation. 

A safety plan should include all the information needed to perform a specific 
type of work safely. Before you create a new safety plan, think about the 
following questions:

! Which work assets might use the safety plan? When designing a safety 
plan, the work asset combined with the type of work (job plan) dictates 
which safety information is required.

! What other assets or locations might have associated hazards or other 
safety concerns that should be considered? 

! Which hazards relate to the work assets�s related assets?   (A work asset 
(asset or location) is always considered a safety related asset to itself.)

How Do I...

associate precautions with hazards listed on the 
safety plan?

Precautions are associated with hazards in the 
Hazards application.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

create a safety plan? Click the New Safety Plan button in the 
toolbar.

delete a record? Select Delete Safety Plan from the Select 
Action menu.

duplicate a record? Select Duplicate Safety Plan from the Select 
Action menu.

list work assets (assets or locations) for the 
safety plan?

On the Safety Plan tab, click New Row in the 
Work Assets table window.

list hazards on the safety plan? On the Hazards and Precautions tab, click New 
Row in the Hazards table window.

list hazardous materials on a safety plan? On the Hazardous Materials tab, click New 
Row in the Hazardous Materials table window.

list lock outs or tag outs on a safety plan? On the Tag Outs tab, click New Row in the 
Hazards table window to add a hazard, then 
click New Row in the Tag Outs for table 
window.

run reports? Select Run Reports from the Select Action 
menu.

select hazards for work assets and related 
assets to include on the safety plan?

Select Select Hazards from the Select Action 
menu.
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! Are there hazardous materials associated with the asset or location or the 
type of work that is going to be performed?

! Are there tag outs created for the asset or location that might apply to this 
safety plan?

If the safety plan is for an asset or location, you indicate it in the Work Assets 
table window on the Safety Plan tab. 

Associating Hazards and Precautions

You can associate hazard records with a safety plan. If these hazards have 
associated precautions, Maximo displays this information on the safety plan. 
These hazards and their associated precautions are defined in the Hazards 
application.

If the hazard is associated with more than one asset, you create a separate 
row in the Hazards table window for each Related Location or Related 
Asset. For example, if you create a safety plan for electrical current at a 
location, the location might have more than one electrical outlet. Each outlet 
must be identified separately on the safety plan.

TIP: If you enter a value in the Related Location or Related Asset field, 
Maximo copies the value to work order records that list the safety plan, 
allowing workers to know which work assets are associated with the 
hazards.

Associating Hazardous Materials

You use the Hazardous Materials tab to associate hazards that have 
hazardous material data defined for the hazard record, with the safety plan. 
The data can include, for example, Material Safety Data Sheets (MSDS), 
health ratings, and flammability ratings.

If the hazardous material is associated with more than one asset, you create a 
separate row for each asset or location.

NOTE: If a hazard is both precaution-enabled and hazardous material-enabled, 
Maximo automatically displays the data on both the Hazards and 
Precautions and the Hazardous Materials tabs.

Listing Tag Outs

You use the Tag Outs tab to list tag out-enabled hazards and associate tag 
outs with the safety plan. Tag outs are asset or location specific. 

! If the hazard is associated with more than one asset or location, you must 
create a separate row for each asset or location and its tag out. For 
example, if you shut down a ventilation system, each fan has its own tag 
out, specific to its asset or location record. 

! If a tag out eliminates more than one hazard, you must associate the tag 
out with each hazard individually.

Duplicating a Safety Plan

You can use the Duplicate Safety Plan action to create a copy of an existing 
safety plan, for example if you are creating similar safety plans for different 
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work assets. When you duplicate a safety plan, Maximo copies all the 
information from the original to the duplicate, including all work asset and 
hazard information. Once you duplicate a safety plan you can then modify it 
as needed.

Managing Safety Plans

You can delete a safety plan using the Delete Safety Plan action available 
from the Select Action menu. You cannot delete a safety plan if it is associated 
with any open or active (non-history) record. 

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Safety Plans Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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A Service Desk is a single point of contact for users who need help or support 
with hardware or software issues. A service desk might also log calls for non-
IT maintenance requests and route them to the appropriate maintenance 
team. Some service desks function as an internal service desk whose 
customers are within the same company and others function as a service 
provider to external clients. 

Maximo�s Service Desk applications are designed to conform to Information 
Technology Infrastructure Library (ITIL®) standards, but can support all 
asset types (facilities, fleet, information technology, and production) and can 
be configured to meet a variety of needs.

The Service Desk Module consists of the following applications:    

You use the Ticket Templates application to create templates to be applied to 
common service desk calls. You can define details that will be copied to the 
ticket record when the template is applied in one of the ticket applications 
(Service Requests, Incidents, and Problems applications), for example who is 
responsible for the type of work to be done, and what activities should be 
included on the ticket.

12 The Service Desk Module

Application Function

Activities Used to report work on activity class work orders.

Changes Used to create records to track changes made to 
information technology (IT) assets.

Incidents Used to create records of incidents that result in an 
interruption to or reduction in the quality of a 
service.

Problems Used to create records of the underlying problems 
that cause incidents and service requests.

Releases Used to create records to plan and record the 
release of changes to information technology (IT) 
assets.

Service Requests Used to create records of customer calls or e-mail 
requesting service. 

Solutions Used to create a library of reusable solutions which 
can be applied to incident and problem records

Ticket Templates Used to create templates for common service desk 
calls.
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You use the Service Requests application to record requests for information, 
maintenance, and service.

You use the Incidents application to record any event which is not part of the 
standard operation of a service, and which causes, or may cause, an 
interruption to, or a reduction in, the quality of that service. 

You use the Problems application to record any event which causes, or could 
potentially cause, incidents which disrupt service. 

You use the Changes application to plan, review, and approve changes for 
assets and locations. Typically you create change records when there is a need 
to alter an information technology asset and you want to manage that change 
via the Changes application.

You use the Releases application to plan, review, and authorize the release of 
a change to an asset or location. Typically you create release records when you 
are testing and releasing a series of changes into the "live" environment for an 
information technology asset or location.

You use the Activities application to manage activity work orders created in 
other applications. Non Service Desk workers or technicians can use the 
Activities application to report completion of activity work orders assigned to 
them by Service Desk agents.

You use the Solutions application to create and manage records of known 
solutions to issues. Solution records can be restricted to just Service Desk 
agents, or can be shared with self-service customers.

Depending on your business needs, your company may choose to implement 
some or all of the Service Desk applications. You can pick and choose the 
applications that best support your business processes. The Service Desk 
module is flexible enough to allow for many different implementation models. 

Service Desk Terms

This guide uses the following terms when discussing the service desk 
applications:

! A service organization is a department or organization that has 
implemented Maximo to manage their operations and processes. This 
might be a maintenance department, facilities department, physical plant 
department, IT department, call center or service desk, operations group, 
IT asset management group, an engineering department, or other group.

! A Service Desk agent is a Maximo user who is responsible for taking calls 
and managing service requests, incidents, problems, and changes using 
the Service Desk applications.

! A requestor is a user or person who calls or e-mails the Service Desk, or 
reports issues or requests via the Self-Service Service Request module.
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About Ticket Records

The records created in the following Service Desk applications are stored in 
the TICKET table in the database:

! Incidents application
! Problems application
! Service Request application

Maximo distinguishes these records by the value in the Class column in the 
database. By default, when Maximo creates a ticket record, it enters a value in 
the Class field to indicate if the record is a service request, incident, or 
problem record.

Maximo uses the Class field as a filter to determine which records from the 
TICKET table to display for each of the ticket applications. You cannot search 
for records of a different Class from within an application. For example, you 
cannot use the Service Requests application to search for incident records, you 
must use the Incidents application.

NOTE: Maximo assigns the Class value to new records automatically. The only 
place where the Class field is visible is on a Related Records tab.

About Work Orders

The records created in the following Service Desk applications are stored in 
the WORKORDER table in the database:

! Activities application
! Changes application
! Releases application

NOTE: Work orders can also be created in the Quick Reporting and Work Order 
Tracking applications, but cannot be viewed in the Service Desk 
applications.

Maximo distinguishes these records by the value in the Class column in the 
database. By default, when Maximo creates a work order record, it enters a 
value in the Class field to indicate if the record is an activity, change, release, 
or work order record.

Maximo uses the Class field as a filter to determine which records from the 
WORKORDER table to display for each of the work order applications. You 
cannot search for records of a different Class from within an application. For 
example, you cannot use the Activities application to search for change 
records, you must use the Changes application.

NOTE: Maximo assigns the Class value to new records automatically. The only 
place where the Class field is visible is on a Related Records tab.

Tickets and Work Orders

A ticket record is used to record a customer request or issue, while a work 
order record records the details of the work performed to resolve the issue. 
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While an incident or problem record may require work to be performed, it is 
recorded on the Activities tab, and activity records are work order records.

When you want to create standardized templates for ticket records you use the 
Ticket Templates application to list the details and activities for the ticket. 
When you want to create standardized templates for work orders, you use the 
Job Plans application to list the tasks, labor, materials, services, and tools for 
the work.

NOTE: Because the information about creating and managing tickets and work 
orders in each of the Service Desk applications are similar, the 
information is presented in the following general overviews, and is not 
repeated for each application.

Multisite and Ticket Records

Because Service Desks are frequently used to manage information technology 
assets for an entire company, ticket records are created at the System, or 
database level. This means that:

! Key fields for new records must be unique within the Maximo database.

! Records are available to all users of the database who have security 
permissions to the application. 

If the ticket is going to be managed at the Site level, you can indicate a Site on 
the ticket record. Site information may be recorded on ticket records in a 
number of ways. The Asset Site field will default to the Site listed on the 
person record of the Affected Person.

Multisite and Work Orders

Work orders are defined at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! The key field must be unique for work orders where CLASS = 
WORKORDER.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Creating Tickets

Ticket records are created in the Service Requests, Incidents, and Problems 
applications. Because the resolution of a ticket sometimes involves the 
creation of additional service request, incident, or problem records, Maximo 
allows you to create ticket records from within a ticket record via the Create 
<record> actions. These actions are available from the Select Action menu in 
the following applications:

! Activities
! Changes
! Incidents
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! Problems
! Quick Reporting
! Releases
! Service Requests
! Work Order Tracking

Ticket records can also be created automatically using data from e-mail 
messages, system monitoring tools, or external software applications.

TIP: Entering a Classification on a ticket can help limit the number of 
duplicate tickets that are entered in the system. You can use the Show 
Similar Tickets action to search for tickets with the same classification.

Using Ticket Templates

Frequently the calls that a Service Desk receives will include similar, 
unrelated service requests, for example every time a new employee is hired, 
the service desk receives a request for a computer to be configured for them.

You can use the Ticket Templates application in the Planning module to 
create standardized templates for issues that generate a high-volume of 
similar tickets. A ticket template can include response activities and an 
Owner or Owner Group who will assume responsibility for the ticket. You 
apply templates to a ticket record using the Apply <ticket class> Template 
action found in the Select Action menu of each ticket application.

Once a ticket template is copied to a ticket record, the information from the 
template can be modified as needed. Using ticket templates reduces the 
amount of time Service Desk agents spend on data entry and allows for a pre-
planned response to high-volume calls. For more information about creating 
and using ticket templates, refer to the Ticket Templates Help. 

Ownership of Tickets

Individuals or groups can assume responsibility, or "ownership" of a ticket in 
Maximo. When a group owns a ticket, all members of the group see the ticket 
in their Work View. You can assume or assign ownership of a ticket using the 
Select Owner and Take Ownership actions. When ownership of a ticket 
changes from a group to an individual, the ticket no longer appears in the 
Work View of other group members. 

When an agent takes ownership of a ticket they are responsible for managing 
the ticket until it is resolved (that is, service is restored to the customer or 
business unit), or the ticket is delegated to another group or person. 

Your company may design a Workflow process that automatically assigns 
ownership of new tickets to the appropriate agent or group. Ownership of a 
ticket can be changed, for example if a more knowledgeable or technical group 
needs to address the issue, or because an service level agreement (SLA) calls 
for escalation of the ticket to a different group if it is not resolved within a 
certain period of time.

NOTE: The Owner and Owner Group fields are read-only. Values can only be 
entered in these fields via the Select Owner and Take Ownership 
actions. 
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Classifying Tickets

Maximo includes a feature called Classifications which can be used to 
structure records into organized hierarchies. Using classifications helps you to 
more easily locate records, and helps to ensure that records are not duplicated 
unintentionally.

Your system administrator creates one or more different classification 
hierarchies using the Classifications application. By default Classifications 
allows you to classify and search the following types of records:

! assets
! items
! locations
! solutions
! tickets (service requests, incidents, problems)
! work orders (activities, changes, releases, work orders)

You can classify solutions, tickets, and work orders by entering a value in the 
Classification field on a record.

Priority and Tickets

Maximo uses values between 1 and 4 to indicate priority for service requests, 
incidents, and problems with 1 being the most urgent priority and 4 being the 
lowest priority. You can use the priority values on a ticket to help determine 
which ticket a service desk agent should work on first when there are 
"competing" tickets for similar assets or locations.

Maximo uses two priority fields on tickets:

! Reported Priority � Priority of the ticket as determined by the person 
making the request or reporting the issue.

! Internal Priority � Priority of the ticket as determined by the service 
desk agent. This value can differ from the value in the Reported Priority 
field.

Activity, change and release records contain an Asset/Location Priority 
field. For information about asset and location priorities, see �Asset/Location 
Priority,� on page 3-3.

Related Records

The Service Desk applications all contain a Related Records tab, which allows 
you to view all of the tickets and work orders that have a relationship to or 
provide additional information about the record you are viewing. A single 
record can be related to many other records. 

NOTE: The Related Records relationship is non-hierarchical. With the 
exception of global issues (discussed in �Global Issues,� on page 12-8) 
associating one record with another does not create any type of direct 
relationship or cause one record to control the status of another record.
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Types of Related Records

The Related Records tab contains two table windows, displaying all ticket 
records and work order records that are related to the current record. The 
value in the Relationship field identifies how the ticket or work order is 
related to the current record. 

Service Requests application - Related Records tab

There are five relationship types:

! Global � indicates that the record is a Global Issue. This ticket type is 
applied to a record when the Global Issue? check box is selected on an 
incident or problem record. Work order records cannot be Global Issues.

! Follow up � indicates that a record has been created as a follow-up to 
another record via one of the Create <record> actions, for example 
Create Change. Both tickets and work orders can be created as follow-up 
records.

! Originator � indicates that the current record was generated from the 
related record. This type is applied to a record when follow-up record is 
created via one of the Create <record> actions, for example Create 
Change. Both tickets and work orders can create other records.

! Related � indicates that a record has been related to the current record 
to provide additional information. This type is applied to records that are 
added to one of the Related records tables using the New Row button. 
Both tickets and work orders can be related in this manner.
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! Related to Global � indicates that the record is related to a Global 
Issue. This type applies to tickets that contain a value in the Related to 
Global ID field. This type of relationship does not apply to work orders.

Relating Other Records to a Ticket

Relationships between records can be created using one of the following 
methods:

! creating one or more records via the Create <record> actions available in 
the Select Action menu.

! associating one or more work orders with a record via the Select Work 
Orders button in the Related Work Orders table window.

! associating one or more tickets with a record via the Select Ticket button 
in the Related Tickets table window.

! associating one or more records with a record via the New Row button in 
the Related Tickets and Work Orders table window.

! selecting the Show Similar Tickets action, then selecting one or more 
tickets and clicking Relate Records.

Global Issues

A global issue is an incident or problem that potentially affects multiple 
users, or is likely to be the root cause of additional issues. For example, a 
problem with an e-mail server could potentially affect many e-mail accounts, 
or flooding from a burst pipe is likely to cause additional reports of problems. 
Using global issues allows you to indicate that multiple records have the same 
underlying cause, and manage and address a single incident or problem 
record, rather than managing multiple records individually.

NOTE: Only incident and problem records can be global issues. However, other 
record types might be associated with a global record. 

Creating Global Issues

You indicate that an incident or a problem is a global issue by selecting the 
Global Issue? check box on the record.

Global Issues Check Box

When you change the status of a global issue ticket, all of the tickets and work 
orders that are related to the record automatically inherit the status changes. 

If you determine that a ticket is not in fact a global issue, you can clear the 
Global Issue? check box, and any tickets and work orders related to the 
record will no longer inherit their status changes from the record.
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Relating Other Records to Global Issues

You can use the Show Similar Tickets action to related service requests, 
incidents, and problems to a global issue record. You can also indicate that an 
incident or problem record is related to a global issue by entering the 
identifier for a global issue in the Related to Global ID field on the record. A 
record can be related to only one global issue at a time. Once a record has been 
marked as "related to" a global issue it will inherit all status changes from the 
global issue. 

When a global issue has follow-up records, that is records created from the 
global issue, the follow-up records cannot be related to the global issue. In 
addition, you cannot relate a record to a global issue that has a status of 
CLOSE. 

NOTE: A ticket can be a global issue or related to a global issue, but not both.

Managing Tickets

Once you�ve taken ownership of a ticket, or ownership of a ticket has been 
assigned to you, you are responsible for managing that ticket until it is either 
resolved, or ownership of the ticket is assigned to another individual or group.

Managing Activities

Activity records describe high level work added directly to a ticket during the 
ticket management process. Activities can be managed from the Activities tab 
of an incident or problem record, or by using the Activities application.

A service desk agent can assign each activity to a different Owner or Owner 
Group if needed. For example, hiring a new employee might generate a 
service request that includes the following activities:

! Issue security badge � assigned to the Security group
! Issue computer � assigned to the Information Technology group
! Assign telephone number � assigned to the Telecommunications group

Time Management

Frequently companies want to capture data about the amount of time workers 
spend on activities or tasks. You may need this information because your 
Service Desk has a goal to resolve issues within a certain time frame, or to 
show that response times are in compliance with an existing service level 
agreement (SLA). Or you may need a record of a laborer�s working hours to 
calculate costs or for billing outside labor.

All of the ticket applications include a Start Timer  and Stop Timer  
button in the toolbar. When you start the timer, Maximo begins recording 
labor actuals for the ticket and enters a new row in the Time Tracking table 
window on the Activities tab. When you stop the timer, Maximo calculates the 
elapsed time. When you confirm the details, Maximo complete the entry in the 
Time Tracking table window.
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Confirm Timer dialog box

NOTE: You can edit the values in the Confirm Timer dialog box, for example if 
you were not working on a record and forgot to stop the timer.

You can use the View Costs action to view the total labor hours for a record.

Working with Solutions

A solution is a predefined response to a problem or commonly asked 
question. A solution record consists of a symptom, a cause, and a resolution.   
A solution record is a means of capturing information so that it can be shared 
with others.

Service Desk agents can record solutions and workarounds in the Solutions 
application. Solution records contain Symptom, Cause, and Resolution text 
fields. Both the Incidents and Problems applications contain a Search 
Solutions button in the toolbar. When you select a solution to apply to a 
record, Maximo copies the details to the Solutions Details tab of the record.

Service Desk calls frequently include a large percentage of "How do I..." 
questions or requests for information. You can create a knowledge base of 
solutions and frequently asked questions that customers can access by 
utilizing Self-Service Access? check box on solution records. 

The Incidents and Problems applications include a Search Solutions  
button in the toolbar which allows you to search for solution records. When 
you apply a solution to an incident or problem record, Maximo copies the 
information to the Solution Details tab.
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Working with Logs

The Service Desk applications all contain a Log tab, which allows you to 
create and view the Work Log and the Communications Log for a record. Both 
the Work Log and the Communications Log provide a means of 
communicating information about a ticket or work order.

Service Desk agents and maintenance workers create the entries in the Work 
Log, which is used to record telephone conversations, work performed, 
observations, and feedback from customers. Maximo makes the entries in the 
Communications Log, which is used to maintain a record of e-mail 
communications created from the record via the Create Communication 
action. 

Understanding the Work Log

You use the Work Log to record work-related information about a ticket or 
work order. You create an entry in the work log using the New Row button 
on the Work Log subtab. When you create a Work Log entry, you must specify 
a Type (Client Note, Update, or Work). You can check Viewable? check box 
to make the entry visible to the individuals listed in the Reported By and 
Affected Person fields on the record. 

Self-service users can view any Work Log entries marked as viewable, and 
create additional Work Log entries in response. For example at the resolution 
of a ticket a Service Desk agent might request feedback from the customer, 
which the customer can provide via a Work Log entry.

Understanding the Communications Log

The Communications Log displays outbound messages sent between Service 
Desk agents and customers. 

Entries in the Communications Log subtab are read-only. Maximo 
automatically creates entries in the Communications Log when you use the 
Create Communication action to create an e-mail message.

Using Communication Templates

You can use the Communication Templates application in the Administration 
module to create standardized templates for frequently used e-mail 
communications. You can also use communication templates to create e-mail 
notifications for use with Maximo�s Workflow and escalation processes. For 
more information about creating and using communication templates, refer to 
the Communications Template help or the Maximo System Administrator�s 
Guide.

Failure Reporting

One of the goals of problem management is to get to the root cause of an 
incident, as well as recording the resolution of the incident. Maximo 
accomplishes this objective with the use of failure reports. A failure report is 
a coded description of the failure, usually expressed in terms of a Problem 
code, Cause code, and Remedy code. 
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The Problem, Cause, Remedy structure of a failure code is different from the 
Symptom, Cause, and Resolution structure of a solution record. The content of 
a solution record is free form text and can differ from one record to the next. 
The content of failure codes are standardized and stored in the database so 
that they can be reused. This allows you to run reports to try to identify 
historical failure trends. This analysis may influence preventive maintenance 
activity or frequency, the creation of problem tickets to investigate a 
permanent solution, and possibly change tickets to implement an 
improvement plan.

Ticket Statuses

Records created in the Service Requests, Incidents, and Problems applications 
are all ticket records, and are stored in the TICKETS table. Every ticket 
record has a status that indicates its position in the ticket life cycle. After you 
change a ticket�s status, Maximo records the date and time of the status 
change, and lets you record a memo. 

NOTE: Your system administrator sets the security authorizations that let 
users change ticket statuses.

A ticket record can have one of the following statuses:

! NEW � Default status for new ticket records. You cannot change a ticket 
status back to NEW once its status has been changed.

! QUEUED � A ticket�s status changes to QUEUED when ownership is 
given to a person or group (a value exists in the Owner or Owner Group 
field). 

! INPRG � In progress. Someone has taken ownership of the ticket and is 
working on it. When you change the status of a ticket to INPRG Maximo 
enters a value in the Actual Start field.

! PENDING � Status for tickets that are waiting for some external action 
(for example response from user, vendor response, parts on order, and so 
forth).

! RESOLVED � Indicates that a solution or service has been provided. 
When you change the status of a ticket to RESOLVED Maximo enters a 
value in the Actual Finish field. If necessary, you can reopen a ticket and 
change the status from RESOLVED back to QUEUED, INPRG or 
PENDING.

! CLOSED � The ticket becomes a history record and cannot have its 
status changed again. You must use the Edit History <ticket> action if 
you need to edit the ticket.

NOTE: The following actions are no longer available once a ticket has had 
its status changed to CLOSED:

! Change Status
! Apply Ticket Template
! Delete Ticket
! Apply SLA
! Modify SLAs
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Deleting Tickets

You can delete a ticket record using the Delete <ticket> action available 
from the Select Action menu. A ticket record may only be deleted when all of 
the following conditions are met:

! the ticket must be in a status of NEW or QUEUED and the ticket must 
never have been in any other status.

! the ticket must never have been in Workflow

! the ticket cannot be marked as a Global Issue

! the ticket cannot have any activity records associated with it

! the ticket cannot have labor transactions logged against it

! the ticket cannot have any related tickets associated with it, and the ticket 
cannot be listed as a related ticket on any other record 

! the ticket cannot have had other records created from it via the Create 
<record> actions (that is, it can not be an originating record for any other 
record)

! the ticket can not have any Work Log entries

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Creating Work Orders

Work order records are created in the Changes and Releases applications in 
the Service Desk. For information about other Maximo applications that can 
be used to create work orders, see �Creating Work Orders Using Maximo,� on 
page 14-2. Because the resolution of a work order sometimes involves the 
creation of additional work orders, you can create records from within a work 
order record via the Create <record> actions. These actions are available 
from the Select Action menu in the following applications:

! Activities
! Changes
! Incidents
! Problems
! Quick Reporting
! Releases
! Service Requests
! Work Order Tracking

NOTE: You cannot create activity records in the Activities application. Activity 
work orders are created in the Incidents and Problems applications.

One difference between a ticket and a work order is that you can create a work 
plan for a work order that includes estimated tasks, labor, materials, services, 
and tools. For information about creating job plans, see �Creating Job Plans,� 
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on page 7-4. For information about creating work plans, see �Creating a Work 
Plan,� on page 14-32.

Managing Work Orders

Whether or not you have created a work plan for a work order, you will 
probably want to report the actual labor hours, materials, services, and tools 
that were used to complete the work order. 

You can report labor actuals for a work order using the Start Timer  and 

Stop Timer  button in the toolbar. When you start the timer, Maximo 
begins recording labor actuals for the work order and enters a new row on the 
Labor subtab. When you stop the timer, Maximo calculates the elapsed time. 
When you confirm the details, Maximo complete the entry on the Labor 
subtab.

For more information about reporting actuals, see �Recording Actuals,� on 
page 14-39.

Work Order Statuses

Records created in the Changes and Releases applications are work order 
records, and are stored in the WORKORDER table. Every work order record 
has a status that indicates its position in the work order processing cycle. 
After you change a work order�s status, Maximo records the date and time of 
the status change, and lets you record a memo. 

NOTE: Your system administrator sets the security authorizations that let 
users change work order statuses.

A work order record can have one of the following statuses:

! WAPPR � Waiting for Approval; default for work orders created in the 
Changes, Releases, and Work Order Tracking applications.

! WSCH � Waiting to be Scheduled; default for work orders generated from 
Preventive Maintenance.

! APPR � Approved. After you approve a work order, Maximo reserves the 
work plan items in inventory and records cost and rate data. If rates 
change in Inventory, Labor, or Tools, the work plan reflects the rates in 
effect when the work order was approved.

! WMATL � Waiting for Material. You can use this option for work orders 
with a status of WAPPR, APPR, or INPRG. Indicates that you cannot 
initiate the work order because you do not have needed material. After the 
direct issue items requisitioned for the work order have been issued in 
Issues and Transfers, the work order status changes to approved (APPR).
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! WPCOND � Waiting for Plant Conditions. Status for work orders that 
require a particular plant condition in order to be worked on, for example, 
for a production line to be shut down.

! INPRG � In Progress; default for work orders created in Quick 
Reporting. This status initiates the work order. If you do not have 
sufficient items to complete the work order, Maximo changes the status to 
WMATL.

! COMP � Completed. Indicates that all physical work is finished. If the 
asset is down, Maximo displays a reminder message.

! CLOSE � Closed. Change status to CLOSE after the electronic 
"paperwork" on a work order is complete and you want to finalize the 
record. Maximo removes inventory reservations for items not issued to the 
work order. The work order becomes a history record and cannot be edited.

! CAN � Canceled. If you select multiple work orders, Maximo cancels the 
ones that have not been initiated or for which no actuals have been 
reported. If the work order has been approved, Maximo removes inventory 
item reservations for the work order. The work order becomes a history 
record.

! HISTEDIT � Edited in History. Indicates that a work order with a status 
of CLOSE has been edited. This status does not appear on a work order 
record itself, but is displayed in the Status History to indicate that 
changes were made after the work order was closed. 

Activities

An activity is a specific class of work order, used to describe general work 
that needs to be done on a ticket record. For example a ticket for a network 
printer problem might include three activities: check network connection, 
check printer, and check network. 

You create activities on incident and problem records to describe general, 
high-level work that must be performed to resolve the ticket. Activities can be 
assigned to different teams, different departments, or vendor or contract 
labor. A service desk agent can assign activities to other individuals or groups 
and still retain ownership of the ticket.

Multisite and Activities

Work orders are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Key fields for new records must be unique for all work orders where 
CLASS = ACTIVITY. 

! Records can only be viewed by users who have security permission to the 
Site and the application.
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Using the Activities Application

To access the Activities application, click the application link on your Start 
Center, or select Service Desk > Activities from the Go To menu.

The Activities application contains the following tabs:

! List � to search Maximo for activity work order records.

! Activity � to view, or modify activity records.

! Plans � to enter, view, modify, or delete information about planned job 
tasks, labor, materials, services, and tools.

! Related Records � to add, view, or delete related ticket and work order 
records.

! Actuals � to enter, view, or modify actual work order start and finish 
times, labor hours and costs, material quantities, service costs, and tool 
costs. 

! Log � to create, view, and modify Work Log entries, and view 
Communication Log entries.

Activities Buttons

The following table lists application specific buttons that appear in the 
Activities application. 

Activities Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the activity application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Activities Help.    

Icon Function Location

Start Timer ! Toolbar

Stop Timer ! Toolbar

How Do I...

apply one or more service level agreements to a 
work order?

Select Apply SLAs from the Select Action 
menu.

assign an owner to a work order? Select Select Owner from the Select Action 
menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.
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change the attributes for an asset? Select Move/Modify Asset from the Select 
Action menu.

change the attributes for a location? Select Move/Modify Asset from the Select 
Action menu.

change the location of an asset? Select Move/Modify Asset from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create an activity record? Activity records are created on the Activities tab 
of the Incidents and Problems applications, and 
on the Plans tab of the Changes and Releases 
applications.

create a communication from the current 
record?

Select Create Communication from the 
Select Action menu.

delete a record? Select Delete Activity from the Select Action 
menu.

delete the work log from the current record? Select Modify/Delete Work Log from the 
Select Action menu.

delete a work plan from a work order? Select Remove Work Plan from the Select 
Action menu.

duplicate a record? Select Duplicate Activity from the Select 
Action menu.

modify data on a record with a status of 
CLOSE?

Select Edit History Activity from the Select 
Action menu.

modify the work log for the current record? Select Modify/Delete Work Log from the 
Select Action menu.

plan an asset modification or move? Select Move/Modify Asset from the Select 
Action menu.

remove a service level agreement from a work 
order?

Select Select/Deselect SLAs from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

select a service level agreement to apply to a 
work order?

Select Select/Deselect SLAs from the Select 
Action menu.

take ownership of a record? Select Take Ownership from the Select Action 
menu.

view costs for a work order? Select View > Costs from the Select Action 
menu.

view the ownership history for a record? Select View > History from the Select Action 
menu.

view purchase orders for materials and services 
for a work order?

Select View > PO Information from the Select 
Action menu.

How Do I...
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Creating Activities

You do not create activity records in the Activities application. Activity work 
orders are defined as child work orders and cannot exist without a parent 
record. Activities can be created on the Activities tab of an incident or problem 
record, or via the Create Activities action available from any ticket or work 
order application.

Managing Activities

You can manage activities on the Activities tab of an incident or problem 
record, or in the Activities application. For information about reporting time 
spent working on activities see �Time Management,� on page 12-9.

Activities Statuses

Activities are work orders. For information about work order statuses, see 
�Work Order Statuses,� on page 14-5.

Activities Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Change Records

An change is a specific class of work order, used to plan the alteration of an 
information technology asset. This can include the addition, modification, or 
removal of approved, supported, or baseline:

! applications
! associated documentation
! desktop builds
! environments

view purchase requisitions for materials and 
services for a work order?

Select View > PO Information from the Select 
Action menu.

view service level agreements applied to a work 
order?

Select View SLAs from the Select Action menu.

view the status change history for a record? Select View > History from the Select Action 
menu.

view warranties for the asset listed on a work 
order?

Select View > Warranties from the Select 
Action menu.

view warranties for the location listed on a work 
order?

Select View > Warranties from the Select 
Action menu.

view the work plan for the hierarchy (the work 
order, its children, and tasks)?

Select View > Entire Plan from the Select 
Action menu.

How Do I...
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! hardware
! networks
! software
! systems

Change Management is the practice of ensuring that all changes to 
information technology assets are carried out in a planned and authorized 
manner. This includes ensuring that there is a reason for the change, 
identifying the specific assets and IT services affected by the change, planning 
the change, testing the change, and having a back out plan should the change 
result in unexpected consequences.

Multisite and Change Records

Work orders are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations. 

! Key fields for new records must be unique for all work orders where 
CLASS = CHANGE. 

! Records can only be viewed by users who have security permission to the 
Site and the application.

Using the Changes Application

To access the Changes application, click the application link on your Start 
Center, or select Service Desk > Changes from the Go To menu.

The Changes application contains the following tabs:

! List � to search Maximo for change records.

! Change � to create, view, or modify change records.

! Plans � to enter, view, or modify information on work orders in a 
hierarchy, and to enter, view, modify, or delete information about planned 
job tasks, labor, materials, services, and tools. 

! Related Records � to add, view, or delete related work order and ticket 
records.

! Actuals � to enter, view, or modify actual work order start and finish 
times, labor hours and costs, material quantities, service costs, and tool 
costs. 

! Log � to create, view, and modify Work Log entries, and view 
Communication Log entries.
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Changes Buttons

The following table lists application specific buttons that appear in the 
Changes application. 

Changes Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Changes application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Changes Help.     

Icon Function Location

Start Timer ! Toolbar

Stop Timer ! Toolbar

How Do I...

apply a route to a work order? Select Apply Route from the Select Action 
menu.

apply one or more service level agreements to a 
work order?

Select Apply SLAs from the Select Action 
menu.

assign an owner to a work order? Select Select Owner from the Select Action 
menu.

assign a work order to a new parent? Select Assign to New Parent from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change the attributes for an asset? Select Move/Modify Asset from the Select 
Action menu.

change the attributes for a location? Select Move/Modify Asset from the Select 
Action menu.

change the location of an asset? Select Move/Modify Asset from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a change record? Click the New Change button in the toolbar.

create a change work order from the current 
record?

Select Create > Change from the Select Action 
menu.

create a communication from the current 
record?

Select Create > Communication from the 
Select Action menu.

create an incident record from the current 
record?

Select Create > Incident from the Select 
Action menu.
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create a problem record from the current 
record?

Select Create > Problem from the Select 
Action menu.

create a release work order from the current 
record?

Select Create > Release from the Select Action 
menu.

create a service request record from the current 
record?

Select Create > Service Request from the 
Select Action menu.

create a work order record from the current 
record?

Select Create > Work Order from the Select 
Action menu.

delete a record? Select Delete Change from the Select Action 
menu.

delete the work log from the current record? Select Modify/Delete Work Log from the 
Select Action menu.

delete a work plan from a work order? Select Remove Work Plan from the Select 
Action menu.

duplicate a record? Select Duplicate Change from the Select 
Action menu.

modify data on a record with a status of 
CLOSE?

Select Edit History Change from the Select 
Action menu.

modify the work log for the current record? Select Modify/Delete Work Log from the 
Select Action menu.

plan an asset modification or move? Select Move/Modify Asset from the Select 
Action menu.

remove a service level agreement from a work 
order?

Select Select/Deselect SLAs from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

select a service level agreement to apply to a 
work order?

Select Select/Deselect SLAs from the Select 
Action menu.

take ownership of a record? Select Take Ownership from the Select Action 
menu.

view costs for a work order? Select View > Costs from the Select Action 
menu.

view the ownership history for a record? Select View > History from the Select Action 
menu.

view purchase orders for materials and services 
for a work order?

Select View > PO Information from the Select 
Action menu.

view purchase requisitions for materials and 
services for a work order?

Select View > PO Information from the Select 
Action menu.

view service level agreements applied to a work 
order?

Select View SLAs from the Select Action menu.

view the status change history for a record? Select View > History from the Select Action 
menu.

How Do I...
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Creating Change Records

Change records can be created in the Changes application, or via the Create 
Change action available from any ticket or work order application.

Managing Change Records

In addition to the creation of change records, change management involves

! assessing the impact, cost, benefit, and risk of the change
! developing a justification for the change
! obtaining approval for the change
! managing the change implementation
! monitoring and reporting on the implementation
! recording the change
! reviewing and closing the change record

Changes Statuses

Changes are work orders. For information about work order statuses, see 
�Work Order Statuses,� on page 14-5.

If planned asset moves exist for the change record, Maximo executes them 
when the change status is changed to COMP (complete).

Changes Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Incident Records

An incident is any event which is not part of the standard operation of a 
service, and which causes, or may cause, an interruption to, or a reduction in, 
the quality of that service.

You use the Incidents application to create, view, modify, or delete incident 
records. Incident management is the resolution and prevention of incidents 
that affect the normal operation of a company�s information technology (IT) 
services. This includes ensuring that all failures are corrected, preventing any 
recurrence of those failures, and the use of preventive maintenance to reduce 
the number of failures.

view warranties for the asset listed on a work 
order?

Select View > Warranties from the Select 
Action menu.

view warranties for the location listed on a work 
order?

Select View > Warranties from the Select 
Action menu.

view the work plan for the hierarchy (the work 
order, its children, and tasks)?

Select View >Entire Plan from the Select 
Action menu.

How Do I...
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Multisite and Incident Records

Tickets are at the System or database level.

! Key fields for new records must be unique within the Maximo database.

! The key field must be unique for tickets where CLASS = INCIDENT.

! Records are available to all users of the database who have security 
permissions to the application.

Using the Incidents Application

To access the Incidents application, click the application link on your Start 
Center, or select Service Desk > Incidents from the Go To menu.

The Incidents application contains the following tabs:

! List � to search Maximo for incident records.

! Incident � to add/create, view, or modify incident records.

! Activities � to create, view, modify, delegate, and delete activity work 
orders and to report labor actuals.

! Related Records � to add, view, or delete related ticket and work order 
records.

! Solution Details � to associate, create, or view solution information.

! Log � to create, view, and modify Work Log entries, and view 
Communication Log entries.

! Failure Reporting � to enter, view, or modify asset and location failure 
information to help identify trends.

Incidents Buttons

The following table lists application specific buttons that appear in the 
Incidents application.  

Icon Function Location

Start Timer ! Toolbar

Stop Timer ! Toolbar

Search Solutions ! Toolbar

Select Owner ! Table rows in the 
Activities table window
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Incidents Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Incidents application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Incidents Help.     

Change Activity Status ! Table rows in the 
Activities table window

Icon Function Location

How Do I...

apply one or more service level agreements to a 
ticket?

Select Apply SLA from the Select Action menu.

assign an owner to a ticket? Select Select Owner from the Select Action 
menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a change work order from the current 
record?

Select Create > Change from the Select Action 
menu.

create a communication from the current 
record?

Select Create > Communication from the 
Select Action menu.

create an incident record? Click the New Incident button in the toolbar.

create an incident record from the current 
record?

Select Create > Incident from the Select 
Action menu.

create an incident record using a ticket 
template?

Click the New Incident button in the toolbar, 
then select Apply Incident Template from 
the Select Action menu.

create a problem record from the current 
record?

Select Create > Problem from the Select 
Action menu.

create a release work order from the current 
record?

Select Create > Release from the Select Action 
menu.

create a service request record from the current 
record?

Select Create > Service Request from the 
Select Action menu.

create a solution record from the information on 
the Solutions Details tab of the record?

Select Create > Solution from the Select 
Action menu.

create a work order record from the current 
record?

Select Create > Work Order from the Select 
Action menu.

delete a record? Select Delete Incident from the Select Action 
menu.
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Creating Incident Records

Incident records can be created in the Incidents application, or via the Create 
Incident action available from any ticket or work order application.

If your company has created templates for common incidents you can apply a 
template to a new incident record by selecting the Apply Incident Template 
action from the Select Action menu. Maximo copies data from the ticket 
template, which you can then edit as needed.

Managing Incident Records

The primary goal of incident management involves the restoration of normal 
service as quickly as possible. 

delete the work log from the current record? Select Modify/Delete Work Log from the 
Select Action menu.

duplicate a record? Select Duplicate Incident from the Select 
Action menu.

find tickets with the same Classification as 
the current record?

Select Show Similar Tickets from the Select 
Action menu.

modify data on a record with a status of 
CLOSE?

Select Edit History Incident from the Select 
Action menu.

modify the work log for the current record? Select Modify/Delete Work Log from the 
Select Action menu.

remove a service level agreement from a ticket? Select Select/Deselect SLAs from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

select a service level agreement to apply to a 
ticket?

Select Select/Deselect SLAs from the Select 
Action menu.

take ownership of a record? Select Take Ownership from the Select Action 
menu.

view costs for a ticket? Select View Costs from the Select Action 
menu.

view the costs for the ticket hierarchy (the 
ticket, its activities, tasks, and child work 
orders)?

Select View Costs from the Select Action 
menu.

view the ownership history for a record? Select View History from the Select Action 
menu.

view service level agreements applied to a 
ticket?

Select View SLAs from the Select Action menu.

view the status change history for a record? Select View History from the Select Action 
menu.

How Do I...
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Incident Record Statuses

Incidents are ticket records. For information about ticket statuses, see �Ticket 
Statuses,� on page 12-12.

Incidents Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Problem Records

A problem is an unknown underlying cause of one or more incidents. Once 
the root cause of the problem is known and a temporary workaround or a 
permanent solution has been identified and provided, the problem record can 
be closed, and any related incident records can also be resolved and closed.

You use the Problems application to create, view, modify, or delete problem 
records. Problem management is the resolution and prevention of problems 
that affect the normal operation of a company�s information technology (IT) 
services. This includes ensuring that all failures are corrected, preventing any 
recurrence of those failures, and the use of preventive maintenance to reduce 
the number of failures.

Multisite and Problem Records

Tickets are at the System or database level.

! Key fields for new records must be unique within the Maximo database.

! The key field must be unique for tickets where CLASS = PROBLEM.

! Records are available to all users of the database who have security 
permissions to the application. 

Problem Records and Incidents

In Maximo, a problem record can be created in the Problems application or 
from an incident record. When a problem record is created from an incident, it 
is for reference purposes only. The problem record is not created to resolve an 
incident. When you change the status of a problem record to RESOLVED, 
Maximo does not change the status of the originating incident record to 
RESOLVED.

Using the Problems Application

To access the Problems application, click the application link on your Start 
Center, or select Service Desk > Problems from the Go To menu.

The Problems application contains the following tabs:



Chapter 12: The Service Desk Module

Maximo 6, 08/2006 12-27

! List � to search Maximo for problem records.

! Problem � to create, view, or modify problem records.

! Activities � to create, view, modify, delegate, and delete activity work 
orders and to report labor actuals.

! Related Records � to add, view, or delete related ticket and work order 
records.

! Solution Details � to associate, create, or view solution information.

! Log � to create, view, and modify Work Log entries, and view 
Communication Log entries.

! Failure Reporting � to enter, view, or modify asset and location failure 
information to help identify trends.

Problems Buttons

The following table lists application specific buttons that appear in the 
Problems application.  

Problems Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Problems application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Problems Help.    

 

Icon Function Location

Start Timer ! Toolbar

Stop Timer ! Toolbar

Search Solutions ! Toolbar

Select Owner ! Table rows in the 
Activities table window

Change Activity Status ! Table rows in the 
Activities table window

How Do I...

apply one or more service level agreements to a 
ticket?

Select Apply SLA from the Select Action menu.

assign an owner to a ticket? Select Select Owner from the Select Action 
menu.
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bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a change work order from the current 
record?

Select Create > Change from the Select Action 
menu.

create a communication from the current 
record?

Select Create > Communication from the 
Select Action menu.

create an incident record from the current 
record?

Select Create > Incident from the Select 
Action menu.

create a problem record? Click the New Problem button in the toolbar.

create a problem record using a ticket template? Click the New Problem button in the toolbar, 
then select Apply Problem Template from 
the Select Action menu.

create a problem record from the current 
record?

Select Create > Problem from the Select 
Action menu.

create a release work order from the current 
record?

Select Create > Release from the Select Action 
menu.

create a service request record from the current 
record?

Select Create > Service Request from the 
Select Action menu.

create a solution record from the information on 
the Solutions Details tab of the record?

Select Create > Solution from the Select 
Action menu.

create a work order record from the current 
record?

Select Create > Work Order from the Select 
Action menu.

delete a record? Select Delete Problem from the Select Action 
menu.

delete the work log from the current record? Select Modify/Delete Work Log from the 
Select Action menu.

duplicate a record? Select Duplicate Problem from the Select 
Action menu.

find tickets with the same Classification as 
the current record?

Select Show Similar Tickets from the Select 
Action menu.

modify data on a record with a status of 
CLOSE?

Select Edit History Problem from the Select 
Action menu.

modify the work log for the current record? Select Modify/Delete Work Log from the 
Select Action menu.

remove a service level agreement from a ticket? Select Select/Deselect SLAs from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

How Do I...
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Creating Problem Records

Problem records can be created in the Problems application, or via the Create 
Problems action available from any ticket or work order application.

If your company has created templates for common problems you can apply a 
template to a new problem record by selecting the Apply Problem Template 
action from the Select Action menu. Maximo copies data from the ticket 
template, which you can then edit as needed.

Managing Problem Records

There are two aspects of problem management, reactive and proactive. 
Reactive problem management involves resolving problems that are the root 
causes of incidents, and preventing further incidents based on the problem. 
Proactive problem management involves trying to identify potential problems 
before they lead to incidents that disrupt normal operations. 

When the underlying cause of a problem has been identified, the problem 
record can be marked as a known error by selecting the Is Known Error? 
check box. This means that the cause of the service disruption and the means 
to remedy the situation have both been identified.

Problem Record Statuses

Problems are ticket records. For information about ticket statuses, see �Ticket 
Statuses,� on page 12-12.

Problems Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

select a service level agreement to apply to a 
ticket?

Select Select/Deselect SLAs from the Select 
Action menu.

take ownership of a record? Select Take Ownership from the Select Action 
menu.

view costs for a ticket? Select View Costs from the Select Action 
menu.

view the costs for the ticket hierarchy (the 
ticket, its activities, tasks, and child work 
orders)?

Select View Costs from the Select Action 
menu.

view the ownership history for a record? Select View History from the Select Action 
menu.

view service level agreements applied to a 
ticket?

Select View SLAs from the Select Action menu.

view the status change history for a record? Select View History from the Select Action 
menu.

How Do I...
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Release Records

A release is a specific class of work order, used to describe one or more tested 
and authorized changes that is being introduced into a "live" or production 
environment.

Release Management is the practice of designing and implementing 
procedures for the distribution and installation of hardware, software, and 
configuration changes to information technology systems.

Multisite and Release Records

Work orders are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! Key fields for new records must be unique for all work orders where 
CLASS = RELEASE.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Using the Releases Application

To access the Releases application, click the application link on your Start 
Center, or select Service Desk > Releases from the Go To menu.

The Releases application contains the following tabs:

! List � to search Maximo for release records.

! Release � to create, view, modify, or delete release records.

! Plans � to enter, view, or modify information on work orders in a 
hierarchy, and to enter, view, modify, or delete information about planned 
job tasks, labor, materials, services, and tools.

! Related Records � to add, view, or delete related ticket and work order 
records.

! Actuals � to enter, view, or modify actual work order start and finish 
times, labor hours and costs, material quantities, service costs, and tool 
costs. 

! Log � to create, view, and modify Work Log entries, and view 
Communication Log entries.
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Releases Buttons

The following table lists application specific buttons that appear in the 
Releases application.  

Releases Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Releases application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Releases Help.   

Icon Function Location

Start Timer ! Toolbar

Stop Timer ! Toolbar

How Do I...

apply a route to a work order? Select Apply Route from the Select Action 
menu.

apply one or more service level agreements to a 
work order?

Select Apply SLAs from the Select Action 
menu.

assign an owner to a work order? Select Select Owner from the Select Action 
menu.

assign a work order to a new parent? Select Assign to New Parent from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change the attributes for an asset? Select Move/Modify Asset from the Select 
Action menu.

change the attributes for a location? Select Move/Modify Asset from the Select 
Action menu.

change the location of an asset? Select Move/Modify Asset from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a release record? Click the New Release button in the toolbar.

create a change work order from the current 
record?

Select Create > Change from the Select Action 
menu.

create a communication from the current 
record?

Select Create > Communication from the 
Select Action menu.

create an incident record from the current 
record?

Select Create > Incident from the Select 
Action menu.
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create a problem record from the current 
record?

Select Create > Problem from the Select 
Action menu.

create a release work order from the current 
record?

Select Create > Release from the Select Action 
menu.

create a service request record from the current 
record?

Select Create > Service Request from the 
Select Action menu.

create a work order record from the current 
record?

Select Create > Work Order from the Select 
Action menu.

delete a record? Select Delete Release from the Select Action 
menu.

delete the work log from the current record? Select Modify/Delete Work Log from the 
Select Action menu.

delete a work plan from a work order? Select Remove Work Plan from the Select 
Action menu.

duplicate a record? Select Duplicate Release from the Select 
Action menu.

modify data on a record with a status of 
CLOSE?

Select Edit History Release from the Select 
Action menu.

modify the work log for the current record? Select Modify/Delete Work Log from the 
Select Action menu.

plan an asset modification or move? Select Move/Modify Asset from the Select 
Action menu.

remove a service level agreement from a work 
order?

Select Select/Deselect SLAs from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

select a service level agreement to apply to a 
work order?

Select Select/Deselect SLAs from the Select 
Action menu.

take ownership of a record? Select Take Ownership from the Select Action 
menu.

view costs for a work order? Select View > Costs from the Select Action 
menu.

view the ownership history for a record? Select View > History from the Select Action 
menu.

view purchase orders for materials and services 
for a work order?

Select View > PO Information from the Select 
Action menu.

view purchase requisitions for materials and 
services for a work order?

Select View > PO Information from the Select 
Action menu.

view service level agreements applied to a work 
order?

Select View SLAs from the Select Action menu.

view the status change history for a record? Select View > History from the Select Action 
menu.

How Do I...
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Creating Release Records

Release records can be created in the Releases application, or via the Create 
Release action available from any ticket or work order application.

Managing Release Records

In addition to the creation of release records, release management involves:

! planning the release of the change(s)
! authorizing the hardware and software changes, for example software 

licensing
! testing the hardware and software changes in a test environment
! authorizing the release of the changes to the production environment
! managing the release implementation
! monitoring and reporting on the implementation
! reviewing and closing the release record

Releases Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Service Requests

A service request is a communication from an internal or external customer 
that reports an issue, requests information, or requests some sort of service. A 
service request record provides a means of tracking all Service Desk 
interactions with customers: walk up customers, phone calls, e-mail requests, 
and so forth. 

You use the Service Request application to enter, view, and modify service 
request records. Depending on how your company chooses to implement the 
Service Desk module, a service request may lead to the creation of additional 
ticket or work order records.

Maximo also includes a self-service Service Requests Module where users can 
log their own service requests. The self-service Service Requests Module is 
described in Appendix B, "Maximo�s Self-Service Applications," on page B-1.

view warranties for the asset listed on a work 
order?

Select View > Warranties from the Select 
Action menu.

view warranties for the location listed on a work 
order?

Select View > Warranties from the Select 
Action menu.

view the work plan for the hierarchy (the work 
order, its children, and tasks)?

Select View >Entire Plan from the Select 
Action menu.

How Do I...
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Multisite and Service Requests

Tickets are at the System or database level.

! Key fields for new records must be unique within the Maximo database.

! The key field must be unique for tickets where CLASS = SR.

! Records are available to all users of the database who have security 
permissions to the application. 

Using the Service Requests Application

To access the Service Requests application, click the application link on your 
Start Center, or select either

! Service Desk > Service Requests 
! Work Orders > Service Requests

from the Go To menu.

The Service Requests application contains the following tabs:

! List � to search Maximo for service request records.

! Service Request � to create, view, or modify service request records.

! Related Records � to add, view, or delete related ticket and work order 
records.

! Log � to create, view, and modify Work Log entries, and view 
Communication Log entries.

Service Request Buttons

The following table lists application specific buttons that appear in the Service 
Request application.  

Service Requests Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Service Requests application. For more detailed information, 

Icon Function Location

Start Timer ! Toolbar

Stop Timer ! Toolbar



Chapter 12: The Service Desk Module

Maximo 6, 08/2006 12-35

including prerequisites to performing an action and detailed procedures, refer 
to the Service Requests Help.   

How Do I...

apply one or more service level agreements to 
ticket?

Select Apply SLA from the Select Action menu.

assign an owner to a ticket? Select Select Owner from the Select Action 
menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a change work order from the current 
record?

Select Create > Change from the Select Action 
menu.

create a communication from the current 
record?

Select Create > Communication from the 
Select Action menu.

create an incident record from the current 
record?

Select Create > Incident from the Select 
Action menu.

create a problem record from the current 
record?

Select Create > Problem from the Select 
Action menu.

create a release work order from the current 
record?

Select Create > Release from the Select Action 
menu.

create a service request record? Click the New Service Request button in the 
toolbar.

create a service request record from the current 
record?

Select Create > Service Request from the 
Select Action menu.

create a service request record using a ticket 
template?

Click the New Service Request button in the 
toolbar, then select Apply Service Request 
Template from the Select Action menu.

create a work order record from the current 
record?

Select Create > Work Order from the Select 
Action menu.

delete a record? Select the Delete Service Request action from 
the Select Action menu.

delete the work log from the current record? Select Modify/Delete Work Log from the 
Select Action menu.

duplicate a record? Select the Duplicate Service Request action 
from the Select Action menu.

find tickets with the same Classification as 
the current record?

Select Show Similar Tickets from the Select 
Action menu.

modify data on a record with a status of 
CLOSE?

Select Edit History Service Request from the 
Select Action menu.

modify the work log for the current record? Select Modify/Delete Work Log from the 
Select Action menu.
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Creating Service Requests

Service request records can be created 

! in the Service Requests application
! in the self-service Create Service Request application
! via the Create Service Request action available from any ticket or work 

order application

If your company has created templates for common service desk calls you can 
apply a template to a new service request record by selecting the Apply 
Service Request Template action from the Select Action menu. Maximo 
copies data from the ticket template, which you can then edit as needed.

Managing Service Requests

Depending on the nature of the request, service requests may be managed and 
closed in the Service Requests application, or they may require the creation of 
additional ticket or work order records to fulfill the request.

Service Requests Statuses

Service requests are ticket records. For information about ticket statuses, see 
�Ticket Statuses,� on page 12-12.

remove a service level agreement from a ticket? Select Select/Deselect SLAs from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

select a service level agreement to apply to a 
ticket?

Select Select/Deselect SLAs from the Select 
Action menu.

take ownership of a record? Select Take Ownership from the Select Action 
menu.

view costs for a ticket? Select View Costs from the Select Action 
menu.

view the costs for the ticket hierarchy (the 
ticket, its activities, tasks, and child work 
orders)?

Select View Costs from the Select Action 
menu.

view the ownership history for a record? Select View History from the Select Action 
menu.

view service level agreements applied to a 
ticket?

Select View SLAs from the Select Action menu.

view the status change history for a record? Select View History from the Select Action 
menu.

How Do I...
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Service Request Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Solutions

A solution is a predefined response to a problem or commonly asked 
question. A solution record consists of a symptom, a cause, and a resolution. 
Solutions can be associated with incident and problem records.

You use the Solutions application to create, approve, and manage solution 
records. Maximo contains a separate application, Search Solutions, that can 
be used to search for and view solution records. 

NOTE: Your security authorizations will determine your ability to create, view, 
modify, or delete solution records.

Multisite and Solutions

Solutions are at the System, or database level. This means that:

! Key fields for new records must be unique within the Maximo database.

! Records are available to all users of the database who have security 
permissions to the application. 

Using the Solutions Application

To access the Solutions application, click the application link on your Start 
Center, or select Service Desk > Solutions from the Go To menu.

The Solutions application contains the following tabs:

! List � to search Maximo for Solution records.

! Solution � to create, view, or modify solution records.

Solutions Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Solutions application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Solutions Help.     

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.
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Creating Solutions

Solution records can be created in the Incidents application, or via the Create 
Solution action available in the Incidents and Problems applications.

A solution record defines a symptom, a cause, and a resolution. To make it 
easier for agents and customers to find a solution record that matches their 
issue, you can associate a Classification with the solution record. When you 
search solutions, Maximo displays solutions that match the Classification on 
the incident or problem record. If Maximo doesn�t find any matching records, 
users can clear the Classification field and perform a search of all solutions.

Managing Solutions

Some solutions records may be designed solely for Service Desk agent use, 
while other may be intended to be used by self-service customers. By default 
the Self-Service Access? check box on a solution record is cleared. Select the 
check box if you want the solution to be accessible to self-service users.

Solutions Statuses

A solution record can have one of the following statuses:

! DRAFT � Default status for new records. The solution is still being 
created and has not yet been approved for use. Solution records with a 
status of DRAFT cannot be associated with incident or problem records.

! ACTIVE � Default status for new records. A solution record must be 
active to be associated with an incident or problem record. Self-service 
users can only view solutions with an ACTIVE status.

! INACTIVE � Inactive solution records do not appear in select value lists. 
Solution records with a status of INACTIVE cannot be associated with 
new ticket records.

Solutions Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a solution record? Click the New Solution button in the toolbar.

delete a solution record? Select Delete Solution from the Select Action 
menu.

duplicate a solution record? Select Duplicate Solution from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

How Do I...
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Ticket Templates

A ticket template is a model for a generic or standardized service desk ticket 
record. You use the Ticket Templates application to create and manage 
generic templates that can be used to create service desk ticket records for 
common or high volume service desk calls. When you apply a ticket template 
to a service request, incident, or problem record, Maximo copies information 
from the template to the ticket, saving data entry time.

Multisite and Ticket Templates

Ticket Templates are at the System, or database level. This means that:

! Key fields for new records must be unique within the Maximo database.

! Records are available to all users of the database who have security 
permissions to the application.

Ticket Templates and the Ticket Applications

Ticket templates can be applied to records created in the following 
applications: 

! Incident
! Problem
! Service Request

When you apply a ticket template to a ticket record, Maximo copies all of the 
values from the template to the ticket. You can change these values if 
necessary.

Using the Ticket Templates Application

To access the Ticket Templates application, click the application link on your 
Start Center, or select Service Desk > Ticket Templates from the Go To 
menu.

The Ticket Templates application contains the following tabs:

! List � to search Maximo for ticket template records.

! Template � to create, view, or modify ticket templates.

Ticket Templates Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Ticket Templates application. For more detailed information, 
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including prerequisites to performing an action and detailed procedures, refer 
to the Ticket Templates Help.     

Creating Ticket Templates

When you create a ticket template, you specify what Class of records the 
template is going to be used for:

! INCIDENT � Templates to be used in the Incidents application.
! PROBLEM � Templates to be used in the Problems application.
! SR � Templates to be used in the Service Requests application.

You can specify the following information on a ticket template:

! Owner or Owner Group � For more information about ownership, see 
�Ownership of Tickets,� on page 12-5.

! Internal Priority � For more information about priority, see �Priority 
and Tickets,� on page 12-6.

! Service Group, Service, and Vendor � For more information about 
service groups and services, see �Service Catalog,� on page 13-1.

! Classification � For more information about classifications, see �Using 
Classifications,� on page 2-35.

! Activities � For more information about activities, see �Activities,� on 
page 12-15.

Managing Ticket Templates

You must change the status of a ticket template to ACTIVE before Maximo 
users can apply it to ticket records.

There are no restrictions on deleting ticket templates because the values from 
a template record are copied to ticket records, not referenced from the 
template.

How Do I...

add activities to a ticket template? Click New Row in the Activities table window.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a ticket template? Click the New Template button in the toolbar.

delete a record? Select Delete Template from the Select Action 
menu.

duplicate a record? Select Duplicate Template from the Select 
Action menu.
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Ticket Template Statuses

A ticket template can have one of the following statuses:

! DRAFT � Default status for new records. Template is still being created 
and has not yet been approved for use on other records. Ticket template 
records with a status of DRAFT cannot be used with ticket records.Once 
you move the ticket template out of DRAFT status you cannot set it back 
to DRAFT.

! ACTIVE � A ticket template record must be active to be used with ticket 
records.

! INACTIVE � Inactive ticket template records do not appear in select 
value lists. Templates with a status of INACTIVE cannot be used with 
ticket records. You can change the status of an INACTIVE ticket template 
to ACTIVE.

Ticket Templates Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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Service Level Management (SLM) is the process of defining, agreeing upon, 
documenting, and managing the levels of service that a service provider 
delivers to customers (either internal or external), and services that you 
receive from vendors. Typically service level management also includes 
monitoring and reporting functions to monitor that the agreed upon service 
levels are being maintained.

Maximo provides two applications specifically designed for service level 
management. The Service Management Module consists of the following 
applications:    

You use the Service Catalog to define all of the services that you provide or 
procure for your organization. You create a service group for each type of 
service, and create a list of services provided by that group. Service Groups 
and Services can be listed on tickets and work orders created in the Service 
Desk module. 

You use the Service Level Agreements (SLAs) application to define and 
document the agreements between the service provider and the customer, 
documenting the agreed upon service levels for the services being provided. 
Information included on an SLA record includes the type of commitment, how 
the commitment will be measured, and what escalations are in place to help 
the service organization meet the commitments.

You can define escalations on an SLA, or use the administrative Escalations 
application to define escalation criteria, and the actions and notifications that 
should happen when a record reaches or exceeds the criteria set on the 
escalation.   You can also create Key Performance Indicator (KPI) reports for 
SLAs, or apply KPIs created in the KPI Manager application.

Service Catalog

The service catalog is a list of all the services that your service organization 
provides to others, or that your company purchases from a service provider. 

13 The Service Management 
Module

Application Function

Service Catalog Used to create service groups and catalog the 
services provided by those groups.

Service Level 
Agreements

Used to define agreements between service 
providers and customers, documenting agreed upon 
levels of service.
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You use the Service Catalog application to create a high-level definition of the 
categories of services that your company provides or procures. Service group 
and service definitions are stored in the COMMODITIES table, and can be 
used to manage records by their associated services. Service groups and 
services can be used to categorize services associated with assets, asset types, 
contracts, locations, service level agreements, tickets, and work orders. 

NOTE: You can only create, view, modify, or delete service type commodities in 
the Service Catalog application.

Multisite and the Service Catalog

The Service Catalog is defined at the Item Set level. Item Sets exist below the 
System level, but above the Organization level so that Organizations can 
share data. This means that:

! Key fields for new records must be unique within the Item Set.

! Records are available to all users in the Organizations that share the Item 
Set and who have security permissions to the application. 

Service Catalog and Assets

You use the Service Catalog application to associate assets with a service 
group.   You can also associated asset types with a service group. For example, 
if you created an IT service group, you could associate all assets where Type = 
IT with the service group. You also can associate assets with a service group 
in the Assets application via the Associate Services action.

Service Catalog and Contracts

Maximo stores service groups in the COMMODITIES table. You can use the 
Associate Commodities action available in the Lease/Rental Contracts, 
Master Contracts, and Purchase Contracts applications to associate a service 
group or service with a contract. 

Service Catalog and Locations

You use the Service Catalog application to associate locations with a service 
group. You also can associate locations with a service group in the Locations 
application via the Associate Services action.

Service Catalog and Purchasing

Maximo stores service groups in the COMMODITIES table. If your company 
organizes and manages purchasing by commodity this allows you to track 
your spending by service group and service.
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Service Catalog and the Service Desk

Service Desks typically use services or service groups to categorized tickets 
when assigning service level agreements, assigning ownership, or for 
reporting purposes.   Both ticket and work order records contain a Service 
Group and Service field which allow you to indicate that a service group is 
responsible for the record. 

Service Catalog and Service Level Agreements

Service level agreement (SLA) records contain a Service Group and Service 
field that enable SLA matching capabilities at a high level.

Service Catalog Records vs. Service Item Records

You use the Service Catalog application to create service groups and services 
which are stored in the COMMODITIES table in the database. You use 
service groups and services to categorize services associated with assets, asset 
types, contracts, locations, service level agreements, tickets, and work orders. 

You use the Service Items application to create standard service records 
which are stored in the ITEM table in the database. You use standard services 
for planning and purchasing services, that is creating job plans and work 
plans, and when creating purchasing records (purchase contracts, PRs, POs 
and so forth).

Using the Service Catalog Application

To access the Service Catalog application, click the application link on your 
Start Center, or select Service Management > Service Catalog from the 
Go To menu.

The Service Catalog application contains the following tabs:

! List � to search Maximo for service catalog records.

! Service Group � to create, view, or modify service group records and 
delete services.

Service Catalog Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Service Catalog application. For more detailed information, including 
prerequisites to performing an action and detailed procedures, refer to the 
Service Catalog Help.   

How Do I...

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.
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Creating the Service Catalog

You first must create a service group before you can create services in the 
Service Catalog.

When you are creating a service group record you can enter either a Contact 
or Contact Group, but not both.

Service Group Types

When you are creating service group records you can specify that the record 
applies to services of a particular Type. By default Maximo allows you to 
create the following types of services:

! BOTH � services that are both provided and procured

associate an asset with a service group? Select Associate Assets/Locations from the 
Select Action menu.

associate a location with a service group? Select Associate Assets/Locations from the 
Select Action menu.

create a service? Click New Row in the Services table window.

create a service group record? Click the New Service Group button in the 
toolbar.

delete a record? Select Delete Service Group from the Select 
Action menu.

remove the association between an asset and a 
service group?

Select Associate Assets/Locations from the 
Select Action menu.

remove the association between a location and a 
service group?

Select Associate Assets/Locations from the 
Select Action menu.

run reports? Select Run Reports from the Select Action 
menu.

view asset records that list the service group? Select View Related Records from the Select 
Action menu.

view asset types that list the service group? Select View Related Records from the Select 
Action menu.

view contracts that list the service group? Select View Related Records from the Select 
Action menu.

view location records that list the service group? Select View Related Records from the Select 
Action menu.

view service level agreements that list the 
service group? 

Select View Related Records from the Select 
Action menu.

view tickets that list the service group? Select View Related Records from the Select 
Action menu.

view work orders that list the service group? Select View Related Records from the Select 
Action menu.

How Do I...
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! PROCURE � services that are procured
! PROVIDE � services that are provided

Creating Services

Every service you create is associated with a service group.

When you create services for a service group, Maximo copies the values from 
the Type, and Contact or Contact Group fields from the service group 
record to the service records. 

Managing the Service Catalog

If you modify the value in the Contact or Contact Group fields, Maximo 
does not change the defaulted value for this field on any services associated 
with the Service Group.

Viewing Related Records

You can use the View Related Records action available from the Select 
Action menu to view the relationships that exist between a service group and 
the following types of records:

! tickets
! work orders
! assets and locations
! asset types
! service level agreements 
! contracts

NOTE: The View Related Records action is also available in the Detail Menu 
from the Service field.

Deleting Services

If a service group does not have any services listed you can delete it by 
selecting Delete Service Group from the Select Action menu. Maximo will 
display an error message if the service group can not be deleted.

NOTE: You can delete a service group that is referenced by another record, 
such as a ticket, work order, or invoice, and the service reference will 
remain on that record. 

Service Catalog Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Service Level Agreements

A service level agreement (SLA) defines the agreement and formal 
commitments between a service provider and a customer. The agreement 
documents the service to be provided or received, the agreed upon service 
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levels for the service, and the means of measuring or quantifying the level of 
service.

A service is a set of tasks provided by the service provider that meets one or 
more customer needs. A service level defines the means of measuring or 
quantifying the level of service that the service organization provides to the 
customer. A commitment is any service, product, or responsibility that can 
be measured in a qualitative or quantitative way and that the service provider 
must meet to fulfill the service level agreement with the customer. An SLA 
can have one or more commitments, each having their own escalation points. 
An escalation is a Maximo function that can be set to automatically monitor 
critical processes.

Service Level Agreement Types

There are three types of service level agreements:

! Customer - An agreement between your company, acting as the service 
provider, and an external customer. 

! Internal - An agreement between your company, acting as the service 
provider, and an internal customer, for example other departments within 
the company. Also known as an operating level agreement (OLA).

! Vendor - An agreement between an external vendor who is providing 
services to your company. Also known as an underpinning agreement.

Multisite and Service Level Agreements

Service level agreements are at the System, or database level. This means 
that:

! Key fields for new records must be unique within the Maximo database.

! Records are available to all users of the database who have security 
permissions to the application. 

You have the option to create SLAs at the Site, Organization, or System level. 
If you specify an Organization or Site for an SLA record, then the associated 
escalation is restricted to that Organization or Site. If you leave both the 
Organization and Site fields empty, the escalation is available to all 
Organizations and Sites that use the database.

Service Level Agreements and Assets/Locations

Service level agreements can be created for specific assets, asset types, or 
locations. You use the Assets and Locations tab to list individual assets and 
locations, or to specify asset types that the SLA applies to. If you list an asset 
type on an SLA then all assets of that type are covered by the SLA.



Chapter 13: The Service Management Module

Maximo 6, 08/2006 13-7

Service Level Agreements and Contracts

Vendor type service level agreements can be associated with contracts created 
in the Contracts module.

You can associate a SLA with a contract via the Associate Contracts action 
in the Service Level Agreements application or via the Associate SLA action 
available from the Select Action menu in the following applications:

! Lease/Rental Contracts
! Master Contracts
! Purchase Contracts
! Warranty Contracts

Service Level Agreements and Escalations

An escalation is a Maximo process that monitors time sensitive records and 
initiates actions and notifications when those records are not acted upon in a 
timely manner. You use escalations to ensure that the service provider 
complies with the commitments specified in the SLA. You can schedule 
escalations to automatically monitor and evaluate conditions, and then trigger 
actions, ownership changes, and notifications based on those conditions. 

Maximo includes a default escalation for the following commitment types:

! Contact
! Response
! Resolution
! Other

You use the Escalation tab to modify default escalations, or to define new 
escalation points, and the actions and notifications that will be taken when 
those points are reached. 

NOTE: Administrators can use the Escalations application in the Configuration 
module to define escalations.

Service Level Agreements and Tickets

You can apply service level agreements to ticket records via the Apply SLA 
action available from the Select Action menu in the following applications:

! Incident
! Problems
! Service Requests

You use the View SLAs action to view all of the service level agreements, if 
any, that are applied to a ticket record. The View Service Level Agreement 
dialog box is read-only. You use the Select/Deselect SLAs action to select a 
service level agreement to apply to a ticket, or to remove a service level 
agreement from a ticket.

NOTE: Deselecting an SLA removes its association with the current record. It 
does not delete the SLA record from the database.
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Service Level Agreements and Work Orders

You can apply service level agreements to work order records via the Apply 
SLA action available from the Select Action menu in the following 
applications:

! Activities
! Changes
! Releases
! Work Order Tracking

You can use the View SLAs action to view all of the service level agreements, 
if any, that are applied to a work order record. The View Service Level 
Agreement dialog box is read-only. You use the Select/Deselect SLAs action 
to select a service level agreement to apply to a work order, or to remove a 
service level agreement from a work order.

NOTE: Deselecting an SLA removes its association with the current record. It 
does not delete the SLA record from the database.

Using the Service Level Agreements Application

To access the Service Level Agreements application, click the application link 
on your Start Center, or select Service Management > Service Level 
Agreements from the Go To menu.

The Service Level Agreements application contains the following tabs:

! List � to search Maximo for SLA records.

! Service Level Agreement � to create, view, or modify service level 
agreements.

! Related SLAs � to associate or view related service level agreements.

! Assets and Locations � to associate or view assets and locations for a 
service level agreement.

! KPIs � to add, view, modify, or delete key performance indicators (KPIs) 
for a service level agreement.

! Escalation � to add, view, modify, or delete escalations for a service level 
agreement.
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Service Level Agreement Buttons

The following table lists application specific buttons that appear in the Service 
Level Agreements application. 

Service Level Agreements Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Service Level Agreements application. For more detailed 
information, including prerequisites to performing an action and detailed 
procedures, refer to the Service Level Agreements Help.    

Icon Function Location

SQL Expression Builder ! SLA Tab - 
Additional SLA 
Criteria section

! Escalation Tab - 
Escalation 
section

Define Escalation ! Commitments 
table window

How Do I...

activate an escalation? Maximo automatically activates the escalation 
on an SLA when you change the status from 
DRAFT to ACTIVE. If you create an escalation 
for an SLA with a status of ACTIVE, select 
Escalation > Activate/Deactivate 
Escalation from the Select Action menu to 
activate the escalation.

associate contracts with a VENDOR type 
service level agreement?

Select Associate Contracts from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a service level agreement (SLA) record? Click the New SLA button in the toolbar.

deactivate an escalation on a service level 
agreement?

Select Escalation > Activate/Deactivate 
Escalation from the Select Action menu.

delete the escalation on a service level 
agreement?

Select Escalation > Delete Escalations from 
the Select Action menu.

delete a record? Select Delete SLA from the Select Action 
menu.

duplicate a record? Select Duplicate SLA from the Select Action 
menu.
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Creating Service Level Agreements

You use the Service Level Agreements application to create records for service 
level agreements, the commitments that define the SLA, and the escalations 
that will ensure compliance.

You can use the Duplicate SLA action to create a copy of an existing service 
level agreement. When you duplicate an SLA, Maximo copies the header 
attributes, commitment values, and associated assets and locations to the new 
SLA, but it does not copy the associated escalation, related SLAs, KPIs, or 
associated contracts. 

Ranking Service Level Agreements

Your system administrator can configure Maximo to allow users to apply only 
one SLA to a record, or to allow the application of multiple SLAs to a record. 
When multiple SLAs are allowed the system administrator must choose 
whether to prioritize them based on a numerical rank or by commitment 
stringency. Maximo uses the value in the Ranking field to determine the 
comparative ranking of competing SLAs. 

For more detailed information about how Maximo ranks multiple SLAs, refer 
to the Service Level Agreements Help.

Associating Related SLAs

Some service level agreements exist to support a SLA, and others are 
supported by other SLAs. You use the Related SLAs tab to create, modify, 
view, and delete associations between an SLA and other SLA records. The 
Related SLAs tab has two subtabs:

! SLAs that this SLA Supports
! Supporting SLAs

When you associate an SLA record with another SLA record Maximo validates 
the commitments of the SLAs you are trying to associate and warns you if 
there are any conflicting or less stringent commitments. You cannot list the 
same SLA as both a supporting and a supported SLA. 

Adding Assets and Locations to an SLA

If there is an Organization specified for the SLA, then the list of assets or 
locations is limited to the records for the Sites within that Organization. If 
there is a Site specified for the SLA, then the list of assets or locations is 
limited to the records for the specified Site.

run reports? Select Run Reports from the Select Action 
menu.

validate the escalation for a service level 
agreement?

Select Escalation > Validate Escalations 
from the Select Action menu.

view contracts associated with a service level 
agreement?

Select Associate Contracts from the Select 
Action menu.

How Do I...
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Managing Service Level Agreements

When an SLA is in DRAFT or INACTIVE status, you can edit or add 
information on the service level agreement, Assets and Locations, and 
Escalation tabs. 

When the SLA is in ACTIVE status, you can edit or add information only on 
the Related SLAs and KPIs tabs.

When you change the values in a commitment line of an SLA that has any 
related SLAs, upon saving the record, Maximo compares the commitments of 
the associated SLAs and warns you if there are any conflicting or less 
stringent commitments. Maximo only validates one level up and one level 
down from the current record, checking all direct parents and all direct 
children of the selected SLA. 

Service Level Agreement Statuses

A service level agreement (SLA) record can have one of the following statuses:

! DRAFT � Default status for new records. Service level agreement is still 
being created and has not yet been approved for use on other records. SLA 
records with a status of DRAFT cannot be associated with Maximo 
records. When an SLA is in DRAFT status, the associated escalation is 
also in DRAFT status. Once you have set an SLA to ACTIVE or 
INACTIVE status, you cannot set it back to the DRAFT status. 

! ACTIVE � Set an SLA to ACTIVE when you are ready for the SLA to be 
used. A SLA record must be active to be associated with Maximo records. 
When an SLA is in ACTIVE status, Maximo sets the associated escalation 
to ACTIVE status as well.

! INACTIVE � Inactive SLA records do not appear in select value lists. 
SLA records with a status of INACTIVE cannot be associated with new 
Maximo records. When you change the status of an SLA to INACTIVE, 
Maximo displays a message asking whether you want to deactivate the 
associated escalation as well. You can change the status of an INACTIVE 
SLA to ACTIVE.

Deleting Service Level Agreements

You can delete a service level agreement record using the Delete SLA action 
available from the Select Action menu. When you delete an SLA, the 
associated escalation is deleted as well.

You cannot delete a service level agreement if any of the following is true:

! the status of the SLA is ACTIVE
! the SLA has been applied to any record
! the service level agreement supports another SLA 

TIP: If you cannot delete a service level agreement, you can change the status 
to INACTIVE to keep it from being applied to new records.
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Service Level Agreements Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.
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Work orders are the core of maintenance management. A work order specifies 
a particular task to be accomplished, and the labor, materials, services, and 
tools needed to complete the work. When you create a work order in Maximo 
you initiate the maintenance management process and create a historical 
record of work requested and performed.

The Work Orders Module consists of the following applications:    

You use the Work Order Tracking application to create, view, and manage 
work orders. This application contains all of the functions that Maximo 
includes for processing work orders.

The Quick Reporting application is a simplified version of the Work Order 
Tracking application that can be used to quickly report actuals for work that 
has already been performed, either on open work orders or on work orders 
that you create in Quick Reporting.

Work order labor requirements can be viewed in the Assignment Manager 
application. You use the Assignment Manager application to schedule planned 
work, for example preventive maintenance work orders, and to dispatch 
urgent or emergency work. 

14 The Work Orders Module

Application Function

Assignment 
Manager

Used to dispatch urgent work and schedule future 
work requirements.

Labor Reporting Used to report hours worked by labor (employees) or 
contractors. You can enter hours worked by labor 
("timecard" reporting), contract/vendor, ticket, or 
work order.

Service Requests Used to create records of customer calls or e-mail 
requesting service. 

NOTE: The Service Requests application is 
documented in Chapter 12, "The Service Desk 
Module," on page 12-1.

Quick Reporting Used to create work orders that do not require 
planning, and to report actuals, equipment 
downtime, failure reporting, and meter readings 
against open work orders.

Work Order 
Tracking

Used to perform every function related to 
processing work orders.
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You use the Labor Reporting application to report the type and total number 
of hours of work that was performed by external contractors or internal 
employees. You can enter labor information by work order, labor ("timecard" 
reporting), ticket, or contract/vendor.

Creating Work Orders Using Maximo

You can use several applications in Maximo to create work orders: 

! Changes � Use to create work orders related to Service Desk tickets.

! Condition Monitoring � Use to generate work orders to correct 
problem conditions found during monitoring procedures.

! Incidents � Use to create work orders related to Service Desk tickets.

! Preventive Maintenance � Use to generate scheduled maintenance 
work orders.

! Problems � Use to create work orders related to Service Desk tickets.

! Quick Reporting � Use to create work orders and report actual work 
done for simple jobs, unplanned work, or work not performed by the 
maintenance department.

! Releases � Use to create work orders related to Service Desk tickets.

! Service Requests � Use to create work orders related to Service Desk 
tickets.

! Work Order Tracking � Use to create and report on high-volume or 
complex work orders. 

Classes of Work Orders

All work orders, regardless of the application that created them, reside in the 
WORKORDER table in the database. Maximo uses the value in the Class 
field to filter which records from the WORKORDER table to display in each of 
the work order applications. Maximo automatically enters a value in the 
Class field when creating records, and the field is read-only.

The work order classes are:

! ACTIVITY � work orders where CLASS = ACTIVITY and the Is Task? 
flag = N are activities. Work orders where CLASS = ACTIVITY and the Is 
Task? flag = Y are tasks. These work orders can be created in one of the 
following ways:

! Tasks inserted on a work order where CLASS = WORKORDER. 
Because task work orders are a different class, you can configure 
Maximo to automatically number then separately from work orders 
with a CLASS = WORKORDER.
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! Tasks inserted on a work order where CLASS = CHANGE or 
RELEASE.

! Activities inserted on the Activities tab of either the Incidents or 
Problems application.

! Activities created via the Create Activities action in one of the ticket 
or work order applications.

! CHANGE � work orders created in the Changes application or via the 
Create Change action in one of the ticket or work order applications.

! RELEASE � work orders created in the Releases application or via the 
Create Release action in one of the ticket or work order applications.

! WORKORDER � Work orders created in the Work Order Tracking, 
Quick Reporting, Preventive Maintenance, or Condition Monitoring 
applications or via the Create Work Order action in one of the ticket or 
work order applications.

NOTE: By default Maximo does not consider class when automatically 
generating work order numbers. Your system administrator can 
configure Maximo to automatically number each work order class 
separately. 

Types of Work Orders

The most common general categories of work orders include:

! CP � Capital Project work orders are part of major projects designed to 
improve the physical assets or infrastructure of an organization. Maximo 
allows you to build a work order hierarchy and view costs for all work 
orders associated with a capital project. Typical capital projects include: 

! Production - purchase and installation of major equipment (assets)
! Facilities - new construction, renovation, addition to a facility
! Fleet - purchase or repair of equipment (assets)
! Technology - Information Management System installation/upgrade, 

computer hardware, audio-visual equipment/systems

! CM � Corrective maintenance work is work that needs to be done, but 
does not have to be performed immediately. You can schedule corrective 
work if necessary. CM work orders can be generated via condition 
monitoring, or you can enter this type of work order in the Work Order 
Tracking application.

! EM � Emergency maintenance work orders are problems that must be 
corrected immediately, because they are life threatening, can damage 
assets, cause production to stop, or are urgent. 

! EV � Event report work orders represent any unscheduled event that 
stops work (production) but does not necessarily require a maintenance 
crew to fix. 

! PM � Preventive maintenance records are used over and over on a 
periodic basis to generate preventive maintenance work orders. You create 
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Preventive Maintenance records in the Preventive Maintenance module. 
However, you process preventive maintenance work orders in Work Order 
Tracking application.

Work Order Priority

Maximo uses values between 0 and 999 to indicate priority for work orders, 
assets, and locations. Maximo can use these different priority values to 
generate a calculated priority to help schedulers determine the overall 
priority of a work order among "competing" work orders for similar assets or 
locations. 

Maximo uses two priority fields on work orders:

! Priority � If the work order is created in Work Order Tracking you can 
specify the priority of the work order. Work Orders generated from a PM 
inherit their priority from the PM. For more information, see �Setting 
Priority for PMs,� on page 8-11.

! Asset/Location Priority � Maximo copies the priority value from the 
asset record. If no priority value is specified on the asset record, Maximo 
copies the priority from the location record.

Since Maximo can use these values to generate a calculated priority, and the 
result of a calculation is always a larger number, MRO Software suggests that 
customers limit the priority values assigned to assets, locations, and work 
orders to a range of 0 to 10. Your priority scale might be similar to the 
following:    

Priority Assigned 
Priority

Comments

Life Safety (any work that could 
result in a life threatening situation 
if not completed in a timely manner)

11 + The priority value for life safety work should be set 
higher than the maximum value that can result 
from the selected priority calculation. 

Urgent work (for example, assets 
will be damaged if work is not 
completed.)

10 

Urgent work 9

Preventive Maintenance 8 Preventive Maintenance should have a higher 
priority than corrective work, since it is designed to 
reduce corrective work orders.

Preventive Maintenance 7

High priority corrective work 6

High priority corrective work 5

Medium priority corrective work 4

Medium priority corrective work 3

Low priority corrective work 2

Low priority corrective work 1
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TIP: Entering a value in the Priority field on work orders can help you 
manage your Workflow In Box by allowing you to sort work orders by 
priority.

Ownership of Work Orders

Individuals or groups can assume responsibility, or "ownership" of a work 
order in Maximo. When a group owns a work order, all members of that group 
see the work order in their Work View. If a member of a group takes 
ownership of a work order, they are responsible for managing the work order 
until it is complete, or delegated to another group or person. 

Job plan and preventive maintenance records contain Owner and Group 
Owner fields, and when you generate a PM work order or apply a job plan to 
a work order, Maximo automatically copies the values in these fields to the 
work order. You can also assign ownership to a work order using the Select 
Owner and Take Ownership actions available in the Work Order Tracking 
application. Your company may also design a Workflow process that assigns 
ownership of work orders to individuals or groups.

Quick Reporting vs. Work Order Tracking

The Quick Reporting application is a simplified version of the Work Order 
Tracking application, and can be configured by your system administrator to 
meet the needs of your site.   The Quick Reporting application is designed to 
simplify reporting actuals and other data after the work has been completed. 
More complex work orders should be created and managed using the Work 
Order Tracking application.

Work Order Statuses

Every work order in Maximo has a status that indicates its position in the 
work order processing cycle. You can create work orders with different 
statuses depending on which application you use to create or generate them. 

After you change a work order�s status, Maximo records the date and time of 
the status change, and lets you record a memo. 

If the Inherit Status Changes? check box on a work order record is checked, 
Maximo will change the status of the work order when the status of its parent 
work order is changed.

NOTE: You might need security authorization to change work order statuses.

A work order record can have one of the following statuses:

Work that is low priority, but should 
be completed if time is available.

0

Priority Assigned 
Priority

Comments
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! WAPPR � Waiting for Approval; default for work orders created in the 
Changes, Releases, and Work Order Tracking applications.

! WSCH � Waiting to be Scheduled; default for work orders generated from 
Preventive Maintenance.

! APPR � Approved. After you approve a work order, Maximo reserves the 
work plan items in inventory and records cost and rate data. If rates 
change in Inventory, Labor, or Tools, the work plan reflects the rates in 
effect when the work order was approved.

! WMATL � Waiting for Material. You can select this option for work 
orders with a status of WAPPR, APPR, or INPRG. Maximo changes a work 
order�s status to WMATL to indicate that you cannot initiate the work 
order because the necessary items or materials are not available in 
inventory. After the direct issue items requisitioned for the work order 
have been issued in Issues and Transfers, Maximo changes the work order 
status to approved (APPR).

! WPCOND � Waiting for Plant Conditions. Status for work orders that 
require a particular plant condition in order to be worked on, for example, 
for a production line to be shut down.

! INPRG � In Progress; default for work orders created in Quick 
Reporting. This status initiates the work order and indicates that physical 
work has been started. If you do not have sufficient items to complete the 
work order, Maximo changes the status to WMATL.

! COMP � Completed. Indicates that all physical work is finished. If the 
asset is down, Maximo can display a reminder message. If failure 
reporting is required, Maximo can display a reminder message.

! CLOSE � Closed. Change status to CLOSE after the electronic 
"paperwork" on a work order is complete and you want to finalize the 
record. Maximo removes inventory reservations for items not issued to the 
work order. The work order becomes a history record and cannot be edited.

! CAN � Canceled. If you select multiple work orders, Maximo cancels the 
ones that have not been initiated or for which no actuals have been 
reported. If the work order has been approved, Maximo removes inventory 
item reservations for the work order. The work order becomes a history 
record.

! HISTEDIT � Edited in History. Indicates that a work order with a status 
of CLOSE has been edited. This status does not appear on a work order 
record itself, but is displayed in the Status History to indicate that 
changes were made after the work order was closed. 

NOTE: Once the status of a work order has been changed to CLOSE or CAN it 
becomes a history record. You must use the Edit History Work Order 
action to modify the record.
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Assignments

A work order is a request for work to be performed. The work may require 
that different tasks be performed, and may require the services of different 
laborers or crafts. Maximo creates a separate requirement for each task/
labor combination listed on a work order�s work plan. If two mechanics are 
required for a task, two requirements are created. Similarly, if two different 
crafts are required for a task, Maximo creates a requirement for each craft. 
Once a labor requirement has been assigned to an appropriate laborer, it is 
considered an assignment.

You use the Assignment Manager application to match laborers to work order 
requirements. You can use Assignment Manager for planning future work 
over a seven day period, or to dispatch available labor to requirements for the 
current day�s work. Workers can also use Assignment Manager to assign 
themselves to work.

Multisite and Assignment Manager

Work orders and labor transactions are managed at the Site level in Multisite. 
However, when assigning labor to work orders, you should remember that 
labor records are at the Organization level. If your company has laborers who 
work at more than one Site it is possible to assign them work at any Site 
within their Organization.

Assignment Manager and Other Applications

In order to most effectively use Assignment Manager to prioritize and assign 
work to laborers there are a number of record fields in other applications that 
should contain values.

The following table lists fields that should contain values. Fields that are 
required for Assignment Manager functions are listed in bold text.  

Module and Application Record Field

Administration > Calendars Calendar ! Shift

Work Orders > Work Order Tracking Work Order ! Priority
! Asset/Location Priority

Preventive Maintenance > Preventive 
Maintenance

Preventive 
Maintenance

! Priority

Assets >Assets Asset ! Location
! Priority

Assets > Locations Location ! Priority

Resources > Labor Labor ! Craft
! Calendar
! Shift
! Work Location
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For information about how to search the database for records that do not have 
a value specified for a field, see �Searching for Null Values,� on page 2-12.

Assignment Manager and Labor Records

Labor records can be created in the Labor application for both internal and 
external (contract) laborers. In order to most effectively view and manage 
labor records in the Assignment Manger application, labor records should 
include a value in their Calendar and Shift fields.

The bottom half of the Assignment Manager page displays the Labor List and 
calendar grid. The Labor List displays labor records that match your default 
saved query in the Labor application. If you do not have a default saved query 
in the Labor application, the Labor List displays all labor records.

NOTE: When a labor record lists more than one craft or skill level, Maximo 
displays craft designated as Default? on the labor record.

You can filter the Labor List using the table filter (described in �Using the 
Table Filter to Refine Search Results,� on page 2-10), or you can change the 
labor query being used to generate the Labor List via the Select Labor 
Query action or button. For example, if you are in charge of scheduling, you 
might create different queries for different crafts, or for different shifts.

For information about creating a saved query, see �Saving a Query,� on 
page 2-8.

Understanding Labor Availability

The right side of the Labor List contains a calendar grid, displaying worker�s 
available hours over a seven day period starting with the current date. By 
default, the first date displayed is the current date.

! If the laborer is available to be scheduled for work that day, there will be a 
numeric value displayed. A value of 0:00 indicates that the worker has no 
available hours in the shift, for example if they have already been assigned 
enough work hours to fill their shift.

! Empty fields indicate days that are designated as non-work days for the 
labor code�s calendar, for example weekends or holidays.

Initially the available hours displayed are based on the following calculation:

labor shift - calendar exceptions - personalized labor 
exceptions

where

labor shift = the calendar defined on the labor record, for example "day" or 
"night."

calendar exceptions = any standard calendar exceptions, for example 
national holidays. 

personalized labor exceptions = any personal calendar exceptions, for 
example vacations. 
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The calendar grid allows you to plan or schedule labor assignments over a 
seven day range. Maximo recalculates available labor hours as assignments 
are made. You can change the date range displayed in the calendar grid by 
clicking the Select Work Date button or choosing Select Work Date from 
the Select Action menu. 

Filtering the Labor List

You have several options for filtering the laborers that are displayed in the 
Labor List. You can:

! Use the Select Labor Query action to select a different labor query.

! Sort one table column at a time. For more information, see �Sorting 
Columns,� on page 2-22.

! Filter the Labor List using the table window filter. For more information, 
see �Filtering Table Windows,� on page 2-22.

! Select one or more requirements in the Work List, then click the Filter 
Labor to Match Work button to display only laborers that match the 
selected work requirements.

! Click the Refresh Labor List button to refresh the Labor List. 

Assignment Manager and Work Orders

Maximo generates the assignments that you see in the Assignment Manager 
application from information that has been entered onto a work order. When a 
work plan is created for a work order Maximo creates an assignment for each 
labor or craft listed on the work plan. For example, if the work plan calls for 
two electricians to work for four hours to complete a job, Maximo will create 
two separate four hour assignments, one for each of the two electricians 
required by the work plan. 

If a work order does not have a defined work plan, Maximo still creates a 
requirement. You can then assign the requirement to an appropriate laborer 
using Assignment Manager. When the requirement is assigned Maximo 
enters a default duration of one hour, which can then be modified as needed.

The top half of the Assignment Manager page displays the Work List. The 
Work List displays all work requirements for work orders with work plans, 
plus any "unplanned" work orders. You also can add new requirements to the 
Work List on the Assignment Manager page via the New Row button.

Understanding Work Priority

Maximo allows values between 0 and 999 to indicate priority for work orders, 
assets, and locations. Maximo can use these different priority values to 
generate a calculated work priority to help schedulers determine the overall 
priority of a work order among "competing" work orders for similar assets or 
locations. 

NOTE: Since Maximo is designed to allow a calculated work priority, by default 
a larger priority value is considered to be more urgent.
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The calculated work priority can be the work order priority, or a combination 
of the work order priority and the asset/location priority. Maximo can be set to 
use any one of the following formulas to determine work priority:   

The formula Maximo uses to calculate work priority can be selected by 
selecting Set Preferences > Set Priority Preferences from the Select 
Action menu.

NOTE: You might need security authorization to change work priority settings.

Filtering the Work List

You have several options for filtering the work requirements that are 
displayed in the Work List. You can:

! Use the Search Toolbar to enter a different query and display a different 
set of work requirements. For more information about using Maximo�s 
search functionality, see �Searching the Maximo Database,� on page 2-6.

! Sort one table column at a time. For more information, see �Sorting 
Columns,� on page 2-22.

! Filter the Work List using the table window filter. For more information, 
see �Using the Table Filter to Refine Search Results,� on page 2-10.

! Select one or more laborers in the Labor List, then click the Filter Work 
to Match Labor button to display only requirements that match the 
selected labor.

! Click the Refresh Work List button to refresh the Work List. 

Using the Assignment Manager Application

To access the Assignment Manager application, click the application link on 
your Start Center, or select Work Orders > Assignment Manager from the 
Go To menu.

The Assignment Manager application contains a single page with two table 
windows.

Option Formula

NONE no calculation

PRIORITY (the default) Work Order Priority 

EQPRIORITY Asset/Location Priority

PRIORITY + EQPRIORITY Work Order Priority + Asset/Location Priority

2 * PRIORITY + EQPRIORITY 2 * Work Order Priority + Asset/Location Priority

PRIORITY + 2 * EQPRIORITY Work Order Priority + 2 * Asset/Location Priority
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Assignment Manager Buttons

The following table lists application specific buttons that appear in the 
Assignment Manager application.   

Icon Function Location

Filter Work to Match Labor � Click to 
filter the Work List to display records that 
match the selected labor records.

! Work List 
! Select Action 

menu

Filter Labor to Match Work � Click to 
filter the Labor List to display records that 
match the selected work requirements.

! Labor List 
! Select Action 

menu

Refresh � Click to refresh the rows 
displayed in table window. Maximo will 
update the rows displayed to match the 
current queries.

! Work List 
! Labor List 

Select Work Date � Click to change the 
dates displayed in the Labor List calendar 
grid.

! Toolbar
! Select Action 

menu

Assign Labor � Click to assign the 
selected work requirements to the selected 
laborer.

! Toolbar
! Select Action 

menu

Start Assignment � Click to start an 
assignment.

! Toolbar
! Select Action 

menu

Interrupt Assignment � Click to 
interrupt an assignment. Maximo modifies 
the assignment, assigning a status of 
INTERPT to the unfinished work.

! Toolbar
! Select Action 

menu

Finish Assignment � Click to finish an 
assignment. When all assignments on a 
work order are finished, Maximo either 
completes or closes the work order.

! Toolbar
! Select Action 

menu

Detail Menu > Go To Work Order 
Tracking � Click to view the selected work 
order in the Work Order Tracking 
application.

! Work List

Show Assignments � Click to view a 
laborer�s assignments during the selected 
seven day period. Use to reassign, 
reschedule, or remove assignments from a 
labor record.

! Labor List

Modify Availability �   Click to modify a 
laborer�s availability to have work assigned 
to them on a given day or shift.

! Labor List
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Assignment Manager Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Assignment Manager application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Assignment Manager Help.       

How Do I...

assign a work requirement to a laborer? Select one or more work requirements in the 
Work List, then select a laborer in the Labor 
List, and select Assign Labor from the Select 
Action menu.

change the date range displayed in the Labor 
list calendar grid?

Select Select Work Date from the Select 
Action menu.

change the labor query used to generate the 
Labor list?

Select Select Labor Query from the Select 
Action menu.

create a new requirement record? Work requirements are generated when you add 
a labor requirement to a work order.

delete a saved labor query? Select Select Labor Query from the Select 
Action menu.

find laborers whose craft, skill level, vendor, 
contract, or Organization matches a work 
requirement?

Select a work requirement, then select Filter 
Labor to Match Work from the Select Action 
menu.

find work requirements whose craft, skill level, 
vendor, contract, or Organization matches those 
of an available laborer?

Select a laborer, then select Filter Work to 
Match Labor from the Select Action menu.

modify an existing labor query? Select Select Labor Query from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

set the number of rows displayed in the Modify 
Availability dialog box?

Select Select Labor Query from the Select 
Action menu.

specify how Maximo should determine work 
order priority?

Select Set Preferences > Set Priority 
Preferences from the Select Action menu.

specify the response time for work orders of a 
certain priority?

Select Set Preferences > Set Priority 
Preferences from the Select Action menu.

specify whether Maximo creates a labor 
transaction when an assignment is finished?

Select Set Preferences >Set Parameter 
Preferences from the Select Action menu.

specify whether Maximo creates a labor 
transaction when an assignment is interrupted?

Select Set Preferences >Set Parameter 
Preferences from the Select Action menu.

specify whether Maximo should change the 
status of a work order to COMPLETE or 
CLOSE when an assignment is completed?

Select Set Preferences >Set Parameter 
Preferences from the Select Action menu.

start recording labor actuals for an assignment? Select Start Assignment from the Select 
Action menu.
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Creating Assignments

Work requirements can be created via all of the applications that create or 
generate work orders. For a list of applications that can create work orders, 
see �Creating Work Orders Using Maximo,� on page 14-2.

Assignment records are managed in the Assignment Manager application.

The Assignment Manager application can be used by a variety of workers to 
assign labor to work orders. Using Assignment Manager 

! Planners can plan future assignments by labor availability over any seven 
day period.

! Dispatchers can dispatch currently available workers to incoming work 
requests.

! Workers can use Assignment Manager to assign themselves to open work 
requirements.

Scheduling Future Work

Once you have selected one or more requirements from the Work List, there 
are three ways to assign the work to a laborer:

! Click a date with available hours in the laborer�s calendar in the Labor 
List

! Click a labor code, then click Assign Labor in the toolbar
! Click a labor code, then select Assign Labor from the Select Action menu

The Assign Labor button and action perform the same function. 

Managing Assignments

Using Assignment Manager, you can

! add hours to a laborer�s availability, for example if a laborer is covering 
another worker�s shift.

! note when laborers are unavailable to be assigned to work, for example 
when they are in training, or on vacation. 

! reassign or reschedule which laborers will perform scheduled work

! un-assign work that was previously assigned to a laborer

stop or finish recording labor actuals for a 
completed assignment?

Select Finish Assignment from the Select 
Action menu.

stop or pause recording labor actuals for an 
incomplete assignment?

Select Interrupt Assignment from the Select 
Action menu.

view all laborers? Select Show All Labor from the Select Action 
menu.

How Do I...
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! filter the table windows to match work to labor, or match labor to work

! start, interrupt, and finish dispatched assignments, and track the 
resulting labor transactions 

For more information about how to perform these actions, refer to the 
Assignment Manager Help. 

Viewing Assignments for a Worker

You can view work assigned to a laborer by clicking the Show Assignments 
button for the Labor Code. The Show Assignments page displays work 
assigned to the laborer over the seven day range currently displayed in the 
Labor List calendar grid.

From the Show Assignments page you can:

! reschedule an assignment by changing the Scheduled Date
! reassign an assignment by changing the Labor Code
! un-assign the assignment by clearing the Labor Code 
! delete the assignment from the laborer using the Mark For Delete 

button

CAUTION: Deleting the assignment deletes the requirement from the work 
order.

Dispatching Work

Dispatchers schedule urgent work, that is requirements that should be 
carried out during the current day�s shift. The procedures for dispatching 
work are similar to those for planning future work, but the work is assigned to 
the current shift (by default the first date in the calendar grid) rather than to 
future shifts. 

TIP: By default new work orders created in the Work Order Tracking and Work 
Request applications do not have a Target Start or Scheduled Start 
date indicated. To find new work requests you should search by the 
Reported Date field.

Once a requirement has been assigned to a laborer, you can use the dispatch 
functions to indicate when work on the assignment has started, been 
interrupted, and has been finished.   

Dispatch 
Function

Description

Start 
Assignment

Use the Start Assignment action to indicate that work has 
been started on an assignment. By default Maximo will 
begin recording labor actuals for an assignment once its 
status has been changed to STARTED.

Interrupt 
Assignment

Use the Interrupt Assignment action when an 
assignment with a status of STARTED needs to be stopped 
for any reason. When you interrupt an assignment Maximo 
logs a labor transaction for the completed portion of the 
work, then modifies the assignment, assigning a status of 
INTERPT to the remaining work hours.
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NOTE: When a work order�s status is changed to COMP in the Work Order 
Tracking application, Maximo changes the status of all assignments on 
the work order to COMPLETE. When a work order�s status is changed 
to CLOSE and the work order becomes a history record, Maximo deletes 
all of the assignments for that work order.

Assignment Statuses

An assignment can have one of the following statuses:

! WAITASGN � Waiting for assignment. When work requirements are 
created they have an initial status of waiting for assignment.

! ASSIGNED � Assigned. When a work assignment has been assigned to a 
laborer, the assignment status changes to ASSIGNED. If the labor code is 
deleted from an assignment, the assignment status reverts back to 
WAITASGN. 

! STARTED � Started. When you click Start Assignment Maximo 
changes the assignment status to STARTED.

! INTERPT � synonym to WAITASGN. If an assignment with a status of 
STARTED is interrupted, Maximo logs a labor transaction to the database 
for the completed portion of the work, then modifies the assignment, 
assigning a status of INTERPT to the remaining work hours.

! COMPLETE � Complete. When you click Finish Assignment, Maximo 
changes the assignment status to COMPLETE. When a work order�s 
status is changed to COMP, Maximo changes the status of all assignments 
on the work order to COMPLETE. When a work order�s status is changed 
to CLOSE, Maximo deletes all of the assignments for that work order.

NOTE: Requirements can exist in the Work List with an empty Status field. 
This type of requirement comes from an unplanned work order. After 
you assign the requirement to a laborer, its status becomes ASSIGNED.

Deleting Assignments

Deleting an assignment is different from un-assigning in that the action 
removes the work requirement from both the work order record and the 
database. You should only delete assignments when the task or labor code is 

Finish 
Assignment

Use the Finish Assignment action to indicate that work 
on an assignment has been completed. Maximo stops 
recording labor actuals once an assignment�s status is 
changed to COMPLETE.
Assignment statuses are linked to the work order that 
contains the work requirement. When the last assignment 
for a work order has been completed, Maximo changes the 
status of the work order to COMP. Maximo can be set to 
CLOSE work orders once all assignments have been 
finished using the Set Preferences action. Note that once 
a work order has been closed it becomes a history record 
and can only be modified using the Edit History action.

Dispatch 
Function

Description
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not required for the work order, for example if an error was made when the 
work plan was created.

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Assignment Manager Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Labor Reporting

A labor transaction is a record of the amount of time a laborer or contractor 
spent performing work. You use the Labor Reporting application to report the 
type and total number of hours of work performed by external contractors or 
internal employees. 

Using the Labor Reporting application you can:

! record daily attendance for a labor code to track when a worker starts and 
ends their work day

! enter labor transactions by contract or vendor

! enter labor transactions by labor code to track time spent on specific tasks

! enter labor transactions by ticket and select all the labor requirements on 
the ticket

! enter labor transactions by work order and select all the labor 
requirements on the work order

Multisite and Labor Reporting

Labor records are at the Organization level, but labor reporting is done at the 
Site level. Care should be taken to make sure that hours are reported against 
the correct Site, as work order numbers can be duplicated at different Sites.

Labor Reporting and Contracts

You can report work hours by contract number or by vendor name using the 
Enter by Contract/Vendor button in the toolbar or action in the Select 
Action menu. Vendor records are created in the Company Master application. 
Labor contract records are created in the Labor Contracts application. For 
more information, see �Labor Rate Contracts,� on page 4-6.
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Labor Reporting and Invoices

Some companies consider a work order that requires outside labor as being 
the equivalent of a purchase order for that labor. Maximo allows you to create 
invoices directly from a labor transaction, without having to create a purchase 
order record. You use the Create Invoice action to create invoice records 
from labor transactions in the Labor Reporting application.

NOTE: You can only create invoices for labor transactions that have been 
approved and have a defined vendor.

Labor Reporting and Labor Records

You can report work hours against any labor record with a status of ACTIVE 
using the Enter by Labor button in the toolbar or action in the Select Action 
menu. Labor records are created in the Labor application. For more 
information, see �Labor Records,� on page 10-6.

Labor Reporting and the Service Desk

You can report work hours by ticket number using the Enter by Ticket 
button in the toolbar or action in the Select Action menu. Ticket records are 
created in the Service Requests, Incidents, and Problems applications. For 
more information, see Chapter 12, "The Service Desk Module," on page 12-1.

Labor Reporting and Work Order Tracking

You can report work hours by work order number using the Enter by Work 
Order button in the toolbar or action in the Select Action menu. Work order 
records are created in the Quick Reporting and Work Order Tracking 
applications. For more information, see �Work Orders,� on page 14-24.

The labor hours that are reported in the Labor Reporting application are 
included when Maximo calculates costs for labor actuals in the Work Order 
Tracking application.

There are two functional differences between the Labor Reporting application 
and the Actuals tab in the Work Order Tracking application:

! The Actuals tab in the Work Order Tracking application only allows you to 
record labor hours for the current work order. The Enter by Work Order 
dialog box in the Labor Reporting application allows you to record labor 
hours for multiple work orders.

! Reported labor in the Labor Reporting application with the types WORK 
(actual work time), TRAV (travel time), or WMATL (waiting materials) 
must have a charge value. The labor can be charged against a work order, 
asset, location, or GL Account code. Any other work type does not require a 
charge value.
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Using the Labor Reporting Application

To access the Labor Reporting application, click the application link on your 
Start Center, or select Work Orders > Labor Reporting from the Go To 
menu. 

The Labor Reporting application contains a single page with one table 
window, which displays labor transaction records. You use the Transactions 
table window to add, modify, or delete labor transactions. You also use the 
table window to select records for approval and invoicing. 

Labor Reporting Buttons

The following table lists application specific buttons that appear in the Labor 
Reporting application. 

Labor Reporting Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Labor Reporting application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Labor Reporting Help. 

Icon Function Location

Enter By Work Order ! Toolbar

Enter By Labor ! Toolbar

Enter By Ticket ! Toolbar

Enter By Contract/Vendor ! Toolbar

How Do I...

approve labor actuals? Select one or more labor transactions, then 
select Approve Labor from the Select Action 
menu.

create an invoice for one or more labor 
transactions?

Select one or more labor transactions, then 
select Create Invoice from the Select Action 
menu.

record daily attendance (time card)? Select Daily Attendance from the Select 
Action menu.

report labor hours by contract? Select Enter by Contract/Vendor from the 
Select Action menu.

report labor hours by laborer? Select Enter by Labor from the Select Action 
menu.
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Creating Labor Transactions

The Transactions table window displays labor transactions that you entered 
in the Labor Reporting application or in any other Maximo application where 
you can record labor actuals. By default, Maximo displays the most recent 
transactions first.

Creating Labor Transactions

You create labor transactions when you report labor actuals in any of the 
following applications:

! in the Assignment Manager application via the Start Interrupt and 
Finish Assignment actions

! in the Activities application via the Start and Stop Timer buttons

! in the Changes application via the Start and Stop Timer buttons or by 
recording labor actuals on the Labor subtab of the Actuals tab

! in the Incidents application via the Start and Stop Timer buttons

! in the Labor Reporting application via any of the actions listed in 
�Reporting Labor Transactions,� on page 14-20.

! in the Problems application via the Start and Stop Timer buttons

! in the Quick Reporting application by recording labor actuals on the Labor 
subtab

! in the Releases application via the Start and Stop Timer buttons or by 
recording labor actuals on the Labor subtab of the Actuals tab

! in the Service Requests application via the Start and Stop Timer buttons

! in the Work Order Tracking application by recording labor actuals on the 
Labor subtab of the Actuals tab

For information about creating labor transactions in another application, 
refer to the appropriate sections of this guide.

report labor hours by ticket (service request, 
incident, or problem)?

Select Enter by Ticket from the Select Action 
menu.

report labor hours by vendor? Select Enter by Contract/Vendor from the 
Select Action menu.

report labor hours by work order? Select Enter by Work Order from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

How Do I...
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Reporting Labor Transactions

You can report labor transactions in the Labor Reporting application in one of 
the following ways:    

When you record labor actuals, if the reported labor has a Type of WORK, 
TRAV (Travel), or WMATL (Waiting for Materials), you must charge it to a 
work order, location, asset, or General Ledger account. Maximo does not 
require a charge value for other work types.

Managing Labor Reporting

You can use Labor Reporting to edit labor transactions created in other 
applications unless the status of the ticket or work order is closed or cancelled.

You can edit a labor transaction until it is approved.

Approving Labor

Some companies require approval for labor transactions, and Maximo 
requires approval before invoices can be created from labor transactions. Each 
transaction record has an Approved? check box. A check mark in the 
Approved? check box indicates that a transaction has been approved. 

You use the Approve Labor action in the Select Action menu to approve one 
or more labor transactions. Labor transactions must be saved before they can 
be approved.

NOTE: You may need security authorization to approve labor actuals.

CAUTION: Once a labor transaction has been approved it can no longer be 
edited or deleted.

Action

Enter by Contract/
Vendor action or 
button

Use when reporting work performed by a vendor or contract labor. Maximo 
validates that the contract and vendor match.

Enter by Labor action 
or button

Use when reporting hours by labor code to either track the time spent on 
specific tasks or record daily attendance.

Enter by Ticket action 
or button

Use when reporting hours by ticket. You can enter the ticket number and 
select or enter all labor transactions for the ticket. When you report labor 
hours by ticket, Maximo copies the Asset, Location, and Start Date 
values from the ticket to the labor transaction.

Enter by Work Order 
action or button

Use when reporting hours by work order. You can enter the work order 
number and select or enter all labor transactions for the work order. When 
you report labor hours by work order, Maximo copies the Asset, Location, 
and Start Date values from the work order to the labor transaction.

Daily Attendance 
action

Use when recording when a worker starts and ends the work day. Maximo 
records the time that you select the Daily Attendance action. Maximo 
calculates the Hours worked based on the Start Time and Finish Time.

New Row button Use to report new labor transactions in the Transactions table window.
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Your system administrator can configure Maximo to automatically approve 
inside labor transactions, automatically approve outside labor transactions, 
and to automatically approve invoices created from labor transactions.

Deleting Labor Transactions

If a labor transaction record has not been approved it can be deleted by 
clicking the Mark Row for Delete button next to the row in the table 
window, then clicking Save.

For more information about the record deletion rules, refer to the Maximo 
System Administrator�s Guide.

Labor Reporting Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Quick Reporting

A work order created in the Quick Reporting application is used for 
reporting work performed after it has been completed. You can enter actual 
labor and material usage information, or report events, such as asset failures 
or downtime, that do not require planning and scheduling.

NOTE: After you save a work order in Quick Reporting, it also can be accessed 
via the Work Order Tracking application.

Multisite and Quick Reporting

Work orders are at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! The key field must be unique for work orders where CLASS = 
WORKORDER.

! Records can only be viewed by users who have security permission to the 
Site and the application.

Using the Quick Reporting Application

To access the Quick Reporting application, click the application link on your 
Start Center, or select Work Orders > Quick Reporting from the Go To 
menu. 

The Quick Reporting application contains the following tabs:

! List � to search Maximo for work order records.
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! Quick Reporting � to enter, view, or modify work orders, record actuals 
for labor, materials, and tools, and perform failure reporting.

Quick Reporting Application Quick Reference

The following chart provides a quick reference to common tasks you perform 
with the Quick Reporting application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Quick Reporting Help.   

How Do I...

apply a route to a work order? Select Apply Route from the Select Action 
menu.

assign a work order to a new parent? Select Assign to New Parent from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change the attributes for an asset? Select Move/Modify Assets from the Select 
Action menu.

change the attributes for a location? Select Move/Modify Assets from the Select 
Action menu.

change the location of an asset? Select Move/Modify Assets from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.
Select Change Status from the Select Action 
menu.

create a change work order from the current 
record?

Select Create > Change from the Select Action 
menu.

create a communication from the current 
record?

Select Create > Communication from the 
Select Action menu.

create an incident record from the current 
record?

Select Create >Incident from the Select Action 
menu.

create a problem record from the current 
record?

Select Create > Problem from the Select 
Action menu.

create a release work order from the current 
record?

Select Create > Release from the Select Action 
menu.

create a service request record from the current 
record?

Select Create > Service Request from the 
Select Action menu.

create a work order record? Click the New Work Order button in the 
toolbar.

create a work order record from the current 
record?

Select Create > Work Order from the Select 
Action menu.

delete a work order record? Select Delete Work Order from the Select 
Action menu.
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Creating Work Orders

You can create a work order with Quick Reporting to report unplanned 
maintenance work that has already been completed. For creating work orders 
that require planning or scheduling, or for adding additional data to a work 
order created through Quick Reporting, use the Work Order Tracking 
application. 

If a work order is being created for an asset or location that has meters 
associated with it, you can use the Enter Meter Readings action to record 
meter readings. You can use the Report Downtime action to record 
downtime for an asset.

You can use the Duplicate Work Order action to create a copy of an existing 
work order, for example if you need to perform the same work for similar 
assets or locations. Once you duplicate a work order you can then modify it as 
needed.

Managing Work Orders

Work orders created in the Quick Reporting application can also be viewed 
and managed in the Work Order Tracking application.

duplicate a work order record? Select Duplicate Work Order from the Select 
Action menu.

enter meter readings for an asset? Select Enter Meter Readings from the Select 
Action menu.

enter meter readings for a location? Select Enter Meter Readings from the Select 
Action menu.

plan an asset modification or move? Select Move/Modify Assets from the Select 
Action menu.

report asset downtime? Select Report Downtime from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

view costs for a work order? Select View > Costs from the Select Action 
menu.

view purchase orders for materials and services 
for a work order?

Select View > PO Information from the Select 
Action menu.

view purchase requisitions for materials and 
services for a work order?

Select View > PO Information from the Select 
Action menu.

view the status change history for a work order? Select View> View History from the Select 
Action menu.

How Do I...
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Reporting Actuals

Quick Reporting work orders are created with a status of WAPPR, which 
changes to INPRG after the work order is saved. If you create a work order 
after the job has been completed, you must save the work order before you can 
report Actuals for labor, materials, or tools.

You also can use Quick Reporting to record actuals for any approved work 
order, regardless of which application was used to create it.

Work Order Statuses

For a list of possible statuses for work orders, see �Work Order Statuses,� on 
page 14-5.

Deleting a Work Order

For information about deleting work orders, see �Deleting a Work Order,� on 
page 14-41.

Quick Reporting Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.

Work Orders

A work order is a request for work to be performed. Using work orders 
allows you to both track work that has been performed in the past and future 
work that is being planned. The information contained on a work order 
includes the tasks performed, labor hours or services required for the work, 
materials and tools needed to do the work, and the assets worked on, or 
locations where the work was performed. 

You can use the Work Order Tracking application to plan, review, and 
approve work orders for assets, locations, or other work charged to general 
ledger (GL) accounts. 

You can use the Work Order Tracking application to perform every function 
related to processing work orders. These tasks include creating, approving, 
and initiating work orders, checking their status history, and closing or 
reworking them when appropriate.

Multisite and Work Orders

Work orders are defined at the Site level. This means that:

! Maximo requires that key fields be unique to a Site, but allows duplication 
of record IDs used by other Sites or Organizations.

! The key field must be unique for work orders where CLASS = 
WORKORDER.



Chapter 14: The Work Orders Module

Maximo 6, 08/2006 14-25

! Records can only be viewed by users who have security permission to the 
Site and the application.

Work Orders and Assets/Locations

Work orders are often created for an asset or location. Asset records are 
created in the Assets application, and location records are created in the 
Locations application.

When there is a value in the Location field on a work order, Maximo 
automatically copies information from the location record to the work order.   
Use the Move/Modify Assets action if the work order involves changing the 
location of the asset or modifying it�s location in an asset hierarchy.

When there is a value in the Asset field on a work order, Maximo 
automatically copies information from the asset record to the work order 
including the Failure Class for the asset. You use the Failure Reporting tab 
to record failure data for the asset or location.

The Asset Up? check box indicates the Up/Down status of the asset as 
recorded using the Report Downtime action.

The Asset/Location Priority field displays the asset priority. Maximo 
displays the location priority only if there is no value specified for asset 
priority.

If an asset record has meters associated with it, you can enter meter readings 
for an asset using the Enter Meter Readings action.

Work Orders and Contracts

When the asset listed on a work order is under warranty, Maximo displays a 
message to alert you to that fact. You can use the View Warranties action to 
view any warranties that apply to the work order.

The Warranties Exist? check box read-only. Maximo automatically checks 
the Warranties Exist? check box if warranties exist for the asset or location 
listed on the work order.

The Contract field on a work order is used to display a warranty or service 
contract that applies to a work order. Warranty and service contracts are 
created in the Warranty Contracts application.

Work Orders and Inventory

You can list materials requirements for a work order on the Materials subtab 
of the Plans tab. When the work order status is changed to APPR (approved), 
Maximo creates an inventory reservation for these items. If the work order 
status is then unapproved or canceled, Maximo removes the reservations. 
Item records are created in the Item Master application and managed in the 
Inventory application.

You can list service requirements for a work order on the Services subtab of 
the Plans tab.
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You can list tool requirements for a work order on the Tools subtab of the 
Plans tab. When the work order is approved, Maximo creates an inventory 
reservation for these items. Tools records are created in the Tools application, 
and managed (issued and returned) using the Stocked Tools application.

You record actual usage of materials, services, and tools on the Actuals tab. 
When Maximo calculates work order costs it uses materials, services, and 
tools actuals in the calculation.

Work Orders and Issues and Transfers

When you record item use on a work order, Maximo creates a material 
transaction record in the database. Item usage on work orders can be recorded 
in one of two ways:

! record materials issued to the work order using the Issues and Transfers 
application.

! record material usage using the Actuals tab of the Work Order Tracking 
application.

Because Maximo updates inventory balances when you perform either of 
these actions, it is possible for the same item to be subtracted from inventory 
twice, thereby causing inaccurate item counts. To ensure accurate inventory 
records, your company should establish a policy for each site regarding 
whether item use will be recorded in the Issues and Transfers application or 
in the Work Order Tracking application.

Work Orders and Job Plans

You can use the applications in the Planning module to create templates for 
job plans and safety plans. 

A job plan describes the tasks that need to be performed on a work order, and 
the labor, materials, services, and tools that will be needed.   Job plans are 
created in the Job Plans application.

When you select a job plan to apply to a work order, or generate a work order 
from a Condition Monitoring or PM record with an associated job plan, 
Maximo copies data from the job plan to the work order. This information can 
be viewed in the Plans tab. You can then modify the data as needed without 
affecting the original job plan. If no job plan exists that meets your needs, you 
can create one in the Tasks table window on the Plans tab.

A safety plan describes hazards and precautions, hazardous materials, lock 
outs and tag outs that apply to specific assets and locations. Safety plans are 
created in the Safety Plans application, and are similar to job plans. They are 
templates that can be copied to work orders. After the safety plan has been 
applied, you can add, edit, or delete plan information on the work order 
without affecting the original safety plan. If no safety plan exists that meets 
your needs, you can create one on the Safety Plan tab.

After you apply a job plan that includes a safety plan to a work order, or 
generate a work order from a Condition Monitoring or PM record with an 
associated job plan, Maximo copies safety information from the job plan to the 
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work order. This safety information can be viewed on the Safety Plan tab. You 
can then modify the data as needed without affecting the original safety plan.

Work Orders and Labor Records

You can list labor and craft requirements for a work order on the Labor subtab 
of the Plans tab. Maximo uses the labor values listed on the Plans tab to 
create the requirements that appear in the Assignment Manager application. 
You use the Assignment Manager application to assign work to individual 
laborers. Labor records for both internal (employee) and external (contract) 
laborers are created in the Labor application.

You record actual usage of labor hours on the Actuals tab. When Maximo 
calculates work order costs it uses labor actuals in the calculation. You can 
also use the Labor Reporting application to report labor actuals against a 
work order.

Work Orders and Meters

You can record meter readings for an asset or location via the Enter Meter 
Readings action available from the Select Action menu. When you record 
meter readings for an asset or location, Maximo updates values in the 
following fields on Meters tab of the asset or location record:

! Last Reading 
! Last Reading Date
! Last Reading Inspector

Work Orders and Preventive Maintenance

Regular inspections and preventive maintenance can help reduce the number 
of emergency work orders that are generated at your company. You use the 
Master PM application to create master PM records which are used as 
templates to create other PM records. You use the Preventive Maintenance 
application to create PM records, which can generate PM work orders.

You can schedule Maximo to generate work orders based on elapsed time, or 
meter readings, or a combination of the two. When a work order has been 
generated from a PM there is a value in the PM field. When you generate a 
work order from a PM, Maximo copies data from the PM to the work order, 
including job plan and safety plan data.

Work Orders and Purchasing

Frequently items, materials, or services must be ordered in order to complete 
a work order. You can create purchase requisitions using either the Purchase 
Requisitions application, or in the self-service Desktop Requisitions 
application. 

You use the View PO Information action to view current purchase 
requisitions and purchase orders for items and services for the work order.
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If you select the Issue on Receipt? check box for a PR line, the item will be 
issued directly to the work order upon receipt. Services are direct issue by 
default.

Work Orders and the Service Desk

Work orders can also be created using Maximo�s Service Desk applications. 
For information about the different classes of work orders that can be created 
using Maximo, see �Classes of Work Orders,� on page 14-2.

The following Select Action menu options allow you to create tickets and work 
orders from within any of the Service Desk or work order applications:

! Create Service Request 
! Create Incident 
! Create Problem 
! Create Change 
! Create Release 
! Create Work Order

The Related Records tab on a ticket or work order record records the 
relationship between the originating record and the follow up record(s).

Work Orders and Service Level Agreements

A service level agreement (SLA) is a written agreement between a service 
provider and customer that documents the agreed-upon service levels for a 
service. 

You use the View SLA action to view all service level agreements that apply 
to a work order and its tasks. 

You use the Apply SLA action when you want Maximo to search for and 
apply applicable service level agreements. Maximo searches for active SLAs 
that match the characteristics of the work order. If no applicable SLA is found, 
Maximo displays a message.    

You use the Select/Deselect SLA action to select and delete associations 
between a work order and one or more service level agreements. When you 
apply an SLA to a work order, Maximo automatically does the following:

! Selects the SLA Applied? check box on the work order. This check box is 
read-only.

! Enters a value in the Target Start date field when an SLA with a 
Response type commitment is applied to the record.

! Enters a value in the Target Finish date field when an SLA with a 
Resolution type commitment is applied to the record.

NOTE: Applying a SLA to a work order only applies it to that record, it does not 
apply the SLA to any task work orders listed on the record. If you want 
to apply the SLA to a task, you must open each task work order 
individually and apply the SLA to each task. 
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NOTE: You might need security authorizations to apply and remove SLAs from 
a work order.

Using the Work Order Tracking Application

To access the Work Order Tracking, click the application link on your Start 
Center, or select Work Orders > Work Order Tracking from the Go To 
menu.

The Work Order Tracking application contains the following tabs:

! List � to search Maximo for work order records.

! Work Order � to create, view, or modify work orders, view identifiers for 
an applied job plan and safety plan, view PM and scheduling information. 
If the work order is a follow-up work order, you can view the identifier of 
its originating work order. You also can identify the failure hierarchy for 
the work asset.

! Plans � to enter, view, or modify information on work orders in a 
hierarchy, and to enter, view, modify, or delete information about planned 
job tasks, labor, materials, services, and tools.

! Related Records � to add, view, or delete related ticket and work order 
records.

! Actuals � to enter, view, or modify actual work order start and finish 
times, labor hours and costs, material quantities, service costs, and tool 
costs. 

! Safety Plan � to add, view, modify, or delete safety information 
associated with a work order.

! Log � to create, view, edit, and delete Work Log entries, and view 
Communication Log entries.

! Failure Reporting � to enter, view, or modify asset and location failure 
information to help identify trends.

Work Order Tracking Application Quick Reference

The following chart provides a quick reference to common tasks performed in 
the Work Order Tracking application. For more detailed information, 
including prerequisites to performing an action and detailed procedures, refer 
to the Work Order Tracking Help.   

How Do I...?

apply a route to a work order? Select Apply Route from the Select Action 
menu.

apply one or more service level agreements to a 
work order?

Select Apply SLAs from the Select Action 
menu.
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assign an owner to a work order? Select Select Owner from the Select Action 
menu.

assign a work order to a new parent? Select Assign to New Parent from the Select 
Action menu.

bookmark a record so that I can view it at a 
later time?

Select Add to Bookmarks from the Select 
Action menu.

change the attributes for an asset? Select Move/Modify Assets from the Select 
Action menu.

change the attributes for a location? Select Move/Modify Assets from the Select 
Action menu.

change the location of an asset? Select Move/Modify Assets from the Select 
Action menu.

change a record�s status? Click the Change Status button in the toolbar.

create a change work order from the current 
record?

Select Create > Change from the Select Action 
menu.

create a communication from the current 
record?

Select Create > Communication from the 
Select Action menu.

create an incident record from the current 
record?

Select Create > Incident from the Select 
Action menu.

create a job plan record from a work order�s 
work plan?

Select Create Job Plan from Work Plan from 
Work Plan from the Select Action menu.

create a problem record from the current 
record?

Select Create > Problem from the Select 
Action menu.

create a release work order from the current 
record?

Select Create > Release from the Select Action 
menu.

create a service request record from the current 
record?

Select Create > Service Request from the 
Select Action menu.

create a work order record? Click the New Work Order button in the 
toolbar.

create a work order record from the current 
record?

Select Create > Work Order from the Select 
Action menu.

delete a safety plan from a work order? Select Remove Safety Plan from the Select 
Action menu.

delete the work log from the current record? Select Modify/Delete Work Log from the 
Select Action menu.

delete a work order record? Select Delete Work Order from the Select 
Action menu.

delete a work plan from a work order? Select Remove Work Plan from the Select 
Action menu.

duplicate a work order record? Select Duplicate Work Order from the Select 
Action menu.

How Do I...?
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enter meter readings for an asset? Select Enter Meter Readings from the Select 
Action menu.

enter meter readings for a location? Select Enter Meter Readings from the Select 
Action menu.

modify data on a record with a status of 
CLOSE?

Select Edit History Work Order from the 
Select Action menu.

modify the work log for the current record? Select Modify/Delete Work Log from the 
Select Action menu.

plan an asset modification or move? Select Move/Modify Assets from the Select 
Action menu.

remove a service level agreement from a work 
order?

Select Select/Deselect SLAs from the Select 
Action menu.

report asset downtime? Select Report Downtime from the Select 
Action menu.

run reports? Select Run Reports from the Select Action 
menu.

select hazards to associate with a work order? Select Select Safety Hazards from the Select 
Action menu.

select a service level agreement to apply to a 
work order?

Select Select/Deselect SLAs from the Select 
Action menu.

take ownership of a record? Select Take Ownership from the Select Action 
menu.

view costs for a work order? Select View > Costs from the Select Action 
menu.

view the ownership history for a work order? Select View> Work Order History from the 
Select Action menu.

view purchase orders for materials and services 
for a work order?

Select View > PO Information from the Select 
Action menu.

view purchase requisitions for materials and 
services for a work order?

Select View > PO Information from the Select 
Action menu.

view service level agreements applied to a work 
order?

Select View SLAs from the Select Action menu.

view the status change history for a work order? Select View> Work Order History from the 
Select Action menu.

view warranties for the asset listed on a work 
order?

Select View > Warranties from the Select 
Action menu.

view warranties for the location listed on a work 
order?

Select View > Warranties from the Select 
Action menu.

view the work plan for the hierarchy (the work 
order, its children, and tasks)?

Select View > Entire Plan from the Select 
Action menu.

How Do I...?
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Creating a Work Order

You can create a work order using a number of different Maximo applications. 
For a list of applications that can be used to create work orders, see �Creating 
Work Orders Using Maximo,� on page 14-2.

Creating work orders often involves planning how the work will be performed. 
You use the Plans and Safety Plans tabs to plan work orders.

Creating a Work Plan

Work orders can range from the relatively simple (a single worker replacing a 
bulb in a lighting fixture) to the extremely complex (teams of workers 
coordinating a nuclear plant shutdown for routine maintenance). The more 
complex a work order is, the more likely you will need to create a plan for 
what needs to be accomplished, who will perform the work, and what 
materials and tools will be needed to complete the work. A work plan 
describes the tasks that need to be performed on a work order, and the labor, 
materials, services, and tools that will be needed. You create and view work 
plans on the Plans tab. 

You can create a work plan in one of two ways:

! Associate a job plan with the work order by entering a value in the Job 
Plan field on the Work Order tab. After you select a job plan, Maximo 
copies the information to the Plans tab of the work order. If there is a 
safety plan associated with the job plan, Maximo also copies the safety 
plan information to the Safety Plans tab. Once Maximo has copied the job 
plan to the work order it becomes a work plan, and can be modified as 
needed.

! Create a custom work plan using the Plans tab. Defining a work plan 
consists of the following tasks:

! Defining the tasks or steps needed to complete the work. Tasks are 
entered in the Tasks table window. You can indicate that the tasks 
need to be performed in a particular sequence, and provide estimates 
of how long each task will take to perform. You can also use the Tasks 
table window to add measurement point data for an asset. 
Measurement points are created in the Condition Monitoring 
application.

! Define the labor, crafts, and skill levels that will be required for the 
work. Labor requirements are entered on the Labor subtab. Labor 
records are created in the Labor application.

! Define the items and materials that will be needed to complete the 
work. Material requirements are entered on the Materials subtab. 
Item records are created in the Item Master application.

! Define the services that will need to be purchased to complete the 
work. Service requirements are entered on the Services subtab. Service 
records are created in the Service Items application.

! Define the tools that will be needed to complete the work. Tool 
requirements are entered on the Tools subtab. Tool records are created 
in the Tools application.
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For more information about creating job plans and work plans, refer to the 
Help.

Defining Work Plan Tasks

When you define tasks for a work order, Maximo numbers each task. Task 
numbers must be unique within each work plan. 

Maximo sorts tasks by Sequence, then by Task ID. If a work plan does not 
have a Sequence indicated, the system sorts tasks in numerically ascending 
order by Task ID, making the task with the lowest number is the first step of 
your work plan. By default, Maximo increments task numbers by 10, for 
example, 10, 20, 30 and so on. This gives you the flexibility to add new tasks 
between existing ones. 

Selecting Multiple Records on Plans and Actuals

Maximo allows you to select multiple records when defining work plan labor, 
material, service, and tool needs, or recording actuals. The following buttons 
appear on both the Plans and Actuals tabs:

! Select Craft � Appears on the Labor subtab. Click to select from a list of 
craft records.

! Select Materials � Appears on the Materials subtab. Click to select from 
a list of item records.

! Select Asset Spare Parts � Appears on the Materials subtab. Click to 
select from a list of spare parts for the asset.

! Select Standard Services � Appears on the Services subtab. Click to 
select from a list of service item records.

! Select Tools � Appears on the Tools subtab. Click to select from a list of 
tool records.

When you select multiple records, Maximo creates a separate row for each 
record on the appropriate subtab.

Adding a Safety Plan to a Work Order

A safety plan describes hazards and precautions, hazardous materials, lock 
outs and tag outs that apply to specific assets and locations. You create and 
view safety plans on the Safety Plan tab. When you are creating safety plans 
for a work order you want to consider the asset or location that is being 
worked on, but also any hazards that might exist in the surrounding area. 

You can create a safety plan in one of the following ways:

! Associate a safety plan with the work order by entering a value in the 
Safety Plan field on the Work Order tab. After you select a safety plan, 
Maximo copies the information to the Safety Plan tab of the work order. 
Once Maximo has copied the safety plan to the work order it can be 
modified as needed.

! Associate a job plan with the work order by entering a value in the Job 
Plan field on the Work Order tab. If the combination of the job plan and 
the work asset (asset or location) listed on the work order require a safety 
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plan, Maximo copies the safety information to the Safety Plan tab of the 
work order. Once Maximo has copied the safety plan to the work order it 
can be modified as needed.

! Create a custom safety plan using the Safety Plan tab. Defining a safety 
plan consists of the following tasks:

! Enter a Location or Asset on the Work Order tab. Location records 
are created in the Locations application. Asset records are created in 
the Assets application.

! Define the safety hazards to include on the safety plan. You can select 
hazards using the Select Safety Hazards action, or add them to the 
Hazards table window. Maximo copies information for the selected 
hazard to the appropriate subtab. Hazard records are created in the 
Hazards application.

! Define the Hazardous Materials that apply to the safety plan. 
Hazardous materials information is defined on a hazard record. 

! Define the tag outs procedures that apply to the asset or location. Tag 
outs records are created in the Lock Out/Tag Out application.

You can add a safety plan to a work order until the status of the work order is 
APPR (Approved). Your system administrator determines which work order 
statuses allow editing of Safety Plan information. 

NOTE: If a work order already has a safety plan applied to it, you must use the 
Remove Safety Plan action to remove the existing safety plan before 
you can select another safety plan. 

For more information on Safety Plans, see �Safety Plans,� on page 11-12.

Duplicating a Work Order

You can use the Duplicate Work Order action to create a copy of an existing 
work order, for example if you need to perform the same work for similar 
assets or locations. Once you duplicate a work order you can then modify it as 
needed.

Managing Work Orders

Managing a work order will often involve additional work orders, for example 
follow up work, or managing a project that involves multiple work orders. 
Managing work orders also involves recording costs, communications, and 
other data about the work. 

You use the Plans and Related Records tabs to create, view, modify, and delete 
associations between work order records. You use the Actuals, Log, and 
Failure Reporting tab to record data about the work done on a work order.

Work Order Hierarchies

A work order hierarchy is a group of work orders arranged in parent-child 
relationships. A work order hierarchy is often used when you have a large 
maintenance project that might need to be broken down into smaller jobs to be 
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completed. Hierarchies let each smaller job be handled as an individual work 
order, while having a relationship to the larger project. 

At the highest level of a work order hierarchy, one work order is the parent. 
This top-level work order can have one or more child work orders. Each child 
work order can have one or more children, and so on. A child work order can 
have only one parent. The lowest level of any branch of the hierarchy is 
usually the task level containing the steps that are defined in a work plan or 
job plan.

Hierarchies let you view work order costs individually and as part of the 
project totals. You can view the actuals for the parent, as well as the combined 
totals of the parent and all its child work orders via the View Costs action. 

After work orders are grouped into hierarchies, you can easily change all 
statuses, view all estimated and actual costs, and put work orders into a 
sequence so that workers can perform tasks in a defined order. You also can 
move a work order to another hierarchy.

Understanding Work Order Hierarchy Terms

The table below lists common terms used when discussing work order 
hierarchies.   

Viewing and Navigating Work Order Hierarchies

You use the Plans tab to entire, view, and modify work order hierarchies when 
creating work plans. The Actuals tab contains a duplicate of the work order 
hierarchy for recording actuals.

Work Order Application indicators Database indicators

Top Level � The work order at the top of a 
multi-level hierarchy.

Parent WO field is 
blank.

PARENT column is null
WOCLASS field = 
WORKORDER

Parent � Any work order that has children or 
tasks associated with it.

NOTE: A work order can be both a parent and a 
child in a multi-level hierarchy.

Rows in the Child or 
Task table window on 
the Plans tab.

HASCHILDREN = Y

Child � A work order that has a parent. Parent WO field 
contains a value. 
When you move to the 
parent work order, work 
order appears in the 
Children table window.

Has value in the 
PARENT column

Task �   A step to be performed as part of a work 
order�s work plan. The lowest branch of the 
hierarchy structure. Tasks are also child work 
orders. 

NOTE: In previous Maximo releases Task work 
orders have been referred to as "operations" 
or "detail" work orders.

Parent WO field 
contains a value
When you move to the 
parent work order, work 
order appears in the 
Tasks table window.

Has value in the 
PARENT column
ISTASK = Y
WOCLASS field = 
ACTIVITY
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! The Parent WO field on the Work Order tab displays the parent work 
order. You can navigate to the parent work order by clicking the Detail 
Menu button next to the Parent WO field. If the work order is a top-level 
work order, or is not part of a hierarchy, this field will be blank. 

! The Children table window displays any child work orders associated with 
the work order. This table is collapsed by default.

! To open the Children table window click Show Table.
! To collapse the table window click Hide Table.

You can navigate to a child work order by clicking the Detail Menu 
button next to the Work Order field.

! The Tasks table window displays any task work orders associated with the 
current work order. You can navigate to a task work order by clicking the 
Detail Menu button next to the Work Order field in the row details.

Building a Work Order Hierarchy

To build a hierarchy you create the top level work order, then create or 
associate child work orders. For example, your company has decided to change 
to more energy efficient lighting, which requires replacing the lighting 
fixtures for the entire plant. You might create a work order for the entire 
project, and a child work order for each building location. Each child work 
order could have a work plan (tasks) detailing the steps at each location.This 
lets you track the costs of the work done at each building location and also 
keep a running total of costs for the entire project.

Work order hierarchies are created in a number of different ways. You can 
create a work order hierarchy using any of the following methods:

! creating children on the Plans tab via the New Row button on the 
Children table window

! associating existing work orders with a parent via the Select Work 
Orders button 

! associating existing work orders with a parent via the Assign to New 
Parent action 

! applying a route to a work order 

! generating a work order hierarchy from a PM hierarchy

! adding tasks to a work order on the Plans tab via the New Row button on 
the Tasks table window

! applying a job plan to a work order 

Adding Children to a Work Order

The Children table window on the Plans tab contains a subset of the work 
order fields, allowing you to create child work orders via the New Row 
button. Once created and saved, you can open each child work order 
individually to enter or modify values for work order fields not contained in 
the Children table window. For more information about moving between 
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parent and child work orders, see �Viewing and Navigating Work Order 
Hierarchies,� on page 14-35.

NOTE: If there is a Priority assigned to the parent work order, it is copied to 
child work orders created from within the Children table window.

You may want to build a hierarchy from existing work orders, for example to 
track costs on a project.   You can associate existing work orders as child work 
orders using the Select Work Orders button in the Children table window. 
You can also associate existing work orders with a hierarchy, or change the 
hierarchy association of a child or task work order using the Assign to New 
Parent action.

NOTE: If there is a Priority assigned to the parent work order, it is not copied 
to existing work orders that are associated with a hierarchy.

TIP: The Assign to New Parent action is available from the Results subtab, 
allowing you to select multiple work orders to be assigned to a parent.

Adding Tasks to a Work Order

You use the Task table window on the Plans tab to add Tasks to a work order. 
Each task also can be managed as a child work order, and Maximo assigns 
each task its own work order number. You can view the work order number 
for a task in the Work Order field in the Work Reference Information section.

You build a work order hierarchy when you add Tasks to a work order on the 
Plans tab as described in �Creating a Work Plan,� on page 14-32.

Applying a Route to a Work Order

You can apply a route to a work order or you can specify one on a PM. When 
you apply a route, the original work order is the parent, and the route stops 
are child work orders, which can have job plan tasks associated with them.

Generating a WO Hierarchy From a PM Hierarchy

PM hierarchies group assets or locations with the same PM schedules in 
parent-child relationships. When you generate work orders from a PM that is 
the part of a hierarchy, work orders are generated for the entire hierarchy. 
You generate PM work orders in the Preventive Maintenance application and 
can view the work orders in Work Order Tracking.

Status Changes and Hierarchy Records

Status changes for a work order hierarchy can be configured to meet the needs 
of your company. 

The Inherit Status Changes? check box on a work order record specifies 
whether the work order will inherit status changes from its parent work 
order. If the check box is selected (the default), the work order's status will 
change when the parent work order's status changes. 

You can change the status of the child work order manually using the 
Change Status button in the Children of Work Order table window. You can 
change the status of the task work order using the Change Status button in 
the Tasks for Work Order table window. However, if the child work order has 
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its Inherit Status Changes? check box selected, any subsequent changes to 
the parent's status will be applied to the child work order, if appropriate. 

Work Order Hierarchies vs. Related Records

By definition, every work order hierarchy has a single, top-level work order 
that is the parent for the entire hierarchy. Each work order in the hierarchy 
can have a single parent, but many children. A work order hierarchy can 
contain many levels.

In contrast, the associations that appear on the Related Records tab are non-
hierarchical. There are no restrictions to the number of relationships a work 
order can have. A work order can be related to many ticket and work order 
records. 

Associating Existing Records with a Work Order

The Related Records tab in the Work Order Tracking application functions the 
same as the Related Records tab in the Service Desk applications. For 
information about using the Related Records tab to relate tickets and work 
orders, see�Relating Other Records to a Ticket,� on page 12-8.

Entering Meter Readings

If an asset or location has meters associated with it, you can enter meter 
readings using the Enter Meter Readings action. The Enter Meter Readings 
dialog box displays all of the meters associated with the asset or location, and 
the reading and date of the last meter reading.

Downtime Reporting

When an asset is not running, the downtime is generally one of the following 
two types:

! planned downtime � the asset is scheduled to be down and available for 
maintenance work to take place.

! unplanned downtime � the asset goes down unexpectedly. 

Maximo lets you report both planned and unplanned downtime. Reducing 
unplanned downtime saves you money. To reduce costs caused by unplanned 
downtime, you can use Work Order Tracking to report downtime, then 
analyze downtime trends and take action to reduce unplanned downtime in 
the future, for example, by increasing your preventive maintenance schedule.

In order to report downtime, an Asset number must be specified on the work 
order. You report downtime using the Report Downtime action available 
from the Select Action menu. The Report Downtime action allows you to 
report asset downtime in two ways:

! Change Status � Use to record a single status change for an asset If you 
need to report downtime as it occurs, you change the asset�s operational 
status from Up to Down, or vice versa.

! Report Downtime � Use to record two status changes for an asset. If 
you need to report downtime after the work order is completed you would 
select this option to record 1) when the asset came down for repairs and 2) 
when it was returned to service.
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Types of Downtime

Maximo recognizes two types of downtime:

! Operational � occurs during a time when the asset normally would be in 
use and stops work or production. 

! Non-operational � occurs during a time that does not stop work or 
production, even though the asset is down. For example, if a production 
line is down during the night shift, but the line does not normally run 
during that shift.

Recording Actuals

You use the Actuals tab to enter, view, and modify data about the actual work 
order job tasks and usage of labor, materials, services, and tools. 

Each work order record contains an Accepts Charges? check box which 
specifies whether or not you can report actuals against the work order. If the 
check box is selected (the default), you can charge actuals against the work 
order. If the check box is cleared you cannot enter charges against the work 
order, but must report actuals against the work order�s parent work order.

A work order must be approved before you can record actuals against it. To 
report Actuals for labor, material, service, and tool usage, click the 
appropriate subtab. If the work plan did not estimate labor, materials, 
services, or tools, you can use the Select Labor, Select Materials, Select 
Tools, or the New Row button to add rows to the subtab�s table window. 

Maximo allows you to select multiple records from the work plan when 
recording actuals. The following buttons appear on the Actuals subtabs:

! Select Planned Labor � Appears on the Labor subtab. Click to select 
from a list of the labor requirements recorded on the Plans tab.

! Select Reserved Items � Appears on the Materials subtab. Click to 
select from a list of reserved inventory items.

CAUTION: If planned materials exist, they should be copied when recording 
actuals to ensure that material reservations in the Inventory 
application are reconciled.

! Select Asset Spare Parts � Appears on the Materials subtab. Click to 
select from a list of spare parts for the asset.

! Select Planned Tools � Appears on the Tools subtab. Click to select 
from a list of tool requirements recorded on the Plans tab.

! Select Issued Tools � Appears on the Tools subtab. Click to select from 
a list of tools that have been issued to work orders.

When you select multiple records, Maximo creates a separate row for each 
record on the appropriate subtab. You can then edit the values to reflect the 
actual labor, materials, or tools used on the work order.
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Removing a Work Plan

There may be instances where a work plan must be removed from a work 
order, for example

! A job plan was applied to a work order in error.
! Work plan information is incorrect and must be replaced with different 

information.

If the work order has not been approved, you can use the Remove Work 
Plan action to clear the Job Plan field and remove

! all planned tasks
! all planned labor
! all planned materials and associated hazards
! all planned services
! all planned tools

NOTE: You might need security authorization to perform this action.

CAUTION: This action removes the work plan immediately. 

Using the Logs

Work order records contain a Log tab, which allows you to create and view the 
Work Log and the Communications Log for a record. Both the Work Log and 
the Communications Log provide a means of communicating information 
about a work order.

Maintenance workers create the entries in the Work Log. Maximo makes the 
entries in the Communications Log, which is used to maintain a record of e-
mail communications created from the record via the Create 
Communication action.

Using the Work Log

You use the Work Log to record work-related information about a work order. 
You create an entry in the work log using the New Row button on the Work 
Log subtab. When you create a Work Log entry, you must specify a Type 
(Client Note, Update, or Work), and you can make the entry visible to the 
individuals listed in the Reported By and Affected Person fields by 
checking the Viewable? check box. 

NOTE: Once you have saved a Work Log entry it cannot be deleted.

Using the Communications Log

Entries in the Communications Log subtab are read-only. Maximo 
automatically creates entries in the Communications Log when you use the 
Create Communication action to create an e-mail message.

Failure Reporting

Failure reporting is a long-term process where you gather data about failures 
so that you can analyze trends and take steps to avoid problems in the future. 
For example, in looking back over the failure reports for a pump, you might 
notice that the pump often breaks down about one week before its monthly 
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preventative maintenance check is scheduled. You might decide to change the 
frequency of the PM checks to every other week, rather than every four weeks.

Failure data for assets and locations is recorded on their work orders. This 
failure data must belong to one or more failure hierarchies, which you create 
in the Failure Codes application. 

A failure hierarchy is an organized set of problems, causes, and remedies 
related to asset and location failures. The failure hierarchy is identified by its 
top-level component, called a failure class. There must be an associated 
failure class for each asset or location that you want to report failures for. This 
association is made in the Assets and Locations applications.

TIP: Indicating a Failure Class and Problem Code on a work order can help 
limit the number of duplicate work orders that are entered in the system. 
Maximo displays a message if the same problem code has already been 
entered for the asset or location.

Recording Failure Data

You report failures on the Failure Reporting tab, using failure hierarchies 
that were created in the Failure Codes application. You build the failure 
report by entering codes for a Problem, Cause, and Remedy for the failure. 

NOTE: You also can enter and view a Failure Class and Problem Code on 
the Work Order tab.

NOTE: If you encounter a Problem, Cause, or Remedy that are not listed in 
Maximo, use the Failure Codes application to add the data to the failure 
hierarchy, then return to Work Order Tracking to complete your failure 
reporting.

Conducting Failure Analysis

Failure analysis is how you examine asset failure history, reported over a 
significant period of time. You can create asset or location failure reports to 
look for breakdown trends, average time between failures, and so on. 

By correlating this failure information with other data available to you, for 
instance, preventive maintenance schedules for an asset or location, you can 
develop ways to reduce or limit asset failures in the future. For example, you 
might want to review your preventive maintenance schedule, or you might be 
able to identify a branch of faulty inventory items.

Work Order Statuses

For information about work order statuses see �Work Order Statuses,� on 
page 14-5.

Deleting a Work Order

If changes have been made to planned work you may find that you need to 
delete a work order, either because the work is no longer required, or because 
a child or task work order is not necessary for the project. Work orders can be 
deleted if they meet the following criteria:

! status is waiting approval (WAPPR) and the work order has never been 
approved (APPR) 
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! work order does not have child or task work orders 
! work order does not have assets moved against it
! work order is not a follow-up work order
! work order is not the top-level of a PM work order hierarchy 
! work order was not generated from the Purchasing module, for example a 

Receiving inspection work order
! work order is not listed on any material requisitions, purchase 

requisitions, or requests for quotation
! work order is not in Workflow and has never been in Workflow

Work orders that do not meet the deletion criteria can still have their status 
changed to cancelled (CAN).

To delete a task work order when viewing the parent work order, click the 
Mark Row for Delete icon in the Task table window for the task(s) you want 
to delete.

To delete a child work order when viewing the parent work order, Move To 
the child work order, then select Delete Work Order from the Select Action 
menu.

To delete a work order, select Delete Work Order from the Select Action 
menu.

CAUTION: The Delete Work Order action deletes the work order immediately. 

Work Order Tracking Reports

For information about the reports available with this application, refer to the 
Report Administration and Development Guide.



Maximo 6, 08/2006 A-1

You can use the following keyboard shortcuts to navigate the Maximo 
application pages.    

A Keyboard Shortcuts

Button Button Name or Action Keyboard Shortcut

General Navigation

Move from one interface element to the next. Tab key 

Select buttons, links, and menu options. Enter key

Select or clear a check box. Spacebar

Display field help for field in focus Alt + F1

Global Navigation Links

NOTE: The shortcut highlights the link, you must click the Enter key to activate it.

Bulletins Alt + B

Go To Alt + G

Reports Alt + R

Start Center Alt + C

Profile Alt + P

Sign Out Alt + S

Help Alt + H

Return Alt + R

Return with Value Alt + W

Toolbar Buttons

 or 
Insert New Record Ctrl + Alt + I

Save Record Ctrl + Alt + S

Clear changes Ctrl + Alt + C

Previous Record Ctrl + Alt + P
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Next Record Ctrl + Alt + N

Change Status Ctrl + Alt + A

Create KPI Ctrl + Alt + K

Application Specific Toolbar Buttons 

Assign Labor (Assignment Manager) Ctrl + Alt + L

Finish Assignment (Assignment Manager) Ctrl + Alt + F

Interrupt Assignment (Assignment Manager) Ctrl + Alt + U

Select Work Date (Assignment Manager) Ctrl + Alt + W

Start Assignment (Assignment Manager) Ctrl + Alt + T

Start Timer (Activities, Changes, Incidents, Problems, 
Releases, Service Requests)

Ctrl + Alt + B

Stop Timer (Activities, Changes, Incidents, Problems, 
Releases, Service Requests)

Ctrl + Alt + E

Table Windows

Next Row Ctrl + "

Previous Row Ctrl + #

 Filter Open/Close table window Filter Ctrl +  Z

Previous Page Ctrl +  <

Next Page Ctrl +  >

Date Fields

Insert today�s date Ctrl +  =

Move back one day Ctrl +  Minus Sign

Move forward one day Ctrl +  Plus Sign

Select Date Dialog Box

Next Month Ctrl + $

Previous Month Ctrl + %

Next Year Ctrl + #

Previous Year Ctrl + "

Button Button Name or Action Keyboard Shortcut
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This appendix documents Maximo�s self-service applications, which are 
designed to guide the occasional Maximo user through the registration and 
record creation process.

This appendix includes information about the following self-service processes:

! �User Self-Registration,� on page B-1
! �Service Requests Module,� on page B-3
! �Desktop Requisitions Module,� on page B-9

User Self-Registration

You need to have a user name and a password to allow you to sign into 
Maximo. Usually these are provided to you by your system administrator. If 
you do not have a user name and need to sign into Maximo to create a service 
request or a purchase requisition, you can register yourself using the register 
now link on the sign in page.

Maximo Sign In

To register yourself as a Maximo user, complete the following steps:

B Maximo�s Self-Service 
Applications
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1 Enter the Maximo URL provided by your company to display the Maximo 
sign in screen.

2 Click register now.

The User Self Registration page appears.

User Self Registration Screen

3 Fill in the required fields. An asterisk (*) indicates a required field.

4 Fill in additional fields as needed.

5 Make a note of the User ID and Password that you entered.

NOTE: Your User ID and Password are case sensitive.

6 Click Submit.

Your registration is submitted. You will receive e-mail notification when 
your Maximo registration is approved. 

Maximo�s Self-Service Applications

The Self Service module contains two modules designed for the self-service 
user:

! Service Requests
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! Search Solutions
! Create Service Requests
! View Service Requests

! Desktop Requisitions
! Create Requisition
! View Requisitions
! View Templates
! View Drafts

Service Requests Module

Maximo�s software suite can be configured to meet the needs of a variety of 
different businesses, including:

! Production (manufacturing and utilities)
! Hotels, universities, and other facilities
! Buses, trains, aircraft, and other fleet vehicles
! Information technology (IT) assets and services

Some businesses may use the Service Requests module solely as a means to 
log maintenance requests, while others will expect you to search the solution 
library for answers to frequently asked questions (FAQs) and other 
information that might help you solve your problem without submitting a 
service request.

You can create and submit service requests using the Create Service Request 
application.

Viewing Bulletin Board Messages

Maximo�s Bulletin Board allows users with the appropriate security 
permissions to send broadcast messages to all Maximo users. Messages can be 
routed to all users, or just selected Organizations, Sites, or person groups. 

Before entering a service request, you should check the bulletin board to see if 
there are any messages relevant to your problem. For example, a bulletin 
board message that the telephone system is down for repairs would mean that 
you probably do not need to log a service request for your telephone because 
the problem has already been reported as affecting multiple users.

TIP: The number after the Bulletins link indicates the current number of 
bulletin board messages.

To view bulletin board messages from any application page, complete the 
following steps:

1 Click the Bulletins link at the top of the application page.

The Bulletin Board appears displaying a list of messages.

2 To view the entire text of a message, click the message.

The bulletin board expands to display the entire message.
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3 To read a different message, click the message.

4 To close the bulletin board click OK.

About Solutions

Maximo�s Solutions application allows the creation of a library of documents 
that contains the resolutions to common problems. Before creating a service 
request you should use the Search Solutions application to see if the solution 
to your problem is already documented.

Searching for Solutions

You can search for solutions using two different methods:

! Keyword � Enter keywords in the Solution Description field to search 
all text fields on a solution record (Description, Symptom, Cause, and 
Resolution).

! Classifications � Drilldown through the Classifications structure to find 
all solutions related to a particular category of problems, for example 
computer hardware or software.

To use keywords to search for solutions, complete the following steps:

1 In the Service Desk Actions portlet window, click the Search Solutions 
link.

The Search Solutions application appears. 

2 Enter a keyword in the Solution Description field, for example to search 
for records relating to a computer error message enter the word "error."

3 Click Find.

Solutions matching your search are displayed in the View Solutions table 
window.

4 To view a solution, click the underlined Solution ID in the View Solutions 
table window.

To use Classifications to search for solutions, complete the following steps:

1 In the Service Desk Actions portlet window, click the Search Solutions 
link.

The Search Solutions application appears. 

2 Next to the Classification field, click the Detail Menu button and select 
Select Classification.

The Classify dialog box appears.
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3 Drill down through the Classification to find the category you are looking 
for, for example: 

1: End User Issues > 101: Hardware > 10104: Printer > 1010401: Cannot 
Print

4 Click the Select Record button next to the category to return the value.

Maximo copies the Classification and Description to the Search 
Solutions page.

5 Click Find.

Solutions matching your search are displayed in the View Solutions table 
window.

6 To view a solution, click the underlined Solution ID in the View Solutions 
table window.

About Service Requests

A service request is a request for work of some kind, for example repair of a 
piece of equipment, or configuration of a computer. A service request can also 
be a request for information, for example how to perform a particular task.

If after searching solutions as described in �Searching for Solutions,� on 
page B-4 you fail to find the solution to your problem you can use the Create 
Service Request application to create a service request. 
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Self-Service Service Requests and Maximo

The self-service Create Service Request application creates a ticket record 
that can be viewed by a service desk agent using the Service Request 
application in the Service Desk module.

Creating a Service Request

There are three ways that you can create a service request:

! From the Search Solutions application
! From the Create Service Request application
! From an e-mail 

NOTE: As a best practice, before creating a service request for an information 
technology issue, you should first search the solutions library. If you are 
creating a service request for maintenance, you may not need to perform 
this step.

Creating a Service Request from Search Solutions

To create a service request from the Search Solutions application, complete 
the following steps:

1 Search for a solution to your problem using the Search Solutions 
application.

2 If you cannot find a solution to your problem, click the No-Create a 
Service Request button at the bottom of the page.

The Create Service Request page appears. Information contained in your 
user profile may be copied to the record automatically.

3 Enter a description of the service request in the Summary and Details 
fields.

4 If appropriate, enter a Classification for the service request by clicking 
the Detail Menu button to select an option from the menu and retrieve a 
classification value.

5 If appropriate, click Attach File or Attach Web Page to attach 
documents outside of Maximo to the service request, for example to attach 
a screen capture of an error message.

6 Click Submit.

A dialog box appears displaying the number of your service request. 
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7 Click one of the following:

! View Details � to view the details of the service request you just 
created.

! Return to Start Center � to return to your start center.
! Create Another Service Request � to return to the Create Service 

Request application.

Creating a Service Request from Create Service Requests

To create a service request from the Create Service Request application, 
complete the following steps:

1 Click the Create Service Request link in either the Service Desk Actions 
portlet or from the Go To menu.

The Create Service Request page appears. Information contained in your 
user profile may be copied to the record automatically.

2 Enter a description of the service request in the Summary and Details 
fields.

3 If appropriate, enter a Classification for the service request by clicking 
the Detail Menu button to select an option from the menu and retrieve a 
classification value.

4 If appropriate, click Attach File or Attach Web Page to attach 
documents outside of Maximo to the service request.

5 Click Submit.

A dialog box appears displaying the number of your service request. 

6 Click one of the following:
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! View Details � to view the details of the service request you just 
created.

! Return to Start Center � to return to your start center.
! Create Another Service Request � to return to the Create Service 

Request application.

Creating a Service Request from an E-mail

Maximo can be configured to create service requests automatically from 
information included in an e-mail message. Your service desk should provide 
you with instructions on where to send e-mail service requests and what 
information to include in the e-mail.

Viewing Service Requests

You can use the View Service Request application to view service requests 
that you have entered, service requests for assets where you are listed as an 
Owner or a Custodian, and service requests where you are listed as the 
Affected User.

To view a service requests, select one of the following choices: 

! click the View Service Requests link in the Service Desk Actions portlet 
window on your Start Center

! select Service Requests > View Service Requests from the Go To menu
! click the View Details button in the dialog box after you have created a 

service request

Searching for Service Requests

To search for a service request in the View Service Requests application, 
complete the following steps:

1 Click View Service Requests.

The View Service Requests application appears displaying your service 
requests.

2 If necessary, enter values in one or more search fields.

3 Click Find.

Service requests matching your criteria are displayed in the View Service 
Requests table window.

4 To view a service request, click the underlined Service Request ID in the 
View Service Requests table window.

Modifying Service Requests

Once you have submitted a service request you cannot modify it. You can 
however add attachments and make notations in the Log. For example, if 
there is an entry in the Log from a Service Desk agent requesting more 
information, you can reply by adding a log entry of your own. Updates that 
you add to the Log are visible to Service Desk agents as CLIENTNOTE 
entries in the Work Log.
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To add an attachment to a service request, complete the following steps:

1 Open a service request record.

2 Select one of the following options:

! Attach File � to attach a document to the record.

! Attach Web Page � to attach a Web page to the record.

3 Click OK.

The new attachment appears in the Attachments table window.

To make a notation in the Log, complete the following steps:

1 Open a service request record.

2 Click Update Service Request.

The Update Service Request Log dialog box appears.

3 Enter a description of the update in the Summary and Details fields.

4 Click OK.

The log update appears in the Log table window.

Deleting Service Requests

Self-service users cannot delete a service request once it has been submitted. 

For information about deletion rules for service requests, see �Deleting 
Tickets,� on page 12-13. For additional information about record deletion 
rules, refer to the Maximo System Administrator�s Guide.

Desktop Requisitions Module

Maximo�s Desktop Requisitions module is a self-service module designed to be 
used by both novice and experienced Maximo users to create purchase 
requisitions. A requisition is a written request for something that needs to 
be purchased. Desktop Requisitions allows you to requisition 

! Items
! Materials
! Services
! Standard Service 
! Tools

from either an internal source, such as a company storeroom, or from an 
external vendor.

Using Desktop Requisitions you can also:

! create template requisitions for repeat orders
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! create a list of favorite items that you order frequently
! view open, draft, and template requisitions
! check the status of your order

Desktop Requisitions and Maximo's Purchasing Module

Requisitions created in Desktop Requisitions use the same business logic as 
Maximo�s automatic inventory reordering process. This means that your 
system administrator can configure Maximo to automatically create new 
external requests (for purchases from an outside vendor) as any one of the 
following:

! Unapproved purchase requisitions (PRs) 
! Approved purchase requisitions (PRs)
! Unapproved purchase orders (POs)
! Approved purchase orders (POs)

Your system administrator can also configure Maximo to automatically create 
new internal requests (for example requesting items from a central storeroom) 
as any one of the following:

! Unapproved purchase requisitions (PRs)
! Approved purchase requisitions (PRs)
! Unapproved purchase orders (POs)
! Approved purchase orders (POs) 

Once a desktop requisition has been converted to a new PR or PO, it can be 
viewed in either the Purchase Requisitions or the Purchase Orders 
application in the Purchasing Module.

Desktop Requisition Buttons

The following table lists application specific buttons that appear in the 
Desktop Requisitions applications. 

Icon Name Function Location

Add to Favorites Add the row to your favorite 
items list.

! Create Requisition application
! View Requisitions application

Create/Edit 
Requisition

Opens the selected draft in the 
Create Requisition application.

! View Drafts application

Create Requisition Create a requisition from the 
current template.

! View Templates application

Create Template Create a template requisition 
from the selected record.

! View Requisitions application

Delete Row Delete the selected row from the 
requisition.

! Create Requisition application
! View Drafts application

Distribute Cost Distribute the cost of the line 
item to more than one GL Debit 
Account.

! Create Requisition application
! View Requisitions application
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Creating a Requisition

You use the Create Requisition application to create new desktop requisitions. 
When you create a requisition Maximo may enter values in some of the fields, 
for example the Requested By field. 

NOTE: These values are copied from your person record. If you have security 
permissions to do so, you can edit information stored in your person 
record using the Profile link in the navigation links.

Creating a requisition is a three step process. 

! Step one � Enter shipping and charge information for the requisition.

! Step two � Enter a line item for each different item, material, service, or 
tool that you are requesting.

! Step three - Review the entire requisition before submitting it.

TIP: If you need to interrupt the requisition creation process you can click 
Save As Draft and your work will be saved as a draft requisition that you 
can return to at a later time. 

To create a desktop requisition, complete the following steps:

1 Click Create Requisition.

The Create Requisition application appears.

2 You can accept the automatically generated Requisition number, or 
enter a different value.

3 Enter a description in the requisition Description field. To enter 
additional information, click Long Description.

4 If appropriate, enter the Date Required.

5 The Requested By field defaults to your person ID. If you are creating a 
requisition for another person, enter a value in the Requested For field.

6 The default Priority of 0 is the lowest priority. You can enter a higher 
priority number. We suggest using a range of 0 to 9, with 9 the highest 
priority.

Step 1 - Shipping and 
Charge information

7 If necessary, enter or edit the values in the Shipping Information section. 
By default Maximo copies these values from your person record.

Print View Print the current record. ! View Drafts
! View Requisitions
! View Templates

Search Return to the application Search 
page.

! View Drafts
! View Requisitions
! View Templates

Icon Name Function Location
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8 If necessary, enter or edit the values in the Charge Information section. By 
default Maximo copies these values from your person record.

9 Click Continue.

Step 2 - Requisition lines 10 Enter a line item for each different item, material, service, or tool that you 
are requesting by selecting one of the following options:

! Click New Row to add a new requisitions line.

! Click Add Line Item and select from the menu to add a new 
requisition line using one of the following options: 

! Select Materials to select from a list of materials.

! Favorite Items to select from a list of favorite items you have 
created using the Add to Favorites button.

! Spare Parts to search for an asset record and select spare parts 
from those listed on the asset record.

! Existing Requisitions to copy line items from existing 
requisitions and templates that you have created. 

NOTE: Draft requisitions are not available from this action.

! Supplier Catalog(s) to select line items from vendor�s e-commerce 
catalogs.

11 Click Continue.

Review and Submit 12 Review the requisition. If you need to edit the requisition you can use the 
Back button to return to the previous steps.

13 Click Submit.

The Requisitions Submitted dialog box appears.

14 Click one of the following:

! View Details � to view the details of the requisition you just created.
! Return to Start Center � to return to your start center.
! Create Another Service Request � to return to the Create 

Requisition application.
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Creating Requisition Templates

You can use the View Requisitions application to create template requisitions 
for orders that you place frequently.

You can create a template requisition in one of two ways:

! From the Requisitions table window, click the Create Template icon.

! From the Details tab of a requisition, click the Create Template button.

Once you have created a template requisition, you can view it in the View 
Requisitions application.

Creating Requisitions Using Templates

You can create a new requisition from a template in one of the following ways:

! From the View Templates application, click the Create Requisition icon 
for the requisition in the Template Requisitions table window.

! From the details of a Template in the View Templates application, click 
the Copy to New Requisition button.

! In the Create Requisition application, enter a value in the Template field.

Saving Draft Requisitions

If you need to interrupt the requisition creation process you can click Save As 
Draft and your work will be saved as a draft requisition that you can return 
to at a later time. 

You can view and modify any requisitions you have saved as drafts by clicking 
the View Drafts link.

Viewing Requisitions

To view requisitions, select one of the following choices:

! click View Requisitions on your Start Center
! select Desktop Requisitions > View Requisitions from the Go To menu
! click View Details in the Requisition Submitted dialog box after you have 

created a requisition

Searching for Requisitions

To search for a requisition, complete the following steps:

1 Click View Requisitions.

The View Requisitions application appears displaying your requisitions.

NOTE: It may be necessary to click the Filter Table button to view your 
requisitions.

2 If necessary, enter values in one or more search fields.
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3 Click Find.

Requisitions matching your criteria are displayed in the Requisitions table 
window.

4 To view a requisition, click the underlined Requisition ID in the 
Requisitions table window.

Modifying or Deleting Requisitions

Once a requisition has been submitted it cannot be modified or deleted via the 
applications in the Desktop Requisitions module. For information about 
deleting purchase requisitions or purchase orders, see Chapter 9, "The 
Purchasing Module," on page 9-1.

Requisition Statuses

A desktop requisition record can have one of the following statuses:

! WAPPR � Waiting on Approval

! APPR � Approved

! CAN � Canceled

! CLOSE � Closed
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Asset management involves the management of your assets from 
requisitioning, through delivery, installation and configuration, servicing and 
maintenance over the life of the asset, to finally decommissioning and 
returning or disposing of the asset. 

Information technology (IT) assets include computer hardware and software 
that is connected to a network, as well as wireless and remote devices, such as 
laptop computers, personal digital assistants (PDAs), wireless telephones, and 
pagers. Because IT assets are configurable, are often moved as needed, and 
are frequently leased rather than purchased, the management of IT assets 
has some differences from general asset management as discussed in 
�Managing Asset Records,� on page 3-14.

Each company has different business needs, and therefore will have different 
IT asset management processes. This appendix provides additional 
information specific to IT asset management, and describes how you can use 
Maximo to implement some of the more common IT asset management 
processes.

IT Asset Terminology and Maximo

There is specific terminology that is often used when discussing information 
technology assets. Because Maximo can be used to manage many kinds of 
assets, not just IT assets, the terminology used throughout Maximo to label 
fields and actions is often generic.

The following are some common terms used when discussing IT assets, and 
the equivalent term that is used in Maximo. For example, what the 
Information Technology Infrastructure Library (ITIL) calls a "configuration 
item" is not called an "item" in Maximo but an "asset." Maximo reserves the 
term "item" for materials management in the Inventory applications.    

C IT Asset Life Cycle 
Management

Information Technology Term Maximo Equivalent

asset repository physical repository = storeroom or 
operating location
data repository = specification

component any part of an asset hierarchy 
(asset, subassembly, or spare part)

configuration item asset record, rotating asset record, 
IT asset record ("Item" refers to 
materials management in Maximo.)
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Information Technology (IT) Asset Records

When creating records in Maximo, the different elements of your company�s IT 
infrastructure can fall into one of two categories:

! Assets � An asset can be a piece of equipment or machinery, or a 
subassembly or component of an asset, or a piece of technology, for 
example computer software. Any leased asset should have an asset record. 
Any asset that requires a maintenance history or serialization should have 
an asset record. 

! Items � An item can be any consumable item, material, or spare part. 
Any item that is going to be requisitioned on a regular basis should have 
an item record. Any item that is going to be stocked in a company 
storeroom should have an item record. Machinery or technology that is so 
inexpensive that your company has decided that it will be replaced rather 
than repaired when it malfunctions might also be categorized as an item 
rather than as an asset.

NOTE: In this context an item record refers to a non-rotating inventory item 
record. For information about rotating item records and IT assets, 
see �Creating Rotating Item Records,� on page C-6.

configuration template item assembly structure

discovery tool Maximo Discovery or other third 
party network device interrogator.

inventory management (computer) asset management ("Inventory 
management" refers to consumable 
items in Maximo.)

knowledge base Solutions application

maintenance contracts service contracts, warranty 
contracts

network asset hierarchy (Note that the term 
"network" is also used when 
referring to location systems in 
Maximo.)

seat workstation or software license

software license contract item (Software licenses can 
be tracked as an item record or asset 
record, depending on your business 
needs.)

system asset hierarchy, bundled asset (The 
term "system" refers to location 
systems in Maximo.)

technology refresh release

vendor company record

Information Technology Term Maximo Equivalent



Appendix C: IT Asset Life Cycle Management

Maximo 6, 08/2006 C-3

The following table gives some examples of how one might categorize a variety 
of IT assets. Your company�s business needs, including the sort of data you 
need to track for individual assets, will determine how your company 
categorizes the elements of your information technology infrastructure. For 
example, software licenses can be tracked as items on a software license 
contract, or you can also create asset records for individual licenses. 

NOTE: You create item records for all of the elements of your information 
technology infrastructure to use with contracts and purchasing.    

IT Assets and Classifications

Maximo includes a feature called Classifications which can be used to 
organize and categorize Maximo records. Maximo�s IT Asset reconciliation 
process uses the value in the Classification field when it matches asset 
records to deployed asset records. IT assets must have a IT Classification for 
reconciliation purposes. This Classification is designated on the rotating 
item record, created in the Item Master application. When you list a Rotating 
Item on an asset record, Maximo automatically copies the item�s 
Classification to the asset record. 

Your system administrator can create one or more different classification 
hierarchies using the Classifications application. MRO Software recommends 
that you base your classifications for information technology assets on the 
United Nations Standard Product and Services Classification (UNSPC) codes. 

IT Assets and Contracts

Because IT assets are often leased rather than owned, Maximo includes 
extensive contract functionality to support the leasing of IT assets. For more 
information about contracts, see Chapter 4, "The Contracts Module," on page 
4-1.

Possible Serialized Assets Possible Consumable or Contract 
Items

Central Processing Units (CPUs)
Cell phones
Computer Monitors
Desktop Workstations 
Disk drives
Ethernet cards
Hubs
Laptop computers
Mainframes and other servers
Modems
Network printers/ local printers
Pagers
Personal Digital Assistants (PDAs)
Routers
Scanners
Servers 
Switches

Antivirus software
Cables and connectors
CD media
Docking stations
E-mail software
Floppy diskettes
Inexpensive software
Install mounts and brackets
Keyboards
Mouse devices
Networking software
Office software
Printer/copier paper
Security software
Server racks
Server software
Toner cartridges
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IT Assets and Lease/Rental Contracts

Both lease and rental type contracts are created using the Lease/Rental 
Contracts application. When you requisition items that are listed on a valid 
purchase contract, Maximo automatically copies the Contract Reference to 
the purchasing record. If more than one valid contract exists for an item, 
Maximo asks you to select which contract to use.

When you create asset records in the Receiving application for items that have 
a Contract Reference, Maximo automatically associates the new asset 
records with the lease or rental contract. You can view the asset records on the 
Associated Assets tab of the Lease/Rental Contracts application. For more 
information about creating IT asset records in the Receiving application see 
�Receiving Rotating Assets,� on page C-7.

IT Assets and Service/Warranty Contracts

Both service and warranty type contracts are created using the Warranty 
Contracts application. You use the Associated Assets tab in the Warranty 
Contracts application to list the assets that are covered by the service or 
warranty contract, the Start Date for the contract, and any meters that 
might be associated with the contract, for example you might create a meter to 
track server failures.

IT Assets and Software License Contracts

Computer software is purchased using a PRICE, BLANKET, or PURCHASE 
type contract, and payment information is recorded on the purchase contract, 
not the license contract. Usually, software is licensed, not sold, meaning that 
you have to follow the terms of the license agreement which defines how you 
may use the software. 

You create software license (SWLICENSE) contracts to record the details of 
the software license, not a software purchase. Software license type contracts 
are created using the Purchase Contracts application. A software licence 
contract records the terms of a software license, for example whether you can 
make copies of the software, or the number of users allowed to use the 
software. A user is an individual or a device that is logged into a system and/
or is using the software 

For more information about managing software licenses, see �Managing 
Software Licenses,� on page C-18.

IT Assets and Job Plans

You can use the Job Plans application to create templates that include a 
detailed description of work to be performed, and labor, material, service, and 
tool requirements. Job plans can be created for assets, items, and locations, 
and can be used in the Activities, Changes, Releases, and Work Order 
Tracking applications.

You can use the Job Plans application to create job plans for rotating item 
records. If you select the Create WO When Purchasing This Rotating 
Asset? check box for the item in the Work Assets and Safety Plans table 
window, Maximo will automatically generate a work order when the specified 
item is received in the Receiving application. You can use this feature to 
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create job plans and generate work orders for installing and configuring IT 
assets. 

IT Assets and Locations

IT assets are always associated with a location. You should note that in 
Maximo a labor type location is considered an inventory location, used when 
inventory is issued to a worker. Assets should be associated with operating 
type locations.   You can use the Domains application in the Configuration 
module to create synonyms for operating type locations. For example, you 
might create a "user" location to be used with individuals, and "office" or 
"mobile" location types to be used with teams or departments.

If you are creating locations that will be used to store IT assets, for example a 
hardware cage or a software storeroom, you may want to consider whether 
you want to create some locations with a Type = OPERATING. The Move/
Modify Assets and Swap Assets actions only allow you to move assets 
between operating locations. You must use one of the inventory applications to 
move assets out of an inventory type location into an operating location before 
you can use the Move/Modify Assets and Swap Assets actions. For more 
information about location types, see �Location Types,� on page 3-26.

IT Assets and Purchasing

Maximo includes two different applications that can be used to requisition IT 
assets:

! Desktop Requisitions � used by self-service users to create material 
requisitions. If desired, you can create a Workflow process to convert 
material requisitions to purchase requisitions or purchase orders.

! Purchase Requisitions � used by purchasing departments to create 
purchase requisitions, which can be converted to purchase orders.

When a purchasing agent create a purchase requisition or purchase order for 
an item, Maximo automatically matches the vendor and item to valid 
purchase contracts. If you do not list a vendor on a PO, or there are multiple 
valid contracts, Maximo displays all valid contracts for the item.

When you receive assets that list a lease contract as the Contract 
Reference, Maximo automatically lists the asset records on the Associated 
Assets tab of the lease contact.

For information about creating IT asset records in the Receiving application 
see �Receiving Rotating Assets,� on page C-7.

Creating IT Asset Records

When you create asset records for IT assets they are always rotating asset 
records, that is, they include a Rotating Item value on the record. In Maximo 
you can track rotating assets by their common item number in the Inventory 
application, and by individual asset number in the Assets application. This 
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flexibility allows you to track IT assets as they move in and out of storage or 
repair areas during the asset�s life cycle.

NOTE: The term rotating item is used when referring to inventory records and 
management, and the term rotating asset is used when referring to 
asset records and maintenance.

Creating Rotating Item Records

The first step in creating an IT asset record occurs when you create rotating 
item records in the Item Master application. These rotating item records will 
be used when you create asset records, and when requisitioning and 
purchasing assets. For more information about creating item records, see 
�Creating Item Master Records,� on page 6-24.

NOTE: You should create item records before you begin procurement/
purchasing of IT assets. 

When creating item records that will be used for IT assets, the following fields 
are required:

! Rotating? check box must be selected.

! Classification field must contain a value that falls under the parent IT 
classification. MRO Software recommends that you base your 
classifications for information technology assets on the United Nations 
Standard Product and Services Classification (UNSPC) codes. Maximo 
copies Specifications and Attributes values from the classification 
record to the item record.

When creating item records that will be used for IT assets, the following fields 
are recommended:

! Commodity Group or Commodity Code field should contain a value if 
your company tracks expenditures by commodity.

! Capitalized? check box should be selected if the item is a capitalized 
expense. Capitalized items are always issued and returned at zero cost, 
regardless of the cost carried in inventory. Non-capitalized items are 
issued and returned at the standard or average cost, based on settings in 
the Organizations application.

! Inspect on Receipt? check box should be selected if you want to require 
inspection of the item upon receipt.

You use the Item Assembly Structure tab to create the item assembly 
structure for the item record, which includes a list of rotating items and non-
rotating items that make up the item. You can use the item assembly 
structure to create a configuration template that you can use when creating IT 
asset records.

For example, if you are creating an item record for the top-level item in a 
computer workstation, you would use the Item Assembly Structure tab to list 
all of the hardware and software components that are included in the 
workstation. This workstation might consist of a central processing unit 
(CPU), a compact disc (CD) drive, a monitor, keyboard, a mouse, operating 
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system and other OEM software. You would list all of the components that are 
delivered with the asset on the Item Assembly Structure tab. You would not 
include software that would be added later by your IT department and 
managed via a software license contract.

Creating Rotating Asset Records

The second step in creating an IT asset record is to create the asset record in 
the Assets application. Maximo automatically copies the Classification, 
Specifications and Attributes from the item record to the asset record. For 
more information about creating asset records, see �Creating Asset Records,� 
on page 3-11.

NOTE: You can also create asset records in the Receiving application. The 
procedure for this is described in �Receiving Rotating Assets,� on 
page C-7.

When creating asset records for IT assets, the following field is required:

! Rotating Item � IT assets are always rotating assets. 

NOTE: Once you save an asset record the Rotating Item field becomes 
read-only. To change the Rotating Item listed on an asset record, 
use the Change Item Number action.

When creating asset records for IT assets, the following fields are 
recommended:

! Type � Enter a value if you are using Maximo to track multiple asset 
types and you want to be able to filter records by asset type.

! Maintain Hierarchy? check box should be checked if you want to 
"bundle" assets and maintain the asset hierarchy when assets are moved. 

NOTE: When you want to modify the asset hierarchy for bundled assets you 
need to clear the Maintain Hierarchy? check box.

! Serial # � Can be used to record the serial number or service tag for an 
IT asset.

You use the Apply Item Assembly Structure action in the Assets 
application to copy the item assembly structure from the item record to the 
asset record. Maximo copies the rotating items to the Subassemblies table 
window, and the non-rotating items to the Spare Parts table window. If a 
rotating item in the item assembly structure has children, the children are 
also copied to the asset hierarchy. Once you have copied the item assembly 
structure to the asset record, you can add, modify, or delete elements without 
affecting the original IAS listed on the item record.

Receiving Rotating Assets 

You can also create IT asset records in the Receiving application when you 
receive ordered items.
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To create IT asset records in the Receiving application, complete the following 
steps:

1 Open the Receiving application.

2 On the List tab, select a PO with a status of Approved (APPR) or In 
Progress (INPRG). 

3 On the Materials Receipts tab, click Select Ordered Items. Maximo 
opens the Select Ordered Items dialog box and displays the items ordered 
on this purchase order.

4 Click the Select Record check box for each line you want to receive, or 
click the Select All Records check box in the table header to select all of 
the items.

5 Click OK. Maximo copies the items to the Materials Receipts tab. 

6 Click Save. 

7 If necessary, inspect the items. Items require inspection if the Inspect on 
Receipt? check box on the item record is selected, or if the Inspection 
Required? check box is selected on the PO line for the item. Maximo 
receives items that require inspection into a Holding location, and assigns 
them a status of Waiting for Inspection (WINSP). Rotating items that do 
not require inspection are received into a Holding location with a status of 
Waiting for Serialization (WASSET).

a Select Change Inspection Status from the Select Action menu. 
Maximo opens the Change Inspection Status dialog box.

b Click the Select Record check box for each line you want to inspect, 
or click the Select All Records check box in the table header to select 
all of the items.

c If appropriate, edit the Quantity Accepted and Reject Quantity 
fields and add Reject Codes, for example "damaged".

d Click OK. Maximo closes the Change Inspection Status dialog box and 
changes the status of the rotating items to Waiting for Serialization 
(WASSET). 

8 From the Select Action menu, select Receive Rotating Items. Maximo 
opens the Receive Rotating Items dialog box.

9 To specify the asset identifier for each item you can either:

! Enter a value in the Asset field for each row.

! Click Autonumber to have Maximo generate asset numbers.

10 You can use the Serial # column to enter serial numbers for each asset, or 
you can enter this information in the Assets application.

11  If appropriate, click the Apply IAS icon on the item row. Maximo opens 
the Apply Item Assembly Structure dialog box.
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a To specify the asset identifier for each item in the table window you 
can either:

! Enter a value in the Asset field for each row.

! Click Autonumber to have Maximo generate asset numbers.

b If appropriate, enter a GL Account and a Rotating Suspense 
Account for each row.

c Click OK. Maximo closes the Apply Item Assembly Structure dialog 
box.

12 Click OK. Maximo closes the Receive Rotating Items dialog box.

13 Click Save. Maximo automatically transfers the item from the Holding 
location to the Asset, Location, Storeroom, or Work Order specified on 
the purchase order.

NOTE: When creating asset records in the Receiving application, you should be 
aware of the following:

! The Type field on asset records created in the Receiving 
application does not contain a value.

! The Status of asset records created in the Receiving application is 
NOT READY. You must use the Change Status action in the 
Assets application to change an asset�s status to OPERATING.

! You cannot enter serial numbers for assets created via the Apply 
IAS action in the Receiving application. You can add serial 
numbers to these asset records in the Assets application.

Managing IT Asset Records

This section describes how you can use Maximo to help you manage your 
information technology assets, which can include both hardware and software 
assets. For additional information about how you can use Maximo to manage 
software licenses, see �Managing Software Licenses,� on page C-18.

Install, Move, Add, Change (IMAC)

Hardware and software installations, moves, additions, and changes are all 
common activities related to IT assets, for example when employees are hired, 
change positions, or leave the company. IT departments often use the acronym 
IMAC (Installation, Move, Add, Change) to describe the movement of 
components through an organization.

! Install - installing new hardware, software, printers and so on (including 
configuration), for example when a new employee is hired.

! Move - physical relocation of hardware, for example when an employee is 
transferred from one building to another.
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! Add - installation of new hardware and software, for example when an 
employee needs additional memory or new software.

! Change - upgrading existing hardware and software, reconfiguring 
existing hardware or software, and physically moving and redeploying 
hardware or software.

The IMAC process your company uses will vary, based on the needs of your 
business. The following sections describe some of the ways that Maximo can 
be used when performing common IMAC activities.

Installing IT Assets

Installing a new IT asset might include one or more of the following tasks:

! Inspection of the asset upon receipt � Items require inspection if the 
Inspect on Receipt? check box on the item record is selected, or if the 
Inspection Required? check box is selected on the PO line for the item. 
Maximo receives items that require inspection into a Holding location, and 
assigns them a status of Waiting for Inspection (WINSP).

! Creation of asset records � IT asset records can be created using the 
Assets application, or when assets are received, as described in �Receiving 
Rotating Assets,� on page C-7. 

! Installation of hardware or software � You can use the Job Plans 
application to create job plans for installations. Job plans can be used in 
the Activities, Changes, Releases, and Work Order Tracking applications.

! Configuration of the asset � You can use the Apply Item Assembly 
Structure action in the Assets application to copy an item assembly 
structure from the item record to the asset record. You can use the Job 
Plans application to create job plans for hardware and software 
configurations.

! Association of the asset with a service group or service � You use the 
Associate Services action in the Assets application to associate an asset 
with a service group or a service.

! Association of the asset with a Service Level Agreement � You use the 
Associated Assets tab in the Service Level Agreements application to list 
assets, asset types, and locations on an SLA.

! Association of the asset with a service or warranty contract � You use the 
Associated Asset tab in the Warranty Contracts application to list assets 
and locations on a service or warranty contract.

! Association of a software asset with a software license contract � When 
you list a software license contract as the Contract Reference on a 
purchase order, Maximo automatically lists the contract on the asset 
record. 

! Changing the asset status to OPERATING � You use the Change Status 
action in the Assets application to change the status of an asset record 
from NOT READY to OPERATING. For more information about asset 
statuses, see �Asset Statuses,� on page 3-15.

TIP: You can change the status of multiple asset records from the List tab.
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! Issuing an asset to an individual � You can use the Associate Users and 
Custodians action in the Assets application to list one or more 
individuals as a user or custodian of an asset.

TIP: You can use the Job Plans application to create job plans for rotating item 
records. If you select the Create WO When Purchasing This Rotating 
Asset? check box for the item in the Work Assets and Safety Plans table 
window, Maximo will automatically generate a work order when the item 
specified on the job plan is received in the Receiving application. You can 
use this feature to create job plans and generate work orders for installing 
and configuring IT assets. 

Moving IT Assets

Moving an IT asset refers to the physical relocation of hardware, for example 
moving computers, printers, or servers. For example, most computers move 
several times during their lifecycle due to repairs, redeployments, exchanges, 
transfers, or the disposal of the computer.

You use the Issue Current Item action in the Inventory application to move 
an asset (rotating item) from a storeroom location to another asset (as a 
subassembly or component of the asset), operating location, or an individual. 
Items can also be issued to and charged against a work order or General 
Ledger account.

If the Attach to Parent Asset on Issue? check box is selected on a rotating 
item record, when the item is issued to an asset Maximo automatically 
attaches the rotating item to the asset as a subassembly (child asset).

NOTE: Maximo also performs the same action if the rotating item is issued to a 
work order for an asset.

You use the Issues and Transfers application to issue or transfer an asset 
(rotating item) from a storeroom location to an asset, operating location, or an 
individual. Items can also be issued or transferred to and charged against a 
work order or General Ledger account.

You use the Move/Modify Asset action available in the Activities, Changes, 
and Releases applications to plan a move or modification for one or more 
assets. You can move an asset to a new location, to a new parent (new location 
in the asset hierarchy), or to a new bin in a storeroom. You can modify the 
attributes for an asset, for example a computer that was purchased with 
additional memory.

You use the Move/Modify Assets action available in the Assets, Purchase 
Orders, and Work Order Tracking applications to make a move or 
modification to one or more assets. You can move an asset to a new location 
(including a different Site), to a new parent (new location in the asset 
hierarchy), or to a new bin in a storeroom. You can add, modify, or delete users 
and custodians listed on an asset record. You can modify the attributes for an 
asset, for example the speed of a central processing unit (CPU).

NOTE: You cannot use the Move/Modify Assets action to move rotating assets 
out of inventory locations (Courier, Holding, Labor, Vendor); you must 
issue or transfer rotating assets using either the Inventory or Issues 
and Transfers application. However, you can use the Move/Modify 
Assets action to move assets into a storeroom location.
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You use the Swap Assets action available in the Assets application to replace 
one asset with another, for example when an asset fails or malfunctions. You 
can swap a single pair of assets, or multiple pairs of assets. You can specify a 
GL Debit Account and a GL Credit Account when you perform a swap.

NOTE: You cannot use the Swap Assets action to move rotating assets out of 
inventory locations (Courier, Holding, Labor, Vendor); you must issue or 
transfer rotating assets using either the Inventory or Issues and 
Transfers application. 

Adding to IT Assets

Adding an IT asset refers to the installation of new hardware or software. 
This may involve adding software, drivers, peripherals, additional memory, a 
new hard drive, and so on. Performing an "add" activity may involve 
purchasing or licensing.

You use the Changes application to plan and implement changes to the 
configuration of existing IT assets. You can create change work orders in the 
Changes application, or by using the Create Change action available from 
the Select Action menu of the following applications:

! Incidents
! Problems
! Quick Reporting
! Releases
! Service Requests
! Work Order Tracking

You use the Releases application to release tested and authorized changes to 
the "live" or production environment. You can use the Releases application to 
plan, review, and manage the release of authorized versions or configurations 
of assets into your production environment, for example large scale hardware 
or software roll-outs. You can create release work orders in the Releases 
application, or by using the Create Release action available from the Select 
Action menu of the following applications:

! Changes
! Incidents
! Problems
! Quick Reporting
! Service Requests
! Work Order Tracking

You use the Spare Parts tab in the Assets application to add new 
subassemblies (assets) and spare parts (items) to the asset hierarchy listed on 
an asset record. For example, if your company tracks software as an asset, and 
new software is installed on a workstation, you would add the software to the 
subassemblies listed on the Spare Parts tab of the workstation record.

Changing IT Assets 

Changing an IT asset refers to changing the configuration of existing 
hardware or software settings. This may involve activities such as configuring 
an asset, upgrading hardware, and software updates such as operating system 
patches, application updates, or security patches.
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You use the Changes application to plan and implement changes to the 
configuration of existing IT assets. You can create change work orders in the 
Changes application, or by using the Create Change action available from 
the Select Action menu of the following applications:

! Incidents
! Problems
! Quick Reporting
! Releases
! Service Requests
! Work Order Tracking

You use the Releases application to release tested and authorized changes to 
the "live" or production environment. You can use the Releases application to 
plan, review, and manage the release of authorized versions or configurations 
of assets into your production environment, for example large scale hardware 
or software roll-outs. You can create release work orders in the Releases 
application, or by using the Create Release action available from the Select 
Action menu of the following applications:

! Changes
! Incidents
! Problems
! Quick Reporting
! Service Requests
! Work Order Tracking

You use the Move/Modify Asset action available in the Activities, Changes, 
and Releases applications to plan a move or modification for one or more 
assets. You can move an asset to a new location, to a new parent (new location 
in the asset hierarchy), or to a new bin in a storeroom. You can modify the 
attributes for an asset, for example if memory is added to a computer.

You use the Move/Modify Assets action available in the Assets, Purchase 
Orders, and Work Order Tracking applications to make a move or 
modification to one or more assets. You can move an asset to a new location 
(including a different Site), to a new parent (new location in the asset 
hierarchy), or to a new bin in a storeroom. You can add, modify, or delete users 
and custodians listed on an asset record. You can modify the attributes for an 
asset, for example the version of software.

Decommissioning IT Assets

Decommissioning IT assets refers to de-installing, decommissioning, and 
disposing of an IT asset. This may occur due to the end of a lease or license, or 
when an IT asset is being replaced or retired because it is technologically 
obsolete.

You can use the Job Plans application to create a job plan that lists all of the 
tasks related to decommissioning an asset. Once you have created a job plan, 
it can be used when you create work orders in the Changes, Releases, or Work 
Order Tracking applications. Decommissioning an IT asset might include one 
or more of the following tasks:

! locating the asset � You can use information contained on the asset 
record to physically locate an asset, including information in the following 
fields:
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! Location � use to locate stationary assets, for example mainframes
! Parent � use to locate bundled assets or subassemblies
! Bin � use to locate assets in a storeroom
! Users and Custodians � use to locate mobile assets, for example 

laptop computers

! reconfiguring an asset � If you must return a leased asset with the same 
configuration that it had when it was received, you can create a job plan 
for the configuration. The job plan can contain any necessary steps in the 
configuration, such as installing or removing software, or deleting 
sensitive or company confidential data.

! reconciling your leased assets � For information about how to use the 
applications in the Deployed Assets and Reconciliation modules to 
reconcile your asset records in Maximo with data discovered by an asset 
discovery tool, see �Deployed Asset Management,� on page C-15.

! shipping a leased asset back to the vendor � There are two ways that you 
can process leased assets that are being returned to a vendor. You can use 
the original purchase order to return leased items in the Receiving 
application via the Select Items for Return button. Or you can use the 
Move/Modify Assets action available in the Assets, Purchase Orders, 
and Work Order Tracking applications to move the leased assets to a 
storeroom, then use the Issues and Transfers application to return the 
items to the vendor via the Select Items for Return button.

! canceling an existing lease or rental agreement � You can use the 
Escalations application to create an escalation that automatically cancels 
a lease or rental agreement once a particular condition has been met, for 
example when all assets on the lease have been returned, or the End Date 
on the contract has been reached.

! changing the status of an asset record to DECOMMISSIONED � You use 
the Assets application to change the status of an asset record from 
OPERATING to DECOMMISSIONED. For more information about 
decommissioning asset records, see �Decommissioning an Asset,� on 
page 3-15.

TIP: You can change the status of multiple asset records from the List tab.

! moving an asset to a salvage location � You use the Move/Modify Assets 
action available in the Assets, Purchase Orders, and Work Order Tracking 
applications to move one or more assets to a salvage location. Depending 
on your business processes this might involve a move to a new location 
(including a different Site), to a new parent, or to a new bin in a storeroom.

! ordering a replacement � You can use either Desktop Requisitions or the 
Purchase Requisitions application to requisition IT assets. You can also 
use the Escalations application to create an escalation that includes 
notifications when leases are about to expire. You can create escalations 
that extend or renew a lease, or that cancel a lease and notify the 
appropriate parties that it is time to negotiate a new contract.
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Deployed Asset Management

Maximo can maintain two distinct sets of data about information technology 
(IT) assets in two different Maximo modules, the Assets module and the 
Deployed Assets module. If your company has purchased an asset discovery 
tool, for example Maximo Discovery, and Maximo Fusion, you can track the 
presence and configuration of IT assets that have been deployed in a network 
environment. 

Deployed Asset Management involves the following components:

! Asset Discovery Tool, for example Maximo Discovery

! Maximo Fusion

! Maximo's Deployed Assets Administration Module

! Maximo's Reconciliation Module

! Maximo's Deployed Assets Module

Asset Discovery Tool

In order to gather data about IT assets deployed across a network you need an 
asset discovery tool such as Maximo Discovery, or another tool another tool, 
such as Microsoft® SMS or Tivoli® Configuration Manager. An asset discovery 
tool scans computers, network devices, and network printers that are 
connected to a network and records information about the hardware and 
software installed on those assets.

To import the data collected by the asset discovery tool requires Maximo 
Fusion. Maximo Fusion is an integration tool that lets you transform data 
from the asset discovery tool's format to the Maximo format and then imports 
the data into Maximo.

Maximo Fusion includes data schema definitions for the following products:

! Altiris® Inventory Solution®

! Centennial Discovery®

! Hewlett Packard's Inventory Manager using Radia®

! IBM's Tivoli® Configuration Manager

! Maximo® Deployed Assets

! Maximo® Discovery

! Microsoft® SMS

Maximo Fusion

Maximo Fusion is an integration tool developed by MRO Software to import 
deployed asset information technology data into Maximo. You use Maximo 



Managing IT Asset Records

C-16 Maximo 6, 08/2006

Fusion to map your discovery tool's data schema to the format required by 
Maximo. Maximo Fusion transforms the collected data and imports it into 
Maximo.

With Maximo Fusion, you can combine data collected by different asset 
discovery tools or data in multiple databases created by the same discovery 
tool and integrate it into Maximo, creating a central repository for enterprise 
IT asset management, reporting, and decision support.

For more information about Maximo Fusion, refer to the Maximo Fusion 
Installation Guide and the Maximo Fusion System Administrator�s Guide.

The Deployed Assets Administration Module

Because the discovery tools collecting deployed asset data do not always use 
consistent naming conventions, Maximo includes a Deployed Assets 
Administration module that includes applications that let you standardize 
naming conventions and control how Maximo displays deployed asset data. 
Authorized users can access the Deployed Assets Administration applications 
by selecting Administration > Deployed Assets from the Go To menu in 
Maximo.

The Deployed Assets Administration module includes the following 
applications that let you specify how Maximo should translate inconsistent 
names used by asset discovery tools to standard naming conventions.

! Adapter Conversion � Use to specify the translation of adapter names, 
both media adapters (such as video and sound cards) and network 
adapters.

! Manufacturer Conversion � Use to specify the translation of 
manufacturer names.

! Operating System Conversion � Use to specify the translation of 
operating system names.

! Processor Conversion � Use to specify the translation of central 
processing unit (CPU) names.

! Software Conversion � Use to specify the translation of software 
application names.

! Software Suite Setup � Use to define which software applications 
belong to a software suite.

! Software Usage Setup � Use to define how Maximo displays software 
usage frequency information collected by an asset discovery tool.

Records in these conversion applications specify one or more variations of a 
name, and the target name that the variants should be translated into when 
Maximo Fusion imports data into Maximo. Maximo uses the target name 
when it displays imported data in the Deployed Assets applications or in 
reports.

For more information about the Deployed Asset Administration module see 
Chapter 5, "The Deployed Assets Module," on page 5-1, or refer to the Maximo 
System Administrator�s Guide.
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The Deployed Assets Module

The Deployed Assets Module contains three applications that let you view 
hardware and software data collected by an asset discovery tool and imported 
into Maximo via Maximo Fusion. Maximo automatically creates the records in 
the Deployed Assets applications when you import data. The Deployed Assets 
Module consists of the following applications: 

! Computers � Displays data about specific computers deployed at your 
company.

! Network Devices � Displays information about deployed network 
devices such as routers, switches, and hubs. 

! Network Printers � Displays information about deployed network 
printers.

You access these applications by selecting Assets > Deployed Assets from 
the Go To menu in Maximo. For more information about the Deployed Assets 
applications, see Chapter 5, "The Deployed Assets Module," on page 5-1.

The Reconciliation Administration Module

The applications in the Reconciliation module let you configure the process 
Maximo uses to compare and reconcile the IT asset information in the Assets 
application with the deployed asset data maintained in the Deployed Assets 
applications. The reconciliation process identifies successful matches between 
IT assets and deployed assets as well as discrepancies and variances between 
the two sets of records. 

You can use this comparison to determine whether or not the IT assets 
deployed at your company match the record of authorized assets maintained 
in the Assets application. Authorized users can view reconciliation results in 
the Reconciliation module applications or in reports. You can also view 
reconciliation results in the Assets application using the Asset Details action 
available from the Select Action menu. Discrepancies might be caused by a 
variety of factors, including:

! Incorrect data entry
! Reconfigured hardware or software
! Retired hardware or software
! Theft
! Unauthorized use of hardware and software 

You can access the Reconciliation Module applications by selecting 
Administration > Reconciliation from the Go To menu in Maximo. The 
Reconciliation module includes the following applications:

! Reconciliation Tasks � This application combines one or more link 
rules and, if necessary, a task filter and one or more comparison rules into 
a reconciliation task. This application also lets you specify how Maximo 
reports results for comparison rule evaluations: all results, failed 
reconciliations, or successful reconciliations.

! Task Filters � This application defines a subset of either assets or 
deployed assets to reconcile. If you do not define a task filter for a 
reconciliation task, Maximo compares all top-level IT assets with all 
deployed assets when it processes the reconciliation task.
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! Link Rules � This application establishes a relation between a top-level 
IT asset and a computer, network printer, or network device in deployed 
assets. The link rule establishes the basis of the comparison by identifying 
the object and attribute in IT assets to link to a specific attribute in 
deployed assets.

! Comparison Rules � This application identifies objects or attributes of 
a child or parent IT asset to compare with objects or attributes of a child or 
parent deployed asset when Maximo executes a reconciliation task. 

! Link Results � This application lists successful one-to-one links Maximo 
establishes between a top-level IT asset and a computer, network printer, 
or network device in deployed assets.

! Reconciliation Results � This application lists link failures that occur 
when Maximo does not find a successful one-to-one link between an IT 
asset and a deployed asset specified in a link rule; failures occur when the 
reconciliation process finds no link or finds multiple links. In addition, the 
application lists results of comparison rule evaluations.

For more information about the Reconciliation Module, refer to the Maximo 
Reconciliation Module Implementation Guide. 

Managing Software Licenses

You need to know what software is installed on your company�s computers so 
that you are in compliance with licensing agreements, so that you don�t 
purchase software that you already own, or purchase more software licenses 
that you need. You also need to be able to track licenses that become available 
through retiring or decommissioning desktops. 

You need to know which versions and patch levels you are running for 
software such as operating systems, network software, and anti-virus 
software to be able to protect your company�s network from viruses, Trojan 
horses, worms, and other programs that can damage or disable your network.

Managing Software IT Assets involves the creation of records in the following 
applications:

! Item Records � You use the Item Master application to create item 
records for software licenses. Software licenses can be tracked as a group 
as items on a software license contract, or as individual assets. You should 
create rotating item records for software that will be tracked via the 
Assets application. For more information about creating rotating item 
records, see �Creating Rotating Item Records,� on page C-6. 

NOTE: You must create item records before you can create contract or 
purchasing records for the items.

! Software Contract Records � You use the Purchase Contracts 
application to create purchase contracts that record the pricing and 
payment information for software purchases and licenses.

You also use the Purchase Contracts application to create software license 
contracts, which record the specific terms of the license agreement. For 
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example the use of license keys, maintenance fees, and if the software is 
transferable.

NOTE: You should create contract records before you create purchasing 
records.

! Asset records � If you choose to track software as a serialized IT asset, 
you can use either the Assets application or the Receiving application to 
create asset records. For more information about creating IT asset records, 
see �Creating Rotating Asset Records,� on page C-7.

Managing Software License Contract Details

Additional information about software license contracts can be entered, 
viewed and modified via the Software License Details action available from 
the Select Action menu of the Purchase Contracts application. This action is 
only available with contracts where Type = SWLICENSE.

The value in the License Type field determines the values Maximo writes to 
the fields in the Software License Type dialog box. For example, for Named 
User type licenses, you can list authorized users in the Named Users table 
window, which is collapsed by default. 

Software License Contract Types

Maximo includes the following License Types for software license contracts:

! CONCURRENT � Concurrent software licenses allow a group of users to 
share a fixed number of software licenses. When you use this type of 
licensing, software can be installed on any number of computers, provided 
that the actual usage of the software does not exceed the number of 
licenses. For example, if you have 100 licenses, you can have no more than 
100 computers using the software at any one time. 

! ENTERPRISE � Enterprise licenses allow you to copy and distribute the 
software for unlimited use across your organization.

! NAMED USER � Named user licenses limit software use to a named set 
of users. The license cannot be transferred to users not on the agreed upon 
list.

! OEM � Original Equipment Manufacturer license. OEM licenses usually 
refer to software licenses that come bundled with a computer, for example 
the operating system that comes installed on a laptop. Usually these 
licenses are limited to use on the computer they came supplied on, and 
cannot be re-used, even if the original machine is no longer in use.

! RETAIL � Retail licenses can refer to single or limited multiple user 
licenses. With a retail license you cannot copy the software, but you can 
transfer the software to a different machine or user.

! SELECT � Select license refer to a volume agreement. You establish an 
agreed upon volume of points. As users log onto the software, points are 
calculated. When you reach the maximum volume of points, additional 
users are not allowed to log onto the software.
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! SUBSCRIPTION � Subscription licenses are based on units of time. 
With a subscription license you purchase the right for authorized users to 
use the software for a set period of time, for example one year.

NOTE: Once a contract is approved the software License Type field becomes 
read-only.

Monitoring Software Usage

You can use the applications in the Deployed Assets and Deployed Assets 
Administration modules to monitor software license usage and compliance. 
You use the Deployed Asset Administration applications to determine how 
Maximo categorizes variations in manufacturer and software naming 
conventions, as well as determine which software products are considered 
part of a software suite.

You use the Software Usage Setup application to specify the range of usage 
that corresponds with different usage labels, for example "weekly," "monthly," 
and "occasionally." Maximo can track usage frequency data for both individual 
software applications and application suites. Maximo determines the 
frequency for a software suite based on the component application with the 
highest usage count.

You can view software usage data in the Computers application. The 
Applications and Suites subtabs on the Software tab contain Usage and Last 
Usage Date fields.
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action menu 2-16
ACTIVE status 7-8, 8-14, 10-10, 10-14, 10-21, 12-38, 12-41, 13-

11
activities

creating 12-18
managing 12-9, 12-18
statuses 12-14, 12-18

Activities application 12-15
accessing 12-16
Activity tab 12-16
Actuals tab 12-16
buttons 12-16
List tab 12-16
Log tab 12-16
Multisite and 12-15
Plans tab 12-16
quick reference 12-16
Related Records tab 12-16

Activities tab
Incidents 12-23
Problems 12-27

Activity tab 12-16
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recording 14-39
reporting 14-24
selecting multiple labor, materials, or tools 14-33

Actuals tab
Activities 12-16
Changes 12-19
Releases 12-30
Work Order Tracking 14-29

Adapter Conversion application 5-2
Add Item to Storeroom action 6-22
Add to Bookmarks

action 2-14
button 2-14, 2-22

Addresses tab
Companies 9-9
Company Master 9-13

Advanced Search button 2-7
agent 12-2
alternate items 6-24
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application

data sharing between 1-9
opening 2-5
pages 2-15
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self-service 2-6
simple 2-6
standard 2-6
tabs and subtabs 2-17
types 2-6

Apply Item Assembly Structure action 6-25
Apply Route action 14-37
APPR status 4-4, 9-18, 9-24, 9-29, 12-14, 14-6
asset assembly structures 3-12

 See also asset hierarchy

asset hierarchy 3-12
creating 3-13
elements of 3-12
navigating 3-14
viewing 3-14

Asset tab 3-9
Asset/Location Drilldown See Drilldown
assets 3-2

Classifications 3-4, C-3
company records and 3-5
condition monitoring 3-5
contracts and 3-5, C-3
creating records 3-11
creating records for information technology assets C-5
decommissioning 3-15, C-13
deployed assets and 3-5
item records and 3-6
job plans and C-4
leased C-4
locations and 3-2, 3-6, C-5
managing assets 3-14
managing information technology assets C-9
meters and 3-6
Multisite and 3-4
preventive maintenance and 3-7
priority 3-3
purchasing and C-5
rotating 3-11, C-7
safety information 3-7
software C-4
statuses 3-15
types 3-8
users and custodians 3-14
warranties C-4
work orders 3-8

Assets and Locations tab 13-8
Assets application 3-4

accessing 3-8
Asset tab 3-9
buttons 3-9
List tab 3-8
Meters tab 3-9
quick reference 3-9
Safety tab 3-9
Spare Parts tab 3-9
Specifications tab 3-9

Assets tab 3-27
Assign Labor

action 14-13
button 14-11, 14-13

ASSIGNED status 14-15
Assignment Manager application 14-7

accessing 14-10
assignment statuses 14-15
buttons 14-11
creating assignments 14-13
deleting assignments 14-15
dispatching work 14-14
labor and 14-8
Labor List 14-8
managing assignments 14-13
Multisite and 14-7
prerequisites 14-7
quick reference 14-12
re-assigning assignments 14-14
rescheduling assignments 14-14
scheduling work 14-13
Work List 14-9
work orders and 14-9
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Associate Folders action 2-43
Associate Users and Custodians button 3-9
Associated Assets tab

Lease/Rental Contracts 4-11
Warranty Contracts 4-24

Associated Contracts tab 4-13
Associated Labor tab

Crafts 10-4
Labor Rate Contracts 4-8
Qualifications 10-19

Attached Documents
actions 2-43
direct attachments 2-42
referential attachments 2-42
types of attachments 2-42
using 2-42

authorized assets 5-1

B

blanket contracts 4-2
bookmarks

adding 2-14
deleting 2-15
managing 2-15
using 2-14

branches 9-10
Branches tab 9-9
browser

Back button 2-2
Forward button 2-2
menu 2-2
pop-up blocker 2-1
settings 2-1
supported version 2-1
toolbar 2-2

Bulletin Board
link 2-3
Start Center portlet 2-4
viewing messages B-3

buttons
See also field buttons, table window buttons, toolbar buttons
Add to Bookmarks 2-14, 2-22
Advanced Search 2-7
Assign Labor 14-11
Change Status 2-17
Close Details 2-21
Create KPI Option 2-17
Delete 2-14
Detail Menu 2-11
Download 2-14
Edit Portlet 2-5
Filter Labor to Match Work 14-11
Filter Work to Match Labor 14-11
Finish Assignment 14-11
Go To Work Order Tracking 14-11
Interrupt Assignment 14-11
Long Description 2-11
Mark Row for Delete 2-22
Maximize 2-18
Maximize Portlet Window 2-5
Minimize 2-18
Minimize Portlet Window 2-5
Modify Availability 14-11
More Search Fields 2-7
New Row 2-24

Next Page 2-14
Next Row 2-14
Previous Page 2-14
Previous Row 2-14
Refresh 14-11
Remove Portlet 2-5
Save Current Query 2-8
Save Query 2-7
Select Date 2-11, 2-30
Select Date and Time 2-11
Select Value 2-11
Select Work Date 14-11
Show Assignments 14-11
Start Assignment 14-11
Undo Delete 2-22
View Details 2-21
View Search Tips 2-7
View/Manage Queries 2-8
WHERE Clause 2-7

C

calculated work priority 14-10
calendar grid 14-8
CAN status 4-5, 9-24, 9-29, 12-15, 14-6
CANCEL status 9-18, 9-38
change order 9-6

creating 9-23
change records

creating 12-22
managing 12-22
statuses 12-14, 12-22

Change Status button 2-17
Change tab 12-19
Changes application 12-18

accessing 12-19
Actuals tab 12-19
buttons 12-20
Change tab 12-19
List tab 12-19
Log tab 12-19
Multisite and 12-19
Plans tab 12-19
quick reference 12-20
Related Records tab 12-19

characteristic meters 3-35
characters 2-11
Classifications 2-32, 3-2, 3-4

classifying a record 2-37
linking items to 6-26
Multisite and 2-36
searching 2-36
ticket records and 12-5
tickets and 12-6
using 2-35

Clear button 2-21
Clear Changes button 2-17
Close Details button 2-21, 2-23
CLOSE status 4-5, 9-24, 9-29, 9-38, 12-15, 14-6
CLOSED status 12-12
columns

database columns 1-6
defined 1-7
sorting table window columns 2-22

commodities 6-3
commodity codes 9-5
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commodity groups 6-3
Communication tab 5-7
communication templates

using 12-11
communications log

tickets 12-11
work order 14-40

COMP status 9-38, 12-15, 14-6
companies

branch hierarchy 9-11
branch locations 9-10
company masters and 9-8
contracts and 9-8
creating records 9-10
deleting records 9-11
disqualifying as a vendor 9-11
duplicating 9-11
managing records 9-11
purchasing and 9-9
types 9-10

Companies application 9-7
accessing 9-9
Addresses tab 9-9
Branches tab 9-9
Company tab 9-9
Contacts tab 9-9
List tab 9-9
Multisite and 9-8
quick reference 9-9

Company Master application 9-12
accessing 9-13
Addresses tab 9-13
Company Master tab 9-13
Contacts tab 9-13
List tab 9-13
Multisite and 9-12
quick reference 9-13

Company Master tab 9-13
company masters

creating 9-13
deleting 9-14
disqualifying 9-14
managing 9-14

Company Set (Multisite) 1-9
Company tab 9-9
Comparison Rules application 5-4
COMPLETE status 14-15
Computer tab 5-6
computers

creating records 5-7
Deployed Asset Administration and 5-5
managing records 5-8
Maximo Fusion and 5-5
Reconciliation and 5-6

Computers application 5-4
accessing 5-6
Communication tab 5-7
Computer tab 5-6
Displays tab 5-7
Image Devices tab 5-7
List tab 5-6
Media Adapters tab 5-7
Multisite and 5-5
Network tab 5-7
Processors tab 5-6
quick reference 5-7
Software tab 5-7
Storage tab 5-6
Users tab 5-7

condition codes
assets and 6-5
creating 6-6
inventory and 6-5
issues and transfers and 6-5
item records and 6-6
managing 6-6
tools and 6-6

Condition Codes application 6-4
accessing 6-6
Multisite and 6-5
quick reference 6-6

condition monitoring
assets 3-17
locations 3-17
managing 3-19
meters and 3-17
preventive maintenance and 3-17
work orders and 3-17

Condition Monitoring application 3-16
accessing 3-17
Condition Monitoring tab 3-18
generating a work order 3-19
List tab 3-18
Multisite and 3-16
quick reference 3-18

Condition Monitoring tab 3-18
Contacts tab

Companies 9-9
Company master 9-13

continuous meters 3-35
Contract Lines tab

Lease/Rental Contracts 4-11
Purchase Contracts 4-17
Warranty Contracts 4-24

Contract tab
Labor Rate Contracts 4-8
Lease/Rental Contacts 4-11
Master Contracts 4-13
Purchase Contracts 4-17
Warranty Contracts 4-24

contracts
details 4-3
revising 4-5
statuses 4-4
terms and conditions 4-3
types 4-2

courier location 3-26
Craft tab 10-4
crafts

creating records 10-5
job plans and 10-3
labor and 10-3
managing records 10-5
skill levels 10-5
work orders and 10-3

Crafts application 10-2
accessing 10-4
Associated Labor tab 10-4
Craft tab 10-4
List tab 10-4
Multisite and 10-3
quick reference 10-4

Crafts tab 10-8
Create Change Order action 9-24
Create KPI Option button 2-17
Create Requisitions application B-11
Create Service Request application B-7
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D

data fields 2-28
database

components 1-6
data sharing 1-9
operators 2-11
overview 1-6
relational 1-8
structure in Maximo 1-8

dates
entering 2-30
Select Date dialog box 2-30

DECOMMISSIONED status 3-15, 3-32
default table data 2-23
Delete button 2-14
Delete Work Order action 14-41
deleting records 2-45
deployed assets 3-2, 5-1

administration 5-2, C-15
asset discovery tools C-15
Deployed Assets Administration module C-16
Deployed Assets module C-17
Reconciliation administration module C-17

Desktop Requisitions Module B-9
buttons B-10
creating a requisition B-11
creating requisitions using templates B-13
creating templates B-13
modifying requisitions B-14
Purchasing Module and B-10
requisition statuses B-14
saving draft requisitions B-13
searching requisitions B-13
viewing requisitions B-13

Detail Menu button 2-11
using 2-32

Device Cards tab 5-9
direct issue items 6-17
discovered assets 5-1
Displays tab 5-7
DMS See Document Management System
Document Management System 2-42

defined 2-42
documents

attaching 2-43
Download button 2-14, 2-21
downtime

non-operational 14-39
operational 14-39
planned 14-38
reporting 14-38
unplanned 14-38

DRAFT status 4-4, 7-8, 8-14, 12-38, 12-41, 13-11
Drilldown 3-3

actions 2-35
creating 3-3
details display 2-33
navigation 2-34
Open Drilldown action 2-32
using 2-32

E

economic order quantity 6-13
Edit Portlet button 2-5
editable table windows 2-24
Enter Meter Readings action 14-23
ENTERED status 9-17
equipment See assets
Escalation tab 13-8
escalations 13-7
EXPIRD status 4-5
external purchase requisition 9-3

F

failure analysis 14-41
failure class 3-20, 14-41
failure codes

assets and 3-21
cause 3-20
creating 3-22
failure class 3-20
failure reporting 3-23
locations and 3-21
managing 3-23
problem 3-20
remedy 3-20
work orders and 3-21

Failure Codes application 3-20
accessing 3-21
Failure Codes tab 3-21
List tab 3-21
Multisite and 3-21
quick reference 3-22

Failure Codes tab 3-21
failure hierarchy 3-20

building 3-22
failure reporting 14-40

failure analysis 14-41
recording failure data 14-41

Failure Reporting tab
Incidents 12-23
Problems 12-27
Work Order Tracking 14-29

field buttons 2-11
Detail Menu 2-11
Long Description 2-11
Select Date 2-11
Select Date and Time 2-11
Select Value 2-11

fields 1-6, 2-26
accepts nulls 2-27
buttons 2-11
calculated values 2-27
data entry 2-26
data types 2-27
default values 2-27, 2-29
defined 1-6
entering partial values 2-30
entering values 2-30
Field Help 2-28
key 1-7
read/write 2-26
read-only 2-26
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required 2-26
value list 2-28

files 1-7
defined 1-6

Filter Labor to Match Work button 14-9, 14-11
Filter Table button 2-21, 2-22
Filter Work to Match Labor button 14-10, 14-11
Find button 2-21
Find field 2-9
Finish Assignment

action 14-15
button 14-11, 14-15

Frequency tab
Master PM 8-3
Preventive Maintenance 8-10

G

gauges 3-35
General Ledger Accounts 2-38

See also GL Account codes
generating a work order

with Condition Monitoring 3-19
with PM application 8-13

GL Account codes
component sequence 2-40
components 2-38
defined 2-38
editing 2-41
entering 2-41
fully defined accounts 2-39
mandatory components 2-39
optional components 2-39
partially defined accounts 2-39
valid account codes 2-39

global issues 12-7, 12-8
creating 12-8
relating other records to 12-9

Go To menu
link 2-3
list of modules and applications 1-2

Go To Work Order Tracking button 14-11

H

Hazardous Materials tab 11-14
hazards

assets and 11-2
creating records 11-5
items and 11-3
locations and 11-2
precautions and 11-3
safety plans and 11-3
tag outs and 11-4

Hazards and Precautions tab 11-14
Hazards application 11-2

accessing 11-4
Hazards tab 11-4
List tab 11-4
Multisite and 11-2
Precautions tab 11-4
quick reference 11-4

Tag Outs tab 11-4
Hazards tab 11-4
Help

button 2-21
Field Help 2-28
link 2-3

Hide Table button 2-21, 14-36
hierarchies 1-8

asset assembly structure 3-12
company branch hierarchy 9-11
failure hierarchy 3-22
item assembly structure 6-25
location 3-29, 3-30
PM hierarchy 8-13
work order hierarchy 14-34

adding children 14-36
adding tasks 14-37
building 14-36
change status 14-37
terms 14-35
viewing 14-35

HISTEDIT status 12-15, 14-6
History tab 3-27
HOLD status 9-18
holding location 3-26
hyphens (-) 2-11

I

IAS See item assembly structures
IMAC See install, move, add, change
Image Devices tab 5-7
INACTIVE status 7-8, 8-14, 10-11, 10-14, 10-21, 12-38, 12-41, 

13-11
Inbox 2-4
Incident tab 12-23
incidents

creating 12-25
managing 12-25
statuses 12-12, 12-26

Incidents application 12-22
accessing 12-23
Activities tab 12-23
buttons 12-23
Failure Reporting tab 12-23
Incident tab 12-23
List tab 12-23
Log tab 12-23
Multisite and 12-23
quick reference 12-24
Related Records tab 12-23
Solution Details tab 12-23

index 1-7
INPRG status 9-24, 9-38, 12-12, 12-15, 14-6
install, move, add, change

adding assets C-12
changing assets C-12
installing assets C-10
moving assets C-11

internal purchase requisition 9-3
INTERPT status 14-15
Interrupt Assignment

action 14-14
button 14-11, 14-14

inventory
condition codes and 6-7
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creating kits 6-11
creating records 6-11
item records and 6-7
kits 6-4
managing 6-11
purchasing and 6-8
reordering 6-8
storeroom records and 6-8
viewing item availability 6-12

Inventory application 6-7
accessing 6-8
Inventory tab 6-8
List tab 6-8
Multisite and 6-7
quick reference 6-8
Reorder Details tab 6-8
Rotating Asset tab 6-8
using 6-10
Where Used tab 6-8

Inventory tab 6-8
Invoice Lines tab 9-15
Invoice tab 9-15
invoices

contracts and 9-15
creating 9-16
deleting 9-18
duplicating 9-17
entering invoice lines 9-17
managing 9-17
purchase orders and 9-15
statuses 9-17
types 9-16

Invoices application 9-14
accessing 9-15
Invoice Lines tab 9-15
Invoice tab 9-15
List tab 9-15
Multisite and 9-14
quick reference 9-16
Terms and Conditions tab 9-16

Issue tab 6-16
issues and transfers

condition codes and 6-15
direct issue items 6-17
inventory and 6-15
purchasing and 6-16
work orders and 6-16

Issues and Transfers application 6-14
accessing 6-16
Issue tab 6-16
List tab 6-16
Multisite and 6-15
quick reference 6-17
Transfer In tab 6-16
Transfer Out tab 6-16

Item Assembly Structure tab 6-23
item assembly structures

applying 3-13, 6-25, C-7
creating 6-25, C-6

Item Master application 6-19
accessing 6-22
Item Assembly Structure tab 6-23
Item tab 6-22
List tab 6-22
Multisite and 6-19
quick reference 6-23
Specifications tab 6-22
Storerooms tab 6-22
Vendors tab 6-22

Item Sets (Multisite) 6-3, 6-19
Item tab 6-22
items

alternate items 6-24
assets and 6-20
balances 6-13
categories 6-10
commodity codes and 6-20
condition codes and 6-21
contracts and 6-21
creating records 6-24
deleting 6-26
determining reorder point 6-12
inventory and 6-21
issuing 6-17
linking to Classifications 6-26
managing 6-26
managing item counts 6-13
managing vendors 6-26
reordering 6-13
requisitioning vendor items 9-28
returning 6-19, 9-32
safety information and 6-22
storerooms and 6-22
transferring 6-18
viewing availability 6-12

Items tab 6-34

J

Job Plan Sequence tab
Master PM 8-3
Preventive Maintenance 8-10

Job Plan tab 7-3
job plans

associating work assets 7-7
creating 7-4
defining labor 7-6
defining materials 7-6
defining services 7-6
defining tasks 7-5
defining tools 7-6
deleting 7-8
duplicating 7-7
managing 7-8
ownership 7-7
preventive maintenance and 7-3
statuses 7-8
task sequence 7-5
work orders and 7-3

Job Plans application 7-2
accessing 7-3
Job Plan tab 7-3
List tab 7-3
Multisite and 7-2
quick reference 7-3
Work Assets tab 7-3

K

key fields 1-7
defined 1-7
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key word 1-7
kits 6-4

creating 6-11, 6-25
managing 6-14, 6-26

KPIs tab 13-8

L

labor
approving actuals in Labor Reporting 14-20
Assignment Manager and 10-6
availability for assignments 14-8
contracts and 10-6
crafts and 10-7
creating records 10-9
defining job plan labor 7-6
deleting crafts 10-10
deleting records 10-11
managing records 10-10
modifying qualifications 10-10
person records and 10-7
statuses 10-10
work orders and 10-7

Labor application 10-6
accessing 10-7
buttons 10-8
Crafts tab 10-8
Labor tab 10-8
List tab 10-8
Multisite and 10-6
Qualifications tab 10-8
quick reference 10-8

labor contracts 4-2
labor hours

reporting (Labor Reporting) 14-20
reporting (Quick Reporting) 14-24
reporting (Service Desk) 12-9, 12-14
reporting (Work Order Tracking) 14-39

Labor List (Assignment Manager) 14-8
calendar grid 14-8
filtering 14-9

labor location 3-26
labor rate contracts

associating labor 4-9
company records and 4-7
crafts and 4-7
creating 4-9
invoices and 4-7
labor and 4-7
labor reporting and 4-7
managing 4-9
rate schedules 4-9
work orders and 4-7

Labor Rate Contracts application 4-6
accessing 4-8
Associated Labor tab 4-8
Contract tab 4-8
labor contracts 4-2
List tab 4-8
Multisite and 4-6
Properties tab 4-8
quick reference 4-8
Rate Schedule tab 4-8
Terms and Conditions tab 4-8

Labor Reporting application 14-16
accessing 14-18

approving labor 14-20
buttons 14-18
contracts and 14-16
creating labor transactions 14-19
deleting labor transactions 14-21
invoices and 14-17
labor and 14-17
Multisite and 14-16
quick reference 14-18
reporting labor hours 14-20
Service Desk and 14-17
work orders and 14-17

Labor tab 10-8
labor transaction timer 12-14
lead time 6-12
lease contracts 4-2
lease/rental contracts

associating assets with 4-12
company records and 4-10
creating 4-12
invoices and 4-10
payment schedules 4-12

Lease/Rental Contracts application 4-10
accessing 4-11
Associated Assets tab 4-11
Contract Lines tab 4-11
Contract tab 4-11
lease contracts 4-2, 4-10
List tab 4-11
Multisite and 4-10
Properties tab 4-11
quick reference 4-11
rental contracts 4-2, 4-10
Terms and Conditions tab 4-11

lines
invoice 9-17
purchase contract 4-20
purchase order 9-22
purchase requisition 9-27
purchasing line types 9-4
quotation 9-37
warranty contracts 4-25

Link Results application 5-4
Link Rules application 5-4
location hierarchy 3-30

building from IAS 3-31
planning 3-30

Location tab 3-27
locations 3-29

assets and 3-24
condition monitoring and 3-24
contracts and 3-24
creating 3-28
decommissioning 3-32
inventory and 3-25
managing 3-32
meters and 3-25
networks 3-31
preparing to create 3-29
preventive maintenance 3-25
priority 3-3
safety information 3-25
statuses 3-32
systems 3-30
terms 3-29
types of 3-26
work orders 3-26

Locations application 3-23
accessing 3-27
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Assets tab 3-27
creating a hierarchical system 3-31
creating a network system 3-31
History tab 3-27
List tab 3-27
Location tab 3-27
Meters tab 3-27
Multisite and 3-24
quick reference 3-27
Safety tab 3-27
Specifications tab 3-27

lock out
defined 11-6

Lock Out/Tag Out application 11-6
accessing 11-7
List tab 11-7
Lock Out/Tag Out tab 11-7
Multisite and 11-6
quick reference 11-7

Lock Out/Tag Out tab 11-7
Log tab

Activities 12-16
Changes 12-19
Incidents 12-23
Problems 12-27
Releases 12-30
Service Requests 12-34
Work Order Tracking 14-29

logging in See signing in
logging out See signing out
logs 12-11

communications log 12-11, 14-40
Service Desk 12-11
work log 12-11, 14-40
work order 14-40

Long Description button 2-11
lower action limit 3-19
lower warning limit 3-19

M

Manage Folders action 2-43
Manage Library action 2-43
Manage Systems action 3-31
Manufacturer Conversion application 5-2
Mark Row for Delete button 2-22
master contracts 4-3

creating 4-14
creating associating contracts 4-15
managing 4-15

Master Contracts application 4-13
accessing 4-13
Associated Contracts tab 4-13
Contract tab 4-13
List tab 4-13
master contracts 4-3
Multisite and 4-13
Properties tab 4-13
quick reference 4-14
Terms and Conditions tab 4-14

Master PM application 8-2
accessing 8-3
Frequency tab 8-3
Job Plan Sequence tab 8-3
List tab 8-3
Master PM tab 8-3

Multisite and 8-2
quick reference 8-3
Seasonal Dates tab 8-3

Master PM tab 8-3
master PMs

create associated PMs 8-6
creating 8-4
deleting 8-7
items and 8-2
job plan sequencing 8-5
job plans and 8-2
managing 8-6
preventive maintenance and 8-3
seasonal dates 8-5
setting frequency 8-4
updating associated PMs 8-7

Material Receipts tab 9-31
materials

defining job plan materials 7-6
receiving 9-31

Maximize button 2-18
Maximize Portlet Window button 2-5
Maximo

applications 1-2
components 1-2
configuration ii-xxv
database 1-8
fields 2-26
hierarchies 1-8
implementation ii-xxv
launching 2-1
modules 1-2
overview 1-1
personalization ii-xxv
searching 2-6
Toolbar 2-15
user 10-1

Maximo Fusion C-15
Maximo Toolbar 2-15
measurement points

creating 3-18
limits for characteristic meters 3-19
limits for gauge meters 3-19
meters and 3-18

Media Adapters tab 5-7
Meter Group tab 3-38
meter groups

assets and 3-37
creating 3-38
deleting 3-39
items and 3-37
locations and 3-37
managing 3-39
meters and 3-38
modifying 3-39

Meter Groups application 3-37
accessing 3-38
List tab 3-38
Meter Group tab 3-38
Multisite and 3-37
quick reference 3-38

Meter tab 3-36
meters

assets and 3-34
characteristic 3-35
condition monitoring and 3-34
continuous 3-35
creating records 3-36
deleting 3-14, 3-36
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entering readings 14-23, 14-38
gauge 3-35
inventory and 3-34
locations and 3-34
managing 3-36
meter groups and 3-35
preventive maintenance and 3-35
types 3-35

Meters application 3-33
accessing 3-35
Meter tab 3-36
Multisite and 3-34
quick reference 3-36
Where Used tab 3-36

Meters tab
Assets 3-9
Locations 3-27

Minimize button 2-18
Minimize Portlet Window button 2-5
Modify Availability button 14-11
More Search Fields button 2-7
Move/Modify Asset button 3-9
MRO Software Support ii-xxvii
Multisite

applications and 1-11
defined 1-9
Organization level 1-10
overview 1-9
Set level 1-9
Site level 1-10
System level 1-9

N

Navigation Bar 2-3
navigation links 2-3
Network Device tab 5-9
network devices

creating records 5-10
Deployed Asset Administration and 5-8
managing records 5-10
Reconciliation and 5-9

Network Devices application 5-8
accessing 5-9
Device Cards tab 5-9
List tab 5-9
Multisite and 5-8
Network Device tab 5-9
quick reference 5-9

Network Printer tab 5-11
network printers

computers and 5-11
creating records 5-12
Deployed Asset Administration and 5-11
managing records 5-12
Reconciliation and 5-11

Network Printers application 5-10
accessing 5-11
List tab 5-11
Multisite and 5-10
Network Printer tab 5-11
quick reference 5-11

Network tab 5-7
networks (locations) 3-29

creating 3-31
viewing 3-32

New Record button 2-17
New Row button 2-22, 2-24
NEW status 12-12
Next Page button 2-14, 2-21
Next Record button 2-17
Next Row button 2-14, 2-21
nonstocked items 6-10
NOT READY status 3-15, 3-32
null

defined 1-7, 2-12
searching for null values 2-12

O

OLA
see operating level agreement 13-6

Open Drilldown action 2-32
operating level agreement 13-6
operating location 3-26, 3-29
OPERATING status 3-15, 3-32
Operating System Conversion application 5-2
operators 2-11
Organization (Multisite) 1-10, 1-12
ownership

job plans 7-7
preventive maintenance 8-8
tickets 12-5
work orders 14-5

P

PAID status 9-18
parent-child relationship 1-8
passwords 1-13, 2-1

self-registration B-1
payment schedules 4-12, 9-7
PENDING status 12-12
People application 10-12

accessing 10-13
List tab 10-13
Multisite and 10-12
Person tab 10-13
quick reference 10-13

Person Group tab 10-16
person groups

creating 10-17
deleting 10-17
managing 10-17
Workflow and 10-16

Person Groups application 10-15
accessing 10-16
List tab 10-16
Multisite and 10-15
Person Group tab 10-16
quick reference 10-16

person records
creating 10-13
deleting 10-15
labor records and 10-13
managing 10-14
statuses 10-14

Person tab 10-13
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pipes (|) 2-11
Plans tab

Activities 12-16
Changes 12-19
Releases 12-30
Work Order Tracking 14-29

PM hierarchies 8-13
PM Hierarchy tab 8-10
PM tab 8-10
PMs

assets/locations and 8-9
creating 8-11
generating a PM work order 8-13
hierarchies 8-13
job plans and 8-9
managing 8-13
master PMs and 8-9
ownership 8-8
priority 8-11
routes and 8-9
safety plans and 8-9
seasonal dates 8-12
setting frequency 8-12
statuses 8-13
work orders and 8-10

PNDREV status 4-4
PO Lines tab 9-20
PO See purchase orders
PO tab 9-20
portlets 2-4

personalizing 2-5
PR Lines 9-27
PR Lines tab 9-26
PR See Purchase Requisition
PR tab 9-26
Precaution tab 11-10
precautions

assets and 11-10
creating records 11-11
hazards and 11-10
locations and 11-10
managing records 11-11
safety plans and 11-10

Precautions application 11-9
accessing 11-10
List tab 11-10
Multisite and 11-9
Precaution tab 11-10
quick reference 11-10

Precautions tab 11-4
Preventive Maintenance application 8-8

accessing 8-10
Frequency tab 8-10
Job Plan Sequence tab 8-10
List tab 8-10
Multisite and 8-8
PM hierarchies 8-13
PM Hierarchy tab 8-10
PM tab 8-10
quick reference 8-10
Seasonal Dates tab 8-10

Previous Page button 2-14, 2-21
Previous Record button 2-17
Previous Row button 2-14, 2-21
pricing contracts 4-2
primary key 1-7
primary system 3-29
printing

HTML User�s Guide ii-xxiv

PDF User�s Guide ii-xxiv
priority

asset 3-3
calculated work priority 14-10
location 3-3
PM 8-11
recommended values 14-4
ticket 12-6
work order 14-4
work order calculations 14-9

problem records
creating records 12-29
incidents and 12-26
managing 12-29

Problem tab 12-27
problems

statuses 12-12
Problems application 12-26

accessing 12-26
Activities tab 12-27
buttons 12-27
Failure Reporting tab 12-27
List tab 12-27
Log tab 12-27
Multisite and 12-26
Problem tab 12-27
quick reference 12-27
Related Records tab 12-27
Solution Details tab 12-27

Processor Conversion application 5-2
Processors tab 5-6
Profile link 2-3
Properties tab

Labor Rate Contracts 4-8
Lease/Rental Contracts 4-11
Master Contracts 4-13
Purchase Contracts 4-17
Warranty Contracts 4-24

purchase contracts 4-2
adding lines 4-20
company records and 4-16
creating 4-19
invoices and 4-16
managing 4-20
purchasing and 4-17, 9-6
software license contracts 4-20, C-4

Purchase Contracts application 4-16
accessing 4-17
blanket contracts 4-2, 4-16
Contract Lines tab 4-17
Contract tab 4-17
List tab 4-17
Multisite and 4-16
pricing contracts 4-2, 4-16
Properties tab 4-17
purchase contracts 4-2, 4-16
quick reference 4-17
software license contracts 4-3, 4-16
Terms and Conditions tab 4-17

purchase orders
adding PO lines 9-22
change order 9-23
creating 9-22
creating from RFQ 9-37
duplicating 9-23
managing 9-23
purchase contracts and 9-19
purchase requisitions and 9-20
statuses 9-24
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storerooms and 9-20
types 9-6

Purchase Orders application 9-19
accessing 9-20
List tab 9-20
Multisite and 9-19
PO Lines tab 9-20
PO tab 9-20
quick reference 9-21
Ship To/Bill To tab 9-20
Terms and Conditions tab 9-20

purchase requisitions
contracts and 9-25
creating 9-27
entering line items 9-27
external 9-3
internal 9-3
managing 9-28
purchase orders and 9-25
statuses 9-28
storerooms and 9-26

Purchase Requisitions application 9-24
accessing 9-26
List tab 9-26
Multisite and 9-25
PR Lines tab 9-26
PR tab 9-26
quick reference 9-26
Ship To/Bill To tab 9-26
Terms and Conditions tab 9-26

purchasing
contracts and 9-5
creating records from contracts 9-6
inventory and 9-3
purchase contracts and 9-6

Q

QBE (query by example) See query
Qualification tab 10-19
qualifications

creating 10-20
deleting 10-21
labor and 10-18
managing 10-21
statuses 10-21

Qualifications application 10-18
accessing 10-19
Associated Labor tab 10-19
List tab 10-19
Multisite and 10-18
Qualification tab 10-19
quick reference 10-19

Qualifications tab 10-8
query 2-6

defined 1-8
results 2-14
saving 2-8, 2-9

QUEUED status 12-12
Quick Reporting application 14-21

accessing 14-21
List tab 14-21
Multisite and 14-21
quick reference 14-22
Quick Reporting tab 14-22

Quick Reporting tab 14-22

quotation lines
awarding to vendors 9-37
recording 9-37

Quotations tab 9-35

R

Rate Schedule tab 4-8
rate schedules 4-9
READY status 9-38
Receive Rotating Items action 9-30
receiving

assets and 9-29
companies and 9-30
creating receipts 9-31
inventory and 9-30
invoices and 9-30
managing receipts 9-33
materials 9-31
materials with changes 9-32
returning materials 9-32
rotating items 9-29, C-7
services 9-32

Receiving application 9-29
accessing 9-30
List tab 9-30
Material Receipts tab 9-31
Multisite and 9-29
quick reference 9-31
Service Receipts tab 9-31

Reconcile Balances action 6-13
reconciliation 5-3, C-17
Reconciliation Results application 5-4
Reconciliation Tasks application 5-4
records 1-7

automatic numbering of 2-28
creation varies by application 2-28
defined 1-6
deleting 2-45
displaying additional 2-20
editing a record 2-44
general procedure for creating 2-29
heading 2-18
making inactive 2-44
sorting 2-22

Refresh button 14-11
Refresh Labor List button 14-9
Refresh Work List button 14-10
related documentation ii-xxvi

database 1-8
installation ii-xxvi
Multisite ii-xxvi
reports ii-xxvi
system administration ii-xxvi

related records
associating 12-8
tickets 12-6
types 12-7
viewing (Service Catalog) 13-5
viewing (Service Desk) 12-7

Related Records tab
Activities 12-16
Changes 12-19
Incidents 12-23
Problems 12-27
Releases 12-30
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Service Requests 12-34
Work Order Tracking 14-29

Related SLAs tab 13-8
Release tab 12-30
releases (purchasing) 9-6
releases (Service Desk)

creating 12-33
managing 12-33
statuses 12-14

Releases application 12-30
accessing 12-30
Actuals tab 12-30
buttons 12-31
List tab 12-30
Log tab 12-30
Multisite and 12-30
Plans tab 12-30
quick reference 12-31
Related Records tab 12-30
Release tab 12-30

Remove Portlet button 2-5
remove sequence 11-8
Remove Work Plan action 14-40
rental contracts 4-2
Reorder Details tab 6-8
reorder point 6-12
reorder process 6-12

actions 6-13
lead time 6-12
reorder point 6-12

repair location 3-26
Report Downtime action 14-38
Reports link 2-3
request for proposal 9-33
Request for Quotations application 9-33

accessing 9-35
List tab 9-35
Multisite and 9-34
quick reference 9-35
Quotations tab 9-35
RFQ Lines tab 9-35
RFQ tab 9-35
Terms and Conditions tab 9-35
Vendors tab 9-35

requestor 12-2
requests for quotation

adding vendors 9-36
awarding quotation lines 9-37
companies and 9-34
contracts and 9-34
creating 9-36
creating PO from 9-37
managing 9-37
purchase orders and 9-34
purchase requisitions and 9-34
recording quotation lines 9-37
statuses 9-37

requisitioning
spare parts 9-28
vendor items 9-28

RESOLVED status 12-12
result set 2-19
Results subtab 2-14
Return link 2-3
Return with Value link 2-3
REVISD status 4-5
RFQ Lines tab 9-35
RFQ See requests for quotation
RFQ tab 9-35

rotable spares See rotating assets
rotables See rotating assets
Rotating Asset tab 6-8
rotating assets 3-6, 3-11, 6-20
rotating equipment See rotating assets
rotating items 3-6, 6-20

creating 6-24
information technology assets and 6-25

rotating parts See rotating assets
Rotating Tool Assets tab 6-31
Route tab 7-9
routes

applying 7-9, 14-37
creating 7-10
managing 7-10

Routes application 7-8
accessing 7-9
List tab 7-9
Multisite and 7-9
quick reference 7-10
Route tab 7-9

Row Details 2-23
rows 1-7

check boxes 2-14
displaying additional 2-20
selecting 2-14

S

Safety Plan tab
Safety Plans 11-14
Work Order Tracking 14-29

safety plans
adding to work orders 14-33
assets and 11-12
associating hazardous materials 11-16
associating hazards 11-16
associating precautions 11-16
creating 11-15
duplicating 11-16
hazards and 11-12
job plans and 11-13
listing tag outs 11-16
locations and 11-12
managing 11-17
precautions and 11-13
tag outs and 11-13
work orders and 11-13

Safety Plans application 11-12
accessing 11-14
Hazardous Materials tab 11-14
Hazards and Precautions tab 11-14
List tab 11-14
Multisite and 11-12
quick reference 11-14
Safety Plan tab 11-14
Tag Outs tab 11-14

safety stock 6-12
Safety tab

Assets 3-9
Locations 3-27

salvage location 3-26
Save button 2-17
Save Current Query button 2-8
Save Query button 2-7
saved queries 2-8, 2-9
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SCHED status 9-18
Search Solutions application B-4
Search Toolbar 2-7
searching 2-6

advanced 2-13
Advanced Search button 2-13
basic 2-8
null values 2-12
toolbar 2-7
using saved queries 2-8
using SQL WHERE clause 2-13
using the Find field 2-9
using wildcard characters 2-12
viewing results 2-14

Seasonal Dates tab
Master PM 8-3
Preventive Maintenance 8-10

sections 2-18
security

overview 1-12
passwords 1-13

segment 2-38
Select Action menu 2-16
Select Date and Time button 2-11
Select Date button 2-11, 2-30
Select Items for Transfer button 6-18
Select Labor button 14-33
Select Labor Query action 14-8
Select Materials button 14-33
Select PO Items button 6-18
Select Row check box 2-14
Select Spare Parts button 9-28
Select Tools button 14-33
Select Value button 2-11, 2-31
Select Work Date button 14-11
Select Work Orders button 14-36
semicolons 2-11
SENT status 9-38
sequence

job plan 7-5
Lock Out apply 11-8
Lock Out remove 11-8
route 7-10
work order task 14-33

serialized assets See rotating assets
serialized equipment See rotating assets
service catalog

assets and 13-2
contracts and 13-2
creating service groups 13-4
creating services 13-5
deleting services 13-5
locations and 13-2
managing 13-5
purchasing and 13-2
related records 13-5
Service Desk and 13-3
service group types 13-4
service level agreements and 13-3

Service Catalog application 13-1
accessing 13-3
List tab 13-3
Multisite and 13-2
quick reference 13-3
Service Group tab 13-3

service contracts 4-3, 4-22
service desk 12-1

agent 12-2
terminology 12-2

Service Group tab 13-3
service items

creating records 6-29
job plans and 6-28
managing 6-29
purchasing 6-28
work orders and 6-28

Service Items application 6-27
accessing 6-28
List tab 6-28
Multisite and 6-27
quick reference 6-28
Service tab 6-28

Service Level Agreement tab 13-8
service level agreements

assets and 13-6
contracts and 13-7
creating 13-10
deleting 13-11
escalations and 13-7
locations and 13-6
managing 13-11
ranking 13-10
related SLAs 13-10
statuses 13-11
tickets and 13-7
types 13-6
work orders and 13-8

Service Level Agreements application 13-5
accessing 13-8
Assets and Locations tab 13-8
buttons 13-9
Escalation tab 13-8
KPIs tab 13-8
List tab 13-8
Multisite and 13-6
quick reference 13-9
Related SLAs tab 13-8
Service Level Agreement tab 13-8

service organization 12-2
service receipts 9-32
Service Receipts tab 9-31
Service Request tab 12-34
service requests

Create Service Request application B-7
creating (self-service) B-6
creating (Service Desk) 12-36
creating from e-mail B-8
creating from Search Solutions B-6
managing 12-36
modifying (self-service) B-8
searching (self-service) B-8
self-service B-5
self-service module B-3
statuses 12-12
View Service Request application B-8

Service Requests application 12-33
accessing 12-34
buttons 12-34
List tab 12-34
Log tab 12-34
Multisite and 12-34
quick reference 12-34
Related Records tab 12-34
Service Request tab 12-34

Service tab 6-28
service tickets See tickets
services

See also service items
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defining job plan services 7-6
Sets (Multisite) 1-11, 6-19
Ship To/Bill To tab

Purchase Orders 9-20
Purchase Requisitions 9-26

Show Assignments button 14-11, 14-14
Show Path to Top button 2-35
Show Table button 2-21, 14-36
Sign Out link 2-3
signing in

to Actuate 2-1
to Maximo 2-1

signing out
of Actuate 2-3
of Maximo 2-3

Site (Multisite) 1-10, 1-12, 3-29
SLA See service level agreements
Software Conversion application 5-3
software license contracts 4-3, 4-20, C-4, C-18

license types C-19
managing license details C-19
monitoring software usage C-20

Software Suite Setup application 5-3
Software tab 5-7
Software Usage Setup application 5-3
Solution Details tab

Incidents 12-23
Problems 12-27

solutions 12-10
creating 12-38
managing 12-38
Search Solutions application B-4
searching B-4
statuses 12-38

Solutions application 12-37
accessing 12-37
List tab 12-37
Multisite and 12-37
quick reference 12-37
Solution tab 12-37

sort key 1-7
spare parts 3-12

in asset assembly structures 3-13
requisitioning 9-28

Spare Parts tab 3-9
special characters 2-11
special order items 6-10
Specifications tab

Assets 3-9
Item Master 6-22
Locations 3-27
Tools 6-37

SQL See Structured Query Language
standard services 9-23

See also service items
Start Assignment

action 14-14
button 14-11, 14-14

Start Center 2-4
components 2-4
defined 2-4
link 2-3
multiple 2-4
portlets 2-4

STARTED status 14-15
status

activity 12-18
asset 3-15
asset up/down status 14-38

assignment 14-15
change 12-22
contract 4-4
desktop requisition B-14
incident 12-26
invoice 9-17
job plan 7-8
labor 10-10
location 3-32
overview 2-44
person records 10-14
preventive maintenance 8-13
problem 12-29
purchase order 9-24
purchase requisition 9-28
qualification 10-21
request for quotation 9-37
service level agreement 13-11
service request 12-36
solution 12-38
ticket 12-12
ticket templates 12-41
work order 12-14, 14-5

stock categories 6-10
stocked equipment See rotating assets
stocked items 6-10
Stocked Tool tab 6-30
stocked tools

creating records 6-32
managing records 6-32

Stocked Tools application 6-30
accessing 6-30
List tab 6-30
Multisite and 6-30
quick reference 6-31
Rotating Tool Assets tab 6-31
Stocked Tool tab 6-30
Vendors tab 6-31
Where Used tab 6-31

stockrooms See storerooms
Storage tab 5-6
Storeroom tab 6-34
storerooms

creating a storeroom record 6-34
inventory and 6-33
items and 6-33
managing 6-35
purchasing and 6-34

Storerooms application 6-33
accessing 6-34
Items tab 6-34
List tab 6-34
Multisite and 6-33
quick reference 6-34
Storeroom tab 6-34

Storerooms tab
Item Master 6-22
Tools 6-37

Structured Query Language 1-8
subassemblies 3-12
subtabs 2-17

Results 2-14
Saved Queries 2-9

SUSPND status 4-5
Swap Asset button 3-9
System (Multisite) 1-9, 1-11
system requirements (Maximo) 2-1
systems (locations) 3-29, 3-30

creating a hierarchical system 3-31
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creating a network system 3-31
viewing 3-32

T

table filter
refining search results 2-10

table window buttons 2-21
See also buttons
Add to Bookmarks 2-22
Clear 2-21
Close Details 2-21
Download 2-21
Filter 2-21
Find 2-21
Help 2-21
Hide Table 2-21
Mark Row for Delete 2-22
New Row 2-22
Next Page 2-21
Next Row 2-21
Previous Page 2-21
Previous Row 2-21
Show Table 2-21
Undo Delete 2-22
View Details 2-21

table windows 2-19
buttons 2-21
creating new rows 2-24
default table data 2-23
editable 2-24
filter 2-14, 2-22
navigating 2-20
paired 2-25
Row Details 2-23
tasks 14-33

tables (database) 1-7
tabs 2-17
tag outs

apply sequence 11-8
assets and 11-7
creating 11-8
hazards and 11-7
locations and 11-7
managing 11-9
safety plans and 11-7
work orders and 11-7

Tag Outs tab
Hazards 11-4
Safety Plans 11-14

Task Filters application 5-4
tasks

defining 7-5, 14-33
task ID 7-5

Template tab 12-39
terms and conditions 9-5

contracts and 4-3, 4-21
creating 4-22
managing 4-22
purchasing and 4-21

Terms and Conditions application 4-20
accessing 4-21
Multisite and 4-21
quick reference 4-21

Terms and Conditions tab
Invoices 9-16

Labor Rate Contracts 4-8
Lease/Rental Contracts 4-11
Master Contracts 4-14
Purchase Contracts 4-17
Purchase Orders 9-20
Purchase Requisitions 9-26
Request for Quotations 9-35
Warranty Contracts 4-24

ticket templates 12-5
creating 12-40
managing 12-40
statuses 12-41
tickets and 12-39

Ticket Templates application 12-39
accessing 12-39
List tab 12-39
Multisite and 12-39
quick reference 12-39
Template tab 12-39

tickets
about 12-3
classes 12-3
classifying 12-6
creating 12-4
deleting 12-13
managing 12-9
managing activities 12-9
Multisite and 12-4
ownership 12-5
priority 12-6
related records 12-6
solutions and 12-10
statuses 12-12
templates 12-5
time management 12-9

tildes (~) 2-12
Tool tab 6-37
toolbar buttons 2-16

See also buttons
Change Status 2-17
Clear Changes 2-17
Create KPI Option 2-17
New Record 2-17
Next Record 2-17
Previous Record 2-17
Save Record 2-17

toolbars
browser 2-2
Maximo 2-15
Search 2-7

tools
assets and 6-36
creating records 6-38
defining job plan tools 7-6
deleting 6-38
duplicating tool records 6-38
managing records 6-38
stocked tools and 6-36
work orders and 6-36

Tools application 6-35
accessing 6-36
List tab 6-36
Multisite and 6-35
quick reference 6-37
Specifications tab 6-37
Storerooms tab 6-37
Tool tab 6-37
Vendors tab 6-37

Transfer In tab 6-16
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Transfer Out tab 6-16

U

underpinning agreement 13-6
Undo Delete button 2-22
upper action limit 3-19
upper warning limit 3-19
user name 2-1, 2-4

self-registration B-1
user record 10-1
users and custodians

assets 3-14
Users tab 5-7

V

Vendor Items button 9-28
vendor location 3-26
vendors

disqualifying 9-11
Vendors tab

Item Master 6-22
Request for Quotations 9-35
Stocked Tools 6-31
Tools 6-37

View Costs action 14-35
View Details button 2-21, 2-23
View Search Tips button 2-7
View Work Order & PMs button 2-35
View/Manage Queries button 2-8

W

WAITASGN status 14-15
WAPPR status 4-4, 9-17, 9-24, 9-28, 12-14, 14-6
warranty contracts 4-3

adding contract lines 4-25
adding meter lines 4-25
associating assets with 4-25
company records and 4-23
creating 4-24
duplicating 4-25
invoices and 4-23
managing 4-25
work orders and 4-23

Warranty Contracts application 4-22
accessing 4-23
Associated Assets tab 4-24
Contract Lines tab 4-24
Contract tab 4-24
List tab 4-24
Multisite and 4-23
Properties tab 4-24
quick reference 4-24
service contracts 4-3, 4-22
Terms and Conditions tab 4-24
warranty contracts 4-3, 4-22

WHERE Clause button 2-7
Where Used tab

Inventory 6-8
Meters 3-36
Stocked Tools 6-31

wildcard characters 2-12
placement 2-12
using 2-12

WMATL status 12-14, 14-6
work assets 7-7
Work Assets tab 7-3
Work List (Assignment Manager) 14-9

filtering 14-10
work log

tickets 12-11
work order 14-40

Work Order tab 14-29
Work Order Tracking application 14-24

accessing 14-29
Actuals tab 14-29
Failure Reporting tab 14-29
List tab 14-29
Log tab 14-29
Multisite and 14-24
Plans tab 14-29
quick reference 14-29
Related Records tab 14-29
Safety Plan tab 14-29
Work Order tab 14-29

work orders
adding children to the hierarchy 14-36
applications used to create 14-2
applying routes to 14-37
assets and 14-25
building a WO hierarchy 14-36
building hierarchy on Plans tab 14-37
change status 14-37
classes 12-3, 14-2
contracts and 14-25
corrective 14-3
creating (Quick Reporting) 14-23
creating (Service Desk) 12-13
creating (Work Order Tracking) 14-32
deleting 14-41
dispatching 14-14
duplicating 14-34
emergency 14-3
entering meter readings 14-38
event report 14-3
generating a PM work order 8-13
generating hierarchy from PM hierarchy 14-37
hierarchy 14-34
hierarchy terms 14-35
inventory and 14-25
issues and transfers and 14-26
job plans and 14-26
labor and 14-27
locations and 14-25
logs 14-40
managing (Quick Reporting) 14-23
managing (Service Desk) 12-14
managing (Work Order Tracking) 14-34
meters and 14-27
Multisite and 12-4
ownership 14-5
preventive maintenance and 14-27
preventive maintenance type 14-3
priority 14-4
purchasing and 14-27
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About This Guide

This guide explains how to use Maximo� Project Manager to exchange 
information between Microsoft® Project and Maximo, and how Maximo 
Project Manager enhances Microsoft Project. 

Maximo Project Manager users must be familiar with Microsoft Project and 
Maximo.

Audience

This guide lets planners, forecasters, and other managers use Microsoft 
Project to plan and schedule Maximo data.

Related Documentation

 

Support

MRO Software, Inc. users with a valid Annual Customer Support Plan (ACSP) 
can obtain online product support at 
http://support.mro.com.

The Support Web site includes information about product releases, software 
patches, and documentation updates. To find the most current version of a 
document, see the Support Web site�s Knowledge Base.

Document Description

Online help Provides instructions for using the 
application.

Maximo Project Manager 
Installation Guide

Provides information about:

! System requirements

! Preparations for a successful 
installation

! Installation instructions
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Maximo Project Manager adds a Maximo menu to the Microsoft Project menu 
bar, so you can:

! Map work order and PM data from the MAXIMO database to Microsoft 
Project.

! Create Maximo work orders from tasks that you created in Microsoft 
Project

! Filter work order, PM, and calendar data from the MAXIMO database.

Maximo Menu

o

After filtering the Maximo data, you can perform project planning tasks with 
the Maximo work orders and save schedule data back to existing work orders 
in the MAXIMO database.

Starting Maximo Project Manager

When you open Maximo Project Manager, the Maximo Project Manager 
Startup dialog box opens.

Maximo Project Manager 
Overview 1
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Select the type of project to work on in Microsoft Project:

Option Description

New Maximo Project Opens a new session in Microsoft Project that 
creates Maximo work orders when you select 
Maximo > Save WO to Maximo.

Load Maximo Work 
Order

Opens a Maximo project in Microsoft Project 
that displays work orders.

The Select Work Orders dialog box opens so 
you can transfer work order data from 
Maximo into Microsoft Project.

Load Maximo PM Opens a Maximo project in Microsoft Project 
that forecasts certain PMs.

The Select PMs dialog box opens so you can 
transfer PM data from Maximo into Microsoft 
Project.

Cancel Opens standard Microsoft Project, without 
Maximo Project Manager�s functionality.
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Using Maximo Data in Microsoft Project

These procedures show how to transfer work order or PM data from a 
MAXIMO database into Microsoft Project.

Process Overview

These steps summarize how to create a project in Microsoft Project using 
Maximo data:

1 Create and save a Maximo query.

2 Create a new project in Microsoft Project.

3 Log in to Maximo from Microsoft Project.

4 Select a Maximo work order or PM query.

5 Modify the project.

6 If you selected a work order query, return schedule data and insert new 
work orders into the MAXIMO database.
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Creating a Project in Microsoft Project Using Maximo Data

1 In Maximo�s Work Order Tracking or Preventive Maintenance application, 
create and save a query.

2 In Microsoft Project, open a new Maximo project.

3 In the Maximo Project Manager Startup dialog box, click New Maximo 
Project.

The Log In to Maximo dialog box opens.

4 Enter the user name and password for your MAXIMO database.

NOTE You can set default login values for the Log In to Maximo dialog 
box in the MaximoProject.ini file.

5 Click OK.

6 Select the type of data to transfer from Maximo to Microsoft Project:

! To transfer work order data, select Maximo > Select Work Orders.

! To forecast PMs in Microsoft Project, select Maximo > Select PMs.

The Select Work Orders or Select PMs dialog box opens.

7 Click the row containing the appropriate query. You see only public 
queries and queries you created.

! To filter the results, click the Advanced tab.

! To preview the results, click the Preview tab.

8 After selecting the appropriate query, click OK to transfer the work order 
or PM data, including assignments, craft and tool resources, and resource 
availability.

NOTE The results may differ when using the same query in Maximo 
and Maximo Project Manager.

9 Use Microsoft Project to perform project planning and management tasks.

10 Save the project in a Microsoft Project file (.MPP) so you can schedule or 
update it later.
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11 (Optional) To save the data back to Maximo, select Maximo > Save WO 
to Maximo.

NOTE If the active project includes several subprojects, all work order 
data is saved to Maximo. However, if the active project includes PM 
subprojects and work order subprojects, only the work order data is 
saved.

12 (Optional) To update the saved project from Maximo, select Maximo > 
Update Work Orders.

Difference in Maximo and Maximo Project Manager Query Results

The results may differ when using the same query in Maximo and Maximo 
Project Manager.

Maximo Maximo Project Manager

Displays only the selected 
work orders or PMs.

Displays the parent and its entire child 
hierarchy, providing a more comprehensive 
and accurate schedule.
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Using the Maximo Menu

Maximo Project Manager adds Maximo menu options and dialog boxes to 
Microsoft Project. 

Select Work Orders

You use this dialog box:

! To display public queries and queries you saved in Maximo�s Work 
Order Tracking application. The available queries depend on the sites 
you have access to.

! To preview the results of a query.

This dialog box contains these tabs:

Queries Tab You use this tab to display public queries and queries you saved in Maximo�s 
Work Order Tracking application.
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Advanced Tab You use this tab:

! To filter the query results by site, task priority, work order status, and 
date.

! To determine whether to retrieve asset and labor calendars from 
Maximo.

Preview Tab You use this tab to check the results of the selected query. The results may 
differ when using the same query in Maximo and Maximo Project Manager.
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To select work orders:

1 In Microsoft Project, select Maximo > Select Work Orders.

The Select Work Orders dialog box opens, displaying the Queries tab.

2 Click the row containing the appropriate query. You see only public 
queries and queries you saved in Maximo.

3 Click the Advanced tab to filter the query results. Use these subtabs:

! Constraints: Select a scheduling constraint for your project. You may 
select only one constraint type.

NOTE Use this option to use Maximo�s Schedule or Target date to 
schedule the work order in Microsoft Project.

NOTE You can only constrain tasks that are not summaries of other 
tasks. Mixing child and parent constraints can violate Microsoft 
Project�s business rules and cause problems with work order 
transfers.

In practice, when you constrain work orders, Maximo Project 
Manager uses that constraint on all tasks at the lowest 
hierarchical level.

To manipulate groups of tasks, transfer the parent tasks from 
Maximo, then set the constraints in Microsoft Project.

Constraints Procedure Description

Work Order Date Select a work order date: Scheduled Start, 
Scheduled Finish, Target Start, Target 
Finish.

NOTE Leaving this field blank disables the 
Task Constraint Type field.

Constrains the task by 
scheduling or targeting the 
work order�s start and finish 
dates.

Task Constraint Type Select a constraint type: Must Start On, 
Start No Earlier Than*, Start No Later 
Than, Must Finish On, Finish No Earlier 
Than*, or Finish No Later Than.

*Recommended selections

NOTE The available selections depend on the 
date in the Work Order Date field.

Constrains the task by 
starting or finishing it on 
specified dates.
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! Calendars: Transfer Maximo asset and labor calendars to Microsoft 
Project. Enter specific dates within which to transfer the calendars.

NOTE Transferring calendar data can significantly impact 
performance; make the date range as small as possible.

NOTE When you transfer asset calendars into Microsoft Project, they 
are the inverse of what they are in Maximo.

Maximo�s asset calendar displays when the asset is operating. 
Microsoft Project�s asset calendar displays the asset�s downtime 
(when it is available for preventive maintenance).

Upon receiving the asset calendar from Maximo, Maximo 
Project Manager names the calendar with the asset number, 
and makes the asset calendar an attribute of the work order 
being scheduled.

! Task Priority: Filter the query results by work order, calculated, or 
location/asset priority. When Maximo�s work orders are copied to 
Microsoft Project, they become tasks and are assigned a priority based 
on Maximo�s priority setting for the work order. 

Select one setting (which uses the value from a column of the MAXIMO 
database�s WORKORDER table):

! Filter: Include only child work orders of the specified status(es) in 
your results set.

Select each status to include. To select all statuses, click All. To clear 
all statuses, click None.

! Site: Include child work orders for the specified sites in your results 
set.

Select each site to include. To select all sites, click All. To clear all 
sites, click None.

4 To preview the results, click the Preview tab.

5 After selecting the appropriate query, click OK to transfer the work order 
data, including assignments, craft and tool resources, and resource 
availability from Maximo to Microsoft Project.

NOTE The results may differ when using the same query in Maximo and Maximo 
Project Manager.

Maximo Priority Field Column Description

Work Order WOPRIORITY (Default) This is the priority level of the 
work order assigned in the work order or 
by a job plan.

Calculated Priority CALCPRIORITY Maximo calculates this value using a 
formula combining the Work Order 
Priority and Location/Asset Priority values 
to produce the Work Priority value.

Location/Asset Priority ASSETLOCPRIORITY This is the priority level of the asset or 
location specified on a work order.
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Select Work Orders Dialog Box

This dialog box contains these elements:

Tab Element Description

Queries Clause Name Displays the names of public queries and the 
queries you created in Maximo�s Work Order 
Tracking application.

Description Displays the descriptions of the queries.

Advanced: 
Constraints subtab

Work Order Date Displays these work order date selections:

! Scheduled Start

! Scheduled Finish

! Target Start

! Target Finish

Select one of the preceding items. If a given work 
order has a value in the selected date field, that 
value becomes a constraint for the corresponding 
task.

Leaving this field blank disables the Task 
Constraint Type field.

Task Constraint Type Lists these constraint types for your project, 
depending on the selection you made in the Work 
Order Date field:

! Must Start/Finish On

! Start/Finish No Earlier Than

! Start/Finish No Later Than

Select one of the preceding items.

You can only constrain tasks that are not 
summaries of other tasks. Mixing child and parent 
constraints can violate Microsoft Project�s business 
rules and cause problems with work order 
transfers.

In practice, when you constrain work orders, 
Maximo Project Manager uses that constraint on 
all tasks at the lowest hierarchical level.

To manipulate groups of tasks, transfer the parent 
tasks from Maximo, then set the constraints in 
Microsoft Project, after transferring the work 
orders.
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Advanced: 
Calendars subtab

Transfer Asset Calendars Select this option to transfer the Maximo calendars 
associated with assets.

Transfer Labor Calendars Select this option to transfer the Maximo calendars 
associated with labor.

From
To

Select start and end dates to transfer asset and 
location calendars.

Advanced: Task 
Priority subtab

These elements use 
values from a 
column of the 
MAXIMO 
database�s 
WORKORDER 
table.

! Work Order Priority
Column: WOPRIORITY

(Default) This is the priority level of the work order 
assigned in the work order or by a job plan.

! Calculated Priority
Column: CALCPRIORITY

Maximo calculates this value using a formula 
combining the Work Order Priority and the 
Location/Asset Priority values to produce the Work 
Priority value.

! Location/Asset Priority
Column: 
ASSETLOCPRIORITY

The priority level of the asset or location is 
specified on a work order.

Advanced: Filter 
subtab

Value Displays the work order�s status list.

When you transfer work orders from Maximo to 
Microsoft Project, only child work orders with the 
selected statuses are transferred with their parent 
work order. Parent work orders are not restricted 
by filtering the child status.

For example, if your query transfers a work order 
hierarchy into Microsoft Project, and the work is in 
progress, you can choose to transfer only open work 
orders in the work structure.

Description Displays descriptions of the work order statuses.

All Selects all statuses. Clear any statuses you do not 
want to include in the work order data.

None Clears all selected statuses.

Advanced: Site 
subtab

Site ID Displays the sites available to you. When you 
select a site, any child work orders for that site are 
transferred to Microsoft Project.

Description Shows site descriptions.

All Selects all sites.

None Clears all selected sites.

Preview Tree View Displays a list of selected work orders. To display 
or close sub-levels in the hierarchy, click + or � to 
the left of the current top-level work order.
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Update Work Orders

You use the Update Work Orders dialog box to periodically update a set of 
work orders displayed in a current Microsoft Project session with the latest 
Maximo data.

Maximo Project Manager matches the data from the incoming work orders to 
the existing work orders and updates Microsoft Project with the incoming 
Maximo data.

NOTE To make extensive changes to the structure of a project or transfer a new 
hierarchy from Maximo, create a new project instead.

This menu option works as follows:

! If a Maximo work order exists as a task in Microsoft Project, data from the 
Maximo work order updates the task in Microsoft Project.

! If a Maximo child work order is not a task in the current project, a new 
child work order is added to Microsoft Project as a subtask, placed after all 
the parent�s existing children. No links are established for new child work 
orders.

! New top-level work orders in Maximo are not transferred to Microsoft 
Project.

To update work orders:

1 In Maximo�s Work Order Tracking or Preventive Maintenance application, 
create and save a query.

2 In Microsoft Project, display the appropriate project.

3 Select Maximo > Update Work Orders. Maximo updates work order 
and task data in Microsoft Project. The updated data displays in the 
project.

All tabs OK Transfers the selected work order data, including 
assignments, craft, people, and tool resources, and 
their calendars to Microsoft Project.

The results may differ when using the same query 
in Maximo and Maximo Project Manager.

! Maximo displays only the selected work orders 
or PMs.

! Maximo Project Manager displays the parent 
and its entire child hierarchy, providing a more 
comprehensive and accurate schedule.

Cancel Closes the dialog box.

Help Opens the help topic for the dialog box.
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Save Work Orders to Maximo

The Save WO to Maximo menu option is available only when the current 
project in Microsoft Project is a work order project.

You use this dialog box to return scheduling data to the MAXIMO database. 
Tasks that you created in Microsoft Project are inserted into the MAXIMO 
database as Maximo work orders.

This data is updated in Maximo:

! A work order�s scheduled dates (SCHEDSTART and SCHEDFINISH) from 
the corresponding task�s start and finish dates.

! A work order�s estimated duration (ESTDUR) from the corresponding 
task�s Duration.

! Other data as specified in the [wofieldmap] section of the 
MaximoProject.ini file.

To save work orders to Maximo:

1 In Microsoft Project, display the project whose data you want to save back 
to Maximo.

2 Select Maximo > Save WO to Maximo.

The Save Work Orders to Maximo dialog box opens.

NOTE An error indicates any rejected work orders. Possible causes 
include:

! Work order status (if it is cancelled, completed, or closed).

! Date format (if the one in Microsoft Project does not match the 
client workstation�s locale setting).

3 Click OK. 

Maximo Project Manager updates the work order data in Maximo.

NOTE If the active project includes several subprojects, all work order data is saved 
to Maximo. However, if the active project includes PM subprojects and work 
order subprojects, only the work order data is saved. Maximo ignores the PM 
data.



Using the Maximo Menu

1-14 Maximo 6, 07/2006

Save Work Orders to Maximo Dialog Box

This dialog box contains these elements:

Select PMs

You use this dialog box to select public queries and queries you saved in 
Maximo�s Preventive Maintenance application.

Forecasting works only on top-level PMs, which forecast the complete 
hierarchical structure. Build your queries accordingly.

NOTE Work orders are not created in the MAXIMO database, only forecasted as 
tasks for analysis in Microsoft Project.

This dialog box contains these tabs:

Queries Tab You use this tab to display public queries and queries you saved in Maximo�s 
Preventive Maintenance application.

Element Description

Help Opens the help topic for the dialog box.

OK ! Saves the work order data from Microsoft Project to 
the MAXIMO database.

! Inserts tasks that you created in Microsoft Project 
into the MAXIMO database as Maximo work orders.

Close Does not save any data to Maximo.
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Advanced Tab You use this tab:

! To determine the period for which Maximo Project Manager will 
forecast preventive maintenance records.

! To filter the results for child PMs by site.

! To determine whether to retrieve asset and labor calendars from 
Maximo.

Preview Tab You use this tab to check the results of the selected query. The results may 
differ when using the same query in Maximo and Maximo Project Manager.
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To select PMs:

1 In Microsoft Project, select Maximo > Select PMs.

The Select PMs dialog box opens, displaying the Queries tab.

2 Click the row containing the appropriate query.

3 To filter the results, click the Advanced tab.

Use these subtabs to filter your query.

4 To preview the results, click the Preview tab. The results may differ when 
using the same query in Maximo and Maximo Project Manager.

5 After selecting the appropriate query, click OK to transfer the PM data, 
including assignments, craft, people, and tool resources, and their 
calendars from Maximo to Microsoft Project.

Subtab Description

Forecast Use this subtab to determine the period for which Maximo Project Manager will 
forecast PMs.

Each option forecasts a set of PM work orders from the selected top-level PM 
hierarchy, then populates Microsoft Project with the work order data.

! Generate Once, without frequency criteria: starts from today�s date.

! Forecast repeatedly until: starts from today�s date until the date you enter.

NOTE The number of sets of work orders forecasted depends on the controlling 
frequency of the hierarchy. Any PM in the hierarchy can trigger all PMs to 
be forecasted as a set.

NOTE Maximo Project Manager only forecasts PMs with ACTIVE status in 
Maximo.

Calendars Use this subtab to transfer Maximo asset and labor calendars to Microsoft Project. 
Enter specific dates within which to transfer the calendars.

NOTE Transferring calendar data can significantly impact performance; make the 
date range as small as possible.

NOTE When you transfer asset calendars into Microsoft Project, they are the 
inverse of what they are in Maximo.

Maximo�s asset calendar displays when the asset is operating. Microsoft 
Project�s asset calendar displays the asset�s downtime (when it is available 
for preventive maintenance).

Upon receiving the asset calendar from Maximo, Maximo Project Manager 
names the calendar with the asset number, and makes the asset calendar 
an attribute of the work order being scheduled.

Site Use this subtab to include child PMs for the specified sites in your results set.

Check the box for each site to include. To select all sites, click All. To clear all sites, 
click None.
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Select PMs Dialog Box

This dialog box contains these elements:

Tab Element Description

Queries Clause Name Displays the names of public queries and the queries you 
created using Maximo�s Preventive Maintenance 
application.

Description Displays the descriptions of the queries.

Advanced: 
Forecast subtab

Determines the period for which Maximo Project Manager 
will forecast PMs.

Generate Once, 
without frequency 
criteria

Starts from today�s date.

Forecast repeatedly 
until

Starts from today�s date until the date you enter. 

NOTE The number of work order sets forecasted 
depends on the controlling frequency of the 
hierarchy. Any PM in the hierarchy can trigger 
all work orders to be forecasted as a set.

NOTE If all the next due dates on the queried PMs are 
after the date you enter in the Forecast 
repeatedly until field, a message indicates that 
no work orders are forecasted.

Advanced: 
Calendars 
subtab

Transfer Asset 
Calendars

Select this option to transfer the Maximo calendars 
associated with assets.

Transfer Labor 
Calendars

Select this option to transfer the Maximo calendars 
associated with labor.

From
To

Select start and end dates from which to transfer asset and 
location calendars.

Advanced: Site 
subtab

Site ID Displays your available sites. If you select a site, child PMs 
from that site are transferred from Maximo to Microsoft 
Project.

Description Displays site descriptions.

All Selects all sites.

None Clears all selected sites.

Preview Tree View Displays a list of selected PMs. To display or close sub-levels 
in the hierarchy, click + or � to the left of the current top-
level PM.
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Load Resources

You use this dialog box to transfer crafts, tools, and labor from Maximo into 
Microsoft Project. The resources then display in Microsoft Project�s Resource 
Information dialog box.

NOTE If you are a Maximo Transmission & Distribution customer, you can also 
transfer crew and crew type data from Maximo.

To load resources:

1 In Microsoft Project, select Maximo > Load Resources.

The Load Resources dialog box opens.

NOTE Maximo Transmission & Distribution customers will see two 
additional check boxes, one for Crews, and one for Crew Types.

2 Select the item(s) to transfer. You can transfer crafts, labor, tools, or any 
combination of the three.

3 Click OK.

Maximo Project Manager closes the dialog box and transfers the selected 
items from Maximo to Microsoft Project. The transferred data displays in 
Microsoft Project�s Resource Information dialog box.

All tabs OK Populates Microsoft Project with the selected PM data from 
the MAXIMO database.

The results may differ when using the same query in 
Maximo and Maximo Project Manager.

! Maximo displays only the selected work orders or PMs.

! Maximo Project Manager displays the parent and its 
entire child hierarchy, providing a more comprehensive 
and accurate schedule.

Cancel Closes the dialog box.

Help Opens the help topic for the dialog box.
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Load Resources Dialog Box

This dialog box contains these elements:

** Maximo Transmission & Distribution customers only

Element Description

! Crafts

! Labor

! Tools

! **Crew Types

! **Crews

Select the item(s) to transfer data from Maximo to 
Microsoft Project.

OK Transfers the selected resources from Maximo to 
Microsoft Project.

Cancel Closes the dialog box without retrieving any data 
from Maximo.

Help Opens the help topic for the dialog box.
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Maximo Project Manager�s additions to Microsoft Project let you apply 
resource leveling and specialized scheduling tasks to Maximo work order and 
PM data. After modifying the project, you can return schedule dates to 
existing Maximo work orders.

These examples use Maximo Project Manager to manage craft availability for 
work orders and PMs.

Planning Work for a Shutdown Period

Example 1: A Specific Location

Suppose several of your pending hierarchical work order projects must be 
done in specific locations. To schedule those projects eligible to be included in 
a shutdown period beginning December 10:

1 In Maximo�s Work Order Tracking application, create a work order 
hierarchy containing all shutdown details. Assign the top-level work 
orders a Work Order Type of CP, for a capital project.

2 In the Work Order Tracking application, create and save a query. Select 
these values:

3 Log in to Microsoft Project.

4 Select Maximo > Select Work Orders.
The Select Work Orders dialog box opens.

5 On the Queries tab, select the appropriate query.

6 To preview the work order set, click the Preview tab.

NOTE (Optional) To modify your query, return to Maximo.

7 To retrieve the Maximo data, click OK.

Maximo Project Manager 
Scenarios 2

Field Value

Work Order Type CP

Scheduled Start December 10, 2005
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8 Use Microsoft Project to resource level the project and adjust the work 
order dates.

9 In Microsoft Project, add another task to the Gantt chart, including a 
description and duration.

10  Select Maximo > Save WO to Maximo.

The schedule dates update the work orders in the MAXIMO database, for 
use by Work Order Tracking.

Tasks you created in Microsoft Project are inserted into Maximo as work 
orders.

Example 2: Using Customized Maximo Fields

Suppose your MAXIMO database is customized so the first set of extra work 
order fields is used to make a Yes or No selection field called Shutdown 
Required. You then can create a project in Microsoft Project and filter for a 
list of work orders that have this field set to Yes. 

1 In Maximo�s Work Order Tracking application, create a work order query 
to meet your criteria.

2 Log in to Microsoft Project.

3 Select Maximo > Select Work Orders.

The Select Work Orders dialog box opens.

4 On the Queries tab, select the appropriate query.

5 To preview the new work order set, click the Preview tab.

NOTE (Optional) To modify your query, return to Maximo.

6 To retrieve the Maximo data, click OK.

7 Use Microsoft Project to resource level the project and adjust the work 
order dates.

8 Work with the Shutdown Required work orders in Microsoft Project to 
create a schedule for the work that must be done during a defined 
shutdown period.

9  Select Maximo > Save WO to Maximo.

The schedule dates update the work orders in the MAXIMO database, for 
use by Work Order Tracking.

Tasks you created in Microsoft Project are inserted into Maximo as work 
orders.

Refreshing the Shutdown 
Project Data

You must refresh this project weekly to include new Maximo work orders in 
the Work Shutdown schedule. To run the update, select the same query used 
to create the original project.

10 In Microsoft Project, open the current project.



Chapter 2: Maximo Project Manager Scenarios

Maximo 6, 07/2006 2-3

11  Select Maximo > Update Work Orders.

12 Repeat Steps 3-9 of this procedure. When you launch the query, the project 
updates with current Maximo data.

The task data in Microsoft Project will reflect changes to the original work 
orders and will insert new work orders that meet the query criteria.

Evaluating Schedule Dates of the Shutdown Project

In an ongoing project, you often want to compare the current schedule dates to 
those from the last scheduling session or to the original target dates. 

Filtering, highlighting, or reporting on date variances in Microsoft Project 
helps you see which tasks are slipping behind schedule from one scheduling 
session to the next.

To compare dates:

1 In the MaximoProject.INI file, map the TARGSTARTDATE and 
SCHEDSTART fields in the MAXIMO WORKORDER table to the spare 
date fields in Microsoft Project (example: Date1 and Date2).

2 In Microsoft Project, create a filter to compare dates.

3 In your open session (showing the latest update from Maximo and the 
latest schedule calculation), select the new filter and click Highlight. 

All tasks showing slippage are highlighted.

Scheduling a Work Order Backlog

With Maximo Project Manager, you can manage a pending work order backlog 
for a location. Suppose many corrective maintenance work orders are 
backlogged for the Shipping location.

You want to create a project schedule that includes only work orders that are 
approved, waiting for approval, or waiting to be scheduled.

1 In Maximo�s Work Order Tracking application, create a work order query 
to filter for work orders meeting these criteria: 

! Work Order Type = CM

! Status = APPR, WAPPR, and WSCHED

! Location = Shipping

2 Log in to Microsoft Project.

3 Select Maximo > Select Work Orders.

The Select Work Orders dialog box opens. 

4 Select the appropriate query.
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5 To preview the selected Maximo data, click the Preview tab.

6 Click OK.

Maximo Project Manager retrieves the work order data from Maximo and 
transfers it into Microsoft Project.

7 Use Microsoft Project to resource level the project. 

8 Select Maximo > Save WO to Maximo.

The Save Work Orders to Maximo dialog box opens.

9 Click OK to save the schedule dates back to the work orders in the 
MAXIMO database, for use by Work Order Tracking.

Holding the Schedule Dates from Session to Session

You can hold the schedule dates for a set of work orders from session to 
session.

Suppose that you manually place the backlog tasks on the Microsoft Project 
Gantt chart where you want them to be done, but don�t want the dates 
overridden by a Microsoft Project schedule calculation.

1 In the next Maximo Project Manager session, select Maximo > Select 
Work Orders.

The Select Work Orders dialog box opens.

2 Click the Advanced tab.

3 Click the Constraints subtab. Choose an appropriate combination of Work 
Order Date and Task Constraint Type.

NOTE Recommended selection: Start No Earlier Than.

4 Click OK.

Microsoft Project assigns the date constraints according to your 
specifications.

NOTE Only the lowest-level tasks in any hierarchy of the project receive 
constraints, which roll up the hierarchy. To constrain a branch of a 
hierarchy, constrain its first detailed subtask.
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Creating a Preventive Maintenance Workload Forecast

You can use Microsoft Project to plan the human resources requirements for 
planned maintenance and for future preventive maintenance projects.

1 In Maximo�s Preventive Maintenance application, create a PM query.

2 Log in to Microsoft Project.

3 Select Maximo > Select PMs.

The Select PMs dialog box opens. 

4 On the Queries tab, select the appropriate query.

5 Click the Advanced tab. On the Forecast subtab, select Forecast 
repeatedly until. Select a date in the future until which you want to 
forecast PMs. 

NOTE If all the next due dates on the queried PMs are after the date you 
specify in the Forecast repeatedly until field, no work orders 
will be forecasted, and a message will appear telling you so.

6 To preview the selected Maximo data, click the Preview tab.

7 Click OK. 

Maximo Project Manager retrieves the PM data from Maximo and 
transfers it into Microsoft Project.

8 Use Microsoft Project to review your future workload and look for conflicts 
between craft availability and work.

9 Resource level future work projects to see what the realistic dates for the 
work orders are, making any manual adjustments to the work order dates. 
Decide how to fix schedule overruns, add or subtract crafts, assign 
dependencies, etc.

10 Save the resulting project file as reference data.
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Creating a Resource Leveled Total Workload Schedule

Use Microsoft Project to combine multiple .mpp files containing work order 
and PM data from your MAXIMO database. You can save the resulting project 
file as reference data.

Example 1

To consolidate projects quickly, view them together.

1 Open both projects individually in Microsoft Project.

2 Select Window > New Window. The New Window dialog box 
opens.

3 Press Shift + click to select the projects. Both projects are 
highlighted.

4 Press OK to view them together in a new window.

Example 2

To establish more permanent relationships between projects, consolidate 
them.

1 Select a project to be the master project, and open it.

2 On the Gantt chart, click the row in which to insert the subproject.

3 Select Project > Insert and select the subproject(s) to insert.

For more information on the following, see the Microsoft Project 
documentation:

! Merging projects

! Inserting subprojects into a master project

! Combining project views

! Sharing resources
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This chapter describes the mapping between MAXIMO database tables and 
Microsoft Project fields.

Default Mapping

Maximo includes these default field mappings between data in its work order 
and PM tables and Microsoft Project�s standard Gantt chart view.

Work Order Tracking Fields

This table describes how Work Order Tracking fields in Maximo are mapped 
to Microsoft Project.

Child Work Orders

Child work orders at the same level of any given work order hierarchy are 
linked together according to their Maximo work order sequence 
(WOSEQUENCE) numbers.

Maximo and Microsoft 
Project Integration Points 3

Maximo Field Microsoft Project Field

Work Order Number (WONUM) Task Notes

Description Task Name

Maximo Field Microsoft Project Field

Child WOs MSP Sub tasks

Task Number 
Sequencing

(WOSEQUENCE) 
determines�

Links

Smaller sequence numbers become 
predecessors to larger sequence numbers. 
Maximo Project Manager creates finish to start 
links between numbered work orders.
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PM Field Mapping

This table describes how PM fields in Maximo are mapped to Microsoft 
Project.

Crafts, Tools, and People

If you assign the same resource multiple times to a task, Maximo Project 
Manager combines the entries by adding the units and taking the maximum 
hours.

For example, suppose a resource appears multiple times in a work plan, and is 
assigned multiple times to the same operation or to the work order itself. The 
entries are combined. The work plan contains these assignments:

Maximo Project Manager assigns three mechanics for eight hours to complete 
the task.

Maximo Field Microsoft Project Field

PM Number (PMNUM) Task Notes

Description Task Name

Labor Code Description Quantity Hours

ME1 Mechanic First Class 2 8:00

ME1 Mechanic First Class 1 6:00
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Crafts 

This table describes how Maximo�s Crafts fields are mapped to Microsoft 
Project.

Tools

This table describes how Maximo�s Tools fields are mapped to Microsoft 
Project.

Maximo Data Microsoft Project Field

Crafts MSP Resources

LABORCODE 
(non-Maximo Transmission & 
Distribution customers)

Resource Name

CREW (Work Group|Crew Type|Crew)
(Maximo Transmission & Distribution 
customers)

Resource Name

NAME Resource Notes

PAYRATE Standard Rate

Payrate x OTscale 
(calculation of these two fields)

Overtime Rate

"CRAFT" Resource Code

Work Plan Labor Assignments

Assignment Work Plan row Assignment

Work Plan quantity (CRAFTQTY) Assignment Units

Work Plan Hours (LABORHRS) x
Work Plan Quantity (CRAFTQTY)
(calculation of these two fields)

Assignment Work Hours

Maximo Data Microsoft Project Field

Tools, from TOOL Table MSP Resources

TOOLNUM Resource Name

Description Resource Notes

Tool Rate Standard Rate

"TOOL" Resource Code

Work Plan Tools Assignments

Assignment Work Plan row Assignment

Work Plan Quantity (TOOLQTY) Assignment Units

Work Plan Hours (TOOLHRS) x
Work Plan Quantity (TOOLQTY)
(calculation of these two fields)

Assignment Work Hours
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People

This table describes how Maximo�s People fields are mapped to Microsoft 
Project.

Scheduling Constraints

To constrain schedules, use the Advanced Options dialog boxes:

1 Define a date constraint:

! Start: Scheduled Start or Target Start

! Finish: Scheduled Finish or Target Finish

2 Define a date constraint type:

! Start: Must Start On, Start No Earlier Than, or Start No Later 
Than

! Finish: Must End On, End No Earlier Than, or End No Later 
Than

NOTE You can only constrain tasks that are not summaries of other 
tasks. Mixing child and parent constraints can violate Microsoft 
Project�s business rules and cause problems with work order 
transfers.

In practice, when you constrain work orders, Maximo Project 
Manager uses that constraint on all tasks at the lowest 
hierarchical level.

To manipulate groups of tasks, transfer the parent tasks from 
Maximo, then set the constraints in Microsoft Project, after 
transferring the work orders.

Maximo Data Microsoft Project Field

People, from PERSON Table MSP Resources

PERSONID Resource Name

DISPLAYNAME Resource Notes

Calendar/Shift (optional) Working Time

Resource Type= "Labor"

Labor Type= "Person"

Work Plan Labor Assignments

Assignment Work Plan row Assignment

Work Plan Quantity Assignment Units

Work Plan Hours Assignment Work Hours
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Maximo�s start and finish date constraints correspond to this Microsoft 
Project task data.

Saved Schedule Date Mapping

After using Maximo Project Manager for planning activities, you can save 
work order scheduling dates to Maximo. Select Maximo > Save WO to 
Maximo.

Data is stored in both applications.

Maximo Start Date Constraints Microsoft Project Task Data

Scheduled Start (SCHEDSTART) ConstraintDate

Target Start (TARGSTARTDATE) ConstraintDate

Maximo Finish Date Constraints Microsoft Project Task Data

Scheduled Finish (SCHEDFINISH) ConstraintDate

Target Finish (TARGCOMPDATE) ConstraintDate

Maximo Start Date Constraint Types Microsoft Project Task Data

Must Start On ConstraintType

Start No Earlier Than ConstraintType

Start No Later Than ConstraintType

Maximo Finish Date Constraint Types Microsoft Project Task Data

Must End On ConstraintType

End No Earlier Than ConstraintType

End No Later Than ConstraintType

Microsoft Project Field Maximo Field

Task Field is saved to... Work Orders

Duration ESTDUR

Start SCHEDSTART

Finish SCHEDFINISH
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Conditional Mapping

This section describes conditional field mapping.

Progress Field Mapping

During data transfer, Maximo uses these conditions to determine the progress 
data to transfer to Microsoft Project.

! If the Maximo Actual Start (ACTSTART) field contains a value, Maximo 
transfers progress-related data to Microsoft Project.

! Otherwise, only the value in the Estimated Duration field is transferred.

Progress Logic Flow

This logic is used during data transfer.

Maximo Field Microsoft Project Field

Estimated Duration (ESTDUR) Duration

Remaining Duration (REMDUR) RemainingDuration

Actual Hours (ACTLABHRS) ActualDuration

Actual Start (ACTSTART) ActualStart

Actual Finish (ACTFINISH) ActualFinish

Condition Result

If there is no ACTSTART ESTDUR ! Duration

If there is an ACTSTART ACTSTART ! Actual Start

If there is an ACTFINISH ACTFINISH ! Actual Finish 

If there is no ACTFINISH These conditions affect the transfer:

! If there is a REMDUR,
REMDUR ! Remaining Duration

! If there is no REMDUR,
ESTDUR ! Duration

! If there are ACTLABHRS,
ACTLABHRS ! Actual Duration
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You can use the MaximoProject.ini file to customize how Maximo and 
Microsoft Project integrate.

Use a text editor to change settings in the MaximoProject.ini file, which is 
located in the MaxProjectClient directory of the computer where you installed 
Maximo Project Manager. 

Customizing Maximo 
Project Manager A

MaximoProject.ini Section Function

[system] (Optional) Sets the login default values and 
automatic login for the Log In to Maximo 
dialog box that connects to the Maximo 
Application Server.

[wofieldmap] Lets you map additional field pairs between 
Microsoft Project and MAXIMO�s work order 
database columns.

[pmfieldmap] Lets you map additional field pairs between 
Microsoft Project and MAXIMO�s PM 
database columns.
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Sections of the MaximoProject.ini File

The MaximoProject.ini file contains the following sections:

! [system]

! [wofieldmap]

! [pmfieldmap]

The fields immediately following the [section name] are the values that define 
Maximo Project Manager�s settings for that section.

Saving Login Settings: The [system] Section

The values in the [system] section define whether you log in to Maximo 
manually or automatically from Microsoft Project.

Sample entry:
[system]
LOGINMODE=Auto
USERNAME=wilson
PASSWORD=wilson

Notes for this section:

LOGINMODE If the LOGINMODE=Auto line is uncommented (does not begin with a semi-
colon ;), the login dialog box does not appear, and you are logged in 
automatically using the system values defined in the MaximoProject.ini file.

USERNAME and 
PASSWORD

You can assign defaults for each login field (User Name and Password). To 
change a default for a field, enter a default value to the right of the equal sign. 

NOTE If no defaults are set, enter values for the User Name and Password fields 
when you log in to the Maximo Application Server.
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Mapping Columns for Data Transfer from Maximo to 
Microsoft Project

The values in the [wofieldmap] and the [pmfieldmap] sections of the 
MaximoProject.ini define which work order or PM data is transferred to 
Microsoft Project. By mapping field pairs between Maximo and Microsoft 
Project, Maximo will transfer data from specified work order or PM columns 
to new fields in the corresponding task in Microsoft Project.

Each specified task field appears as a new column in the Gantt Chart table. 
Select Maximo > Update Work Orders to refresh data in Microsoft Project.

For both sections, each map line contains a key name and the values for these 
parameters:

! MAXIMO column name

! Microsoft Project task field name

! lookup status in Maximo Project Manager

NOTE You cannot change the key name.

Available Fields You can use the following Microsoft Project task fields to map to Maximo 
fields:

! Date1-Date10

! Text1-Text27

! Cost1-Cost10

! Number1-Number20

NOTE Select a data type for the Microsoft Project field that is compatible with the 
data type of the MAXIMO column. For example, if the Maximo field is ALN, or 
alphanumeric, the Microsoft Project field should be ALN also. 

CAUTION Do not reuse the same field in multiple sections.
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[wofieldmap] Section

Use this section to transfer specific work order data in Maximo to Microsoft 
Project. Maximo Project Manager transfers the Maximo data to the current 
work order project, and displays it in the Gantt Chart table. 

Sample entry:
[wofieldmap]
WOMAPROW1=location text1 TRUE

In the preceding entry, the map line contains: 

Notes for this section:

Key Name The key name always starts with WOMAPROW. You can map up to 99 rows 
(WOMAPROW1-WOMAPROW99) in this section.

Work Order Column Name The MAXIMO database column from which work order data is transferred to 
Microsoft Project and stored in the current project. The data from the 
MAXIMO column appears in the project�s Gantt Chart table.

Microsoft Project Field The Microsoft Project task field that holds the incoming Maximo work order 
column data. This field name is language dependent; it must match the field 
name in Microsoft Project.

NOTE Select a data type for the Microsoft Project field that is compatible with the 
data type of the MAXIMO Work Order column. For example, if the Maximo 
work order field is ALN, or alphanumeric, the Microsoft Project field should be 
ALN also. You must spell MAXIMO column names and Microsoft Project 
fields correctly. 

Lookup Status This setting determines if a Select Value list is enabled for the Maximo Project 
Manager field. If TRUE, the Select Value list is enabled in Maximo Project 
Manager. If FALSE, the Select Value list is disabled.

Parameter Value Description

Key Name WOMAPROW1 Key name

Maximo Column Name location MAXIMO column name value

Microsoft Project Task Field 
Name

text1 Microsoft Project task field name value

Lookup Status TRUE Lookup has been enabled in Maximo Project 
Manager
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[pmfieldmap] Section

Use this section to transfer specific PM data in Maximo to Microsoft Project. 
Maximo Project Manager transfers the Maximo data to the current project, 
and displays it in the Gantt Chart table. 

Sample entry:
[pmfieldmap]
PMMAPROW2=assetnum text2 TRUE

In the preceding entry, the map line contains: 

Notes for this section:

Key Name The key name always starts with PMMAPROW. You can map up to 99 rows 
(PMMAPROW1-PMAPROW99) in this section.

PM Column Name The MAXIMO database column from which PM data is transferred to 
Microsoft Project and stored in the current project. The data from the 
MAXIMO column appears in the project�s Gantt Chart table. 

Microsoft Project Field The Microsoft Project task field that holds the incoming Maximo PM column 
data. This field name is language dependent; it must match the field name in 
Microsoft Project.

NOTE Select a data type for the Microsoft Project field that is compatible with the 
data type of the MAXIMO PM column. For example, if the Maximo PM field is 
ALN, or alphanumeric, the Microsoft Project field should be ALN also. You 
must spell MAXIMO column names and Microsoft Project fields correctly. 

Lookup Status This setting determines if a Select Value list is enabled for the Maximo Project 
Manager field. If TRUE, the Select Value list is enabled in Maximo Project 
Manager. If FALSE, the Select Value list is disabled.

Parameter Value Description

Key Name PMMAPROW2 Key name

Maximo Column Name assetnum MAXIMO column name value

Microsoft Project Task Field 
Name

text2 Microsoft Project task field name value

Lookup Status TRUE Lookup has been enabled in Maximo Project 
Manager
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Sample Copy of the MaximoProject.ini File

; MaximoProject.INI

;  NOTE: Semicolons (;) placed before lines of text in this file indicate
;  to the application that the text can be ignored. For the application to 
;  be able to read a value, you must remove the semicolon (if one exists) 
;  at the beginning of its line.   

;  The [system] section enables you to customize field defaults for the 
;  MAXIMO Login dialog box that connects your system to MAXIMO MXServer. 
;  You can set defaults for one or more of the fields. To ensure a successful 
;  log in, semicolons (;) should not be placed in front of the SERVERIP, 
;  SERVERRMI, SERVERPORT, or SERVERNAME Parameters and each of these must 
;  contain a valid value. In the case of SERVERRMI, the semicolon (;) should
;  only be removed if the server has a non-standard entry (other than 1099) 
;  in the server's mxe.registry.port setting.

;  If the LOGINMODE=Auto line is uncommented, the login dialog box will not 
;  appear and you will be logged in automatically using the Username and 
;  Password values defined below.

[system]
SERVERIP=
;SERVERRMI=
SERVERPORT=
SERVERNAME=MXServer

;LOGINMODE=AUTO

USERNAME=<your maximo username>
PASSWORD=<your maximo password>

;  The [wofieldmap] section enables you to map additional MAXIMO work order
;  fields to specified Microsoft Project task fields. MAXIMO Project Manager 
;  uses these mapped field pairs to transfer data from MAXIMO to Microsoft 
;  Project.  You can define up to 99 rows (field pairs) in this section. Each 
;  row starts with a numbered keyword (WOMAPROW1-WOMAPROW99). The parameters 
;  for each row include the work order field name, the Microsoft Project task 
;  field name, and whether lookup has been enabled.

;  The title of the column header that displays in the Microsoft Project Gantt chart
;  is the value from the title field of the maxattribute table.

;  Below is a sample [wofieldmap] section. Note that these fields would not be
;  mapped (and no data would be transferred) unless the semicolon were removed
:  from the beginning of each line.

[wofieldmap]
;WOMAPROW1=location text1 TRUE
;WOMAPROW2=assetnum text2 TRUE

;  The [pmfieldmap] section enables you to map additional PM work order fields
;  to specified Microsoft Project task fields. MAXIMO Project Manager uses these 
;  mapped field pairs to transfer data from MAXIMO to Microsoft Project. The 
;  format is the same as in the [wofieldmap] section above, except MAXIMO PM 
;  fields are used instead of work order fields. 
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[pmfieldmap]
;PMMAPROW1=location text1 TRUE
;PMMAPROW2=assetnum text2 TRUE

;Do not edit the fields below unless you are sure you know what you are doing

[field-WONUM]
lookuptype=false
editable=false

[field-PARENT]
lookuptype=false
editable=false

[field-STATUS]
lookuptype=valuelist
lookuptable=SYNONYMDOMAIN
keyfield=MAXVALUE
description=description
editable=false

[field-STATUSDATE]
lookuptype=false
editable=false

[field-WORKTYPE]
lookuptype=valuelist
lookuptable=SYNONYMDOMAIN
keyfield=MAXVALUE
description=description
editable=true

[field-DESCRIPTION]
lookuptype=false
editable=true

[field-ASSETNUM]
lookuptype=table
lookuptable=ASSET
keyfield=ASSETNUM
description=description
editable=true

[field-LOCATION]
lookuptype=table
lookuptable=LOCATIONS
keyfield=LOCATION
description=description
editable=true

[field-JPNUM]
lookuptype=table
lookuptable=JOBPLAN
keyfield=JPNUM
description=description
editable=true

[field-FAILDATE]
lookuptype=false
editable=true
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[field-CHANGEBY]
lookuptype=false
editable=true

[field-CHANGEDATE]
lookuptype=false
editable=true

[field-ESTDUR]
lookuptype=false
editable=true

[field-ESTLABHRS]
lookuptype=false
editable=true

[field-ESTMATCOST]
lookuptype=false
editable=true

[field-ESTLABCOST]
lookuptype=false
editable=true

[field-ESTTOOLCOST]
lookuptype=false
editable=true

[field-PMNUM]
lookuptype=false
editable=false

[field-ACTLABHRS]
lookuptype=false
editable=true

[field-ACTMATCOST]
lookuptype=false
editable=true

[field-ACTLABCOST]
lookuptype=false
editable=true

[field-ACTTOOLCOST]
lookuptype=false
editable=true

[field-HASCHILDREN]
lookuptype=false
editable=true

[field-OUTLABCOST]
lookuptype=false
editable=true

[field-OUTMATCOST]
lookuptype=false
editable=true

[field-OUTTOOLCOST]
lookuptype=false
editable=true
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[field-HISTORYFLAG]
lookuptype=false
editable=true

[field-CONTRACT]
lookuptype=false
editable=false

[field-WOPRIORITY]
lookuptype=false
editable=true

[field-TARGCOMPDATE]
lookuptype=false
editable=true

[field-TARGSTARTDATE]
lookuptype=false
editable=true

[field-WOEQ1]
lookuptype=false
editable=true

[field-WOEQ2]
lookuptype=false
editable=true

[field-WOEQ3]
lookuptype=false
editable=true

[field-WOEQ4]
lookuptype=false
editable=true

[field-WOEQ5]
lookuptype=false
editable=true

[field-WOEQ6]
lookuptype=false
editable=true

[field-WOEQ7]
lookuptype=false
editable=true

[field-WOEQ8]
lookuptype=false
editable=true

[field-WOEQ9]
lookuptype=false
editable=true

[field-WOEQ10]
lookuptype=false
editable=true
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[field-WOEQ11]
lookuptype=false
editable=true

[field-WOEQ12]
lookuptype=false
editable=true

[field-REPORTEDBY]
lookuptype=table
lookuptable=PERSON
keyfield=PERSONID
description=DISPLAYNAME
editable=true

[field-REPORTDATE]
lookuptype=false
editable=true

[field-PHONE]
lookuptype=false
editable=true

[field-PROBLEMCODE]
lookuptype=false
editable=false

[field-CALENDAR]
lookuptype=table
lookuptable=CALENDAR
keyfield=CALNUM
description=description
editable=true

[field-DOWNTIME]
lookuptype=false
editable=true

[field-ACTSTART]
lookuptype=false
editable=true

[field-ACTFINISH]
lookuptype=false
editable=true

[field-SCHEDSTART]
lookuptype=false
editable=true

[field-SCHEDFINISH]
lookuptype=false
editable=true

[field-REMDUR]
lookuptype=false
editable=true
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[field-CREWID]
lookuptype=valuelist
lookuptable=ALNDOMAIN
keyfield=VALUE
description=description
editable=true

[field-SUPERVISOR]
lookuptype=table
lookuptable=PERSON
keyfield=PERSONID
description=DISPLAYNAME
editable=true

[field-WOEQ13]
lookuptype=false
editable=true

[field-WOEQ14]
lookuptype=false
editable=true

[field-WOJP1]
lookuptype=false
editable=true

[field-WOJP2]
lookuptype=false
editable=true

[field-WOJP3]
lookuptype=false
editable=true

[field-WOJP4]
lookuptype=false
editable=true

[field-WOJP5]
lookuptype=false
editable=true

[field-WOL1]
lookuptype=false
editable=true

[field-WOL2]
lookuptype=false
editable=true

[field-WOL3]
lookuptype=false
editable=true

[field-WOL4]
lookuptype=false
editable=true

[field-WOLABLNK]
lookuptype=false
editable=true
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[field-RESPONDBY]
lookuptype=false
editable=true

[field-ASSETLOCPRIORITY]
lookuptype=false
editable=true

[field-CALCPRIORITY]
lookuptype=false
editable=true

[field-CHARGESTORE]
lookuptype=false
editable=true

[field-FAILURECODE]
lookuptype=table
lookuptable=FAILURECODE
keyfield=FAILURECODE
description=description
editable=true

[field-WOLO1]
lookuptype=false
editable=true

[field-WOLO2]
lookuptype=false
editable=true

[field-WOLO3]
lookuptype=false
editable=true

[field-WOLO4]
lookuptype=false
editable=true

[field-WOLO5]
lookuptype=false
editable=true

[field-WOLO6]
lookuptype=false
editable=true

[field-WOLO7]
lookuptype=false
editable=true

[field-WOLO8]
lookuptype=false
editable=true

[field-WOLO9]
lookuptype=false
editable=true

[field-WOLO10]
lookuptype=false
editable=true
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[field-GLACCOUNT]
lookuptype=false
editable=true

[field-ESTSERVCOST]
lookuptype=false
editable=true

[field-ACTSERVCOST]
lookuptype=false
editable=true

[field-DISABLED]
lookuptype=false
editable=true

[field-ESTATAPPRLABHRS]
lookuptype=false
editable=true

[field-ESTATAPPRLABCOST]
lookuptype=false
editable=true

[field-ESTATAPPRMATCOST]
lookuptype=false
editable=true

[field-ESTATAPPRTOOLCOST]
lookuptype=false
editable=true

[field-ESTATAPPRSERVCOST]
lookuptype=false
editable=true

[field-WOSEQUENCE]
lookuptype=false
editable=true

[field-HASFOLLOWUPWORK]
lookuptype=false
editable=true

[field-WORTS1]
lookuptype=false
editable=true

[field-WORTS2]
lookuptype=false
editable=true

[field-WORTS3]
lookuptype=false
editable=true

[field-WORTS4]
lookuptype=false
editable=true

[field-WORTS5]
lookuptype=false
editable=true
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[field-SOURCESYSID]
lookuptype=false
editable=true

[field-OWNERSYSID]
lookuptype=false
editable=true

[field-PMDUEDATE]
lookuptype=false
editable=true

[field-PMEXTDATE]
lookuptype=false
editable=true

[field-PMNEXTDUEDATE]
lookuptype=false
editable=true

[field-WORKLOCATION]
lookuptype=table
lookuptable=LOCATIONS
keyfield=LOCATION
description=description
editable=true

[field-EXTERNALREFID]
lookuptype=false
editable=true

[field-SENDERSYSID]
lookuptype=false
editable=true

[field-FINCNTRLID]
lookuptype=false
editable=true

[field-GENERATEDFORPO]
lookuptype=false
editable=true

[field-GENFORPOLINEID]
lookuptype=false
editable=true

[field-ORGID]
lookuptype=false
editable=false

[field-SITEID]
lookuptype=false
editable=false

[field-TASKID]
lookuptype=false
editable=true

[field-INSPECTOR]
lookuptype=false
editable=true
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[field-MEASUREMENTVALUE]
lookuptype=false
editable=true

[field-MEASUREDATE]
lookuptype=false
editable=true

[field-OBSERVATION]
lookuptype=false
editable=true

[field-POINTNUM]
lookuptype=false
editable=true

[field-WOJO1]
lookuptype=false
editable=true

[field-WOJO2]
lookuptype=false
editable=true

[field-WOJO3]
lookuptype=false
editable=true

[field-WOJO4]
lookuptype=false
editable=true

[field-WOJO5]
lookuptype=false
editable=true

[field-WOJO6]
lookuptype=false
editable=true

[field-WOJO7]
lookuptype=false
editable=true

[field-WOJO8]
lookuptype=false
editable=true

[field-ISTASK]
lookuptype=false
editable=false

[field-ESTTOTALCOST]
lookuptype=false
editable=true

[field-WOCLASS]
lookuptype=false
editable=true
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[field-VENDOR]
lookuptype=false
editable=true

[field-ORIGRECORDCLASS]
lookuptype=false
editable=true

[field-ORIGRECORDID]
lookuptype=false
editable=true

[field-JUSTIFYPRIORITY]
lookuptype=false
editable=true

[field-RISK]
lookuptype=false
editable=true

[field-ENVIRONMENT]
lookuptype=false
editable=true

[field-BACKOUTPLAN]
lookuptype=false
editable=true

[field-BACKOUTPLAN_LONGDESCRIPTION]
lookuptype=false
editable=true

[field-MOVETOLOC]
lookuptype=false
editable=true

[field-MOVETOPARENT]
lookuptype=false
editable=true

[field-WOACCEPTSCHARGES]
lookuptype=false
editable=true

[field-OWNER]
lookuptype=false
editable=true

[field-CLASSSTRUCTUREID]
lookuptype=table
lookuptable=CLASSSTRUCTURE
keyfield=CLASSSTRUCTUREID
description=description
editable=true

[field-PARENTCHGSSTATUS]
lookuptype=false
editable=true
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[field-OWNERGROUP]
lookuptype=table
lookuptable=PERSONGROUP
keyfield=PERSONGROUP
description=description
editable=true

[field-COMMODITYGROUP]
lookuptype=false
editable=true

[field-COMMODITY]
lookuptype=false
editable=true

[field-WORKORDERID]
lookuptype=false
editable=true

[field-WHOMISCHANGEFOR]
lookuptype=false
editable=true

[field-REASONFORCHANGE]
lookuptype=false
editable=true

[field-VERIFICATION]
lookuptype=false
editable=true

[field-PERSONGROUP]
lookuptype=table
lookuptable=PERSONGROUP
keyfield=PERSONGROUP
description=description
editable=true

[field-LEAD]
lookuptype=table
lookuptable=PERSON
keyfield=PERSONID
description=DISPLAYNAME
editable=true

[field-MOVETOBINNUM]
lookuptype=false
editable=true

[field-PERFORMMOVETO]
lookuptype=false
editable=true

[field-LANGCODE]
lookuptype=false
editable=true

[field-INTERRUPTIBLE]
lookuptype=false
editable=true
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[field-WOGROUP]
lookuptype=false
editable=true

[field-ONBEHALFOFID]
lookuptype=false
editable=true

[field-HASLD]
lookuptype=false
editable=true
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If you are installing Maximo Project Manager in an environment where you 
have multiple languages enabled for Maximo, you will need to run the 
importlang.bat utility for Maximo Project Manager, the same way you did for 
Maximo. You will need to run the utility once for each additional language 
(besides your base language) that you have enabled.

About the importlang.bat Utility

Importlang.bat populates the corresponding multi language table of the 
MAXIMO database with data from the .XML file. The usage of the 
importlang.bat batch file is as follows:

-infile <path and filename of projectlang<langcode>.xml file>

-propfile <path to maximo.properties file>

-l <language code>

Example

The most common usage of the importlang.bat utility for Maximo Project 
Manager is as follows:

importlang.bat -infile 
C:\maximo\tools\maximo\<langcode>\project\
projectlang<langcode>.xml -l FR

NOTE Your language code will differ, depending on what language you are 
importing. For example, FR means French.

Running the importlang.bat Utility

For each secondary language that you are enabling, you will need to do the 
following:

1 Install the Maximo Server portion of the installation program on your 
Maximo application server. 

2 Run the importlang.bat file included in the installation program for that 
language.

Multi-Language Set Up B
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Example

In your Maximo environment, you have English established as your base 
language, but also have users that access Maximo in French and Chinese.

You install Maximo Project Manager in English (both the server and client 
portions). You then insert the French Maximo Project Manager CD, install 
only the server portion, and run the importlang.bat file for French. Then, you 
insert the Chinese Maximo Project Manager Installation CD, install only the 
server portion, and run the importlang.bat file for Chinese.

CAUTION When you re-install the server portion of Maximo Project Manager, your 
projectlang<langcode>.xml file will be overwritten with the version on the CD. 
If you have made any customizations to the projectlang<langcode>.xml file 
that you do not want erased, select No when the installation program asks 
you if you want to overwrite the existing file.
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